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About this Guide

This preface describes who should read the Cisco Service Control Application for Broadband User
Guide, how it is organized, its document conventions, and how to obtain documentation and technical
assistance.

This guide assumes a basic familiarity with the concept of the Service Control solution, the Service
Control Engine (SCE) platforms, and related components.

Document Revision History

The Document Revision History below records changes to this document.

Cisco Service Control

Revision Release and Date Change Summary

OL-7205-11 35.0 Addition of information regarding traffic mirroring and blacklist URL
January, 2011 database.

OL-7205-10 3.1.7 Changes to the default configuration. See Managing Advanced Service
December, 2008 Configuration Options, page 10-43.

OL-7205-09 3.1.6 Minor correction regarding filter rules.
July, 2008

OL-7205-08 3.1.6 Minor changes throughout the guide.
May, 2008

OL-7205-07 3.1.5 Added the following new features:

November, 2007 e Configuration Wizards, page 4-24

See:
— How to Use the Usage Analysis Wizard, page 4-25
— How to Use the P2P Traffic Optimization Wizards, page 4-37
— How to Use the Reporter DB Configuration Wizard, page 4-52
- How to Configure SCE and CM Devices Using a Wizard, page 5-7

e DSCP ToS Classification (ToS is added as a flavor type, see Managing
Flavors, page 7-45)

e DSCP ToS Marking (see How to Manage DSCP ToS Marker Values,
page 9-28)

Cisco Service Control Application for Broadband User Guide
[ oL-7205-11 .m



About this Guide |

|
Cisco Service Control
Revision Release and Date Change Summary
OL-7205-05 3.1.0 Added the following new features:
May, 2007 e Virtual Links (see Managing Virtual Links, page 9-52)
e Asymmetric Routing Classification Mode, page 10-41
e NetFlow (see NetFlow records, page 8-2)
* Quota Replenish Scatter, page 9-58
Updated the following sections of the document
e Managing Bandwidth, page 9-29
e Information About the System Modes, page 10-40
e Managing Advanced Service Configuration Options, page 10-43
OL-7208-04 3.0.5 Added the following new feature:
November, 2006 e The SCA BB Real-Time Monitoring Configuration Utility, page 13-3
Updated the following sections of the document
e Quick Forwarding (see Filter Rule Actions, page 10-19 and Automatic
Quick Forwarding of Media Flows, page 10-20)
OL-7205-03 3.0.3 Added the following new features:
May, 2006

e Hitless Upgrade of the SLI, page 4-20
¢ Content Filtering (see Managing Content Filtering, page 7-57)
e The Service Security Dashboard, page 10-1

Removed the following deprecated feature:

e Attack Filtering and Subscription Notification
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| About this Guide

Cisco Service Control

Revision Release and Date Change Summary

OL-7205-02 3.0.0

Document name changed to Cisco Service Control Application for Broadband

December, 2005 User Guide.

Both the look-and-feel and the functionality of the Cisco Service Control
Application for Broadband (SCA BB) Console were redesigned for release
3.0. Consequently, this document underwent a major rewrite. The major
changes in this document are listed below.

e Appendixes B, C, D of the 2.5.5 release user guide were moved to a new
document: the Cisco Service Control Application for Broadband
Reference Guide.

e Chapter 8 and Appendix A of the 2.5.5 release user guide were moved to
a new document: the Cisco Service Control Application Suite Reporter
User Guide.

e The Cisco Service Control Application Suite for Broadband Installation
Guide was deprecated; it forms the basis for part of the Getting Started
chapter.

e Chapter 5 of the 2.5.5 release user guide (Constructing Service
Configurations) was completely rewritten and split into three chapters.

e New chapters were added for the new tools included in the Console: the
Network Navigator tool and the Signature Editor tool.

OL-7205-01 2.5.5

First version of this document (then named Cisco Service Control Application

February, 2005 Suite for Broadband User Guide).

Organization

This guide contains the following sections:

Section Title Description

1 Cisco Service Control Overview, Provides a general overview of the Cisco Service

page 1-1 Control solution.

2 System Overview, page 2-1 Provides a functional overview of the Cisco
Service Control solution.

3 Traffic Processing Overview, Provides a technical overview of the Cisco

page 3-1 Service Control solution.

4 Getting Started, page 4-1 Guides you through the process of installing or
upgrading SCA BB and describes the concept of
the Console as a collection of tools.

5 Using the Network Navigator, Explains how to use the Network Navigator to

page 5-1 create a model of all devices that are part of the
Cisco Service Control solution and how to
manage the devices remotely.

6 Using the Service Configuration Explains how to use the Service Configuration

Editor, page 6-1 Editor to manage service configurations.

[ oL-7205-11
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Section Title Description

7 Using the Service Configuration Explains how to configure service configurations
Editor: Traffic Classification, to perform traffic classification.
page 7-1

8 Using the Service Configuration Explains how to configure service configurations
Editor: Traffic Accounting and to perform traffic reporting.
Reporting, page 8-1

9 Using the Service Configuration Explains how to configure service configurations
Editor: Traffic Control, page 9-1 to perform traffic control.

10 Using the Service Configuration Documents additional, advanced options
Editor: Additional Options, page 10-1 |available in the Service Configuration Editor.

11 Using the Subscriber Manager GUI  |Explains how to use the SM GUI tool to configure
Tool, page 11-1 subscribers on the SCMS-SM database.

12 Using the Signature Editor, page 12-1 |Documents the Signature Editor tool, which can

create files for updating protocols in SCA BB.
13 Additional Management Tools and Documents and explains other tools that are

Interfaces, page 13-1 available for use with SCA BB.

Related Publications

Use this Cisco Service Control Application for Broadband User Guide in conjunction with the following
Cisco documentation:

Cisco Service Control Application for Broadband Reference Guide
Cisco Service Control Application for Broadband Service Configuration API Programmer Guide
Cisco Service Control Management Suite Collection Manager User Guide
Cisco Service Control Management Suite Subscriber Manager User Guide
Cisco Service Control Application Reporter User Guide
The SCE platform installation and configuration guides:
— Cisco SCE 1000 2xGBE Installation and Configuration Guide
— Cisco SCE 2000 4xGBE Installation and Configuration Guide
— Cisco SCES8000 Installation and Configuration Guide
Cisco SCE 2000 and SCE 1000 CLI Command Reference
Cisco SCES8000 CLI Command Reference
Cisco SCE 2000 and SCE 1000 Software Configuration Guide
Cisco SCES8000 Software Configuration Guide
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Conventions

This document uses the following conventions:

Convention

Indication

bold font

Commands and keywords and user-entered text appear in bold font.

italic font

Document titles, new or emphasized terms, and arguments for which you supply
values are in italic font.

[ ]

Elements in square brackets are optional.

{xlylz}

Required alternative keywords are grouped in braces and separated by
vertical bars.

[xlylz]

Optional alternative keywords are grouped in brackets and separated by
vertical bars.

string

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

courier font

Terminal sessions and information the system displays appear in courier font.

< >

Nonprinting characters such as passwords are in angle brackets.

[ ]

Default responses to system prompts are in square brackets.

I #

An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

Note Means reader take note.

Tip Means the following information will help you solve a problem.

Caution  Means reader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Timesaver  Means the described action saves time. You can save time by performing the action described in

the paragraph.

A

Warning  Means reader be warned. In this situation, you might perform an action that could result in

bodily injury.
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Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.
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Cisco Service Control Overview

This chapter provides a general overview of the Cisco Service Control solution. It introduces the Cisco
service control concept and capabilities.

It also briefly describes the hardware capabilities of the service control engine (SCE) platform and the
Cisco specific applications that together compose the total Cisco service control solution.

¢ Cisco Service Control Solution, page 1-1
e Cisco Service Control Capabilities, page 1-2
¢ SCE Platform Description, page 1-3

e Management and Collection, page 1-4

Cisco Service Control Solution

The Cisco service control solution is delivered through a combination of hardware and specific software
solutions that address various service control challenges. Service providers can use the SCE platform to
support classification, analysis, and control of Internet and IP traffic.

Service control enables service providers to:
e (apitalize on existing infrastructure.
¢ Analyze, charge for, and control IP network traffic at multigigabit wire line speeds.
e Identify and target high-margin content-based services and enable their delivery.

As the downturn in the telecommunications industry has shown, IP service providers’ business models
need to be reworked to make them profitable. Having spent billions of dollars to build ever larger data
links, providers have incurred massive debts and faced rising costs. At the same time, access and
bandwidth have become commodities where prices continually fall and profits disappear. Service
providers have realized that they must offer value-added services to derive more revenue from the traffic
and services running on their networks.

Cisco service control solutions allow the service provider to capture profits from IP services through
detailed monitoring, precise, real-time control, and awareness of services as they are delivered.

Service Control for Broadband Service Providers

Service providers of any access technology (DSL, cable, mobile, and so on) targeting residential and
business consumers must find new ways to get maximum leverage from their existing infrastructure,
while differentiating their offerings with enhanced IP services.

Cisco Service Control Application for Broadband User Guide
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The Cisco service control application for broadband adds a layer of service intelligence and control to
existing networks that can:

Report and analyze network traffic at subscriber and aggregate level for capacity planning

Provide customer-intuitive tiered application services and guarantee application service level
agreements (SLAS)

Implement different service levels for different types of customers, content, or applications
Identify network abusers who are violating the acceptable use policy (AUP)

Identify and manage peer-to-peer traffic, NNTP (news) traffic, and spam abusers

Enforce the AUP

Integrate Service Control solutions easily with existing network elements and business support
systems (BSS) and operational support systems (OSS)

Cisco Service Control Capabilities

The core of the Cisco service control solution is the network hardware device: the Service control engine
(SCE). The core capabilities of the SCE platform, which support a wide range of applications for
delivering service control solutions, include:

Subscriber and application awareness—Application-level drilling into IP traffic for real-time
understanding and controlling of usage and content at the granularity of a specific subscriber.

— Subscriber awareness—The ability to map between IP flows and a specific subscriber to
maintain the state of each subscriber transmitting traffic through the SCE platform and to
enforce the appropriate policy on this subscriber’s traffic.

Subscriber awareness is achieved either through dedicated integrations with subscriber
management repositories, such as a DHCP or a RADIUS server, or through sniffing of RADIUS
or DHCP traffic.

— Application awareness—The ability to understand and analyze traffic up to the application
protocol layer (Layer 7).

For application protocols implemented using bundled flows (such as FTP, which is
implemented using Control and Data flows), the SCE platform understands the bundling
connection between the flows and treats them accordingly.

Application-layer, stateful, real-time traffic control—The ability to perform advanced control
functions, including granular bandwidth (BW) metering and shaping, quota management, and
redirection, using application-layer, stateful, real-time traffic transaction processing. This requires
highly adaptive protocol and application-level intelligence.

Programmability—The ability to quickly add new protocols and adapt to new services and
applications in the service provider environment. Programmability is achieved using the Cisco
Service Modeling Language (SML).

Programmability allows new services to be deployed quickly and provides an easy upgrade path for
network, application, or service growth.

Robust and flexible back-office integration—The ability to integrate with existing third-party
systems at the service provider, including provisioning systems, subscriber repositories, billing
systems, and OSS systems. The SCE provides a set of open and well-documented APIs that allows
a quick integration process.
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SCE Platform Description

e Scalable high-performance service engines—The ability to perform all of these operations at wire
speed.

SCE Platform Description

The SCE family of programmable network devices performs application-layer stateful-flow inspection
of IP traffic, and controls the traffic based on configurable rules. The SCE platform is a network device
that uses ASIC components and reduced instruction set computer (RISC) processors to exceed beyond
packet counting and expand into the contents of network traffic. Providing programmable, stateful
inspection of bidirectional traffic flows, and mapping these flows with user ownership, SCE platforms
provide real-time classification of network use. The classification provides the basis of the SCE platform
advanced traffic-control and bandwidth-shaping functionality. Where most bandwidth shaper
functionality ends, the SCE platform provides further control and shaping options, including:

e Layer 7 stateful wire-speed packet inspection and classification
e Robust support for more than 600 protocols and applications, including:

— General —HTTP, HTTPS, FTP, Telnet, Network News Transfer Protocol (NNTP), Simple Mail
Transfer Protocol (SMTP), Post Office Protocol 3 (POP3), Internet Message Access Protocol
(IMAP), Wireless Application Protocol (WAP), and others

— Peer-to-Peer (P2P) file sharing—FastTrack-KazaA, Gnutella, BitTorrent, Winny, Hotline,
eDonkey, DirectConnect, Piolet, and others

— P2P VoIP—Skype, Skinny, DingoTel, and others

— Streaming and Multimedia—Real Time Streaming Protocol (RTSP), Session Initiation Protocol
(SIP), HTTP streaming, Real Time Protocol (RTP) and Real Time Control Protocol (RTCP),
and others

¢ Programmable system core for flexible reporting and bandwidth control
e Transparent network and BSS and OSS integration into existing networks
e Subscriber awareness that relates traffic and usage to specific customers

Figure 1-1 illustrates a common deployment of an SCE platform in a network.

Cisco Service Control Application for Broadband User Guide
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Figure 1-1 SCE Platform in the Network

o,

Peer network
& Internet

Sy

Aggregation SCE platform

device

Management and Collection

The Cisco service control solution includes a complete management infrastructure that provides the
following management components to manage all aspects of the solution:

e Network management
e Subscriber management
e Service Control management

These management interfaces are designed to comply with common management standards and to
integrate easily with existing OSS infrastructure (Figure 1-2).

Cisco Service Control Application for Broadband User Guide



| Chapter1 Cisco Service Control Overview

Management and Collection

Figure 1-2 Service Control Management Infrastructure
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Network Management

The Cisco service control solution provides complete network Fault, Configuration, Accounting,
Performance, Security (FCAPS) Management.

Two interfaces provide network management:

¢ Command-line interface (CLI)—Accessible through the Console port or through a Telnet
connection, the CLI is used for configuration and security functions.

e SNMP—Provides fault management (through SNMP traps) and performance-monitoring
functionality.

Subscriber Management

Where the Cisco service control application for broadband (SCA BB) enforces policies on different
subscribers and tracks usage on an individual subscriber basis, the Cisco service control management
suite (SCMS) subscriber manager (SM) may be used as middleware software for bridging between OSS
and SCE platforms. Subscriber information is stored in the SM database and can be distributed between
multiple platforms according to actual subscriber placement.

The SM provides subscriber awareness by mapping network IDs to subscriber IDs. It can obtain
subscriber information using dedicated integration modules that integrate with AAA devices, such as
RADIUS or DHCP servers.

Subscriber information may be obtained in one of two ways:

e Push Mode—The SM pushes subscriber information to the SCE platform automatically upon logon
of a subscriber.

e Pull Mode—The SM sends subscriber information to the SCE platform in response to a query from
the SCE platform.

Cisco Service Control Application for Broadband User Guide
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Service Configuration Management

Service configuration management is the ability to configure the general service definitions of a service
control application. A service configuration file containing settings for traffic classification, accounting
and reporting, and control is created and applied to an SCE platform. The SCA BB application provides
tools to automate the distribution of these configuration files to SCE platforms. This standards-based
approach makes it easy to manage multiple devices in a large network.

Service Control provides a GUI to edit and create these files and a complete set of APIs to automate their
creation.

Data Collection

Data collection occurs as follows:

1.

All analysis and data processing functions of the SCE platform result in the generation of Raw Data
Records (RDRs), which the SCE platform forwards using a simple TCP-based protocol
(RDR-Protocol).

RDRs are processed by the Cisco service control management suite collection manager.

The collection manager software is an implementation of a collection system that receives RDRs
from one or more SCE platforms. It collects these records and processes them in one of its adapters.
Each adapter performs a specific action on the RDR.

RDRs contain a variety of information and statistics, depending on the configuration of the system.
Three main categories of RDRs include:

Transaction RDRs—Records generated for each transaction, where a transaction is a single event
detected in network traffic. The identification of a transaction depends on the particular application
and protocol.

Subscriber Usage RDRs—Records generated per subscriber, describing the traffic generated by that
subscriber for a defined interval.

Link RDRs—Records generated per link, describing the traffic carried on the link for a defined
interval.

Cisco Service Control Application for Broadband User Guide
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The Cisco Service Control Application for Broadband (SCA BB) is the Cisco Service Control solution
that allows broadband service providers to gain network-traffic visibility, to control the distribution of
network resources, and thereby to optimize traffic in accordance with their business strategies. It enables
service providers to reduce network costs, improve network performance and customer experience, and
create new service offerings and packages.

System Components, page 2-1
Subscribers and Subscriber Modes, page 2-2

Service Configuration, page 2-6

System Components

The Cisco Service Control solution consists of four main components:

The Service Control Engine (SCE) platform—A flexible and powerful dedicated network-usage
monitor that is purpose-built to analyze and report on network transactions at the application level.

For more information about the installation and operation of the SCE platform, see the Cisco SCE
Platform Installation and Configuration Guides.

The Service Control Management Suite (SCMS) Subscriber Manager (SM)—A middleware
software component that is used where dynamic binding of subscriber information and policies is
required. The SM manages subscriber information and provisions it in real time to multiple SCE
platforms. The SM can store subscriber policy information internally, and act as a stateful bridge
between the AAA system (such as RADIUS and DHCP) and the SCE platforms.

For more information about the installation and operation of the SM, see the Cisco Service Control
Management Suite Subscriber Manager User Guide.

The Quota Manager (QM) is an optional component of the Subscriber Manager. It enables Service
Control solution providers to manage subscriber quota across subscriber sessions with a high degree
of flexibility.

For more information about the installation and operation of the QM, see the Cisco Service Control
Management Suite Quota Manager Solution Guide.

The Service Control Management Suite (SCMS) Collection Manager (CM)—An implementation of
a collection system that receives Raw Data Records (RDRs) from one or more SCE platforms. It
collects usage information and statistics, and stores them in a database. The CM also converts
subscriber usage information and statistics into simple text-based files for further processing and
collection by external systems.

[ oL-7205-11
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For more information about the installation and operation of the CM, see the Cisco Service Control
Management Suite Collection Manager User Guide.

e The Service Control Application (SCA) Reporter—A software component that processes data stored
by the CM and provides a set of insightful reports from this data. The SCA Reporter can run as a
standalone or as an integrated part of the Console.

Together, the SCE platform, the SCMS-CM, the SCMS-SM, and the SCA Reporter are designed to
support detailed classification, analysis, reporting, and control of IP network traffic. The SCMS-CM, the
SCA Reporter, and the SCMS-SM are optional components; not all deployments of the Cisco Service
Control solution require them. Sites that employ third-party collection and reporting applications, those
that do not require dynamic subscriber-aware processing, and those that use a RADIUS or DHCP
sniffing option may not require all of these components.

Figure 2-1 illustrates the flow of information in the Cisco Service Control solution.
¢ Horizontal flow—Represents traffic between subscribers and an IP network.
The SCE platform monitors traffic flow.

e Vertical flow—Represents transmission of the Raw Data Records (RDRs) from the SCE platform to
the CM.

The SM may be added to the control flow to provide subscriber data. This allows SCA BB to conduct
subscriber-level analysis and control.

Figure 2-1 Flow of Information in SCA BB
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Subscribers and Subscriber Modes

One of the fundamental entities in the Cisco Service Control solution is a subscriber. A subscriber is the
most granular entity on which SCA BB can individually monitor, account, and enforce a policy. In the
most granular instance of the SCA BB system a subscriber is an actual customer of the service provider

[l Cisco Service Control Application for Broadband User Guide
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Subscribers and Subscriber Modes

on whom an individual policy is implemented. However, you can also to use SCA BB to monitor and
control traffic at a higher granularity, such as when monitoring or controlling traffic by subnets or
aggregation devices.

One of the most important decisions to be made when designing a service control solution is what
subscribers in the system represent. This determines which subscriber mode will be used, which in turn
determines what (if any) integrations are required and what policies to define. The following sections
describe the different subscriber modes supported and, for each mode, the functions supported, any
prerequisites, and the components needed.

SCA BB supports the following four subscriber modes:

¢ Subscriberless mode—No subscribers are defined. Control and link-level analysis functions are
provided at a global platform resolution.

¢ Anonymous subscriber mode—IP addresses are controlled and monitored individually. The SCE
platform automatically identifies IP addresses as they are used and assigns them to a package.

¢ Static subscriber mode—Incoming IP addresses are bound and grouped statically into “subscribers”
as configured by the system operator.

e Subscriber-aware mode—Subscriber information is dynamically bound to the IP address currently
in use by the subscriber. This can be achieved by integrating with the system (RADIUS, DHCP) that
assigns IP addresses to subscribers, or by sniffing this information. Policy information is either
administered to SCA BB directly or provisioned dynamically via an integration.

Subscriberless Mode

Note

Subscriberless mode is the choice for sites where control and analysis functions are required only at a
global platform resolution. It can be used, for example, to monitor and control the total P2P traffic over
the link.

Subscriberless mode requires no integration; hence the SCMS-SM is not required.

Subscriberless mode is not influenced by the number of subscribers or inbound IP addresses Thus the
total number of subscribers using the monitored link is unlimited from the point of view of the SCE
platform.

Anonymous Subscriber Mode

Anonymous subscriber mode provides the means to analyze and control network traffic at
subscriber-inbound IP address granularity. Use this mode when you do not require
subscriber-differentiated control or subscriber-level quota tracking, when analysis on an IP level is
sufficient, or when offline IP-address/subscriber binding can be performed. For example, you can
identify which subscribers generate the most P2P traffic by identifying the top IP addresses and
correlating them to individual subscribers using RADIUS or DHCP logs. The total bandwidth of P2P
traffic allowed for each subscriber can also be limited.

Anonymous subscriber mode requires no integration or static configuration of the IP addresses used, so
the SCMS-SM is not required. Rather, ranges of IP addresses are configured directly on the SCE
platform, for which the system dynamically creates “anonymous” subscribers, using the IP address as
the subscriber name.

[ oL-7205-11
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S

Note  The total number of concurrently active anonymous subscribers supported by the SCE platform is the
same as the total number of concurrently active subscribers.

Static Subscriber Mode

Static subscriber mode binds incoming IP addresses together into groups, so that traffic from and to
defined subscribers can be controlled as a group. For example, you can define all traffic from and to a
particular network subnet (used by multiple subscribers concurrently) as a (virtual) “subscriber” and
controlled or viewed as a group.

Static subscriber mode supports cases in which the entity controlled by the Cisco Service Control
solution uses a constant IP address or address range that does not change dynamically, such as:

¢ Environments where the subscriber IP addresses do not change dynamically via, for example, DHCP
or RADIUS

¢ Deployments in which a group of subscribers using a common pool of IP addresses (such as all those
served by a particular aggregation device) will be managed together to provide a shared bandwidth
to the entire group

The system supports the definition of static subscribers directly on an SCE platform; it does not require
external management software (such as the SCMS-SM). Use the SCE platform CLI to define the list of
subscribers, their IP addresses, and the associated package.

Subscriber-Aware Mode

In subscriber-aware mode, the SCE is populated by subscriber information (OSS ID and policy) that is
dynamically bound to the (IP) address currently in use by the subscribers. Regardless of the IP address
in use, this provides differentiated and dynamic control per subscriber and subscriber-level analysis. Use
this mode to control and analyze traffic on a subscriber level, to monitor subscriber usage, and to assign
and enforce different control policies (packages) for different subscribers.

In this mode, the SCMS-SM may provision the SCE platform with subscriber information.

Subscriber Modes: Summary

Table 2-1 summarizes the different subscriber modes supported by the system.
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Table 2-1

Summary of Subscriber Modes

Subscribers and Subscriber Modes

Mode

Features Supported

Main Advantages

Use for...

Subscriberless mode

Global
(platform-level)
analysis and control

No subscriber
configuration
required.

Global control solution

or subscriber-level
analysis.

Examples:

¢ Control P2P
uploads at peering
points.

e Limit total
bandwidth of P2P
to a specified
percentage.

Anonymous subscriber
mode

Global analysis and
control

Individual IP
address-level
analysis and control

No subscriber
configuration
required; only
define subscriber IP
address ranges
used.

Provide
subscriber-level
control without
integration.

IP-level analysis or
control that is not
differentiated per
subscriber, and where
offline
IP-address/subscriber
binding is sufficient.

Examples:
e Limit P2P
bandwidth per
subscriber.

e Identify top
subscribers by
identifying top IP
addresses and
correlating them
with RADIUS or
DHCP logs.
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Table 2-1

Summary of Subscriber Modes (continued)

Mode

Features Supported

Main Advantages

Use for...

Static subscriber mode .

Global analysis and
control

Control based on
individual or group
IP addresses as
configured
statically to the
SCE platform

One-time static
subscriber
configuration, with
no integration
requirements.

Manage subscriber
traffic in logical
groups.

Control of traffic of
groups of subscribers.

Example:

e Assignabandwidth
limit for P2P traffic
for each group of
subscribers using a
single CMTS
device.

Subscriber-aware mode |

Full system
functionality

Differentiated and
dynamic control per
subscriber.

Subscriber-level
analysis, regardless
of IP address in use.

Control and analysis of
traffic on a subscriber
level.

Examples:

* Monitor
subscriber-usage,
regardless of IP
addresses.

e Assign different
control policies
(packages) to
different
subscribers, and
change packages
dynamically.

Service Configuration

Service configuration defines the way the SCE platform analyses and controls traffic. In very general
terms, as illustrated in Figure 2-2, service configuration defines the following:

Protocol and service classification

Packages and policies
Bandwidth controllers

Global controllers

[l Cisco Service Control Application for Broadband User Guide
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Figure 2-2 Service Configuration
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Service configuration is accomplished using one of the following:
e The Console
e The SCA BB Service Configuration Utility
e The Service Configuration API

The SCA BB Console

The SCA BB Console is a set of GUI tools that are used to manage, configure, and monitor the solution
components.

The Console is fully documented in the remainder of this guide.

The Service Configuration Utility

The SCA BB Service Configuration Utility (servconf) is a simple command-line utility that you can use
to apply PQB configuration files onto SCE platforms or to retrieve the current configuration from an
SCE platform and save it as a PQB file. The utility configures SCE platforms with the service
configuration defined in a PQB file. You can install and execute it in a Windows or Solaris environment.

For full documentation of servconf, see The SCA BB Service Configuration Utility, page 13-1.

The Service Configuration API

The Service Configuration API is a set of Java classes used to:
e Program and manage service configurations
e Apply service configurations to the SCE platforms
e Integrated applications with third-party systems

This allows service providers to automate and simplify management and operational tasks.

Cisco Service Control Application for Broadband User Guide
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The Service Configuration API is documented in the Cisco Service Control Application for Broadband
Service Configuration API Programmer Guide.
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Traffic Processing Overview

This module describes how the Cisco Service Control Application for Broadband (SCA BB) installed on
a Service Control Engine (SCE) platform processes traffic.

The module also defines the main elements (service configuration entities) of the SCA BB system and
explains how they relate to each other.

Routing Environment, page 3-1

Traffic Processing, page 3-2

Traffic Classification, page 3-2

Traffic Accounting and Reporting, page 3-8
Traffic Control, page 3-12

Other Traffic Processing Features, page 3-16

Service Configurations, page 3-19

Routing Environment

Traffic processing depends on the routing environment. The Cisco Service Control solution can operate
in two typical routing schemes:

Symmetric (Normal)—For most flows the inbound and outbound traffic is routed through one SCE
platform. For a marginal number of flows only one direction goes through this SCE platform.

Asymmetric—For a significant number of flows, only one direction (inbound or outbound) is routed
through the SCE platform. For other flows, both directions go through this SCE platform.

A flow is bidirectional when the inbound and outbound traffic of the flow pass through the same
SCE platform. A unidirectional flow is one where only one of the inbound traffic and the outbound
traffic go through the SCE platform.

The Cisco Service Control solution can handle both unidirectional and bidirectional flows. The SCE
platform can be configured to operate in either a symmetric or an asymmetric routing environment.
The traffic processing capabilities of the SCE platform in the asymmetric environment is a subset of
its capabilities in the symmetric environment.

When the Cisco Service Control solution is deployed in an asymmetric routing environment, and
unidirectional classification is enabled, the SCE platform classification is better tuned to identify
traffic based on a single direction. The SCE platform handles unidirectional flows independently,
with no synchronization with other SCE platforms that might handle the flows’ opposite direction.
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Traffic Processing

There are three stages of traffic processing:

e Traffic classification—SCA BB analyses traffic flows and determines their type (for example,
browsing, e-mail, file sharing, or voice).

e Traffic accounting and reporting—SCA BB performs bookkeeping and generates Raw Data Records
(RDRs) that let you analyze and monitor the network.

e Traffic control—SCA BB limits and prioritizes traffic flows according to their service,
subscriber-package, subscriber quota state, and so on.

These three stages are described in the following sections.

You control how classification, reporting, and control are performed by editing service configurations
and applying them to the SCE platform.

Traffic Classification

Services

Traffic processing starts with traffic classification, which categorizes network sessions into services.

For each commercial service that a provider offers to its subscribers, a corresponding service is defined
in the Cisco Service Control solution. You can use this service to classify and identify the traffic, report
on its usage, and control it.

e Services, page 3-2

e Protocols, page 3-4

e Initiating Side, page 3-6

e Zones, page 3-6

e Flavors, page 3-7

e Mapping Flow Attributes to Services, page 3-8

In the traffic classification process, SCA BB categorizes network sessions into services.
Services are the building blocks for:
e Service configurations (because SCA BB can enforce different rules on different services)
e Aggregated usage reporting

From a provider’s point of view, a service is a network product sold to a subscriber. The service is usually
a network application—such as browsing, e-mail, file sharing, or voice—that the subscriber uses. From
a technical point of view, a service consists of one or more service elements, each of which enables a
decision about the service associated with a network traffic flow type.

A number of services are predefined in the default service configuration (these services are listed in the
“Default Service Configuration Reference Tables” chapter of the Cisco Service Control Application for
Broadband Reference Guide). You can modify these services and add additional services to a service
configuration.

A service configuration can contain up to 500 services.
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The classification process occurs when a session starts. The process examines the first few packets of
the session and decides to which service the session belongs. The session is then assigned a service ID
that remains the same during the session’s life cycle.

Traffic is classified and mapped to services on the basis of some or all of the following service elements:

e Protocol—The protocol used. This allows, for example, the mapping of browsing flows and e-mail
flows to separate services.

¢ Initiating side—Whether the subscriber side or the network side generated the flow. This allows, for
example, the mapping of subscriber-initiated and network-initiated peer-to-peer traffic to separate
services.

e Zone—Lists of IP addresses of the network-side host of the flow. This allows, for example, the
mapping of all voice flows going to a specified server to a specific service.

e Flavor—Specific Layer 7 properties such as host names of the network-side host of the flow. This
allows, for example, the mapping of all HTTP flows where the URL matches a certain pattern to a
specific service.

Flavors are not used for classification when unidirectional classification is enabled.

SCA BB uses these flow mappings to map each network connection passing through it to a service. You
define rules for the different services to implement control policies. The classification rules can contain
Layer 3 and Layer 4 parameters (such as port numbers and IP addresses), and also Layer 7 parameters
(such as host name and user agent for HTTP connections).

SCA BB cannot achieve 100% classification of all P2P services, because some P2P applications are very
persistent in trying to connect. They use many alternate protocols and connection schemes. Their native
protocol is encrypted and this encryption tends to change whenever a new version is released. This
means that if you try to block the P2P traffic, the client may eventually connect in some cases. A better
approach may be to limit bandwidth for this traffic to make it ineffective instead of trying for a complete
block.

Service Elements

Note

A service consists of one or more service elements; different network traffic flow types are mapped to
different service elements.

A service element maps a specific protocol, initiating side, zone, and flavor to the selected service. Some
or all of these parameters can take wild-card values.

When unidirectional classification is enabled, the flavor of a service element is always the wild-card
value.

A traffic flow is mapped to a specific service if it meets all four of the following criteria:
e The flow uses the specified protocol of the service element.
e The flow matches the initiating side specified for the service element.
e The destination of the flow is an address that belongs to the specified zone of the service element.

e The flow matches the specified flavor of the service element.
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e If a flow matches two service elements and one is more specific than the other, the flow will be
mapped to the more specific of the two.

For example: Service A is defined for browsing and Service B is defined for browsing to a specific
list of URLs. A browsing flow to a URL on Service B’s list matches both services, but will be
mapped to Service B.

e If a flow matches one parameter of one service element and a different parameter of another service
element, precedence will be given first to matching flavors, then to protocols, then to zones, and
finally to the initiating side.

For example: Service A is defined for e-mail and Service B is defined for all traffic to a specific
network zone. An e-mail flow to the specific network zone matches both services, but will be
mapped to Service A.

Examples of Services

Protocols

Table 3-1 contains examples of services and their network parameters.

Table 3-1 Examples of Services and Service Parameters

Service Name Protocol Initiating Side Zone Flavor

Web Browsing HTTP Subscriber- * *
HTTPS initiated

Web Hosting HTTP Network-initiated |* *

(network-initiated |HTTPS

browsing)

Local SMTP SMTP * Local-mail servers |*

(215.53.64.0/24)

One of the main classifications of a flow is the protocol of a session (that is, of the network application
that generated the session).

A protocol, as defined in the SCA BB system, is a combination of one or more signatures, one or more
port numbers, and a transport type. The protocol of the network flow is identified according to these
parameters. For example, if the port number is 80, the transport type is TCP, and content matches the
HTTP signature, SCA BB maps the flow to the HTTP protocol.

The default service configuration contains a long list of predefined protocols. You can add additional
protocols.

When a TCP or UDP flow does not match a specific protocol definition, SCA BB maps the flow to the
Generic TCP or Generic UDP protocol.

When a non-TCP/UDP flow does not match a specific protocol definition, SCA BB maps the flow to the
Generic IP protocol.

When unidirectional classification is enabled protocol classification is performed in the normal way,
with one exception: unidirectional UDP flows. In this case, SCA BB tries to classify the protocol using
the destination port of the first packet. If no exact match is found, SCA BB tries to classify the protocol
using the source port.

[l Cisco Service Control Application for Broadband User Guide
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Protocol Elements

Signatures

A protocol is a collection of protocol elements.

A protocol element maps a specific signature, IP protocol, and port range to the selected protocol. Some
or all of these parameters can take wild-card values; port numbers can take range values.

A traffic flow is mapped to a specific protocol if it meets all three of the following criteria:
e The flow matches the specified signature of the protocol element.
e The flow protocol matches the IP Protocol of the protocol element.
¢ The flow matches the specified port range of the protocol element.

e If a flow matches two protocol elements and one is more specific than the other, the flow will be
mapped to the more specific of the two.

For example: Protocol A is defined for flows that match the FTP signature and Protocol B is defined
for flows that match the FTP signature on TCP port 21. An FTP flow on port 21 matches both
protocols, but will be mapped to Protocol B.

e If a flow matches the signature of one protocol element and the port of another protocol element; it
will be mapped to the matching signature.

For example: Protocol A is defined for flows that match the FTP signature and Protocol B is defined
for flows on TCP port 21. An FTP flow on port 21 matches both protocols, but will be mapped to
Protocol A.

SCA BB examines traffic flows using the SCE platform’s deep-packet-inspection capabilities, and
compares each flow with an installed set of protocol signatures to identify the network application that
generated the flow.

SCA BB comes with a set of predefined signatures for common network applications and protocols, such
as browsing, e-mail, file sharing, and VoIP.

When unidirectional classification is enabled and a unidirectional flow (inbound or outbound) passes
through the SCE platform, the flow is matched against a special set of unidirectional protocol signatures.
When a bidirectional flow passes through the SCE platform the protocol library tries to match it to one
of its standard (bidirectional) protocol signatures.

Cisco periodically publishes protocol packs containing new signatures and updates to existing
signatures. You can use these protocol packs to update the set of signatures installed on SCA BB,
enhancing its classification capabilities.

Dynamic Signatures

Most signatures used by SCA BB are predefined and hard-coded. SCA BB also allows you to add
dynamic signatures, which can be user-defined.

You can create and edit dynamic signatures in the Signature Editor tool. The Dynamic Signature Script
(DSS) engine in SCA BB carries out the classification using these user-defined signatures in addition to
the predefined signatures.
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Initiating Side

The SCE platform is usually located between the provider’s subscribers and the network.
Subscriber-initiated flows are initiated by the subscriber toward the network; network-initiated flows are
initiated from the network toward the subscriber.

You can limit some flow-types to one initiating side. For example, with HTTP you can restrict the
direction of the flow to subscriber-initiated, because HTTP is always subscriber-initiated when the
subscriber ventures outward to surf the Internet. If the direction of the HTTP flow is network-initiated,
this probably means that a web server is open on the subscriber’s local machine for receiving incoming
HTTP traffic. The provider can block network-initiated HTTP.

Zones
A zone is a collection of network-side IP addresses.
You configure zones by arranging IP addresses in groups connected by a common purpose. A
subscriber’s network flow mapped to a service may be applied to a zone. In practice, zones often define
geographical areas.
Zones are used to classify network sessions; each network session can be assigned to a service element
based on its destination IP address.
Examples of Zones:
e A “walled garden”—A range of IP addresses of a server farm with premium video content, for which
the provider would like to limit access to specific subscribers and to assure traffic priority.
e A zone to differentiate between off-net and on-net flows.
Example of Assigning a Zone to a Session:
e Zone A and Zone B are two user-defined zones. Zone A includes the IP address range 10.1.0.0/16,
and Zone B includes the IP address range 10.2.0.0/16. Analysis of a new session shows that its
network IP address is 10.1.1.1—the session belongs to zone A.
Zone ltems

A zone is a collection of related zone items.
A zone item is an IP address or a range of IP addresses.

Table 3-2 gives examples of zone items.

Table 3-2 Examples of Zone Items

Network Address Example

IP address 123.123.3.2
IP address range (and mask) 123.3.123.0/24

This means that the first 24 bits of the IP address
must be included as specified and the final 8 bits
can take any value. (That is, all IP addresses in the
range 123.3.123.0 to 123.3.123.255.)
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Flavors are advanced classification elements that classify network sessions according to
signature-specific Layer 7 properties.

Flavors provide an additional level of granularity in defining services in the Cisco Service Control
solution. A protocol flavor uses an additional protocol attribute in classifying a service, making this
service a flavor of the service based on the protocol only. For example, the user-agent attribute of the
HTTP protocol could be added as a protocol flavor, enabling the definition of all HTTP traffic generated
by the same browser type (indicated in the user-agent field) as one service.

Examples of flavor types are HTTP User Agent and SIP Source Domain.

Flavors are not used for traffic classification when unidirectional classification is enabled.

A flavor is a collection of flavor items.

The type of a flavor item depends on the flavor type. For a list of available flavor types, see Flavor Types
and Parameters, page 7-46.

The default service configuration includes some predefined flavors, such as HTTP Streaming Agents (a
flavor of HTTP) and Vonage (a flavor of SIP).

One flavor type is TOS. This allows DSCP ToS to be used as a classification criterion so that a packet
carrying a specific marking can be assigned to a predefined service with, for example, unlimited
bandwidth or reported. The DSCP ToS classification process takes precedence over other classification
mechanisms to allow external devices, such as a voice gateway, to dictate how the flow is treated. DSCP
ToS-based classification is an excellent way of marking proprietary managed services where SCA BB
does not recognize the applications but identifies them via the DSCP ToS field.

Content filtering involves classification and control of HTTP flows according to the requested URL. The
classification of the URL is performed by accessing an external database.

Service providers require effective web filtering for their subscribers, for various purposes such as
avoiding litigation and providing parental control. The problem is that the web is huge and constantly
growing, and SCA BB and the SCE platform are not designed to track and maintain the huge database
of URLSs required for effective filtering.

SCA BB provides content filtering by integrating with SurfControl Content Portal Authority (CPA).
SurfControl’s technology enhances SCA BB URL classification capabilities by eliminating the need for
a network administrator to manage a URL database or interact with the server, while creating a powerful
filtering solution. It provides complete coverage of the web’s most trafficked sites and access to the most
accurate and relevant database of URLs classified by risk category, such as sexually explicit, racist,
hacker, and so forth.
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The integration of SurfControl’s CPA into SCA BB provides the required web-filtering solution. SCA

BB, running on the SCE platform, contacts a CPA server to categorize the website that a subscriber

requests. The returned category is then used to classify the HTTP flow. This classification is then used

for the normal SCA BB traffic control and reporting.

SCA BB includes an internal database of URLs used by the HTTP URL flavor classification. When a
URL is found in both the internal database and the external content filtering database, the URL is

classified according to the internal database.

Mapping Flow Attributes to Services

Figure 3-1 illustrates the mappings of flow elements of a session to service elements of a service.

Figure 3-1 Mapping Flow Attributes to a Service
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You can use data gathered by the SCE platforms for real-time signaling, billing, and reporting.

Various metrics are collected in different scopes—global (per entire link), per service (or group of
services), per package (or group of packages), and per subscriber—based on user-defined usage
counters.

Global control bandwidth is based on Layer 1 volume.

Subscriber bandwidth control (and accounting and reporting) is based on Layer 3 volume.
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The values from the usage counters can be either pushed or pulled:

e The SCE platform generates and transmits Raw Data Records (RDRs) that contain flow, usage, and
other data.

e The SCE platform maintains an SNMP MIB that can be queried by external systems.

Usage Accounting

Note

SCA BB collects and maintains various network metrics, per service, in different scopes.
The network metrics are:

e Upstream volume (L3 kilobytes)

e Downstream volume (L3 kilobytes)

e Sessions

e Active subscribers

e Concurrent sessions

e Session duration

For VoIP services, such as SIP and MGCP, the concurrent sessions usage counter counts concurrent
voice calls, and the session duration usage counter measures voice call duration.

Per service accounting takes place in the following scopes:
e Per subscriber
e Per group of subscribers (package)
e Per link (global)

Several services may share the same service usage counter. For example, in the default service
configuration, the SMTP service and the POP3 service share the E-Mail Counter. The assignment of
services to usage counters is determined by the service hierarchy, as explained in the following section.
Similarly, several packages may share the same package usage counter, and the assignment of packages
to usage counters is determined by The Package Hierarchy.

The Service Hierarchy

Services are arranged in a hierarchal tree. A single default service is at the root, and you can place each
new service anywhere in the tree.

Services inherit the rule of their parents. When a rule is defined for a particular service (in a specific
package), all its child services are controlled by the same rule for that package, unless explicitly
specified.

Service Usage Counters

The service hierarchy provides a way to share usage counters and to organize services according to their
semantics. Services are accounted in groups, as defined in the service hierarchy. Each service is assigned
usage counters.

There are two categories of usage counters for services:

¢ Global—Used for Link Usage and Package Usage RDRs and reports
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¢ Subscriber—Used for Real-Time Subscriber Usage RDRs and reports

A global usage counter and a subscriber usage counter are assigned to each service. The use of a service
can be accounted either exclusively for traffic classified to it or in conjunction with the traffic of its
parent service. For example, if a service called Premium Video Content is defined as a child of
Streaming, the operator can either define a special usage counter for Premium Video Content or
configure it to use the same usage counter as Streaming. The global usage counter and the subscriber
usage counter are independent; for the same service, one usage counter may be the same for parent and
child, whereas the other is exclusive to the child.

The Package Hierarchy

Packages are arranged in a hierarchal tree. A single default package is the root of the tree, and you can
place new packages anywhere in the tree.

Package Usage Counters

The package hierarchy allows you to organize packages according to their semantics and provides for
sharing package usage counters. You can define a maximum of 1024 different exclusive package usage
counters per service configuration, one of which is used for the Unknown Subscriber Traffic package.

Usage reporting at a package level is grouped as follows:

e Package assigned an exclusive package usage counter—All traffic associated with this package is
accounted separately in the assigned counter, along with any children that are not assigned exclusive
counters.

e Package NOT assigned an exclusive package usage counter—All traffic associated with this
package is accounted together with its parent package.

For example, in the example package tree shown in Figure 3-2, if the Mail & Web Baseline package is
allocated an exclusive counter, but neither child package is assigned an exclusive counter, then all
Package Usage RDRs and derived reports (such as “Package Bandwidth per Service”) would group
together usage of subscribers assigned to all three packages.

On the other hand, if the Mail & Web Boost package also had an exclusive counter, the traffic for Main
& Web Baseline and Mail & Web Captive HTTP would be accounted together, but traffic for Mail &
Web Boost would be accounted separately. (In general this is not an efficient configuration. You should
use the hierarchical structure to group packages that can share the same counter.)

Figure 3-2 Example Package Tree
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SCE platforms running SCA BB generate and transmit Raw Data Records (RDRs) that contain
information relevant to the service provider.

RDRs contain a wide variety of information and statistics, depending on the configuration of the system.

RDRs are transmitted using a Cisco proprietary protocol. This requires you to use the Cisco Service
Control Management Suite (SCMS) Collection Manager (CM) or to develop software to process the
RDRs.

The data in some RDRs can also be exported using the NetFlow reporting protocol, which has become
an industry standard. NetFlow reporting allows the SCA BB solution to be more easily integrated with
your existing data collectors.

e RDRs, page 3-11
e NetFlow, page 3-11

The following are the main categories of RDRs:

e Usage RDRs—Generated periodically. These RDRs contain the state of the usage counters, per
service and per accounting scope. There are four types of usage RDRs:

- Link Usage RDRs—Global usage per service, for the entire link.
— Package Usage RDRs—Usage per group of subscribers, per service.

— Subscriber Usage RDRs—Usage per subscriber, per service. These RDRs are generated for all
subscribers. The Cisco Service Control Management Suite (SCMS) Collection Manager (CM)
and Cisco Service Control Application (SCA) Reporter use these RDRs to generate
top-subscriber reports and aggregated usage billing records.

— Real-Time Subscriber Usage RDRs—Generated for selected subscribers only. The SCMS-CM
and SCA Reporter use these RDRs by to generate detailed subscriber activity reports.

e Transaction RDRs—Generated for a sample of the flows. These RDRs are used to create statistical
histograms such as Top TCP Ports.

e Transaction Usage RDRs—Generated for every flow according to user-defined filters. These RDRs
contain detailed Layer 7 information for browsing, streaming, and voice flows. They are used for
flow-based billing.

e Real-Time Signaling RDRs—Generated to indicate specific network events such as flow start or
end. These RDRs are used to signal external systems to allow real-time actions across the network.

e Malicious Traffic RDRs—Generated to indicate that the SCE platform has detected a traffic
anomaly, such as a DDoS attack. These RDRs are used to detect attacks and attackers in order to
mitigate them.

NetFlow
The following information can be exported using the NetFlow protocol
e Usage—Generated periodically. These RDRs contain the state of the usage counters, per service and
per accounting scope.
e Malicious Traffic—Generated to indicate that the SCE platform has detected a traffic anomaly, such
as a DDoS attack.
Cisco Service Control Application for Broadband User Guide
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Packages

Traffic Control provides means to block, limit, or prioritize traffic flows according to service, subscriber
package, subscriber quota state, and so on.

e Packages, page 3-12

e Unknown Subscriber Traffic, page 3-12
e Rules, page 3-13

e Bandwidth Management, page 3-13

e Quota Management, page 3-16

A package is a collection of rules describing subscriber policy. The package defines the group of
services delivered to a specific group of subscribers and the system’s behavior for each service. It may
contain restrictions on network flows, guidelines for flows’ prioritization, and instructions about how to
report flows.

Each subscriber in the network is provided a reference to a package to which that subscriber belongs.
The system:

1. Maps each network flow to a service by matching the flow with a service element

2. Identifies the subscriber to whom the flow pertains, according to the subscriber’s network ID
(usually the subscriber’s IP address)

3. Identifies the package to which the subscriber belongs
4. Applies the correct rule to the service of the subscriber’s network flow

Another scheme is described in Virtual Links Mode, page 3-12.

Virtual Links Mode

In normal mode, you define bandwidth controllers for each package (see Bandwidth Management,
page 3-13). In Virtual Links mode, you define template bandwidth controllers. The actual bandwidth
parameters are assigned to a subscriber when the subscriber enters the system. These parameters depend
on the subscriber's package and the direction of the virtual link.

For more information, see Managing Virtual Links, page 9-52.

Unknown Subscriber Traffic

The SCE platform tries to identify the subscriber responsible for every traffic flow that it processes. The
platform looks at the IP address or VLAN tag of the traffic flow, and checks its internal database for a
subscriber identified by this IP Address or VLAN tag. If such a subscriber is not found in the database,
the traffic flow is mapped to the Unknown Subscriber Traffic category.
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Rules
A rule is a set of instructions that tell the SCE platform how to treat network flows of a specific service.
A rule may:
e Specify that a flow should:
- be blocked
— be granted a certain amount of bandwidth
— have its packet's DSCP ToS marked with a given value (see DSCP ToS Marking, page 3-18)
e Define an aggregate volume or session limit, after which a set of different restrictions will be
enforced on the flow
¢ Specify how a flow will be reported for billing or analysis purposes
Calendars

You can use calendars to divide the hours of the week into four time frames.

After you have configured a calendar, you can add Time-Based Rules to a package that uses the calendar.

Time-Based Rules

A time-based rule is a rule that applies to only one time frame. Time-based rules allow you to set rule
parameters that will only apply at specific times. You might, for example, want to define different rules
for peak, off-peak, nighttime, and weekend usage.

You can add time-based rules to any rule. If a time-based rule is not defined for a time frame, the parent
rule is enforced.

Often, you will want the rules for the different time frames to be similar. When you add a time-based
rule, the settings of the parent rule are copied to the new time-based rule; you can make any needed
changes. Subsequent changes to the parent rule do not affect the time-based rule.

Bandwidth Management

The physical link bandwidth is an absolute limit on the bandwidth that can pass through the system. You
can limit the total bandwidth passing through the SCE platform to a value lower than the physical link
bandwidth. For example, if another device sitting next to the SCE platform on the IP stream has limited
BW capacity, you can limit the bandwidth passing through the SCE platform to match the capacity of

the other device.

Bandwidth control in SCA BB is accomplished in two stages:
¢ Global control
e Subscriber bandwidth control
¢ Global control bandwidth is based on Layer 1 volume.

e Subscriber bandwidth control (and accounting and reporting) is based on Layer 3 volume.

Global Bandwidth Control

Total bandwidth use is controlled by global controllers. Global controllers are virtual queues in SCE
platforms. You configure them for the entire system, rather than for individual subscribers.

Cisco Service Control Application for Broadband User Guide
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Global controllers provide constraints for large, global volumes of traffic, such as “Total Gold
Subscriber Traffic”, or “Total P2P Traffic”. Each global controller defines the maximum percentage of
total available bandwidth allocated to all traffic of a particular type. Using a global controller, you can
limit total traffic of services such as P2P in the system to any desired percentage of the total available
bandwidth. In this way, you keep the total bandwidth consumed by this traffic under control.

The upstream and downstream interfaces are each assigned one default global controller that, by default,
controls 100 percent of the link traffic. You can add up to 1023 more global controllers for each
interface, and you can assign a maximum percentage of the total link limit to each global controller
separately.

For each global controller, you can define separate values for the maximum percentage of total available
bandwidth separately for each time frame. (See Calendars, page 3-13.)

In dual-link systems you can define different bandwidth values for each link. You can also set a limit on
the aggregated bandwidth passing on the two links.

Virtual Links mode uses template global controllers. Template global controllers are templates of virtual
queues; they are applied to as many separate physical links as exist in the system. For each physical link,
actual bandwidth parameters depend on the link. (For more information, see Managing Virtual Links,
page 9-52.)

Subscriber Bandwidth Control

Bandwidth used by individual subscribers is controlled by Subscriber BW Controllers (BWCs). Each
BWC controls available bandwidth for selected services. Services controlled by a particular BWC are
defined per package, but bandwidth control is per service.

A BWC is specified by the following parameters:

e Committed Information Rate (CIR)—The minimum bandwidth that must be granted to the services
that are controlled by the BWC

e Peak Information Rate (PIR)—The maximum bandwidth that can be allocated to the services that
are controlled by the BWC

¢ Global Controller—The global controller to which this BWC links

e Assurance Level (AL)—The rate of change of available bandwidth under conditions of traffic
congestion

As illustrated in Figure 3-3, the maximum available bandwidth (Admitted Information Rate (AIR))
ranges between the CIR and the PIR. The actual consumed bandwidth is always less than the AIR.

The BWC has a third parameter that controls how the AIR is determined at different congestion
conditions. When the network is not congested the system allows the PIR and when the network is highly
congested the system provides the CIR. In between these two extremes, the AIR is determined by a third
parameter—Assurance Level (AL). The AL controls how fast the AIR would decrease from the PIR to
the CIR as congestion builds, or increase from the CIR to the PIR as congestion decreases. A higher AL
ensures a higher AIR compared to a similar BWC with a lower AL.

The BWC ensures that even when the network is congested (PIR-congestion) at least the CIR is granted.
Similarly, the BWC ensures that even when there is little traffic associated with a BWC the PIR is not
exceeded.
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Figure 3-3 Bandwidth Control Levels

Bandwidth may be thought of in terms of a virtual pipe of adjustable width. The PIR is the maximum
allowed width of the virtual pipe. The CIR is the minimum width to which the pipe can contract. The
actual pipe width is the AIR. During network congestion, the system contracts each pipe differently to
differentiate between subscribers and between their services.

Primary and Internal Bandwidth Control

In SCA BB each subscriber has an independent set of BWCs, consisting of a single Primary (Total) BWC
(tBWC) that controls the total bandwidth available to the subscriber and several Internal BWCs (iBWCs)
that control the available bandwidth of some services of that subscriber, as illustrated in Figure 3-4. For
example, one BWC may control the Streaming Service; another may control the Download and E-mail
Services together.

The PIR defines the maximum bandwidth for the associated services; the CIR defines the minimum
bandwidth for them.

Figure 3-4 Bandwidth Control on Two Levels

Total level
tBWC

Internal level

141643

You can link iBWCs to traffic in the following way:
1. In the package general definitions, add a subscriber BWC, defined by its CIR, PIR, AL and CoS.

2. When defining a rule, assign each service to one subscriber BWC.

[ oL-7205-11
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Quota Management

You can assign subscribers a quota limit on selected services.

Each subscriber has 16 quota buckets, each of which you can define for volume or sessions. When a
subscriber uses a certain service, the amount of consumed volume or number of sessions is subtracted
from one of the buckets.

The service configuration determines which bucket to use for each service. Consumption of volume
buckets is measured in units of L3 kilobytes. Consumption of session buckets is measured by the number
of sessions. For example, you can define that the Browsing and E-Mail services consume quota from
Bucket #1, that the P2P service consumes quota from Bucket #2, and that all other services are not bound
to any particular bucket.

External quota provisioning systems can use the Quota Provisioning API (see the Cisco SCMS SCE
Subscriber API Programmer’s Guide) to dynamically modify the quota in each bucket. For example, you
can increase the quota of a certain bucket when a subscriber purchases additional quota. These external
systems can also query the amount of remaining quota in each bucket. This can be used, for example, to
show subscribers in a personal web page how much of their quota remains.

External quota provisioning can also be acquired using the Quota Manager (QM), an off-the-shelf
solution provided by Cisco. For more information about the installation and operation of the QM, see
the Cisco Service Control Management Suite Quota Manager Solution Guide.

Note  External quota provisioning is not supported when unidirectional classification is enabled.

The internal SCA BB quota provisioning system replenishes each quota bucket by a fixed amount at
fixed intervals.

Subscribers can be notified when they breach the quota in any bucket.

Subscriber Notification

The subscriber notification feature lets you push web-based messages (such as notifications of quota
depletion) to a subscriber by redirecting the subscriber HTTP traffic to relevant web pages. HTTP
redirection starts when the subscriber notification is activated and ceases when the notification is
dismissed.

A

Note  Subscriber notification is not supported when unidirectional classification is enabled.

Other Traffic Processing Features

This section outlines other traffic processing features provided by SCA BB.
e Service Security, page 3-17
e Traffic Filters, page 3-18
e Traffic Forwarding to Value Added Services Servers, page 3-19
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Service Security

SCA BB includes service security functionality to help protect network operators and their subscribers
from attacks and malicious traffic:

DoS attacks

DDoS attacks

VolIP threats

Worms

Hacker activity

Malicious takeover of subscriber computers:
- Spam zombies

— E-mail based viruses

Although it is never possible to provide complete protection from network threats, the Cisco Service
Control solution provides insight into malicious activity in a network, and can mitigate large scale
eruptions of malicious activity that compromise overall network performance.

Networks operators can use SCA BB to:

Monitor network traffic for suspicious activity
Block malicious traffic

Notify subscribers that are creating or have been affected by malicious traffic

Detecting Malicious Traffic

SCA BB uses three threat detection mechanisms:

A

Anomaly Detection—This set of mechanisms monitors the rate of connections (both successful and
unsuccessful) to and from each host IP address. High connection rates or a low ratio between
successful and unsuccessful connections indicate malicious activity.

Anomaly detection characteristics can indicate the following categories of malicious activity:
— IP sweep—Scanning multiple IP addresses, all on the same port (a behavior typical of worms)
— Port scan—Scanning all ports at one IP address (a behavior typical of hackers)
— DoS attack—An attack (on a single IP address) from a single IP address
— DDoS attack—An attack (on a single IP address) from multiple IP addresses

Note  SCA BB will identify a DoS attack with spoofing (using many fake IP addresses instead of one real
address) as a DDoS attack.

The anomaly detection mechanism is effective in addressing new threats as they appear. It does not
need knowledge about their exact nature and Layer 7 signatures, but is based on the characteristics
of their network activity.

Mass mailing activity detection—This mechanism monitors SMTP session rates for individual
subscribers (using SCE platform subscriber-awareness; it can work in subscriber-aware or
anonymous subscriber mode). A high rate of SMTP sessions from an individual subscriber is usually
an indicator of malicious activity that involves sending e-mail (either mail-based viruses or
spam-zombie activity).

[ oL-7205-11
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e Signature based detection—The SCE platform’s stateful Layer 7 capabilities are used to detect
malicious activity that is not easily detectable by the other mechanisms. Operators can add
signatures for such threats, achieving a very quick response time in addressing new threats.

Responding to Malicious Traffic

You can define the following actions when configuring the detection mechanisms described in the
preceding section:

e Monitor the network for malicious activity detected by each of these mechanisms.
You can display graphs in the Console based on data collected for malicious activity analysis.

e Automatically block malicious activity detected by the SCE platform to avoid threat propagation
and adverse effects to the network.

¢ Notify subscribers that are involved in malicious activity by redirecting their web sessions to a
captive portal.

SCA BB provides a high level of flexibility in tuning the detection methods to define malicious activity
and in configuring the actions to be taken when malicious activity is detected.

Traffic Filters

Filter rules are part of service configurations. They allow you to instruct the SCE platform to ignore
some types of flow (based on the flow’s Layer 3 and Layer 4 properties) and to transmit the flows
unchanged.

When a traffic flow enters the SCE platform, the platform checks whether a filter rule applies to the flow.
If a filter rule applies to this traffic flow, the SCE platform performs one of the following actions:

e Bypass—The SCE platform passes the traffic flow to its transmit queues without generating any
RDRs (the flow will not appear in records generated for analysis purposes) and without enforcing
any service configuration rules.

¢ Quick forward—A flow filter rule action whose aim is to ensure low latency for delay sensitive
flows. The packets of quick-forwarded flows are duplicated and sent through different paths: one
copy goes directly to the transmit queue and thus suffers only a minimal delay, the other copy goes
through the normal packet path.

A filter rule can also set the DSCP ToS value of the filtered traffic. (See DSCP ToS Marking, page 3-18.)

It is recommended that you add filter rules for OSS protocols (such as DHCP) and routing protocols
(such as BGP) that might traverse the SCE platform. These protocols usually should not be affected by
policy enforcement, and their low volume makes them insignificant for reporting.

A number of filter rules are included in the default service configuration.

Flows of certain protocols can also be filtered according to the flow’s Layer 7 characteristics.

DSCP ToS Marking

DSCP ToS marking is used in IP networks to signal the type and priority of a flow between network
elements. DSCP ToS marking is typically performed by elements that have an insight regarding how
traffic should be treated throughout the network. Such an element can be the element generating
traffic—a voice gateway, for example. SCA BB, being application aware, can, for example, allocate
bandwidth resources based on the business model and the specific needs of latency sensitive
applications.
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Traffic Forwarding to Value Added Services Servers

N

Note

Traffic forwarding to Value Added Services (VAS) servers allows the Cisco Service Control solution to
use an external expert system (VAS server) for additional traffic processing. The SCE reroutes traffic to
the preconfigured location of the VAS server. After processing, the traffic is sent back to the SCE, which
then sends it to its original destination.

VAS traffic forwarding is not supported when unidirectional classification is enabled.

Service Configurations

A service configuration implements and enforces the provider’s business strategy and vision.

A service configuration can take effect only after it is propagated to the appropriate SCE platform. SCA
BB enforces the service configuration by analyzing the network traffic passing through them.

A service configuration consists of:

Traffic classification settings—Services, such as web browsing, file sharing, and VoIP. Each service
consists of elements that define how network traffic is mapped to the service. The configuration
building blocks of services are protocols, zones, flavors, and signatures.

Traffic accounting and reporting settings—Settings that determine how traffic flows and network
usage accounting are reported.

Traffic control settings—Packages, which consist of a set of rules (such as bandwidth rate limit and
quota limits) defined for different services. The main configuration building blocks of packages are
rules, quota buckets, subscriber BWCs, and global controllers.

Defining Service Configurations in Practice

In practice, defining service configurations is an iterative process.

It is recommended that you use the following sequence of steps:

1.

L

Set up the system.
Apply the default serviceconfiguration.
Gather data.
Analyze.
Do one or both of the following:
— Continue traffic discovery by partitioning the traffic into (additional) services.

— Create rules to limit and prioritize traffic according to services and subscriber packages.
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This module:

e Guides you through the process of installing or upgrading the Cisco Service Control Application for
Broadband (SCA BB)

e Explains how to install Protocol Packs, which contain new and updated protocol signatures

e Describes the concept of the Console as a collection of tools, presents each tool and its role, and
describes how to launch the tools andnavigate between them

e Concludes with a Quick Start that describes how to apply your first service configuration and
generate your first report

How to Install SCA BB

You install SCA BB in two stages:
1. Install the SCA BB front ends:
— The SCA BB Console

— The SCA BB Service Configuration Utility, the SCA BB Signature Configuration Utility, and
the SCA BB Real-Time Monitoring Configuration Utility

2. Install the SCA BB application components:

— The SCA BB Service Modeling Language Loadable Image (SLI) and the SCA BB Service
Control Engine (SCE) applicative management plug-in

— The SCA BB Subscriber Manager applicative management plug-in (for systems with a Cisco
Service Control Management Suite (SCMS) Subscriber Manager (SM))

If you are upgrading an existing installation of SCA BB, see How to Upgrade the SCE Using the SCE
Software Upgrade Wizard, page 4-7 or Working with Protocol Packs, page 4-17.

The SCA BB Installation Package

The SCA BB installation package is a ZIP file located in the CCO.
The installation package consists of the following files:

e The installer for the Console: scas-bb-console-<version>-<build>.exe.

Cisco Service Control Application for Broadband User Guide
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e A Cisco installation application package file (PQI file) for each type of SCE platform. Each PQI file
is located in a subfolder whose name is the platform name.

e The file scas_bb_util.tgz, which contains the files for the SCA BB Service Configuration Utility
(servconf), the SCA BB Signature Configuration Utility (sigconf), and the SCA BB Real-Time
Monitoring Configuration Utility (rtmemd) (together with real-time monitoring report templates).

e The file PCubeEngageMib.mib, which defines the SCAS BB MIB, located in the SNMP subfolder.
e The SCA BB Service Configuration Java API distribution file: serviceconfig-java-api-dist.tgz.

¢ The file surfcontrol.xml, which lists the content categories for content filtering using SurfControl
Content Port Authority, located in the URL Filtering subfolder.

Installing SCA BB Application Components

SCA BB has two software components that reside on the SCE platform:
e The SCA BB SLI, which performs traffic processing

e The SCA BB SCE applicative management plug-in, which performs some service configuration
operations

SCA BB also has one software component that resides on the SM device:

e The SCA BB SM applicative management plug-in, which performs some application-specific
subscriber management operations

To install these components from the Console, see How to Install PQI Files on SCE Devices, page 5-21
and Managing CM Devices, page 5-26.

To install these components from a command line, see Installing PQI Files from the Command Line,
page 13-9.

Prerequisites

Before installing SCA BB, verify that the SCE platform and, if used, the SCMS-SM are operational and
are running appropriate versions of their software.

e How to Verify that the SCE Platform is Operational, page 4-2

e How to Verify that the SCE Platform is Running an Appropriate Version of the OS, page 4-3
e How to Verify that the SM is Correctly Installed, page 4-3

e How to Verify that an Appropriate Version of the SM is Running, page 4-3

How to Verify that the SCE Platform is Operational

Step1  Verify that the status LED on the SCE flashes green. (Orange—booting up; flashing orange—warning;
red—failure.)
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How to Verify that the SCE Platform is Running an Appropriate Version of the 0S

Step 1 At the SCE platform CLI prompt (Sce#), type show version.
Step2  Press Enter.

The response shows the version of the OS running on the SCE platform.

How to Verify that the SM is Correctly Installed

Step1  Open a Telnet session to the SM.
Step2  Go to the SM bin directory and type p3sm --sm-status.
Step3  Press Enter.

The response to this command displays the operational status of the SM.

How to Verify that an Appropriate Version of the SM is Running

Step 1 Open a Telnet session to the SM.
Step2  Go to the SM bin directory and type p3sm version.
Step3  Press Enter.

The response to this command displays the SM version.

How to Install SCA BB Front Ends

You should install the following SCA BB front ends:
e The Console

e The SCA BB Service Configuration Utility (servconf), the SCA BB Signature Configuration Utility
(sigconf), and the SCA BB Real-Time Monitoring Configuration tool (rtmemd) (together with
associated real-time monitoring report templates)

— servconf requires access to the Java Runtime Environment (JRE) (see Installing the Java
Runtime Environment, page 4-4).

Hardware Requirements

e Atleast 1024 MB RAM is required to run the Console

e The minimal supported screen resolution for the Console is 1024x768 pixels.

Cisco Service Control Application for Broadband User Guide
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Operating System Requirements

The SCA Reporter GUI front end can be installed on any computer running Windows 2000 or Windows
XP.

Installing the Java Runtime Environment

The SCA BB Service Configuration Utility, serveonf, requires access to JRE version 1.6.
You can download a JRE from the Sun™ website at http://java.com/en/download/

To verify that the JRE is installed, run java -version from the command prompt. The Java version should
start with 1.6.

If a different version of JRE is also installed on the workstation, you may need to tell servconf where to
find the appropriate JRE. Do this by setting the JAVA_HOME environment variable to point to the JRE
1.6 installation directory. For example:

JAVA_HOME=C:\Program Files\Java\j2rel.6_08
How to Install the Console

Step 1 Navigate to the Console installation file, sca-bb-console-3.5.0.exe, and double-click it.

The Welcome page of the SCA BB Console 3.5.0 Setup wizard appears.

® scA BB Console 3.5.0 Setup

Welcome to the SCA BB Console
3.5.0 Setup Wizard
This wizard will guide vou through the installation of SCA BB

Console 3.5.0,
It is recommended that vou close all other applications
before starting Setup. This will make it possible to update

relevant syskem files without having ko reboot your
compuker,

Click Mext to continue,

Mexk = ][ Cancel ]

274158

Step2  Click Next.

The Install Location page of the Setup wizard opens.
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® ScA BB Console 3.5.0 Setup

‘ Choose Install Location
2 @ Choose the folder in which to install SCA BE Consale 3.5.0,

Setup will install SCA BB Console 3.5.0 in the Following Folder. To install in & different Falder,
click Browse and select anather falder, Click Mext ko continue.,

Destination Folder

Browse. ..

Space required: 243, 8ME
Space available: 70,.7GE

< Back. ” MexE > l[ Cancel ]

Step 3 (Optional) Click Browse and choose a different destination folder.
Step4  Click Next.

The Start Menu Folder page of the Setup wizard opens.

SCA BB Console 3.5.0 Setup

‘ Choose Start Menu Folder
2 @ Choose a Start Menu Falder For the SCA BE Consale 3.5.0

sharteuts,

Select the Start Menu Folder in which you would like to create the program's shortcuts, You
can also enter a name to create a new Folder,

ACCEssaties

Adrinistrative Tools 3
Adabe

authar-it 5

Avantio

CEPS Client

Cisco

Cisco IPTV Wiewer
Cisco SCA

Cisco Security Agent
Cisco Systemns YPM Client b

|:| Do not create shortouks

’ < Back. ” Inskall l [ Cancel ]

Step5  (Optional) Enter a different Start Menu folder in the Start Menu Folder field.

Step6  (Optional) Check the Do not create shortcuts check box.
Step 7 Click Install.

The

Installing page of the Setup wizard opens.

274160

274159

How to Install SCABB
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Step 8

Step 9

Step 10
Step 11

® ScA BB Console 3.5.0 Setup

‘ Inztalling
2 Please wait while SCA BE Console 3.5.00is being installed.

Extract: org.eclipse.help.ui_3.3.100,v20080205.jat ... 100%:

[

Extract; org eclipse, equino:, common_3,4.0,v20030201 jar,.. 100%
Extract: org.eclipse. equinoe, htbp.jetty_1.0,100,v20080201 jar. .. 100%:
Extract: org.edipse.equinosx, http. registry_1.0, 100420071203, jar... 100%:
Extract: org.eclipse. eguino:. http.servlet_1.0.100,+200380201 jar... 100%
Extract: org.eclipse, eguino:, jsp. jasper registry_1,0,0,v20080201 jar. .. 100%:
Extract: org.edipse.equinox. jsp.jasper_1.0,100,+20080201.jar... 100%
Extract: org.eclipse. equino:.launcher_1.0.100,v20080205.jar... 100%:
Extract; org.eclipse, eguino:, preferences_3,2,200,v20030201 . jar, ., 100%:
Extract: org.edipse.equinox registry_3.4.0,%20080201 jar... 100%
Extract: org.edipse.help.appserver_3.1.200.v20070510.jar. .. 100%
Extract; org.eclipse.help. base_3.3,100,v20080201 jar, .. 100%

Extract: org.edipse,help,ui_3.3,100,+20080205. jar, .. 100%

[

-

< Back MexE = Cancel

Wait until installation is complete.
The Next button is enabled.
Click Next.

The Installation Complete page of the Setup wizard opens.

‘D SCA BB Console 3.5.0 Setup. M

Completing the SCA BB Console
3.5.0 Setup Wizard

SCA BB Console 3.5.0 has been installed on wour computer,

Click Finish ko close this wizard,

Launch the SCA BE Console 3.5.0

Back [ Firish ] [ Caneel

]

274162

274161

To launch the Console, check the Run SCA BB Console after installation check box.

Click Finish.
The SCA BB Console 3.5.0 Setup wizard closes.

The Console is now installed on the machine.
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A shortcut is added to the Start menu.

How to Install the SCA BB Configuration Utilities

Step 1 From the SCA BB installation package, extract the file scas_bb_util.tgz, and copy it to a Windows,
Solaris, or Linux workstation.

Step2  Unpack the file to a new folder.

The SCA BB Service Configuration Utility (servconf), the SCA BB Real-Time Monitoring
Configuration Utility (rtmemd) (and associated real-time monitoring report templates), and the SCA BB
Signature Configuration Utility (sigconf) are located under the bin folder.

How to Upgrade SCA BB Components

Upgrading SCA BB includes upgrading each of the following software components:
¢ SCE Firmware
e The SCE PQI file
e Protocol Pack SPQI file
e Policy file

~

Note  This section describes the upgrade of SCA BB application components only. For a full description of the
entire Cisco solution upgrade procedure, consult the solution upgrade document accompanying the
formal release.

¢ When you upgrade old PQB files, some protocol IDs are changed automatically. Messages such as
the following may be displayed to indicate the change:

Protocol ID of BaiBao changed from 80 to 43
Protocol ID of PPLive changed from 81 to 44

e When you upgrade a device with a new SPQI or PQI file, all other devices that are not upgraded may
fail

¢ NewCABRleasednatsthdefaulDynamiSignaturBcrigDS Silesee thavas
installed for a previous SCA BB release.

e Ifaprotocol pack for the new release is available, install it after the product installation is complete.
Do not install an old protocol pack on top of a new product installation.

How to Upgrade the SCE Using the SCE Software Upgrade Wizard

You can upgrade the SCE using the Network Navigator Tool via the SCE Software Upgrade Wizard.

Step 1 Open the Network Navigator.

Step2  Choose one or more devices in the Site Manager tree.

Cisco Service Control Application for Broadband User Guide
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Step3  Right-click one of the selected devices.
Step4  From the popup menu that appears, choose SCE Software Upgrade Wizard.
The SCE Software Upgrade Wizard appears.

H SCE Software Upgrade Wizard |:|@®

SCE Software Upgrade :

This wizard helps to upgrade set of SCE devices with most recent software, including
5C035 and Application, and also apply policy settings through POE and Protocal Packs,

273596

Step 5 Click Next.
The SCE IP Addresses page of the SCE Software Upgrade Wizard opens.
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3£ SCE Software Upgrade Wizard |Z|@@

SCE IP Addresses :

Configuring the SCE platforms requires that they are First added to the Metwork
Mawigatar,

Tao add SCE platforms to the Metwork Mavigator, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

fio.56.201.81
10,56,216,40

’ < Back ” Tesk = l

273505

Step6  (Optional) In the edit box, enter additional IP addresses.
Step7  Click Next.
The SCE Usernames and Passwords page of the SCE Software Upgrade Wizard opens.

Cisco Service Control Application for Broadband User Guide
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3 SCE Software Upgrade Wizard |Z|EJE|

SCE Usernames and Passwords
@ & password For the SCE 10.56.201.81 is missing

In otdet bo connect to the SCE platforms, & username and a password need to be
specified for each SCE.

(%) Use a common username and a common password for all SCE platforms:

Username: | admin
Password: | |
() Use separate usernames and passwords for each SCE platform:

SCE IP Address | Username  Password

273587

Step8  Enter the user names and passwords for the SCE devices.
Do one of the following:

e To use the same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field.

e To provide a different user name and password pair for each SCE device, choose the Use separate
usernames and passwords for each SCE platform radio button, and, for each SCE device, enter
the user name and password in the appropriate cell of the table.

Step9  Click Next.
The Connectivity Test page of the SCE Software Upgrade Wizard opens.
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3 SCE Software Upgrade Wizard

Connectivity Test

Testing conneckivity ...

The wizard will now test the cannectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used,
Please wait for the connectivity test bo camplete,

In case of an error, you may use the 'Back! button to go back to previous steps and
correct the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

Type [P Address Status

SCE 10.56.201.81  Testing connectivity ...
SCE 10.56.216,40 Testing connectivity ...

Skip connectivity best ] [Retry conneckivity kest

273589

The wizard tests to see that the connections to the defined devices can be made.

S

Note If a connection to one or more of the devices cannot be made or if there is some problem with
the connection (such as invalid version of the device) an error is displayed next to the device.
You can skip these tests by clicking Skip connectivity test. The connections will be validated
when you click Finish at the end of the wizard.

Click Next.
The SCE Firmware (PKG) Installation page of the SCE Software Upgrade Wizard opens.
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3 SCE Software Upgrade Wizard

SCE Firmware (PKG) Installation
Configure the SCE firmware installation options.

() Install SCE Firmware From a Local File

() Install SCE Firmware From a Remote File (FTR)
{e.g. ftpiffuser:password@ 10,56, 216, 129:21 /software, pai)

(%) Skip SCE Firmware Installation

[ < Back ” Tesk =

273594

Choose the SCE Firmware installation file.
Do one of the following:
e To install SCE Firmware from a local file, click Browse.
A Select file dialog box appears.
Browse to the SCE Firmware installation file that you are installing.

e To download SCE Firmware from a remote site, choose the Install SCE Firmware from a Remote
File (FTP) radio button and in the FTP URL field, enter the URL.

Step11  Choose the Skip SCE Firmware Installation radio button.
Step12 Click Next.
The SCE Application Software (PQI) Installation page of the SCE Software Upgrade Wizard opens.
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3 SCE Software Upgrade Wizard |Z|@g|
SCE Application Software (PQI) Installation
Configure the SCE application software installation options, F
() Install SCE Application Software from a Local File
() Install SCE Application Software From a Remote File (FTR)
{e.q. Ftp:ffuser: password@10.56.216.129: 21 fsaftware. pgi)
(%) Skip 5CE Application Software Installation
o
(o s i
-
Step13 Choose the PQI installation file.
Do one of the following:
¢ To install the PQI file from a local file, click Browse.
A Select file dialog box appears.
Browse to the PQI file that you are installing.
¢ To download a PQI file from a remote site, choose the Install SCE Application Software from a
Remote File (FTP) radio button and in the FTP URL field, enter the URL.
Choose the Skip SCE Software Application Installation radio button.
Step14 Click Next.
The Protocol Pack (SPQI) Update page of the SCE Software Upgrade Wizard opens.
Cisco Service Control Application for Broadband User Guide
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3 SCE Software Upgrade Wizard

Protocol Pack (SPQI) Update

) The file name is empky. b

(%) Update Protocol Pack From a Local File

File name: v| [Browse ]

() Skip Protocaol Pack Update

273598

Step15 Update the protocol pack.

Do one of the following:

To update the SPQI file from a local file, click Browse.
A Select file dialog box appears.
Browse to the SPQI file that you are updating.

Choose the Skip Protocol Pack Update radio button.
Step16  Click Next.

The Service Configuration (PQB) Update page of the SCE Software Upgrade Wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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3 SCE Software Upgrade Wizard

Service Configuration {POB) Update
Configure the PQE update options.

(%) apply the Current Service Configuration

() apply the Defaul: Service Configuration
() apply a Service Configuration From a Local File

’ < Back ” Tesk =

27353

Step17 Choose one of the PQB update options.
e Apply the Current Service Configuration—Keep the existing service configuration.

¢ Apply the Default Service Configuration—Apply the default service configuration delivered with
the product.

e Apply the Service Configuration from a Local File—Apply a service configuration from a local
file.

Step18 If you selected the Apply the Service Configuration form a Local File radio button, click Browse.
A Select file dialog box appears.
Browse to the file containing the service configuration.

Step19 Click Next.
The Confirmation page of the SCE Software Upgrade Wizard opens.

Cisco Service Control Application for Broadband User Guide
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3 SCE Software Upgrade Wizard

The Following upgrade process will kake place when you click the 'Finish' button:

SCE platforms participating in the process:
10.56.201.51
10.56,216,40

SCE Firmware:
Skipped

SCE Application Software:
Skipped

Protocol Pack:
Skipped

Service Configuration:
Keep current configuration

et = L Finish ][ Cancel ]

273588

The actions that the wizard is about to take are listed in the page.
Step20 Click Finish.

You can view the progress in the Progress view.
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3 Network Navigator - SCA BB Console

File Tools Window Help

E7 | network Navigator |

3 network Navigator 23 &2 0 O[3 rroperties 22 B ==

| = [& site Manager || Property Walue
=] default sike

[Z 5M device [1.1.1.1]
FE 5cE-4[10.56.216,41]
& A pr o513 [10.56.216.131]

&l site
| @ Progressview 52 5* T

Main SCE Software Upgrade Task.
| 11 ) ] @
Waiting For SCE upgrade tasks ko complete
Upgrading SCE at 10.56.216.129
Apply policy

i |

El Consale 2 e BE | = e =0

Consale

+ 11/10/08 2:01:24 PH GWT
+ 11/10/08 2:01:31 PM GMT
+ 11/10/08 2:01:39 PM GMT
+ 11/10/08 2:01:48 PM GMT

Reading SCE platform data ...

Preparing configuration script for SCE2000 - 4xGEE ...
sending configuration to SCE ...

Executing configuration script on SCE ...

|
=
=
o

273593

Working with Protocol Packs

SCA BB uses stateful Layer 7 capabilities for classification of traffic flows.

When a traffic flow is handled by the system, it is assigned a signature ID according to the set of Layer

3 to Layer 7 parameters (the signature) characterizing this flow. Typically, these signatures come
embedded in SCA BB.

In order to enable rapid response to the ever-changing protocol environment, SCA BB was enhanced to
allow signatures to be updated dynamically. You can load a protocol support plug-in onto an operational
system, enhancing the system’s protocol support without compromising the stability of the system (no
update of an existing software component is required) and without any service downtime.

e Protocol Packs, page 4-18

¢ Installing Protocol Packs, page 4-18

e How to Verify Version Compatibility for Protocol Packs, page 4-19
e How to Verify the Installation of a Protocol Pack, page 4-19

e Hitless Upgrade of the SLI, page 4-20

Cisco Service Control Application for Broadband User Guide
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Protocol Packs

Periodically, Cisco publishes protocol packs containing new and improved protocol signatures for SCA
BB. A typical protocol pack is a file containing signatures for detecting network worms, popular
peer-to-peer applications, and other relevant protocols. When loaded into SCE platforms, these
signatures improve SCA BB classification abilities.

Note  You can install a protocol pack on an SCE platform only if a PQI is already installed on the platform.

A protocol pack for SCA BB may be either a DSS file or an SPQI file:
e Loading a DSS file to the SCE platform requires no downtime of SCA BB or the platform.
e Loading an SPQI file to the SCE platform entails updating the SCE application:

— If hitless upgrade (see Hitless Upgrade of the SLI, page 4-20) is enabled, there is no downtime
of the SCE platform when loading the SPQI file.

- If hitless upgrade is not enabled, loading an SPQI file requires a short downtime (up to one
minute) of the SCE platform. During that time, network traffic bypasses the platform and is
neither controlled nor reported.

Note  If hitless upgrade is disabled, SPQI installation can cause the loss of the following subscriber data from
all subscribers: package ID, real-time monitoring flag, and quota settings. Subscribers are assigned
default values for these properties.

Installing Protocol Packs

You install a protocol pack on an SCE platform using one of the following:
e The SCA BB Service Configuration Utility, page 13-1
e The Network Navigator tool (see How to Install a Protocol Pack, page 5-17)

S

Note  If the protocol pack is an SPQI file you can enable and configure the hitless upgrade option using Hitless
Upgrade CLI commands. (See Hitless Upgrade of the SLI, page 4-20.)

The tool or utility performs the following steps:

1. Retrieves the current service configuration from the SCE platform and (optionally) stores a backup
copy in a folder that you specify.

2. Imports the signatures that are in the DSS or SPQI file into the service configuration. This
overwrites any DSS that was previously imported into the service configuration.

3. For each new signature that includes a Buddy Protocol attribute (an attribute that points to an
existing protocol) (see The Buddy Protocol, page 12-4)—Adds the new signature to all services that
include the buddy protocol.

4. If the protocol pack is an SPQI file—Replaces the SCE application. This causes a short (up to one
minute) downtime in SCE platform service.

5. Applies the new service configuration to the SCE platform.
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If the protocol pack is an SPQI file and the hitless upgrade option is enabled, you can monitor the
progress of the upgrade using Hitless Upgrade CLI Commands, page 4-20.

How to Verify Version Compatibility for Protocol Packs

A protocol pack is compatible only with specific versions of the SCE application. When working with
protocol packs, you should verify that the protocol pack version matches the SCE application version.
For example, only use a protocol pack for 3.5.0 on SCE application version 3.5.0.

The version compatibility information for each protocol pack is included in the protocol pack’s release
notes.

Step1  Verify that the correct version of servconf is installed and running correctly.
¢ From the command prompt, type servconf --version.
e Press Enter.
The version of the utility should match that of the protocol pack.
Step2  Verify that the correct version of the SCE application is installed.
e At the SCE platform CLI prompt (SCE#), type show version.
e Press Enter.
The application version should match that of the protocol pack.
Step3  Verify that a service configuration (PQB) is applied to the SCE platform.

e In the Console, retrieve and view the current PQB.

How to Verify the Installation of a Protocol Pack

Step 1 At the SCE platform CLI prompt (sce#), type show version.
Step 2 Press Enter

The response shows the version of the OS running on the SCE platform. This includes information about
the installed protocol pack version.

Step3  Retrieve the PQB from the SCE platform and view it using the Console.

Step4  Verify that the new protocols from the protocol pack were added to the service configuration.

The problems that may cause the installation of a protocol pack to fail and their remedies include:

e Missing or incorrect version of the JRE—Install the correct version of the JRE (see Installing the
Java Runtime Environment, page 4-4).

¢ Incorrect or missing SCE application version on the SCE platform— Verify that the correct version
of the SCE application is installed (see How to Verify Version Compatibility for Protocol Packs,
page 4-19).

e No service configuration (PQB) is applied to the SCE platform—Create a new PQB and apply it
using the Console.

Cisco Service Control Application for Broadband User Guide
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e servconf failed to import the new signatures into the PQB—Use the --force-signature update
signature option when running servconf (see servconf Syntax, page 13-1).

When reporting problems to Cisco, please include the servconf log file, located at
<user.home>\.p-cube\servconf.log. On Windows, this usually maps to C:\Documents and
Settings\<username>\.p-cube\servconf.log.

Hitless Upgrade of the SLI

Hitless upgrade is the SCA BB method of upgrading the software components that reside on the SCE
platform without incurring any service downtime.

e Hitless upgrade is available on SCE 2000 and SCE 1000_2U platforms.
e Hitless upgrade is not available on SCE 1000_1.5U platforms.

If hitless upgrade is enabled, classification, reporting, and control continue uninterrupted when you
install an SPQI file (see Working with Protocol Packs, page 4-17). You can install SPQI files using either
the Console or servconf, the SCA BB Service Configuration Utility. An SPQI file is a package that
includes the required (SLI) files.

After the new application is loaded on the SCE platform:
e The new application services all new flows and bundles.

¢ The old application continues to service existing flows (and new flows that belong to bundles of
existing flows).

¢ Both applications share available memory.

Until all old flows die or are killed, the hitless upgrade is considered to be in progress. In order to make
the hitless upgrade process bounded, you can set criteria that will trigger the explicit killing of all flows
still executing on the old application. Two such criteria exist:

e When a specified amount of time has passed since the process started.
e  When the number of old flows goes below a specified threshold.

The default value for the first criterion is 60 (minutes); the default value for the second is zero (flows).
This means that the replace operation is guaranteed to complete after no more than one hour (sooner, if
all old flows die naturally), but no old flows are killed by the application before one hour passes.

These criteria are configurable by CLI commands.

You can initiate the explicit killing of all old flows using a manual command.

Hitless Upgrade CLI Commands

You can configure, monitor, and control hitless upgrade using the SCE platform Command-Line
Interface (CLI). For more information about the SCE platform CLI, see the Cisco SCES8000 CLI
Command Reference.

The commands listed here are explained in the following section.
Use the following CLI commands to configure the criteria for completing a hitless upgrade:

replace completion time <minutes>

no replace completion time

default replace completion time
replace completion num-flows <num>
no replace completion num-flows
default replace completion num-flows
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These commands are line interface configuration commands. To run these commands you must enter line
interface configuration mode (see How to Enter Line Interface Configuration Mode, page 4-22) and see

the sCE(config if)# prompt displayed.

The following two CLI commands are EXEC mode commands.

Use the following CLI command to monitor the progress of a hitless upgrade:

show applications slot <num> replace

Use the following CLI command to force immediate completion of a hitless upgrade:

application slot <num> replace force completion

Description of Hitless Upgrade CLI Commands

Table 4-1 describes the hitless upgrade CLI commands listed in the previous section.

Table 4-1

Hitless Upgrade CLI Commands

Command

Description

replace completion time <minutes>

Sets the time criterion for killing all old flows and
completing the hitless upgrade.

Specifying a value of zero disables this
criterion—the hitless upgrade is completed only
when the number-of-flows criterion is met.

no replace completion time

Sets the time criterion for completing the hitless
upgrade to zero.

default replace completion time

Resets the time criterion for completing the
replace operation to the default value of 60.

replace completion num-flows <num>

Sets the number-of-flows criterion for completing
the hitless upgrade operation.

When the number of old flows drops below the
number specified by this criterion, the remaining
flows are killed and the hitless upgrade is
complete.

no replace completion num-flows

Sets the number-of-flows criterion for completing
the hitless upgrade to zero.

default replace completion num-flows

Resets the number-of-flows criterion for
completing the hitless upgrade to the default value
of zero.

show applications slot <num> replace

Shows the current hitless upgrade state:
e Current replace stage
e Current completion criteria

e Current completion status (elapsed time and
number of flows on each traffic processor)

e Whether this is an upgrade or a downgrade

e Values for spare memory

application slot <num> replace force
completion

Forces the current hitless upgrade process to
complete (killing all old flows).

[ oL-7205-11
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How to Enter Line Interface Configuration Mode

To run line interface configuration commands you must enter line interface configuration mode and see
the SCE(config if)# prompt displayed.

Step 1 At the SCE platform CLI prompt (sce#), type configure.
Step2  Press Enter.
The sCE (config)# prompt appears.
Step3  Type interface LineCard 0.
Step4  Press Enter.

The SCE(config if)# prompt appears.

How to Launch the Console

Step 1 Choose Start > All Programs > Cisco SCA > SCA BB Console 3.5.0 > SCA BB Console 3.5.0.
The Cisco Service Control SCA BB Console splash screen appears.

]
ciIsco

Cisco Service Control

ystems, and the Cisco Systems logo are trademarks
ndfar its affiliates in the United States and certain

After the Console has loaded, the main window of the Console appears.

The first time that you launch the Console, the Welcome view is open in the main window.
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3 Network Navigator, -

Ch BB Console

the SCABB Console

System-wide Configuration

‘WUsage Analysis Wizard
about the li

SCA BB can collect statisti 4] tions and
services used by individual subscribers. This data can be
used for capacity planning and detailing the subscriber
demographics. This wizard lets vou quickly setup the system
for usage analysis.

= P2P Traffic Optimization Wizard

SCA BB can prevent network congestion and reduce costs,
caused by bhandwidth-hunary applications such as P2P, and
improve subscriner experience in using latency sensitive
applications such as woice. This wizard lets vou quickly setup
the system for P2P traffic optimization.

b P2P Traffic Optimization for Asymmetrical Routing

File Tools Preferences Window Help
1 welcome 52 =g
A
alialn . . .
cIsco Introducing Cisco Service Control

The Cisco Service Control Application {SCA) utilizes deep-packet inspection and application classification allowing service providers to offer
application-aware and subscriber-aware services. Use the wizards helow to quickly setup the system, or close this Welcome view and go to

Tools Setup

42" Initial Reporter Setup Wizard

This wizard lets you guickly connect the SCA BB Reporter to a

Caollection Manager's datahase.

241899

Step 2

Close the Welcome view and click Go to the console.

The Welcome view closes. The Network Navigator tool is open in the Console.

3 Network Navigator - SCA BB Console

Preferences

File  Tools

Window  Help

B |ﬂ Metwaork Mavigator |
&3 Network Navigator 52

&7 00

[= %/ Site Manager
o) default site

El console &2

Consale

= Properties 532 | B
Property Yalue
& Progress 2
Mo operations to display at this time,
Ex BH |

%vmﬁ

—
274095
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S

Wte When you close the Console, it will remember which tools are open, which is the active tool, and whether
the Welcome view is displayed, and apply this the next time you launch the Console.

How to Use the Console

The Console is the front end of SCA BB. You use it to configure the services that the SP offers to you.
The Console consists of the following tools:

e Network Navigator tool

¢ Service Configuration Editor tool

e Signature Editor tool

e Subscriber Manager GUI tool

e Reporter tool

The Console GUI has a menu bar and a standard toolbar (see Figure 4-1). Underneath the toolbar is
another bar that displays the button of any open Console tool. When you launch a tool, a button is added
to this bar. To switch between open tools, click the appropriate button on the bar.

Figure 4-1 Menu Bar and Toolbar of the Console GUI

File Tools Preferences Window Help
| o

B Signature Editor -ﬁ Subscriber Manager & Reporter |6 matwork Mavigatar g Service Configuration Editor

274102

Note  The title of the Console window shows the active tool and the active service configuration.

The Welcome View of the Console links to a number of Configuration Wizards that can configure the
initial, basic configuration of your system.

e Configuration Wizards, page 4-24

e The Network Navigator Tool, page 4-59

e The Service Configuration Editor Tool, page 4-60
e The Signature Editor Tool, page 4-62

e The Subscriber Manager GUI Tool, page 4-63

e The Reporter Tool, page 4-64

e Online Help, page 4-65

Configuration Wizards

Four configuration wizards are available from the Welcome view (three of these wizards can also be
executed from the Network Navigator tool):

e Usage Analysis wizard—Creates a simple model of devices and connects to them.
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e The P2P Traffic Optimization wizards:

— P2P Traffic Optimization wizard—Creates a simple model of devices, connects to them, and
limits P2P traffic to a specified percentage of total available bandwidth.

— P2P Traffic Optimization at a Peering Point wizard—Creates a simple model of devices,
connects to them, limits P2P traffic to a specified percentage of total available bandwidth, and
allows you to enable asymmetric routing classification mode.

e Reporter DB Configuration wizard—Connects the SCA BB Reporter tool to a database.

Asymmetric Routing

Traffic processing depends on the routing environment. The Cisco Service Control solution can operate
in two typical routing schemes, symmetric and asymmetric. In asymmetric routing, for a significant
number of flows, only one direction (inbound or outbound) is routed through the SCE platform.

Anonymous Subscriber Mode
Anonymous subscriber mode is a mode in which entities defined as IP addresses or VLANs are treated
as subscribers.

How to Use the Usage Analysis Wizard

The Usage Analysis wizard allows you to create a simple model of devices and connect to them.

~

Note If they do not already exist, devices defined in the wizard are added to the default site in the Site Manager
tree.

Step 1 From the Console main menu, choose Help > Welcome.

The Welcome view opens.

Cisco Service Control Application for Broadband User Guide
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3 Network Navigator - SCA BB Console

File Tools Preferences Window Help

Ex] welcome £2

et . . =
cllsclo Introducing Cisco Service Control

The Cisco Service Control Application (SCA) utilizes deep-packet inspection and application classification allowing service providers to offer
application-aware and subscriber-aware senices. Use the wizards helow to quickly setup the system, or clase this Welcome view and go to
the SCA BB Console.

Systemn-wide Configuration Tools Setup
‘yUsage Analysis Wizard 4 Initial Reporter Setup Wizard
SCA BB can collect statistics abouwt the applications and This wizard lets you quickly connect the SCA BB Reporter to &
services used by individual subscribers. This data can be Collection Manager's datahase.

used for capacity planning and detailing the subscriber
demographics. This wizard lets you quickly setup the system
far usage analysis.

= P2P Traffic Optimization Wizard

SCA BB can prevent netwark congestion and reduce costs,
caused by handwidth-hungry applications such as P2P, and
improve subscriner experience in using latency sensitive
applications such as voice. This wizard 1ets you quickly setup
the system for P2P traffic optimization.

; P2P Traffic Optimization for Asymmetrical Routing

241899

Step2  Click Usage Analysis Wizard.
The Welcome page of the Usage Analysis wizard appears.
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3£ Usage Analysis Wizard

Usage Analysis .f_

SCA BB can collect statistics about the applications and services used by individual
subscribers. This data can be used For capacity planning and detailing the subscriber
dermographics.

This wizard lets wou quickly setup the system For usage analysis.

Cancel

244880

N

Note  You can also execute the Usage Analysis wizard from the Network Navigator tool:

1. Select one or more devices in the Site Manager tree.
2. Right-click one of the selected devices.

3. From the popup menu that appears, select Configuration Wizards > Usage Analysis
Configuration.

4. You can set only one CM and one Reporter database in the wizard. If you select more than one CM
or Reporter database, only one CM and one Reporter database is selected and a warning message is
displayed. Click OK to continue.

Step3  Click Next.
The SCE IP Addresses page of the Usage Analysis wizard opens.

Cisco Service Control Application for Broadband User Guide
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3£ Usage Analysis Wizard

SCE IP Addresses .f_
One or more SCE IP addresses must be specified .

Configuring the SCE platforms requires that they are first added to the Metwork
Mawigatar.,

Tao add SCE platforms to the Mebwork Mavigataor, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

241803

Step4d In the edit box, enter the IP addresses of the SCE devices that should be added to the model.

If you started from the Network Navigator, the IP addresses of the SCE devices that you selected are
displayed in the edit box. You can add additional addresses.

Note  You can work with up to 20 SCE devices at one time using the wizard.

Step5  Click Next.

The SCE Usernames and Passwords page of the Usage Analysis wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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3£ Usage Analysis Wizard E

SCE Usernames and Passwords .f_
@ & password For the SCE 10.56.216.37 is missing

In otdet bo connect to the SCE platforms, & username and a password need to be
specified for each SCE.

(%) Use a common username and a common password for all SCE platforms:
Username: | admin

Passward: |

() lUse separate usernames and passwords For each SCE platform:

SCE IP Address | Username  Password
10.56.216.37 admin

2448G0

Step6  Enter the user names and passwords for the SCE devices.

Do one of the following:

e To use the same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field

¢ To provide a different user name and password pair for each SCE device, select the Use separate
usernames and passwords for each SCE platform radio button, and, for each SCE device, enter
the user name and password in the appropriate cell of the table.

Step7  Click Next.
The CM Setup page of the Usage Analysis wizard opens.

Cisco Service Control Application for Broadband User Guide
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3£ Usage Analysis Wizard

CM Setup
3 AnIP address is missing

Configuring the CM requires that it is First added ko the Nebwork Mavigatar, To add the

M ta the Metwork Mavigator, tvpe its IP address, username and password in the text
boxes below,

The wizard will werify the CMM operational state, and configure the SCE platfroms to

send RDRs ko the M. You may skip this step if the CM is already defined as the RDR
destination of the SCE platforms.

[ skip this step

CM IP address:

CMusername: | scmscm

CM password: |

241804

Step8  Define the SCSM Collection Manager (CM) to use with this configuration.

Do one of the following:

Enter the IP address, user name, and password of the CM device in the appropriate fields.

If you started from the Network Navigator, this information is retrieved and displayed. You can
modify these parameters.

¢ Check the Skip this step check box.
Step9  Click Next.

The Reporter Setup page of the Usage Analysis wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Step 11

3£ Usage Analysis Wizard

Reporter Setup

database IP address and its bvpe below,

[ skip this step

The Reporter generates reparts by executing queties on a database, Specify the

‘Yau may skip this step if the Reporter is already connected to a database.

How to Use the Console W

Database IP address: I

Database type: Evaase |

’ % Back ” et = ]

|

Cancel

244ag2

Define the database to which the Reporter tool should connect.

Do one of the following:

e Enter the IP address of the database and select the database type.

If you started from the Network Navigator, this information is retrieved and displayed. You can

modify these parameters.

¢ Check the Skip this step check box.

Click Next.

The Connectivity Test page of the Usage Analysis wizard opens.

[ oL-7205-11
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3£ Usage Analysis Wizard _
Connectivity Test .f_

Al connectivity tests have passed. %
The wizard will now test the connectivity to the devices that wou specified, to werify

that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and
cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Tvpe 1P Address Stabus

SEE 10.56,216,37  Connection succeeded
Database 10.56.201.81  Connection succeeded
M 10.56.201.81 Connection succeeded

Skip connectivity besk ] [Betry conneckivity best

241803

The wizard tests to see that the connections to the defined devices can be made.

Note If a connection to one or more of the devices cannot be made or if there is some problem with the
connection (such as invalid version of the device) an error is displayed next to the device. You can skip
these tests by clicking Skip connectivity test. The connections will be validated when you click Finish
at the end of the wizard.

Step12 Click Next.

The Anonymous Subscribers page of the Usage Analysis wizard opens.
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3£ Usage Analysis Wizard

Processing traffic per individual subscriber’s IP address 3
in Anonymous Subscribers Mode

In Anonymous Subscribers mode, analysis is performed on an incoming IP address, as
the 5CE platform creates an ‘anonymous', on-the-fly record for each subscriber,

This permits analyzing and controlling traffic at an individual subscriber IP address level,
without 0SS integration,

‘Yol may choose to skip this step if ather Form of subscriber integration is already
configured in the system,

[#]Enable Anonymous Subscribers mode:

241844

Step13  To disable anonymous subscriber mode, clear the Enable Anonymous Subscribers mode check box.
Step14 Click Next.

The Confirmation page of the Usage Analysis wizard opens.

Cisco Service Control Application for Broadband User Guide
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Step 15

3£ Usage Analysis Wizard @

The Foilowing actions will be perFormed when you'Hit the 'Firish' buttan:

Connect to the following SCE platforms and add them to the febwork Mavigator:
10,56.216.37

Conmect ko the CM 10056,201,81 and add it to the Mebwark Mavigataor

Configure the SCE platforms ko send category 1 RDRs to the M

Set the SCE platforms to Anonymous Subscribers mode

Create a Report Only service configuration with transaction RDR rate set as default,

divided by the number of SCE platforms

Apply the service configuration ko the SCE platforms

Connect the Reporter tothe database 10,56,201.81

Merify that the database is connected and configured correckhy

et = [ Einish ” Cancel ]

N

The actions that the wizard is about to take are listed in the page.

Click Finish.

The Configuration Output page of the Usage Analysis wizard opens.

ce Control Application for Broadband User Guide
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Configuration Output

Please wait while the swstem is being configured.

+ 11 11 Cl? Iz IST | INFO | F=,
+ 5T Tl | A0 OUS il G im
+ 11{11/0? T IST App'ly'lng confi gur'at'lcm ‘tD SCE 10 S6. 216 37 (1 out of
+ 111107 1: I=T Eeading 5CE platform data ..
+ 11/11/07 1: I=T Preparing configuration scr1pt for SCE2000 - 4=<FE ..
+ 111107 1: TS sending configuration to SCE ...
+ 111107 1: I=T Executing configuration script on 3CE ...
+ 11/11/07 2: I=T Updating configuration registry ...
+ 11/11/07 2: IST Updating CM at 10.56.201.81 with serwvice configurati
+ 111107 2: TS5 Updating the €M at 10.56.201.81 completed.
+ 1111707 2: I=T Updating CM at 10.56,216.3& with service configurati
+ 11/11,/07 2: IST App]y'lng ccm'F'l gurat10n to SCE 14. 56 216, 3? comp]eted
G Br 2 M IS7T W F: t M at 6. 216,38 service con
+ 1111707 2: I=T | INFO | CDnnec‘t'l ng the Reparter to ‘the da‘tabase
+ 11/11,/07 2: IST | INFD | Werifying that the database 1s connected and configu
SCA BE Templates:
[FA55] A database connection is defined and awvailable.
[P2ss] A11 mandatory preferences have settings.
[P2SS] Policy string translations are available.
[PAs5] Timezone information in CM DE is awvailable.
+ 11/11/0F7 2:00:42 PM IST | INFQO | Configuration completed successtuly L
[ v
< Ed
w0
Back Mext = ] [ Close ][ Cancel ] %
7l

New devices are added to the default site of the Site Manager tree in the Network Navigator.

= & Sike Manager

=R
SCE device 1 [10.56.216.37]

B M device [10.56.201.81]

g Database device [10.56.201.581]

241885

The wizard attempts to connect to all devices that you defined. The operation fails if:
e The wizard cannot connect to any of the SCE devices that you listed in Step 4.
* You defined a CM in Step 8, but the wizard cannot connect to it.
* You defined a database in Step 10, but the wizard cannot connect to it.

If you defined a CM in Step 8, the SCE devices are configured so that the only category 1 RDR
destination is the CM.

Note  RDR categories are the mechanism by which different types of RDRs can be sent to different collectors.
For more information about RDR categories, see the Raw Data Formatting: The RDR Formatter and
NetFlow Exporting” chapter of the Cisco SCE8000 Software Configuration Guide.

Cisco Service Control Application for Broadband User Guide
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Step 16

Step 17

A new service configuration named Usage Analysis is created, and opens in the Service Configuration

Editor.

2 '&9 Service Canfiguration Editor | € Network Mav

: Default Package

(@] Metwork Traffic | L Services

Mo XN

-5 Filtered Traffic
My Service Security

&% Unknawn Subscriber Trafic
| = Contralled Traffic
o] Eij Default Package

The service configuration has the following characteristics:

e Report Only mode.

241888

e The maximum Transaction RDR rate is set as the default value (250) divided by the number of SCE
devices. (To configure the Transaction RDR see How to Manage Transaction RDRs, page 8-4; the
content and structure of the Transaction RDR is listed in "Transaction RDR" in the “Raw Data
Records: Formats and Field Contents” chapter of the Cisco Service Control Application for

Broadband Reference Guide.)

The service configuration is applied to the SCE devices.

If you defined a database in Step 10

1. The SCA BB Reporter tool is connected to the selected database.

2. The first SCE platform entered in Step 4 is selected as the source of service configuration data.

3. The Next button is enabled.

If you did not define a database in Step 10, click Close.

The Usage Analysis wizard closes.

Click Next.

The Create common reports page of the Usage Analysis wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Create common reports

This wizard can create and display carmman reports once the systern configuration is completed.

Moke that in arder For the reparts to show meaningful infarmation, sufficient data must first be accumulated in the database. You may
refresh the reports every Few minutes, as data arrives From the SCE platforms ko the database.

[Jcreate and display common reparts once the configuration is completed

Close ][ Cancel ]

Step18 To create reports, check the Create and display common reports check box.

S

241827

Note Report instances will be created for four predefined report types:

Global Bandwidth per Service

Global Active Subscribers per Service

Top P2P Protocols

Global Hourly Call Minutes per Service (VoIP)

Step19 Click Close.

The wizard closes.

The Reporter tool opens in the Console.

Report instances of each of the four report types open in the Report View of the Reporter tool.

How to Use the P2P Traffic Optimization Wizards

There are two wizards for optimizing P2P traffic:

The P2P Traffic Optimization wizard allows you to create a simple model of devices, connect to

them, and limit P2P traffic to a specified percentage of total available bandwidth.

[ oL-7205-11
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e The P2P Traffic Optimization at a Peering Point wizard allows you to create a simple model of
devices, connect to them, limit P2P traffic to a specified percentage of total available bandwidth, and
enable asymmetric routing classification mode.

Note If they do not already exist, devices defined in the wizard are added to the default site in the Site Manager
tree.

Step 1 From the Console main menu, choose Help > Welcome.

The Welcome view opens.

# Network Mavigator - SCA BB/ Console

File Tools Preferences Window Help

£ welcome £2 =8

] . . .
cI1SCo Introducing Cisco Service Control

The Cisco Service Control Application (SCA) utilizes deep-packet inspection and application classification allowing service providers to offer
application-aware and subscriberaware senices. Use the wizards below to guickly setup the system, or clage this Welcome view and go to
the SCA BB Console.

System-wide Configuration Tools Setup
‘yUsaye Analysis Wizard “7"Initial Reporter Setup Wizard
SCA BB can collect statistics about the applications and This wizard lets you guickly connect the SCA BB Reporer to a
services used hy individual subscribers, This data can be Collection Manager's database.

used for capacity planning and detailing the subscriber
demographics. This wizard lets you quickly setup the system
far usade analysis.

= P2P Traffic Optimization Wizard

SCA BB can prevent netwark congestion and reduce costs,
caused by handwidth-hungry applications such as P2P, and
imprave subscriber experience in using latency sensitive
applications such as voice. This wizard lets you quickly setup
the system for P2P traffic optimization.

p P2P Traffic Optimization for Asymmetrical Routing

241899

Step2  Click P2P Traffic Optimization Wizard or P2P Traffic Optimization for Asymmetrical Routing
Wizard.

The Welcome page of the selected wizard appears:

Cisco Service Control Application for Broadband User Guide
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3¢ P2P Traffic Optimization Wizard

P2P Traffic Dptimization

SCA BE can prevent nebwork cangestion and reduce costs, caused by

bandwidth-hungry applications such as P2P, and imprave subscriber experience in using

latency sensitive applications such as woice,

This wizard lets wou quickly setup the swstem For P2P Traffic Optimization. 1=
=1}
-
(=t}

3 P2P Traffic Optimization for Asymmetrical Routing Wizard [g]
P2P Traffic Optimization

SCA BB can prevent network congestion and reduce costs, caused by

bandwidth-hungry applications such as P2P, and improve subscriber experience alsoin

environments where Asymmetrical Routing occurs (that is, the two sides of a TCP or

LIDP Flow, or some parts of the overall subscriber's traffic braverse on different network

roukes),

This wizard lets wou quickly setup the system For PZP Traffic Optimization in -

Asymmetrical Routing Environments., 5
T
o

A
Note  You can also execute the P2P Traffic Optimization wizard from the Network Navigator tool:

1. Select one or more devices in the Site Manager tree.

2. Right-click one of the selected devices.

3. From the popup menu that appears, select Configuration Wizards > P2P Traffic Optimization
Wizard or Configuration Wizards > P2P Traffic Optimization for Asymmetrical Routing
Wizard.

4. You can set only one CM and one Reporter database in the wizard. If you select more than one CM
or Reporter database, only one CM and one Reporter database is selected and a warning message is
displayed. Click OK to continue.

Step3  Click Next.
The SCE IP Addresses page of the P2P Traffic Optimization wizard opens.
Cisco Service Control Application for Broadband User Guide
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3 P2P Traffic Optimization Wizard

SCE IP Addresses

One or more SCE IP addresses must be specified ;

Configuring the SCE platforms requires that they are first added to the Metwork
Mawigatar.,

Tao add SCE platforms to the Mebwork Mavigataor, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

241888

Stepd  In the edit box, enter the IP addresses of the SCE devices that should be added to the model.

If you started from the Network Navigator, the IP addresses of the SCE devices that you selected are
displayed in the edit box. You can add additional addresses.

Note  You can work with up to 20 SCE devices at one time using the wizard.

Step5  Click Next.

The SCE Usernames and Passwords page of the P2P Traffic Optimization wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Step 6

Step 7

3 P2P Traffic Optimization Wizard

How to Use the Console W

SCE Usernames and Passwords
@ & password For the SCE 10.56.216.37 is missing

specified for each SCE.

Username: | admin

Password: |

SCE IP Address | Username  Password
10.56.216.37 admin

In otdet bo connect to the SCE platforms, & username and a password need to be

(%) Use a common username and a common password for all SCE platforms:

() lUse separate usernames and passwords For each SCE platform:

—

Cancel

241883

Enter the user names and passwords for the SCE devices.

Do one of the following:

e To use the same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field.

e To provide a different user name and password pair for each SCE device, select the Use separate
usernames and passwords for each SCE platform radio button, and, for each SCE device, enter
the user name and password in the appropriate cell of the SCE device table.

Click Next.

The CM Setup page of the P2P Traffic Optimization wizard opens.

[ oL-7205-11
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3 P2P Traffic Optimization Wizard

CM Setup
3 AnIP address is missing

Configuring the CM requires that it is First added ko the Nebwork Mavigatar, To add the

M ta the Metwork Mavigator, tvpe its IP address, username and password in the text
boxes below,

The wizard will werify the CMM operational state, and configure the SCE platfroms to

send RDRs ko the M. You may skip this step if the CM is already defined as the RDR
destination of the SCE platforms.

[ skip this step

CM IP address: |

CMusername: | scmscm

CM password: |

241880

Step8  Define the SCSM Collection Manager (CM) to use with this configuration.

Do one of the following:

e Enter the IP address, user name, and password of the CM device in the appropriate fields.

If you started from the Network Navigator, this information is retrieved and displayed. You can
modify these parameters.

e Check the Skip this step check box.
Step9  Click Next.

The Reporter Setup page of the P2P Traffic Optimization wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Step 10

Step 11

3 P2P Traffic Optimization Wizard

Reporter Setup

database IP address and its bvpe below,

[ skip this step

The Reporter generates reparts by executing queties on a database, Specify the

‘Yau may skip this step if the Reporter is already connected to a database.

How to Use the Console W

—

Database IP address: I

Database type: Evaase |

’ % Back ” et = ]

|

Cancel

241861

Define the database to which the Reporter tool should connect.

Do one of the following:

¢ Enter the IP address of the database and select the database type.

If you started from the Network Navigator, this information is retrieved and displayed. You can

modify these parameters.
e Check the Skip this step check box.
Click Next.

The Connectivity Test page of the P2P Traffic Optimization wizard opens.

[ oL-7205-11
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3 P2P Traffic Optimization Wizard

Connectivity Test

Testing conneckivity ...

The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and

cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Tvpe 1P Address Stabus

SEE 10.56,216,37  Connection succeeded
Database 10.56.201.6  Testing conneckivity ...
M 10.56.201.81 Connection succeeded

Skip connectivity besk ] [Betry conneckivity best

Cancel

241882

The wizard tests to see that the connections to the defined devices can be made.

Note If a connection to one or more of the devices cannot be made or if there is some problem with the
connection (such as invalid version of the device) an error is displayed next to the device. You can skip
these tests by clicking Skip connectivity test. The connections will be validated when you click Finish
at the end of the wizard.

Step12 Click Next.

The Anonymous Subscribers page of the P2P Traffic Optimization wizard opens.
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3 P2P Traffic Optimization Wizard

Processing traffic per individual subscriber’s IP address
in Anonymous Subscribers Mode

In Anonymous Subscribers mode, analysis is performed on an incoming IP address, as
the 5CE platform creates an ‘anonymous', on-the-fly record for each subscriber,

This permits analyzing and controlling traffic at an individual subscriber IP address level,
without 0SS integration,

‘Yol may choose to skip this step if ather Form of subscriber integration is already
configured in the system,

[#]Enable Anonymous Subscribers mode:

ot e [ oo

241853

Step13  To disable anonymous subscriber mode, clear the Enable Anonymous Subscribers mode check box.
Step14 Click Next.
The effect of P2P traffic optimization page of the P2P Traffic Optimization wizard opens.

Cisco Service Control Application for Broadband User Guide
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3 P2P Traffic Optimization Wizard

The effect of P2P traffic optimization

This wizard configures the system to enfarce strick priority between 3 levels of service:
High {vaice), Mediurn {ather) and Low (P2P),

The bwao charts below demonstrate the effect of P2P traffic optimization. The chart an
the left shows how, during peak hours, uncontrolled P2P (in blue) causes congestion
(total kraffic crosses the red ling), while browsing (vellow) and woice (green) quality
deteriorates.

The prictitization that is enforced by this configuration takes place when the katal
traffic rate crosses the configured limit. The chart on the right shows how congestion is
mitigated by thrattling P2P traffic, while allowing brawsing and voice traffic to kake its

’ = Back ]| Mext = | Einish

241854

This page explains why you should optimize (limit) P2P traffic.
Step15 Click Next.
The Link rate limits for P2P traffic optimization page of the P2P Traffic Optimization wizard opens.
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3€ P2P Traffic Optimization for Asymmetrical Routing Wizard @

Classification of split flows

Enable Asymmetric Routing Classification Made when the SCE platforms are inserted in
topalogies with Asymmetrical Routing where the SCE platforms "sees" one direction
part of the each TCP ar UDP bi-directional Flow,

In this mode, the system is better tuned Far still classifying the traffic correcthy while
the SCE platform "sees" only one direction of & flaw, but, some of the system?s
functionality is disabled in this mode (please refer ta the SCA BB User Guide For details),

[JEnable asymmetric Routing Classification Mode:

T T

241855

Step16 Use the sliders to configure the upstream and downstream link rate limits.
The scale of each slider is the percentage of the aggregated bandwidth of both links.
Step17 If you are running the P2P Traffic Optimization wizard, go to Step 20.

If you are running the P2P Traffic Optimization for Asymmetrical Routing wizard, continue at the next
step.

Step18 Click Next.
The Classification of split flows page of the P2P Traffic Optimization wizard opens.

Cisco Service Control Application for Broadband User Guide
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3 P2P Traffic Optimization for Asymmetrical Routing Wizard

Classification of split flows

Enable Asymmetric Routing Classification Made when the SCE platforms are inserted in
topalogies with Asymmetrical Routing where the SCE platforms "sees" one direction
part of the each TCP ar UDP bi-directional Flow,

In this mode, the system is better tuned Far still classifying the traffic correcthy while
the SCE platform "sees" only one direction of & flaw, but, some of the system?s
functionality is disabled in this mode (please refer ta the SCA BB User Guide For details),

[JEnable asymmetric Routing Classification Mode:

T T

241855

Step19 To enable asymmetric routing classification mode, check the Enable Asymmetric Routing
Classification Mode check box.

Step20 Click Next.

The Confirmation page of the P2P Traffic Optimization wizard opens.

Cisco Service Control Application for Broadband User Guide
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3 P2P Traffic Optimization Wizard

The Foilowing actions will be perFormed when you hit the 'Finish' buttan:

Connect to the fFollowing SCE platforms and add them to the Mebwork Mavigator:
10,56.216.37
Connect to the CM 10,56,201,81 and add it to the Network Navigator
Configure the SCE platforms ko send category 1 RDRs to the M
Set the SCE platforms to Anonymous Subscribers mode
Create a Fully Functional service configuration with the following characteristics:
Defaulk Upstream GC PIR is sek at 30%
Default Downstream GC PIR. is set at 100%
For both the 'Default Package' and the 'Unknown Subscriber Package’, the
Following BWCs are created;
P2P BWC: CIR=Min, PIR=Unlimited, AL=1
YolIP BWC: CIR=Ma:, PIR=Unlimited, AL=10
Other BWC: CIR=Mazx, PIR=Unlimited, AL=1
Apply the service configuration ko the SCE platforms
Connect the Reporter to the database 10,56,201,51
Merify that the database is connected and configured correckhy

[ Einish ” Cancel ]

24867

The actions that the wizard is about to take are listed in the page.

For an explanation of the bandwidth controller parameters, see Subscriber BWC Parameters, page 9-40.
Step21 Click Finish.

The Configuration Output page of the P2P Traffic Optimization wizard opens.

Cisco Service Control Application for Broadband User Guide
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Note

Configuration Output

Please wait while the swstem is being configured.

+ 11/11/07 IST | INFO | V F=,
+ 11/11/07 2 ST | W ohymals group SCE ap ce.cisco. com
+ 1111507 IST App'ly'lng confi gur'at'lcm ‘tD SCE 10.56.216. 3? (1 “out of
+ 11/11/07 I=T Eeading 5CE platform data ..
+ 11/11/07 I=T Preparing configuration scr1pt for SCE2000 - 4=<FE ..
+ 11/11/07 TS sending configuration to SCE ...
+ 11/11,/07 I=T Executing configuration script on 3CE ...
+ 11/11,/07 I=T Updating configuration registry ...
+ 11/11/07 IST Updating CM at 10.56.201.81 with serwvice configurati
+ 11/11,/07 TS5 Updating the M at 10.56.201.81 completed.
+ 11/11/0? 5 I=T sl 10.56. 216 38 W th 5erv1ce
+ 2 IST | | Ea 1 oM At 10, % with
+ 11{11/0? IsT App'ly'lng confi gur'at'lcm to SCE 10 56 216,37 cnmp'leted
+ 11/11/07 I=T Connecting the Reporter to the database
+ 11/11/07 IsT Werifying that the database 1s connected and configu
SCA BE Templates:
[FA55] A database connection is defined and awvailable.
[P2ss] A11 mandatory preferences have settings.
[P2SS] Policy string translations are available.
[PAs5] Timezone information in CM DB is awvailable.
+ 11/11/0F 2:35:30 PM IST | INFQ | Configuration completed successtuly L
[ v
< Ed
forl
]
g
Mext = ] [ Close ][ Cancel ]

New devices are added to the default site of the Site Manager tree in the Network Navigator.

SCE device 1 [10,56,216,57]
B M device [10.56.201.81]
Database device [10.56.201.81]

241885

The wizard attempts to connect to all devices that you defined. The operation fails if:
e The wizard cannot connect to any of the SCE devices that you listed in Step 4.
¢ You defined a CM in Step 8, but the wizard cannot connect to it.
¢ You defined a database in Step 10, but the wizard cannot connect to it.

If you defined a CM in Step 8, the SCE devices are configured so that the only category 1 RDR
destination is the CM.

RDR categories are the mechanism by which different types of RDRs can be sent to different collectors.
For more information about RDR categories, see the “Raw Data Records: Formats and Field Contents”
chapter of the Cisco Service Control Application for Broadband Reference Guide.

ce Control Application for Broadband User Guide
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A new service configuration named P2P Traffic Optimization (or P2P Traffic Optimization for
Asymmetrical Routing) is created, and opens in the Service Configuration Editor.

B !Q Service Corfiguration Editar l@*‘ Metwork Mav

Traffic : Default Package
=] Mebwork Traffic :-|;|-Services

o X N\

1

P Filtered Traffic

By Service Security

&%, Unknawn Subscriber Traffic

Controlled Traffic
2 fi-ﬂ' Cefault Package

248683

The service configuration has the following characteristics:
e Full functionality mode.
e The upstream and downstream default AGCs are set with the link limit values defined in Step 16.

e For both the default package and the Unknown Subscriber Traffic package, the following upstream
and downstream BWCs are created:

- P2P
CIR=0
PIR = <value set in global controller>
AL =1

- VoIP

CIR = <value set in global controller>
PIR = <value set in global controller>
AL =10
- P2P
CIR = <value set in global controller>
PIR = <value set in global controller>
AL =1
The service configuration is applied to the SCE devices.
If you defined a database in Step 10:
1. The SCA BB Reporter tool is connected to the selected database.
2. The first SCE platform entered in Step 4 is selected as the source of service configuration data.
3. The Next button is enabled.
Step22 If you did not define a database in Step 10, click Finish.
The P2P Traffic Optimization wizard closes.
Step23 Click Next.

The Create common reports page of the P2P Traffic Optimization wizard opens.

Cisco Service Control Application for Broadband User Guide
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Create common reports

This wizard can create and display carmman reports once the systern configuration is completed.

Moke that in arder For the reparts to show meaningful infarmation, sufficient data must first be accumulated in the database. You may
refresh the reports every Few minutes, as data arrives From the SCE platforms ko the database.

[Jcreate and display common reparts once the configuration is completed

Close ] [

Cancel ]

Step24 To create reports, check the Create and display common reports check box.

N

241827

Note  Report instances will be created for four predefined report types:

Global Bandwidth per Service

Global Active Subscribers per Service

Top P2P Protocols

Global Hourly Call Minutes per Service (VoIP)

Step25 Click Close.

The wizard closes.

The Reporter tool opens in the Console.

Report instances of each of the four report types open in the Report View of the Reporter tool.

How to Use the Reporter DB Configuration Wizard

The Reporter DB Configuration wizard allows you to connect the Reporter to a database.

[l Cisco Service Control Application for Broadband User Guide
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A

Caution  You should run the Reporter DB Configuration wizard only after you have applied a service
configuration to the SCE platform.

Step1  From the Console main menu, choose Help > Welcome.

The Welcome view opens.

3 Network Navigator - SCA BB Console |:||E|E|

File Tools Preferences ‘Window Help

£ welcome 2 =8
»

afr]n . . .
cISCO Introducing Cisco Service Control

The Cisco Service Control Application (SCA) utilizes deep-packet inspection and application classification allowing service providers to offer
application-aware and subscriberaware senices. UUse the wizards below to guickly setup the system, ar close this Welcome view and go to
the 3CA BB Console.

System-wide Configuration Tools Setup
‘g Usage Analysis Wizard f.y"’ Initial Reporter Setup Wizard
SCA BB can collect statistics about the applications and This wizard lets you quickly connect the SCA BB Reporter to a
serices used by individual subscribers. This data can he Collection Manager's databhase.

used for capacity planning and detailing the subscriber
dermographics. This wizard lets vou guickly setup the system
far usage analysis.

= P2P Traffic Optimization Wizard

SCA BB can prevent netwaork congestion and reduce costs,
caused by handwidth-hungry applications such as P2P, and
improve subscriber experience in using latency sensitive
applications such as voice. This wizard lets you quickly setup
the systern for P2P traffic optimization.

b P2P Traffic Optimization for Asymmetrical Routing

241899

Step2  Click Initial Reporter Setup Wizard.
The Welcome page of the Reporter DB Configuration wizard appears.

Cisco Service Control Application for Broadband User Guide
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3£ Reporter DB Configuration Wizard

Reporter DB Configuration ﬁ
Z

This wizard lets wou quickly setup the Reparter, by connecting it to a database and
fFetching policy data from the database to initislize the report termplates.

Cancel

241878

Step3  Click Next.
The Reporter Setup page of the Reporter DB Configuration wizard opens.
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Step 4
Step 5
Step 6

3£ Reporter DB Configuration Wizard

The Reporter generates reparts by executing queties on a database, Specify the
database IP address and its bvpe below,

Reporter Setup ﬁ
&n 1P address is missing

Database IP address: | |

Database bype: . Swbase ;

24875

How to Use the Console

In the Configure the IP address of the database field, enter the IP address of the database.

From the Select the correct database type drop-down list, select the type of the database.

Click Next.

The Connectivity Test page of the Reporter DB Configuration wizard opens.
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3£ Reporter DB Configuration Wizard

Connectivity Test ﬁ

Al connectivity tests have passed. s{',;},

A

The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and
cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Tvpe 1P Address Stabus
Database 10.56.201.81 Conneckion succeesded

Skip connectivity besk ] [Betry conneckivity best

244880

Step7  Click Next.

The Confirmation page of the Reporter DB Configuration wizard opens.
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3£ Reporter DB Configuration Wizard

The Foilowing actions will be perFormed when wau hit the 'Finish' buttan:

Connect the Reporter to the database 10.56.201.81
Merify that the database is connected and configured correckhy

[ Einish ” Cancel ]

241824

The actions that the wizard is about to take are listed in the page.
Step8  Click Finish.
The Configuration Output page of the Reporter DB Configuration wizard opens.

Cisco Service Control Application for Broadband User Guide
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Configuration Output
@ Configuration Failed

Please wait while the swstem is being configured.

+ 11/14/07 7:26:038 AM IST | INFD
+ 11/14,/07 7:26:09 AM IST | INFOD

| Adding devices to the MNetwork Nawigator
| Connecting the Reporter to the database

+ 11/14,/07 7:26:09 AM IST | ERROR | Configuration failed

Cancel

The wizard attempts to connect the SCA BB Reporter tool to the selected database. The operation fails

if the wizard cannot connect to the database.

244802

The database is queried for its service configuration data and the first SCE device in the response is
chosen as the source of service configuration data.

The database device is added to the Site Manager tree in the Network Navigator.

Step9  Click Next.

The Create common reports page of the Reporter DB Configuration wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Step 10

~

Note

Step 11

How to Use the Console W

Create common reports

This wizard can create and display carmman reports once the systern configuration is completed.

Moke that in arder For the reparts to show meaningful infarmation, sufficient data must first be accumulated in the database. You may
refresh the reports every Few minutes, as data arrives From the SCE platforms ko the database.

[Jcreate and display common reparts once the configuration is completed

Close ][ Cancel ]

241827

To create reports, check the Create and display common reports check box.

Report instances will be created for four predefined report types:

Global Bandwidth per Service

Global Active Subscribers per Service

Top P2P Protocols

Global Hourly Call Minutes per Service (VoIP)

Click Close.

The wizard closes.

The Reporter tool opens in the Console.

Report instances of each of the four report types open in the Report View of the Reporter tool.

The Network Navigator Tool

The Network Navigator is a tool that allows you to create and manage a simple model of all local and
remote devices that are part of the Cisco Service Control solution.

For more information about the Network Navigator, see Using the Network Navigator, page 5-1.

[ oL-7205-11
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How to Open the Network Navigator Tool

Step 1 From the Console main menu, choose Tools > Network Navigator.

The Network Navigator tool opens.

F Network Navigator - SCA BB Console |'._||'E|r5__<|
File Tools Preferences ‘Window Help
%} |ﬂ ebwork Mavigator |
% network Navigator 53 &~ 7 8| = properties 32 [ 5|2 = =0
=) &% Site Manager Property Value
s default site
n Progress & Sﬁ ¥ =0
Mo operations to display at this time,
El console 52 ae Eﬁ a r5- =0
Consale
=
b

How to Close the Network Navigator Tool

Step 1 Right-click the Network Navigator button.
Step2  From the popup menu that appears, select Close.

The Network Navigator tool closes.

The Service Configuration Editor Tool

The Service Configuration Editor is a tool that allows you to create service configurations. A service
configuration is a data structure that defines how the SCE platform analyses network traffic, what rules
apply to the traffic, and what actions the SCE platform takes to enforce these rules.

Most of this document discusses using the Service Configuration Editor. See Using the Service
Configuration Editor, page 6-1.
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e How to Open the Service Configuration Editor Tool, page 4-61
e How to Close the Service Configuration Editor Tool, page 4-62

How to Open the Service Configuration Editor Tool

Step 1 From the Console main menu, choose Tools > Service Configuration Editor.

A No Service Configuration Is Open dialog box appears.

3 No Service Configuration Is Open

Mo service configuration is currently open.
\".f} Would you like to edit a new service configuration?

15585858

Step2  Click Yes.

A New Service Configuration Settings dialog box appears.

New Service Configuration Settings

~System Operational Mode

Select the system's operational mode For handling the network traffic;
() Transparent
(%) Report Cnly

() Full Functionality

~Routing Classification Mode -

Ensble Asymmetric Routing Classification Mode in topologies
with high rate of unidirectional Aows. In this mode, the system is
better tuned for classifying traffic according to just one side of the
Flaw, but some contral capabilities are disabled.

[] Enable the Asymmetric Routing Classification Mode

[ oK H Cancel ]

210800

Step3  Select one of the System Operational Mode radio buttons.

e Transparent —The system does not generate RDRs and does not enforce active rules on the
network traffic.

¢ Report only —The system generates RDRs only. No active rule enforcement is performed on the
network traffic.

e Full functionality —The system enforces active rules on the network traffic and performs reporting
functions (that is, generates RDRs).

Note  You can change the system operational mode at any time.

Cisco Service Control Application for Broadband User Guide
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Step 4

S

Note

Step 5

& <new servics configurations £3

Policies : Subscriber Policies : Default Package

(Optional, but highly recommended if your system has a high proportion of unidirectional flows) To
switch to asymmetric routing classification mode, check the Enable the Asymmetric Routing
Classification Mode check box.

It is recommended that you do not change the routing classification mode after creating a service
configuration, as this causes loss of service configuration data. (See Asymmetric Routing Classification
Mode, page 10-41.)

Click OK.

A default service configuration opens in the Service Configuration Editor tool.

L& Polcies | 18] Classification

% 4 M . Configuration ~

TP Filtered Traffic
B Service Securiy
L Global Policy
=L Subscriber Policies
befault Package
L. Unknown Subscriber Package

How to Close the

Step 1
Step 2

Default Package : Default Service
Rule Action

4 Default Rule controlled ; unlimited quota

274113

Service Configuration Editor Tool

Right-click the Service Configuration Editor button.
From the popup menu that appears, select Close.

The Service Configuration Editor tool closes.

The Signature Editor Tool

The Signature Editor is a tool that allows you to create and modify files that can add and modify
protocols and protocol signatures in SCA BB.

For more information about the Signature Editor, see Using the Signature Editor, page 12-1.
e How to Open the Signature Editor Tool, page 4-63
¢ How to Close the Signature Editor Tool, page 4-63

ce Control Application for Broadband User Guide
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How to Open the Signature Editor Tool

Step 1 From the Console main menu, choose Tools > Signature Editor.

The Signature Editor tool opens.

57 | [ signature Editor |
B saipt - d
ds - 9% =1 Property Value

EConsole. EN r_.E s - = 5

Console
)
(=]
[=2)
o
o

How to Close the Signature Editor Tool

Step 1 Right-click the Signature Editor button.
Step2  From the popup menu that appears, select Close.

The Signature Editor tool closes.

The Subscriber Manager GUI Tool

The Subscriber Manager (SM) GUI is a tool that allows you to connect to an SCMS-SM and then manage
subscribers, assign packages to subscribers, edit subscriber parameters, and manually add subscribers.

For more information about connecting to an SCMS-SM and using the SM GUI, see Using the
Subscriber Manager GUI Tool, page 11-1.

For more information about the SCMS-SM, see the Cisco Service Control Management Suite Subscriber
Manager User Guide.

¢ How to Open the SM GUI Tool, page 4-63
¢ How to Close the SM GUI Tool, page 4-64

How to Open the SM GUI Tool

Step 1 From the Console main menu, choose Tools > Subscriber Manager.

Cisco Service Control Application for Broadband User Guide
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The SM GUI tool opens.

ﬁ |-ﬁ- Subscriber Manager |

=
" Subscriber Manager

Subscribers

+ X N\ | K

210016

How to Close the SM GUI Tool

Step 1 Right-click the Subscriber Manager button.
Step2  From the popup menu that appears, select Close.

The SM GUI tool closes.

The Reporter Tool

The Cisco Service Control Application (SCA) Reporter is a tool that allows you to query the Cisco
Service Control Management Suite (SCMS) Collection Manager (CM) RDR database, and present the
results in a chart or a table. This valuable tool helps you to understand the habits and resource
consumption of the applications and subscribers that use your network. It also helps you evaluate the
efficacy of various rules and the possible impact of their implementation on the network. You can view
the reports in both tabular and chart formats, export them, save them, and edit their appearance.

You can run the SCA Reporter as a standalone or inside the Reporter tool in the Console. For more
information about the SCA Reporter, see the Cisco Service Control Application Reporter User Guide.

¢ How to Open the Reporter Tool, page 4-64
¢ How to Close the Reporter Tool, page 4-65

How to Open the Reporter Tool

Step 1 From the Console main menu, choose Tools > Reporter.

The Reporter tool opens.
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5 | &0 reporter
= 0| f2 Hierarchy 2
o

& Templates &3

bype text to Filer templates

= @ Global Monitaring A
Dj Average Subscrit
Dj Average Subscrit
+-{1] Global Bandwidth
i1 Global Bandwidth
Dﬂ Global &ggregate
Dﬂ Global Hourly Usz
|ﬂ Global Hourly Agg
i1 Global Hourly Usz

v

L I P I [P,

< >

¥ Favarites 52 = O || E Properties &2

@ || Property Value
= &E Favarites
\ﬁ- Global Bandwidth per
4 >

o

i&i

How to Use the Console

R

274141

You can use the SCA Reporter to generate reports only if the Console is connected to a database. (See

How to Make Databases Accessible to the SCA Reporter, page 5-27.)

How to Close the Reporter Tool

Step 1
Step 2

Online Help

Right-click the Reporter button.
From the popup menu that appears, select Close.

The Reporter tool closes.

You can access relevant parts of this user guide from the Console.
e How to Access Online Help, page 4-65
e How to Search Online Help, page 4-66

How to Access Online Help

Step 1

From the Console main menu, choose Help > Help Contents.

[ oL-7205-11
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Online help opens in a separate window.

How to Search Online Help

You can also search online help from the current tool.

Step 1 From the Console main menu, choose Help > Search.

The Help view opens next to the current tool.

Help &3
s <o =
% Search
Search expression; »
v

b Search scope Default

Go To:
All Topics

' Related Topics
O Bockmarks [ Indes

158851

Step2  Enter a word, phrase, or more complex search expression in the Search expression field.

The Go button is enabled.

Note  Click >> (Expand) for an explanation of how to construct search expressions.

Step3  Click Go.
Help topics containing your search expression are listed under Local Help.

Step4  Click a help topic to view its contents.

Note  You can bookmark topics for later reference.

Step5 By clicking the appropriate link at the bottom of the Help view, you can switch to:
e All topics
e Related topics

e Bookmarks
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Quick Start with the Console

This Quick Start section will help you get started with the Console. The section includes an example of
using the Network Navigator tool and the Service Configuration Editor to apply the default service
configuration to an SCE platform.

Example: How to Configure the Console and Apply the Default Service
Configuration

In this example, you will add an SCE device to the default site and apply the default service configuration
to the SCE.

Step 1 Launch the Console.

Choose Start > All Programs > Cisco SCA > SCA BB Console 3.5.0 > SCA BB Console 3.5.0.
Step 2 If necessary, close the Welcome view.
Step3  Open the Network Navigator.

From the Console main menu, choose Tools > Network Navigator.

This step sets up the Console for network device operations.

Note  The Network Navigator tool is open the first time you launch the Console.

You should now be able to see the default site displayed in the Network Navigator view.
Stepd  Add an SCE device to the default site.
a. Right-click the default site, and, from the popup menu that appears, select New > SCE.
The Create new SCE wizard appears.
In the Address field, enter the actual IP address of an SCE platform.
b. Click Finish.
The Create new SCE wizard closes.
The new device is added to the site.
Step5  Check the SCE platform version and operational state.
a. Right-click the SCE device and, from the popup menu that appears, select Online Status.
A Password Management dialog box appears.
b. Enter the username and password for managing the SCE and click Extract.
The SCE online status is retrieved.
c. Check that the system and application versions are correct, and that the operational state is Active.
Step6  Open the Service Configuration Editor.
e From the Console main menu, choose Tools > Service Configuration Editor.
The Service Configuration Editor opens.

A No Service Configuration Is Open dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Step7  Create a new service configuration.
a. Click Yes in the No Editor Is Open dialog box.
A New Service Configuration Settings dialog box appears.
b. Click OK.
A default service configuration opens in the Service Configuration Editor tool.
Step8  Apply the service configuration to the SCE platform.
a. From the toolbar, select *F (Apply Service Configuration to SCE Devices).
A Password Management dialog box appears.
b. Enter the username and password for managing the SCE and click Apply.

The service configuration is applied to the SCE platform.

Cisco Service Control Application for Broadband User Guide
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Using the Network Navigator

To manage a network entity—Service Control Engine (SCE) platform, Subscriber Manager (SM), or
Collection Manager (CM)—from the Console, you must first define it as a device in the Network
Navigator.

This chapter describes how to use the Network Navigator tool to create a model of all local and remote
sites and devices that are part of the Cisco Service Control solution, how to manage the devices remotely,
and other functionality that is part of the Network Navigator tool.

The Usage Analysis wizard, which can be used to create a simple model of devices and connect to them,
is also described in this chapter.

The Network Navigator Tool, page 5-1

Managing Sites, page 5-2

Managing Devices, page 5-6

Working with Network Navigator Configuration Files, page 5-29
Network Settings Requirements, page 5-33

The Network Navigator Tool

The Network Navigator tool (Figure 5-1) contains four views:

Network Navigator view—Displays, in the Site Manager tree, all sites and devices that you have
defined as part of your system

Properties view—Displays the editable properties of the node selected in the Site Manager tree in
the Network Navigator view

ProgressView view—When you perform an operation on a site or device in the Site Manager tree,
displays a progress bar

Console view—Displays log messages concerning actions performed in the Network Navigator tool

[ oL-7205-11
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Figure 5-1 The Network Navigator Tool

# Network Mavigator - SCA BB/ Console

File Tools Preferences Window Help

| €% netwark Mavigator |
% network Navigator 53 o 7 7 B E properties 2 | EH‘::"> v~

[= %/ Site Manager Property Yalue
&/ default site

@ Progress i3 % - — O

Mo operations to display at this time,

L
4

I

0

El console &2 % @b | o

Consale

m)

—
274095

Managing Sites

You can manage an SCE, SM, or CM from the Console only if the network entity is defined as a device
in the Network Navigator. After a device is added to the Network Navigator, you can perform
management and monitoring operations on the device.

You can also perform operations on a group of devices. For example, you can apply the same service
configuration to a group of SCE platforms. The Network Navigator allows you to group devices by
adding them under the same site. A site is a group of devices that can be managed together. At
installation, the Network Navigator contains a default site with no devices. You can add devices to this
site or add additional sites, as described in the following sections.

Grouping devices in sites can also help to manage the passwords for these devices (see Password
Management, page 5-6).

e How to Add a Site to the Site Manager, page 5-2
e How to Add Devices to a Site, page 5-3
e How to Delete Sites, page 5-6

How to Add a Site to the Site Manager

Before adding devices, you must add your sites to the Site Manager.

Cisco Service Control Application for Broadband User Guide
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Step1  In the Network Navigator view, right-click the Site Manager node.

A popup menu appears.

2 st
Editing 3

274118

Show Properties Wiew

Step 2 From the menu, select New > Site.
A new Site node is added to the Site Manager.
Step 3 In the Properties view, enter a name for the site in the Name cell.

Step 4 (Option) In the Version cell, enter a version number.

How to Add Devices to a Site

You can add SCE, SM, CM, or database devices to a site.
e How to Add SCE Devices to a Site, page 5-3
e How to Add SM Devices to a Site, page 5-4
e How to Add CM Devices to a Site, page 5-4
¢ How to Add Database Devices to a Site, page 5-4
e How to Delete Devices, page 5-5

How to Add SCE Devices to a Site

To use the Network Navigator to configure, monitor, and update the software of an SCE platform, you
must first add the SCE platform to a site.

Step1  In the Site Manager tree, right-click a site.

A popup menu appears.

o9 Apply Service Configuration, .. & Database
@@ Retrieve Service Configuration. .. % SCE
2 5m
& tnstall Prokocol Pack (PO
Configuration Wizards 4
Editing 4

Show Properties \isw

274119

Step 2 From the menu, select New > SCE.
The Create New SCE wizard appears.
Step 3 In the Address field, enter the IP address of the SCE.

Cisco Service Control Application for Broadband User Guide
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Stepd  (Option) In the Name field, enter a meaningful name for the SCE.
Step5  Click Finish.
The Create New SCE wizard closes.

The new device is added to the site.

How to Add SM Devices to a Site

To use the Network Navigator to configure, monitor, and update the software of an SM, you must first
add the SM to a site.

Step 1 In the Site Manager tree, right-click a site.
A popup menu appears.
Step 2 From the menu, select New > SM.
The Create New SM wizard appears.
Step 3 In the Address field, enter the IP address of the SCMS-SM.
Step 4 (Option) In the Name field, enter a meaningful name for the SM.
Step5  Click Finish.
The Create New SM wizard closes.

The new device is added to the site.

How to Add CM Devices to a Site

To use the Network Navigator to monitor a CM, you must first add the CM to a site.

Step 1 In the Site Manager tree, right-click a site.
A popup menu appears.
Step 2 From the menu, select New > CM.
The Create New CM wizard appears.
Step 3 In the Address field, enter the IP address of the CM.
Step4  (Option) In the Name field, enter a meaningful name for the CM.
Step5  Click Finish.
The Create New CM wizard closes.

The new device is added to the site.

How to Add Database Devices to a Site

To use the Reporter tool to produce reports, you must first connect to a database.
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Step1  In the Site Manager tree, right-click a site.
A popup menu appears.
Step 2 From the menu, select New > Database.

The Create New Database wizard appears.

3 Create New Database

Create new Database =
This wizard creates a new Database.

Database Creation

Address | |
Mame | Database device |
Databaze type |5\,rbase ASE w |

[JEnable Advanced Settings

Url

Driver

User

Password

’ Finish _] ’ Cancel ]

210583

Step 3 In the Address field, enter the IP address of the database.
Stepd  (Option) In the Name field, enter a meaningful name for the database.
Step5 From the Database type drop-down list, select a database type.

Step 6 (Option) Check the Enable Advanced Settings check box and enter new values in the Url, Driver, User,
and Password fields.

Step7  Click Finish.
The Create New Database wizard closes.

The new device is added to the site.

How to Delete Devices

Step 1 In the Site Manager tree, right-click a device.
A popup menu appears.
Step 2 From the menu, select Delete.

The device is deleted and removed from the Site Manager tree.

Cisco Service Control Application for Broadband User Guide
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How to Delete Sites

Step 1

Step 2

In the Site Manager tree, right-click a site in the Site Manager tree.
A popup menu appears.

e Enter your password if prompted.
From the menu, select Delete.

The site and all its devices are deleted and the site is removed from the Site Manager tree.

Managing Devices

A

Note

The Network Navigator allows you to manage SCE, SM, CM, and database devices.

The Usage Analysis wizard allows you to create a simple model of devices and connect to them. (See
How to Use the Usage Analysis Wizard, page 4-25.)

e Password Management, page 5-6

e Managing SCE Devices, page 5-7

e Managing SM Devices, page 5-23

e Managing CM Devices, page 5-26

e Managing Database Devices, page 5-27

Password Management

Normally, before you can access a device (SCE, SM, CM, or database), you must enter its password.
When you try to perform any operation on a site device, the Network Navigator first asks for the device
username and password. (Repeating the same operation on the same device does not always require a
second entry of the password.)

When performing operations on multiple devices, password entry can become tedious. The Site Master
Password can help you remember some or all of your element’s usernames and passwords by storing

them as part of the site’s data, and entering them for you automatically when you connect to an element.

The Site Master Password protects saved usernames and passwords in the password manager. The
Password Management dialog box (Figure 5-2) prompts you for the site’s master password when you
wish to activate the site password manager. If you have multiple sites, each site will require a separate
master password.
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Figure 5-2 The Password Management Dialog Box
3 password Management E]
Password Required for Apply to SCE Operation g
This wizard gets the password for the device SCE 1 [172.2.5.31]. S o
h
Target: SCE 1[172.2.5.31]
Type: SCE
Service: RPC
User: | acmin
Password: [-n
The Site Master Password can help you remember some or all of your
element's passwords by storing them as part of the site's data, and
entering them for you automatically when you connect to an element.
[VIEnable Site Master Password: |
[Change Site Master Password
I Apply l[ Cancel ]

158893

Managing Devices I

For each site, when the Password Management dialog box appears, check the Enable Site Master

Password check box.

Managing SCE Devices

¢ How to Configure SCE and CM Devices Using a Wizard, page 5-7
e How to Generate Tech Support Info Files for SCE Devices, page 5-15
e How to Retrieve the Online Status of SCE Devices, page 5-16

e How to Install a Protocol Pack, page 5-17

e How to Apply Service Configurations to SCE Devices, page 5-19

¢ How to Retrieve Service Configurations from SCE Devices, page 5-21

e How to Install PQI Files on SCE Devices, page 5-21

e How to Install an SCE OS Software Package on SCE Devices, page 5-22

How to Configure SCE and CM Devices Using a Wizard

S

Note

Step 1

The Network Navigator Device wizard allows you to configure SCA and CM devices and connect to

them.

If they do not already exist, devices defined in the wizard are added to the default site in the Site Manager

tree.

In the Network Navigator view toolbar, click = (Configure SCE and CM devices).

[ oL-7205-11

Cisco Service Control Application for Broadband User Guide g



Chapter5  Using the Network Navigator |

Bl Managing Devices

The Welcome page of the Network Navigator Device wizard appears.

3 Network Navigator Device Wizard

o

am

g

This wizard lets wou quickly add SCE platforms and CM to the Metwark Mavigator device
tree.

Cancel

241845

Step2  Click Next.
The SCE IP Addresses page of the Network Navigator Device wizard opens.
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Step 3

Note

Step 4

Managing Devices

3 Network Navigator Device Wizard

SCE IP Addresses
@ One or more SCE IP addresses must be specified !_E‘

Configuring the SCE platforms requires that they are first added to the Metwork
Mawigatar.,

Tao add SCE platforms to the Mebwork Mavigataor, tvpe their IP addresses in the text
bax below (For exarnple: 10.56.216.37, 10.56,216,38):

244847

In the edit box, enter the IP addresses of the SCE devices that should be added to the model.

If you started from the Network Navigator, the IP addresses of the SCE devices that you selected are
displayed in the edit box. You can add additional addresses.

You can work with up to 20 SCE devices at one time using the wizard.

Click Next.

The SCE Usernames and Passwords page of the Network Navigator Device wizard opens.

[ oL-7205-11
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Step 5

Step 6

3 Network Navigator Device Wizard

SCE Usernames and Passwords
@ & password For the SCE 10.56.216.37 is missing 5!‘.

In otdet bo connect to the SCE platforms, & username and a password need to be
specified for each SCE.

Use a common username and a common password for all SCE platforms:
Username: | admin
Password:

() Use separate usernames and passwords for each SCE platform:

SCE IP Address | Username  Password
10.56.216.37 admin

Enter the user names and passwords for the SCE devices.

Do one of the following:

241848

e To use the same user name and password for all the SCE devices that you are adding, enter the user
name in the Username field and the password in the Password field.

e To provide a different user name and password pair for each SCE device, check the Use separate
usernames and passwords for each SCE device radio button, and, for each SCE device, enter the

user name and password in the appropriate cell of the SCE device table.

Click Next.

The Setting CM devices page of the Network Navigator Device wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Step 7

Step 8

3 Network Navigator Device Wizard

CM Setup
3 AnIP address is missing

Configuring the CM requires that it is First added ko the Nebwork Mavigatar, To add the

M ta the Metwork Mavigator, tvpe its IP address, username and password in the text
boxes below,

The wizard will werify the CMM operational state, and configure the SCE platfroms to

send RDRs ko the M. You may skip this step if the CM is already defined as the RDR
destination of the SCE platforms.

[ skip this step
CM IP address: |

CM username: | scmscm

CM passward: [

244845

Define the SCSM Collection Manager (CM) to use with this configuration.

Do one of the following:

Managing Devices

Enter the IP address, user name, and password of the CM device in the appropriate fields.

If you started from the Network Navigator, this information is retrieved and displayed. You can

modify these parameters.

e Check the Skip this step check box.
Click Next.

The Connectivity Test page of the Network Navigator Device wizard opens.

[ oL-7205-11
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3 Network Navigator Device Wizard

Connectivity Test fF

Al connectivity tests have passed. Sm

The wizard will now test the connectivity to the devices that wou specified, to werify
that carrect IP addresses, usernames and passwords were used.
Flease wait Ffor the connectivity test bo camplete,

In case of an error, you may use the 'Back! button ko go back to previous steps and
cotrect the IP addresses, usernames of passwords, if necessary. You may alsa choose
to skip or retry the connectivity test using the buttons belaw,

[ Type [P Address Status

SCE  10.5%6.216,37 Connection succeeded
M 10.56,201.81 Connection succeeded

Skip connectivity besk ] [Betry conneckivity best

T W

241860

The wizard tests to see that the connections to the defined devices can be made.

Note If a connection to one or more of the devices cannot be made or if there is some problem with the
connection (such as invalid version of the device) an error is displayed next to the device. You can skip
these tests by clicking Skip Connections. The connections will be validated when you click Finish at
the end of the wizard.

Step9  Click Next.

The Confirmation page of the Network Navigator Device wizard opens.
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3 Network Navigator Device Wizard

The Foilowing actions will be perFormed when wau hit the 'Finish' buttan:

Connect to the following SCE platforms and add them to the Mebwork Mavigator:
10,56.216.37

Conmect ko the CM 10,56,201,81 and add it bo the Mebwork Mavigataor

Configure the SCE platforms ko send category 1 RDRs to the M

[ Einish ” Cancel ]

241851

The actions that the wizard is about to take are listed in the page.
Step10  Click Finish.

The Configuration Output page of the Network Navigator Device wizard opens.

Cisco Service Control Application for Broadband User Guide
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Note

Configuration Output

Please wait while the swstem is being configured.

+ 11/14/0F7 6:27:12 AWM IST | INFO | Adding devices to the Network Nawigator

+ 11/14/07 6:27:12 &AM IST | INFO | Connecting to SCE 10.56.216.37

+ 111407 6:27:13 AM IST | INFD | werifying that the SCE platforms are installed prope
+ 11/14/07 6:27:13 &M IST | INFQ | wWerifying that the M is installed properly

F— 11/14,/07 6:27:13 AM IST | INFC | Configuration completed successtuly

< Ed

241882

[ Close ][ Cancel ]

New devices are added to the default site in the Site Manager tree in the Network Navigator.

hv

(@ Network Mavigatar

= & Sike Manager

=R
SCE device 1 [10.56.216.37]
B CMdevice [10.56.201.81]

The wizard attempts to connect to all devices that you defined. The operation fails if:

24864

e The wizard cannot connect to any of the SCE devices that you listed in Step 3.
¢ You defined a CM in Step 7, but the wizard cannot connect to it.

If you defined a CM in Step 7, the SCE devices are configured so that the only category 1 RDR
destination is the CM.

RDR categories are the mechanism by which different types of RDRs can be sent to different collectors.
For more information about RDR categories, see the “Raw Data Formatting: The RDR Formatter and
NetFlow Exporting” chapter of the Cisco SCES8000 Software Configuration Guide.

A new service configuration is created:

e Report Only mode.

[l Cisco Service Control Application for Broadband User Guide
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The maximum Transaction RDR rate is set as the default value (250) divided by the number of SCE
devices. (To configure the Transaction RDR see How to Manage Transaction RDRs, page 8-4; the
content and structure of the Transaction RDR is listed in "Transaction RDR" in the “Raw Data

Records: Formats and Field Contents” chapter of the Cisco Service Control Application for
Broadband Reference Guide.

Step11  Click Finish.

The Network Navigator Device wizard closes.

How to Generate Tech Support Info Files for SCE Devices

This operation generates the SCE platform’s support file, for the use of Cisco technical support staff.

Step 1 In the Site Manager tree, right-click an SCE device.

A popup menu appears.

@ SCE Software Upgrade YWizard, .,
= Apply Service Configuration. ..

@ Retrieve Service Configuration..,

@) Online Status. ..
fd Generate Tech Support Info File...

& tnstall Protocol Pack (5RO,

Advanced L
Configuration Wizards 4
Editing 3

274112

Show Properties \isw

Step2  From the menu, select Generate Tech Support Info File.
The Generate Tech Support Info File dialog box appears.

Cisco Service Control Application for Broadband User Guide
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3 Generate Tech Support Info File

Extracts the logs from the device
Extracting the logs from the device

Select file to extract to: . v |

Add GUI Console log files
[]open file after itis fetched

Cancel

158839

Step3  Click Browse.
A Select File dialog box appears.
Step4  Browse to the folder where you want to save the tech support info file.
Step 5 In the File name field, enter a new file name, or select an existing ZIP file.
Step6  Click Open to select the file.
If the file exists, it will be overwritten when you generate the tech support info.
The Select File dialog box closes.

Step7  (Optional) To add log files to the output tech support info file, check the Add GUI Console log files
check box.

Step8  (Optional) Check the Open file after it is fetched check box.
Step9  Click Finish.
The Generate Tech Support Info File dialog box closes.
A Password Management dialog box appears.
Step10  Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Step11  Click Generate.
The Password Management dialog box closes.
A Generate tech support info file progress bar appears.

The file is generated.

How to Retrieve the Online Status of SCE Devices

This operation provides information about the SCE platform’s current software version and operational
status.
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Step 2

Step 3
Step 4

Managing Devices I

In the Site Manager tree, right-click an SCE device.

A popup menu appears.

From the menu, select Online Status.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Click Extract.

The Password Management dialog box closes.

An Extracting info progress bar appears.

The SCE online status is retrieved.

E I x|
SCE SCE device[10.56.216.40]
Information For SCE SCE device[10.56.216.40]

SCE Platform SCE2000 - 4xGEE

Operational State Ackive

SCE Skatus Started

05 Yersion ‘ersion 3.1.0 Build 999

Management Yersion SCE Agent 3.1.0 Build 163

application Engage SML Yersion 3.1.0 build 022 Using Lib - PL_3.1.0b20 Using Lib - Classifier _3.1.0b7
Last POI Installed Operation: Install; ; Package: SCA BE 3.1.0 build 15

Logger counters Fatals: O0; Errors: 0; Warnings: 4

0ok I Refrash

211295

How to Install a Protocol Pack

Note

Step 1
Step 2

You can install a protocol pack on a single SCE platform, on selected SCE platforms, or on all SCE
platforms at one or more selected sites. For more information about protocol packs, see Working with
Protocol Packs, page 4-17.

It is recommended to use the SCE Software Upgrade Wizard when installing a protocol pack on multiple
SCE platforms

e How to Install a Protocol Pack on a Single SCE Platform, page 5-17
e How to Install a Protocol Pack on Multiple SCE Platforms, page 5-18

How to Install a Protocol Pack on a Single SCE Platform
In the Site Manager tree, right-click the SCE where the protocol pack is to be installed.

From the popup menu that appears, select Update Dynamic Signature Pack.

The Update Dynamic Signature Pack dialog box appears.

[ oL-7205-11
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Step 3
Step 4
Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

¥

Update Dynamic Signature Pack
This wizard updates SCE boxes with a Dynmaic Signature Pack.

)

Select the dynamic signature: v | [Browse... ]

Backup the current configuration:
[ Backup the current configuration

Backup file :

Cancel

210041

Click Browse.

A Select file dialog box appears.

From the Files of type drop-down list, select *.spqi or *.dss, according to the file to be installed.
Browse to the file to be installed.

Click Open.

The Select file dialog box closes.

(Recommended) Check the Backup the current configuration check box, click Browse, and select a
backup file.

Click Finish.

A Password Management dialog box appears.

Enter the appropriate password.

For more information, refer to Password Management, page 5-6.
Click Update.

The Password Management dialog box closes.

An Update Dynamic Signature Pack progress bar appears.

The service configuration on the SCE platform is updated.

How to Install a Protocol Pack on Multiple SCE Platforms

You can install a protocol pack on multiple SCE Platforms using the SCE Software Upgrade Wizard. See
How to Upgrade the SCE Using the SCE Software Upgrade Wizard, page 4-7
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How to Apply Service Configurations to SCE Devices

You can apply a service configuration to a single SCE platform, to selected SCE platforms, or to all SCE
platforms at one or more selected sites.

Note  The service configuration that you are applying must be open in the Service Configuration Editor.
Caution  If anomaly-based detection of malicious traffic is enabled, any access control list (ACL) that is
configured on the Service Control Engine (SCE) platform but is not applied to anything (for example,
an interface, an access map, or anSNMP community string) might be deleted when a service
configuration is applied to the platform.
Workaround:
Disable anomaly-based detection of malicious traffic.
In the Network Traffic tab, select Service Security.
In the Service Security Dashboard, clear the Enable anomaly detection check box.
e How to Apply a Service Configuration to a Single SCE Platform, page 5-19
e How to Apply a Service Configuration to Multiple SCE Platforms, page 5-20
How to Apply a Service Configuration to a Single SCE Platform
Step 1 In the Site Manager tree, right-click an SCE device.
A popup menu appears.
Step2  From the menu, select Apply Service Configuration.

Note

The Choose Policy dialog box appears, listing all service configurations that are open in the Service
Configuration Editor.

If only one service configuration is open in the Service Configuration Editor, a Password Management
dialog box appears. Continue at Step 5. (If no service configurations are open in the Service
Configuration Editor, an error message is displayed.)

[ oL-7205-11
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Step 3
Step 4

Step 5
Step 6

Step 1

Step 2

Note

Step 3

Step 4

3 Choose Policy

disco 1.pgh
dscoZ.pgb

I oK H Cancel ]

158777

Select a service configuration from the list.

Click OK.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Click Apply.

The Password Management dialog box closes.

An Applying service configuration to SCE progress bar appears.

The service configuration is applied to the selected SCE platform.

How to Apply a Service Configuration to Multiple SCE Platforms

In the Site Manager tree, select sites or SCE devices to which you are applying the service configuration
and right-click one of them.

From the popup menu that appears, select Apply Service Configuration.

The Choose Policy dialog box appears, listing all service configurations that are open in the Service
Configuration Editor.

If only one service configuration is open in the Service Configuration Editor, a Password Management
dialog box appears. Continue at Step 4. (If no service configurations are open in the Service
Configuration Editor, an error message is displayed.)

Select a service configuration from the list and click OK.
A separate Password Management dialog box appears for each SCE device that you have selected.

For each SCE device, enter the password and click Apply.
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The service configuration is applied to each selected SCE platform in turn.

How to Retrieve Service Configurations from SCE Devices

Step 1

Step 2

Step 3
Step 4

Step 1

Step 2

Step 3

You can retrieve service configurations from a single SCE platform, from selected SCE platforms, or
from all SCE platforms at one or more selected sites.

e How to Retrieve Service Configurations from a Single SCE Platform, page 5-21

e How to Retrieve Service Configurations from Multiple SCE Platforms, page 5-21

How to Retrieve Service Configurations from a Single SCE Platform

In the Site Manager tree, right-click an SCE device.
A popup menu appears.
e Enter your password if prompted.
From the menu, select Retrieve Service Configuration.
A Password Management dialog box appears.
Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Click Retrieve.
The Password Management dialog box closes.
A Retrieving from SCE progress bar appears.

The service configuration is retrieved from the SCE platform and opened in the Service Configuration
Editor.

How to Retrieve Service Configurations from Multiple SCE Platforms

In the Site Manager tree, select sites or SCE devices whose service configurations you want to retrieve,
and right-click one of them.

From the popup menu that appears, select Retrieve Service Configuration.
A separate Password Management dialog box appears for each SCE device that you have selected.
For each SCE device, enter the password and click Retrieve.

The service configuration is retrieved from each SCE platform in turn, and is opened in the Service
Configuration Editor.

How to Install PQI Files on SCE Devices

This operation installs the Cisco Service Control Application for Broadband (SCA BB) on the SCE
platform.

[ oL-7205-11
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Note It is recommended to use the SCE Software Upgrade Wizard when installing a PQI file on multiple SCE
devices. See How to Upgrade the SCE Using the SCE Software Upgrade Wizard, page 4-7.

Note  Installing a PQI file usually takes a few minutes.

Step 1 In the Site Manager tree, select an SCE device.
Step2  From the Console main menu, choose Network > Install Application Software (PQI).

The Update Software dialog box appears.

3 Update Software

Please choose a file

Select the pai file: | v-i

Cancel

210046

Step3  Click Browse.
A Select file dialog box appears.
Step4  Browse to the PQI file that you are installing.
Step5 Click Open.
The Select file dialog box closes.
Step6  Click Finish.
A Password Management dialog box appears.
Step7  Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Step8  Click Apply.
The Password Management dialog box closes.
An Updating software to SCE progress bar appears.
The PQI file is installed on the selected SCE.

How to Install an SCE 0S Software Package on SCE Devices

This operation installs the SCE OS software package (the operating system software and firmware of the
SCE platform).
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Note

Step 1
Step 2

Step 3

Step 4
Step 5

Step 6

Step 7
Step 8

Managing Devices I

For more information, see “Upgrading SCE Platform Firmware” in the “Operations” chapter of the Cisco
SCES8000 Software Configuration Guide.

It is recommended to use the SCE Software Upgrade Wizard when installing an SCE OS software
package on multiple SCE platforms. See How to Upgrade the SCE Using the SCE Software Upgrade
Wizard, page 4-7.

In the Site Manager tree, select an SCE device.
From the Console main menu, choose Network > Upgrade SCE Platform Firmware (PKG).

The Update OS dialog box appears.

3 Update 05

Please choose a file

Select the pkg file: | | |

Cancel

210042

Click Browse.

A Select file dialog box appears.

Browse to the PKG file containing the OS that you are installing.
Click Open.

The Select file dialog box closes.

Click Finish.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Click Apply.

The Password Management dialog box closes.

An Updating software to SCE progress bar appears.

The PQI file is installed on the selected SCE.

Managing SM Devices

e How to Generate Tech Support Info Files for SM Devices, page 5-24
e How to Retrieve the Online Status of SM Devices, page 5-25
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e How to Connect to SM Devices, page 5-25

How to Generate Tech Support Info Files for SM Devices

Step 1

Step 2

Step 3

Step 4
Step 5
Step 6

Step 7

Step 8
Step 9

Step 10
Step 11

This operation generates the SM’s support file, for the use of Cisco technical support staff.

In the Site Manager tree, right-click an SM device.

A popup menu appears.

&g, Manage Subscribers

(@) Online Status. ..
fal Generate Tech Support Info File, ..

Advanced 4
Configuration Wizards 4
Editing 4 8
Shaow Properties Yiew E

From the menu, select Generate Tech Support Info File.

The Generate Tech Support Info File dialog box appears.

Click Browse.

A Select File dialog box appears.

Browse to the folder where you want to save the tech support info file.

In the File name field, enter a new file name, or select an existing ZIP file.
Click Open to select the file.

If the file exists, it will be overwritten.

The Select File dialog box closes.

(Optional) To add log files to the output tech support info file, check the Add GUI Console log files

check box.

Check the Open file after it is fetched check box.
Click Finish.

The Generate Tech Support Info File dialog box closes.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)

Click Generate.
The Password Management dialog box closes.
A Generate tech support info file progress bar appears.

The file is generated.

[l Cisco Service Control Application for Broadband User Guide
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How to Retrieve the Online Status of SM Devices

Step 1

Step 2

Step 3
Step 4

This operation provides information about the SM’s current software version and operational status.

In the Site Manager tree, right-click an SM device.
A popup menu appears.
From the menu, select Online Status.
A Password Management dialog box appears.
Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Click Extract.
The Password Management dialog box closes.
An Extracting info progress bar appears.
The SCMS-SM online status is retrieved.
3 x|
SM Site SM[10.56.212.71]
Information Far 5M Site SM[10.56.212.71]

Cperational State Active
Database Errors
Critical Errors

Last Installation Cperation: Install; ; Package: SCA BB 3.1.0 build 14
fumber of logins a

Login rake 0.0

Mumber of Logouts i}

Logout rake 0.0

Mumber of pull requests 0

Pull requests rate 0.0

.mm6kmmmmé EE

211299

How to Connect to SM Devices

A

Note

Step 1

Step 2

In order to manage subscribers using the SM GUI tool, you must connect to an SM device.

The SM GUI tool performs authentication on the SCMS-SM by opening a PRPC connection to port
14374 and attempting to log in using the username and password that you entered in the Password
Management dialog box. If a PRPC server with this user is not running on the SCMS-SM, authentication
will fail.

If you have changed the PRPC port on the SCMS-SM, see User Authentication, page 5-34.

In the Site Manager tree, right-click an SM device.
A popup menu appears.
From the menu, select Manage Subscribers.

A Password Management dialog box appears.
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Step3  Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Step4  Click Connecting.

The Password Management dialog box closes.

A Connecting to progress bar appears.

You connect to the SM, and the Console switches to the SM GUI tool.

For an explanation of how to proceed, see Using the Subscriber Manager GUI Tool, page 11-1.

Managing CM Devices

You can configure CM devices using a wizard. (See How to Configure SCE and CM Devices Using a
Wizard, page 5-7.)

How to Retrieve the Online Status of CM Devices

This operation provides information about the CM’s current software version and operational status.

Step 1 In the Site Manager tree, right-click a CM device.

A popup menu appears.

(@) Online Status. ..
Advanced 4
Configuration ‘Wizards ¥
Editing 4

Show Properties Yiew

274079

Step 2 From the menu, select Online Status.

A Password Management dialog box appears.
Step3  Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Stepd  Click Extract.

The Password Management dialog box closes.

An Extracting info progress bar appears.

The SCMS-CM online status is retrieved.

For an example of a retrieved online status window (for an SCE platform), see How to Retrieve the
Online Status of SCE Devices, page 5-16.
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Managing Database Devices

How to Make Databases Accessible to the SCA Reporter

Step 1

Step 2

Step 3

e The Reporter DB Configuration wizard allows you to connect the Reporter to a single database. (See
How to Use the Reporter DB Configuration Wizard, page 4-52.)

e An alternative procedure is described in “Configuring a Database Connection” in the “Using the
Cisco Service Control Application Reporter” chapter of the Cisco Service Control Application
Reporter User Guide.

In the Site Manager tree, right-click a database device.

A popup menu appears.

1 J Add to Reporter
Configuration Wizards #
Editing 4

Shaw Properties Wiew E

From the menu, select Add to Reporter.

The Preferences dialog box appears.

3 Preferences (Filtered)

% | Databases
= Reparter
Charts Colors Add or remove databases to the kable using the ‘add’ and 'Remaove’ buttons,
Configuration When done, select one of the databases in the table, and use the ‘Activake’ button ko make it the current database,
Databases
Templates N
URL User Password Drriver o add...
¥ jdbcioracle:thin:@10,56,203.24:1521:pqube  pab_adminl  pab_adminl  oracle.jdbe. OracleDriver
jdbc:sybase: Tds:10.56.201,81:4100 pab_admin  pgb_admin  com.sybase jdbc3.jdbe. SybDrive
4 4
:
Click Add.

The Add Database wizard appears.
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Database connection definition mode [j

Choose definition moda
(%) 5imple - default values for driver, port, etc:

() Advanced - spedify all values

Step4  Select one of the Choose definition mode radio buttons.

158733

e Simple
e Advanced
Step5  Click Next.
The Define new database connection page of the Add Database wizard opens:

e If you selected Simple in Step 4, the Define new database connection page looks like this:

Define new database connection [j

Database bype and location

Database type: |Sybase ASE
Database IP address: I:I

Activate this database

—
274071

e If you selected Advanced in Step 4, the Define new database connection page looks like this:
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Step 6
Step 7

Step 8
Step 9
Step 10
Step 11

Working with Network Navigator Configuration Files 1l

5 B=1E3
Define new database connection [PJ

Database connection attributes
LRL:

Driver:
User:

Password:

activate this database

Fill in all the fields.
Click Finish.
The Add Database wizard closes.

158734

The definition of the database is added to the list in the Preferences dialog box.
Repeat Steps 3 to 7 for other databases.

If required, delete databases from the list in the Preferences dialog box.

Make sure that the correct database is activated.

Click OK.

The Preferences dialog box closes.

Working with Network Navigator Configuration Files

After you add sites and devices to the Network Navigator, you can export this data to a file to back up
your settings and to share them with other users, who can import your Network Navigator settings into
their Console.

If you use the Site Master Password to store the passwords of the network devices, the passwords are
also exported, in encrypted form. This means that other users who import this data need only provide the
Site Master Password to access the devices.

e How to Export a Network Navigator Configuration, page 5-30

e How to Import a Network Navigator Configuration, page 5-31
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How to Export a Network Navigator Configuration

Step1  From the Console main menu, choose File > Export.

The Export dialog box appears.

3£ Export |Z|@

Select /—‘
hoose export destination. I E 5 i

Select an export destination:

|type Filker bext |

= Metwork Mavigator
(= Reporter

Service Configuration

Export service configuration parts ko a CSY file

Cancel

Step2  From the export destination list, select Network Navigator Configuration to a file.

Step3  Click Next.

150845

The Export Network Navigator Configuration to a file dialog box appears.
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Working with Network Navigator Configuration Files

#

Import Network Navigator Configuration from file
@ At least one site should be selected for export

Ed

Available sites:
O &lnew York |
[] '/ washington
|:| &/ Boston

’ Select All ] [ Deselect Al ] [ Invert Selection ]

Select the export destination:

Metwork Navigator configuration file: | W | [Browse. = ]

The Available sites pane lists all of the sites in the configuration.

158817

Step4  Select the sites to export, using the check boxes and the select buttons.
Step 5 In the Select the export destination area, click Browse.
An Open dialog box appears.
Step6  Browse to the folder where you want to save the configuration file.
Step7 In the File name field, enter a new file name, or select an existing site_xml file.

Step8  Click Open to select the file.

Note If the file exists, it will be overwritten.

The Open dialog box closes.
Step9  Click Finish.
The Export Network Navigator Configuration dialog box closes.

The configuration is saved to the file.

How to Import a Network Navigator Configuration

Step1  From the Console main menu, choose File > Import.

Cisco Service Control Application for Broadband User Guide
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The Import dialog box appears.

3£ Import |Z|®

Select

hoose import source, I'E P 5

Select an import source:

|type filker bext |

== Service Configuration
Iport content filkering database settings From an XML File
Import service configuration parts From a C5Y file

= Signature Editar

Cancel

274083

Step2  From the import source list, select Network Navigator Configuration from file.
Step3  Click Next.

The Import Network Navigator Configuration from file dialog box appears.
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£ 3

Import Network Navigator Configuration from file

This wizard imports a Network Navigator configuration from a file

Select Metwork Navigator configuration file: [ R

Cancel

158859

Step4  Click Browse.
An Open dialog box appears.
Step5  Browse to the folder containing the file to import, and select a site_xml file.
Step6  Click Open to select the file.
The Open dialog box closes.
Step7  Click Finish.
The Import Network Navigator Configuration dialog box closes.

The configuration is imported from the file.

Network Settings Requirements

e Firewall/NAT Requirements, page 5-34
e User Authentication, page 5-34
¢ How to Disable PRPC Authentication, page 5-35

Cisco Service Control Application for Broadband User Guide
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Firewall/NAT Requirements

Table 5-1 lists the firewall/NAT open port settings required for the Network Navigator to operate
properly.
The ports listed in the table are the default values. If you change a port in a device, you must modify the

firewall/NAT settings accordingly. (Modifying the Console settings to connect to a different PRPC port
is described in the following section.)

Table 5-1 Required Firewall/NAT Settings
Source Destination Comments
Workstation SCE port 14374/TCP PRPC—Required for all SCE
operations
SCE Workstation port 21/TCP FTP—Required for the
following SCE operations:
e Install OS
¢ Generate Tech Support Info
File
SCE Workstation ports 21000/TCP to |FTP—Alternative to port
21010/TCP 21/TCP, required if port 21/TCP
is already used by another
application on the workstation
Workstation SM port 14374/TCP PRPC—Required for all SM
operations
Workstation CM port 14375/TCP PRPC—Required for the CM
Online Status operation and for
CM authentication

The SCA Reporter may have additional requirements for connecting to the database. For more
information, see the Cisco Service Control Application Reporter User Guide.

User Authentication

Note

User authentication is performed when a PRPC connection is made to an SCE platform, a CM, or an SM.
For authentication to succeed, a PRPC server must be running at the destination, and you must know the
username and password of a user of the server.

If you change a PRPC server port in a device (SM/CM/SCE), you must add a line to the configuration
file engage.ini:

<IP address of device>.rpc.port=<port number>

For example:

10.56.216.37.rpc.port=222

Add one line for each (non-default) port that you use.

The file engage.ini is located in the folder Program files\Cisco SCA\SCA BB Console
3.5.0\plugins\policy.contribution_3.5.0\config\.

Cisco Service Control Application for Broadband User Guide
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You define the username and password using the user/password mechanism in the SCE platform or a
command-line utility in the SM and CM.

For more information about defining users, see the following:

e SCE—“TACACS+ Authentication, Authorization, and Accounting” in the “Configuring the
Management Interface and Security” chapter of the Cisco SCES8000 Software Configuration Guide

e CM—“Managing Users” in the “Managing the Collection Manager” chapter of the Cisco Service
Control Management Suite Collection Manager User Guide

e SM—“p3rpc Utility” in the “Command-Line Utilities” appendix of the Cisco Service Control
Management Suite Subscriber Manager User Guide

Note  PRPC authentication from the SCA BB Console to any CM/SM/SCE IP address other then the device's
real IP address is not supported. This is especially important when the CM/SM/SCE resides on the inside
interface of a NATing router or firewall
Workaround:

Redesign your network so that the SCA BB Console is given the real IP address of the CM/SM/SCE.
Disable PRPC authentication on the SCE/CM/SM/SCE as described in the following sections.

How to Disable PRPC Authentication

e How to Disable PRPC Authentication on an SCE Platform, page 5-35
e How to Disable PRPC Authentication on a CM, page 5-35
e How to Disable PRPC Authentication on an SM, page 5-35

How to Disable PRPC Authentication on an SCE Platform

Step 1 Use the CLI to disable PRPC authentication.
Run the following CLI in config mode:

ip rpc-adapter security-level none

How to Disable PRPC Authentication on a CM

Step1  Edit the CM configuration file.
Edit the cm/um/config/p3cm.cfg configuration file:

[RPC.Server]
security_level=none

Step2  Reload the CM process.

How to Disable PRPC Authentication on an SM

Step1  Edit the SM configuration file.

Cisco Service Control Application for Broadband User Guide
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Edit the ~pcube/sm/server/root/config/p3sm.cfg configuration file:

[RPC. Server]
security_level=none

Step2  Load the configuration.
Run the following CLU:

p3sm --load-config
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Using the Service Configuration Editor

To configure a Service Control Engine (SCE) platform to handle traffic, you must define a service
configuration and apply it to the platform. Use the Service Configuration Editor tool to create, define,
and manage service configurations.

This module describes how to use the Service Configuration Editor tool.
e Service Configurations, page 6-1

e Managing Service Configurations, page 6-1

Service Configurations

A service configuration is a data structure that defines how the SCE platform analyses network traffic,
what rules apply to the traffic, and what actions the SCE platform takes to enforce these rules.

A service configuration consists of the following two main elements:
e Services—Define the categories to which transactions are classified
e Packages—Define how the SCE platform acts upon transactions from different services

Service configurations are stored as PQB files.

Managing Service Configurations

This section explains how to:
e Manage service configurations
e Export and import service configuration data

e Apply service configurations to SCE platforms and retrieve them

Opening the Service Configuration Editor Tool

If no service configurations are open when you open or switch to the Service Configuration Editor tool,
a No Service Configuration Is Open dialog box appears as shown in Figure 6-1.
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Figure 6-1 No Service Configuration Is Open

3 No Service Configuration Is Open

Mo service configuration is currently open,
,._-/ Would you like to edit a new service configuration?

158883

e To create a new service configuration (see How to Add New Service Configurations, page 6-2), click
Yes.

¢ To open an existing service configuration (see How to Open Existing Service Configurations,
page 6-4), click No.

The Configuration option is included in the main menu only when at least one service configuration is
open.

You can have many service configurations open at one time; each is displayed in its own view, and you
click a view to make that view’s service configuration active.

When a service configuration has unsaved changes, an asterisk precedes its name on the view.

How to Add New Service Configurations

You can add a new service configuration whenever necessary.

A

Note  You cannot add a second new service configuration until you have saved the first one.

When a new service configuration opens, it contains the default service configuration supplied with SCA
BB. This includes a default package, which contains a default service rule.

CH
Step 1 In the Console toolbar, click || (New Service Configuration).

A New Service Configuration Settings dialog box appears.
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Step 2
Step 3

Step 4

Managing Service Configurations ||

New Service Configuration Settings

~aystem Operational Mode

Select the system's operational mode For handling the network traffic:
() Transparent
(%) Report Cnly

() Full Functionality

~Routing Classification Mode -

Enable Asymmetric Routing Classification Mode in topologies
with high rate of unidirectional Aows, In this mode, the system is
better tuned for classifying traffic according to just one side of the
Flows, bt some control capabilities are disabled.

[] Enable the Asymmetric Routing Classification Mode

[ [8]4 H Cancel ]

210800

Select an operational mode for the service configuration.
Select a routing classification mode for the system.

Selecting asymmetric routing classification mode gives more accurate protocol classification in
topologies with a high rate of unidirectional flows. Several classification, reporting, and control features
are not supported when this mode is enabled (see Asymmetric Routing Classification Mode,

page 10-41).

Click OK.

If you have set a default DSS file (see The Default DSS File, page 7-40), a Default Signature message
appears.

3 Default Signature

92 Would you like to set the default signature script?
\‘-.

158798

¢ (Recommended) Click Yes to import the default DSS file.
¢ Click No to continue without importing the default DSS file.

The new service configuration is added to the Console window, open on the Network Traffic tab, and
becomes the active service configuration.

[ oL-7205-11
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3 Service Configuration Editor - <new service configuration> - SCA BB Console

File Tools Preferences Window Help
- IERE
=} |g Service Configuration Editor |ﬂ Netwark Navigatar

Q <new service configuration= &3 =8

: Default Package

= Palicies | 5| Classification

W d4f 3 . Configuration ~

5 Filkered Traffic

: H Service Security

&% Global Policy

{0} subscriber Policies

5] <r sulk Package

Urknown Subscriber Traffic

Default Package : Defaulk Service

Rule Action

4 Default Pule controlled

& console [ Problems ERN: = -
Console

274098

Repart Only

How to Open Existing Service Configurations

You can open a saved service configuration for viewing or for editing, or to apply it to an SCE platform.

Service configuration files have the extension PQB.

Step 1 In the Console toolbar, click E‘ (Open A Service Configuration File). (Or, from the Console main
menu, choose File > Open Service Configuration.)

An Open dialog box appears.
Step2  Browse to a service configuration file.
Step3  Click Open.

The Open dialog box closes.

If the default DSS file has not been imported into the service configuration, a Default Signature message
appears.

3 Default Signature

9P Would you like to set the default signature script?

<
B
=
(=]
156798
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If the default DSS file has not been imported into the service configuration, a Default Signature message
appears.

¢ (Recommended) Click Yes to import the default DSS file.
¢ Click No to continue without importing the default DSS file.
The service configuration is loaded into the Console:
e This service configuration becomes the active service configuration.

e The title of the Console window includes the name of the service configuration.

How to Save the Current Service Configuration

You can save the active service configuration.
e How to Save the Current Service Configuration to a Service Configuration File, page 6-5

e How to Save the Current Service Configuration to the File from Which it Was Loaded, page 6-5

How to Save the Current Service Configuration to a Service Configuration File

Step 1 From the Console main menu, choose File > Save As.
A Save As dialog box appears.
e Enter your password if prompted.
Step2  Browse to the folder where you want to save the file containing the service configuration.
Step 3 In the File name field, enter a new file name, or select an existing PQB file.
Step4  Click Save.
The service configuration is saved to the selected file. If the file exists, it is overwritten.

During processing, a Saving Service Configuration File message appears.

How to Save the Current Service Configuration to the File from Which it Was Loaded

Step 1 In the Console toolbar, click L&l (Save).

If the current service configuration was not loaded from a PQB file (that is, if it is new, or it was retrieved
from an SCE platform), the Save As dialog box opens as in the previous procedure.

How to Close Service Configurations

Step1  On the service configuration view, click E (Close).

e If there are no unsaved changes, the service configuration view closes.

Cisco Service Control Application for Broadband User Guide
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e [If there are unsaved changes a Save Resource message appears.

3£ Save Resource

'znew service configuration>' has been modified. Save changes?

2

Mo Cancel

I
211749

e C(Click Yes:

— If this is an existing edited service configuration, the changes are saved and the service
configuration view closes.

— If this is a new service configuration, a Save As dialog box opens.
Enter a name for the service configuration and click Save.

The Save As dialog box closes, the changes are saved, and the service configuration view closes.

How to Export Service Configuration Data

You can export service configuration data from the current service configuration to CSV files. The CSV
file formats are described in the “CSV File Formats” chapter of the Cisco Service Control Application
Suit for Broadband Reference Guide.

Each type of service configuration element is exported to a separate file.

Step 1 From the Console main menu, choose File > Export.

The Export dialog box appears.
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3 Export |Z|®

Select /—‘
Choose export destination, I E 5 i

Select an export destination:

|type Filker bext |

(= Wetwork Mavigator
== Reporter

onfiguration
Export service configuration parts ko a CSY file

(et )
b

Step2  From the export destination list, select Export service configuration parts to CSV file.
Step3  Click Next.

The Export Service Configuration Parts dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Step 4

Note

Step 5
Step 6

3 Export Service Configuration Parts

Export Service Configuration Part to File

This wizard exports service configuration parts to a file

Select service configuration element to export:

™ Service Elements
" Protocol Elements
~

" Flavors

SR S VO il SR el R Nl ST s v el

Cancel

Select one of the Select service configuration element to export radio buttons.

The radio buttons are:
¢ Service Elements
¢ Protocol Elements
e Zones

e Flavors

If you select Flavors, the flavors in the flavor area of the dialog box are enabled.

211743

Only those flavors for which a flavor type is defined in this service configuration are enabled.

If you selected Flavors, select one of the flavor type radio buttons.

Click Next.

The second screen of the Export Service Configuration Parts dialog box opens.

[l Cisco Service Control Application for Broadband User Guide
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3 Export Service Configuration Parts

Export Service Configuration Parts to File
At least one element should be selected for export

Available elements:

(] Skype

[] sittorrent

|:| DirectConnect

[] eDonkey

JFre

[] FastTrack KaZaA File Transfer
[] FastTrack KaZaA Metworking
[ ceneric 1P

[] Gnutella File Transfer

[] Gnutella Netwaorking

|:| HTTP Browsing

[] Hotline

T mms

] Manalito

[ Select All ] [ Deselect Al ] [ Invert Selection

Select the export destination:

Service Configuration file: |

v-i [Browse. - ]

Cancel

158519

The Available elements pane lists all elements in the service configuration of the selected type.

Browse to the folder where you want to save the file containing the service configuration elements.

Step7  Select the elements to export, using the check boxes and the select buttons.
Step8 In the Select the export destination area, click Browse.

An Open dialog box appears.
Step 9
Step10 In the File name field, enter a new file name, or select an existing CSV file.
Step11  Click Open to select the file.

If the file exists, it will be overwritten.

The Open dialog box closes.
Step12 Click Finish.

The selected service configuration elements are exported to the file.

An Export Complete message appears.

[ oL-7205-11
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3 Export Complete

i ] Export completed successfully, 3 elements have been exported,

158816

Step13  Click OK.

The Export Service Configuration Parts dialog box closes.

How to Import Service Configuration Data

You can import service configuration data to the current service configuration from CSV files. The CSV
file formats are described in the “CSV File Formats” chapter of the Cisco Service Control Application
Suit for Broadband Reference Guide.

Each type of service configuration element is imported from a separate file.

Step1  From the Console main menu, choose File > Import.

The Import dialog box appears.

¥ Import |:|®

Select

Choose import source. |' E -

Select an import source:

|type filker bext |

= E avigator

= [ Service Configuration
Import content filkering database settings from an XML file
Import service configuration parks From a 5 file

= Signature Editar

< Back. Mext = Finish |

274089

Step2  From the Select an import source list, select Import service configuration parts from CSV file.
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Step3  Click Next.

The Import Service Configuration Parts dialog box appears.

3 Import Service Configuration Parts

Import Service Configuration Part from File

This wizard imports service configuration parts from a file

Select service configuration element to import:

" Service Elements
" Protocol Elements
" Zones

" Flavors

THUL S G el e Yl e S e S v e

| t | Cancel

211748

Step4  Select one of the Select service configuration element to import radio buttons.
The radio buttons are:
¢ Service Elements
¢ Protocol Elements
e Zones
¢ Flavors
If you select Flavors, the flavors in the flavor area of the dialog box are enabled.
Step5  If you selected Flavors, select one of the flavor type radio buttons.
Step6  Click Next.

The second screen of the Import Service Configuration Parts dialog box opens.

Cisco Service Control Application for Broadband User Guide
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3 Import Service Configuration Parts

Import Service Configuration Part from File

This wizard imports service configuration parts from a file

Select a C5V file: bt ! [Browse. = ]

Cancel

158861

Step7  Click Browse.
An Open dialog box appears.
Step8  Browse to the folder containing the file to import, and select a CSV file.
Step9  Click Open to select the file.
The Open dialog box closes.
Step10 Click Finish.
The configuration elements are imported from the file.

An Import Complete message appears.

3£ Import Complete

i ] Import completed successfully, 2 elements have been imported.

158855

Step11  Click OK.

The Import Service Configuration Parts dialog box closes.
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Applying and Retrieving Service Configurations

For a new or edited service configuration to take effect, you must apply it to the SCE platform. Until you
do, the SCE platform continues to enforce the previous service configuration.

You can use the Service Configuration Editor to apply a service configuration to an SCE platform, but
not to retrieve a service configuration.

You can apply or retrieve a service configuration using:
e The Network Navigator Tool, page 5-1

¢ servconf, the SCA BB Service Configuration Utility (see The SCA BB Service Configuration
Utility, page 13-1)

e How to Validate the Current Service Configuration, page 6-13

e How to Apply a Service Configuration to SCE Platforms, page 6-14

How to Validate the Current Service Configuration

Step 1

Step 2

Use the Validate optionto validate the new or updated service configuration currently displayed. The
validation process checks for overall service configuration coherence, and points out possible pitfalls in
the service configuration.

The Validate process runs automatically when you select Apply Service Configuration to SCE devices.
The Validation Results dialog box appears only if the procedure found errors or issued warnings about
the current service configuration.

From the Console main menu, choose File > Validate.

The Validation Results dialog box appears.

3£ Validation Results

‘i;) Service Configuration is valid.

210987

3£ Validation Results

' Service Configuration has errors.
b Errors and Warnings are listed in the Problem View.

210986

Any problems with the service configuration are listed in the Problems view.
Click OK.

The Service Configuration Validation dialog box closes.

[ oL-7205-11
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How to Apply a Service Configuration to SCE Platforms

When you click Apply Service Configuration to SCE Devices, the validation process runs
automatically on the current service configuration.

Note  You can use the Validate menu command to manually validate the service configuration.

Caution  If anomaly-based detection of malicious traffic is enabled, any access control list (ACL) that is
configured on the Service Control Engine (SCE) platform but is not applied to anything (for example,
an interface, an access map, or anSNMP community string) might be deleted when a service
configuration is applied to the platform.

Workaround:

Disable anomaly-based detection of malicious traffic.

In the Network Traffic tab, select Service Security.

In the Service Security Dashboard, clear the Enable anomaly detection check box.

Step 1 In the Console toolbar, click % (Apply Service Configuration to SCE Devices).
The Select SCE Devices dialog box appears.

3£ Select SCE Devices

| SCE1[172.2.5.31]
SCE2 [172.2.5.127]
SCE3 [172.2.5.83]

I 0K ][ Cancel ]

158967

All SCE platforms defined in the Network Navigator are listed in the dialog box.
Step2  Select one or more SCE platforms from the list.
Step3  Click OK.
A Password Management dialog box appears for each platform selected.
Step4  Enter the appropriate password.
Step5  Click Apply.

The Password Management dialog box closes.
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An Applying service configuration to SCE progress bar appears for each SCE platform selected.
The validation process runs on the service configuration.

e If there is a problem and the validation process ends with a warning or error, the Validation Results
dialog box appears. Click OK, modify the service configuration based on the information provided
in the Problems view, and then repeat this procedure.

e If the validation process runs successfully, the service configuration is applied to the selected SCE
platforms.

Cisco Service Control Application for Broadband User Guide
I oL-7205-11 .m



Chapter 6 Using the Service Configuration Editor |

Bl Managing Service Configurations

Cisco Service Control Application for Broadband User Guide



= CHAPTER 7

Using the Service Configuration Editor: Traffic
Classification

Traffic classification is the first step in creating a Cisco Service Control Application for Broadband
(SCA BB) service configuration. Traffic is classified according to services.

For each commercial service that providers offer to their subscribers, a corresponding service is defined
in the Cisco Service Control solution. You can use this service to classify and identify the traffic, report
on its usage, and control it.

This module explains how to work with services and their elements and subelements.
e How to Search Traffic Classification Settings, page 7-1
e Managing Services, page 7-2
e Managing Protocols, page 7-20
e Managing Zones, page 7-29
e Managing Protocol Signatures, page 7-34
e Managing Flavors, page 7-45
e Managing Content Filtering, page 7-57

How to Search Traffic Classification Settings

Step 1

You can search for any classification detail by name or numeric ID, such as services, protocols, port number,
or counter assignments. You can also search for protocols or signatures that are not assigned to a service.

e

In the Classification tab, click . (Search Classification Settings).

The Search Classification Settings dialog box appears.

[ oL-7205-11
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# Search Classification Settings

Twpe kext to filker classification elements;

- E pefault Service [id=0; glabal-counter=0; subscriber-counter=0] -
= EJ Browsing [id=7; global-counter=0; subscriber-counter=1]

EJ HTTF [id=16; global-counter=3; subscriber-counter=1]

Bl HTTPS [id=17; global-counter=10; subscriber-counter=1]

Bl Location Based Services [id=48; global-counter=31; subscriber-counter=1]
EJ Servicel [id=99; global-counter=0; subscriber-counter=1]

EJ E-Mail [id=4; global-counter=0; subscriber-counter=2]

EJ File Sharing [id=4%; global-counter=0; subscriber-counter=0]

Bl Gaming [id=29; global-counker=0; subscriber-countar=4]

EJ Instant Messaging [id=28; global-counter=0; subscriber-counter=5]

EJ Internet Privacy [id=94; global-counter=0; subscriber-counter=g]

EJ Internet Yideo [id=70; global-counter=0; subscriber-counter=0]

Bl Met Admin [id=33; global-counter=0; subscriber-counter=g]

Bl Mewsgroups [id=8; global-counter=5; subscriber-counter=10]

EJ Voice and Video Calls [id=12; global-counter=0; subscriber-counter=2]

EJ Cther [id=1; global-counter=0; subscriber-counter=0]

T=F Unassigned Signature-Based Protocols
1=F Cther Unassigned Pratocals
1=F Unassigned Zones

[ 3 R 3 e =2 e R S

Ok, H Cancel ]

24337

Step2  Enter the text to search.

Note  You can include the following wildcards in the search:
e 7—any character

e e *_any string

The dialog box is populated with the search results.

Step3  Double-click the item to take you to the screen where you can edit it. For example, if you double-click
a protocol, the protocol dialog box opens on the selected protocol.

Managing Services

Services are used to classify controlled traffic.

A service consists of one or more service elements; different network traffic transaction types are
mapped to different service elements.

Traffic is classified on the basis of some or all of the following:

¢ Protocol—The protocol used by the transaction, as identified by the Service Control Engine (SCE)
platform

e Initiating side—Where the transaction was initiated
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e Zone—IP address of the network-side host of the transaction

e Flavor—Specific Layer 7 properties of the transaction; for example, hostnames of the network-side
host of the transaction

A service configuration can contain up to 500 services and 10,000 service elements. Every service
element in a service configuration must be unique.

Service Parameters

A service is defined by the following parameters:
e General parameters:
- Name—A unique name
- Description—(Optional) A description of the service
e Hierarchy parameters:
— Parent Service

The default service, which is the base of the service hierarchy, does not have a parent.

Note  The parent service is important when services share usage counters (see next parameter).

- Service Usage Counters—Used by the system to generate data about the total use of each
service. A service can use either its own usage counters, or those of the parent service.

Each usage counter has:

— A name assigned by the system (based on the service name).

Note  An asterisk is appended to a service usage counter name whenever the counter applies to more than one

service.

— A unique counter index—A default value of the counter index is provided by the system. Do
not modify this value.
e Advanced parameter:

- Service Index—A unique number by which the system recognizes the service (changing the
service name does not affect SCE platform activity). A default value of the service index is
provided by the system. Do not modify this value.

These parameters are defined when you add a new service (see How to Add a Service to a Service
Configuration, page 7-4). You can modify them at any time (see How to Edit Services, page 7-8).

Adding and Defining Services

A number of services are predefined in the Console installation. You can add additional services to a
service configuration, subject to the limit of 500 services (including predefined services) per service

configuration.

After you have added and defined a new service, you can add service elements to the service (see How
to Add Service Elements, page 7-11).
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e How to Add a Service to a Service Configuration, page 7-4
e How to Define Hierarchical Settings for a Service, page 7-5
e How to Set the Service Index, page 7-6

e How to View Services, page 7-7
How to Add a Service to a Service Configuration

Step 1 In the Services tab, select a service from the service tree. This service will be the parent of the service
you are adding.

Step2  In the left pane, click ':E:' (Add Service).
The Service Settings dialog box appears.

Service Settings for ""

Generd | Hierarchy | Advanced

Mame:
| Servicel

Descriptian:

[ QF H Cancel ]

158976

Step3  In the Name field, enter a unique and relevant name for the service.
Step4  In the Description field, enter a meaningful and useful description of the service.

Step5  To set exclusive usage counters for this service, or to change the parent service you selected when adding
the service, continue with the instructions in the section How to Define Hierarchical Settings for a
Service, page 7-5.

Step6  (Optional) To specify an index for this service, continue with the instructions in the section How to Set
the Service Index, page 7-6.

Note  The system automatically assigns a free number for the new service. Modify this number only where a
specific index value must be assigned to a specific service.

Step7  Click OK.

The Service Settings dialog box closes.
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The service is added to the service tree as a child to the service you selected in the hierarchy.

How to Define Hierarchical Settings for a Service

Step 1 In the Service Settings dialog box, click the Hierarchy tab.
The Hierarchy tab opens.

Service Settings for ""

General |

Farent Service

Parent Service: | SMTP |

Service Usage Counters

Per usage accounting scope {global accounting and subscriber accountingy),
a service can either be mapped ko an exclusive usage counker, or share a
usage counter with its ancestor service.

[] Map this Service ta an exclusive Global usage counter
Global counter used by this service: E-Mail CoL_lnter*
Counter Index: 3 v |

[ Map this Service ta an exclusive Subscriber usage counter
Subscriber counter used by this service: | E-Mail Counter®

Counter Index:

K Cancel

Step2  To set a different parent service, select the desired parent from the Parent Service drop-down list.

158977

Step3 By default, a new service uses its parent’s global usage counter. To define an exclusive global usage
counter, check the Map this Service to an exclusive Global usage counter check box.

The name in the read-only Global counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.

(Optional) Select a value for the counter index from the Counter Index drop-down list.

Note A default value of the counter index is provided by the system. Do not modify this value.

Step4 By default, a new service uses its parent’s subscriber usage counter. To define an exclusive subscriber
usage counter, check the Map this Service to an exclusive Subscriber usage counter check box.

The name in the read-only Subscriber counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.

(Optional) Select a value for the counter index from the Counter Index drop-down list.

Note A default value of the counter index is provided by the system. Do not modify this value.

Cisco Service Control Application for Broadband User Guide
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Step5  To specify an index for this service, continue with the instructions in the section How to Set the Service
Index, page 7-6.

Note  The system automatically assigns a free number for the new service. Modify this number only where a
specific index value must be assigned to a specific service.

Step6  Click OK.
The Service Settings dialog box closes.

The service is added to the service tree as a child to the service selected in the Parent Service drop-down
list.

How to Set the Service Index

Step1  In the Service Settings dialog box, click the Advanced tab.
The Advanced tab opens.

Service Settings for ""

| General I Higrarchy

Service Index

Set the Index For this Service: |40 v

[ QF ][ Cancel ]

158975

Step2  From the Set the Index for this Service drop-down list, select a service index.

The service index must an integer in the range 1 to 499; zero is reserved for the default service.

Note  The system automatically assigns a free number for the new service. Modify this number only where a
specific index value must be assigned to a specific service.

Step3  Click OK.

The Service Settings dialog box closes.
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The service is added to the service tree as a child to the service selected in the Parent Service drop-down
list.

How to View Services

You can view a hierarchy tree of all existing services and see their associated service elements.

Step 1 In the current service configuration, click the Classification tab.

The Classification tab appears.

E | g Service Configuration Editar |” Metwork Mavigatar

Q *znew service configuration> &5 =0
Clas

i
& Policies 5 Classification |

¥ e R . Configuration =

Protocol Initiating Side Zones Flavor

[ ing

# EJ E-Mail

[ EJ File Sharing

[ EJ @aming

[ Q Instant Messaging
[ EJ Inkernet Privacy
(-8 Tnternet Videa
-/ Mat Adrmin

EJ Mewsgroups

# EJ woice and Yideo Calls
(-5 Other

El consale BJ Problems Ex Sﬁ ) O
Console

274116

Reepart Only

A list of all services is displayed in the service tree (left pane).
Step2  Click a service in the hierarchy to display its service elements.

A list of all service elements defined for this service is displayed in the right (Service Elements) pane.
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Step 3

Step 4

Classification : IMAP

& Policies 5 Classification |

4" 4F ¥ . Configuration ~

Q *<new service configuration= &3

Loy

g Erowsing

- g E-Mail

=
- Q 13 Push Mail
L [E PP
~ [ sMTR

Q File Sharing
Q Eaming
Q Instank Messaging

Q Inkernet Privacy

g Internet Yideo

B Met: Admin

g Mewsgraups
JH voice and Video Calls
Q Qther

= console

Console

E_\ Prablems

Feepart Only

i<} |g Service Configuration Editor |ﬂ Netwark Navigatar

IMAP © imap
Protacol Initiating Side Zones Flawvor

imap Initiated by either side u u
imap3 Initiated by either side [+ [+
imapd-ssl Initiated by either side * *
imaps Initiated by either side * *
G gl Cike

To view more information about a service,

Service).

The Service Settings dialog box appears.
Click OK.

The Service Settings dialog box closes.

274114

select a service from the service tree and click l (Edit

How to Edit Services

Step 1
Step 2

Step 3

Step 4

Step 5

You can modify the parameters of a service, even those included in the Console installation.

To add, modify, or delete service elements, see Managing Service Elements, page 7-10.

In the Services tab, select a service from the service tree.

In the left pane, click l (Edit Service).

The Service Settings dialog box appears.

(Optional) Give a new name to the service.

Enter a new name in the Name field.

(Optional) Give a new description for the service.

Enter a new description in the Description field.

To change hierarchical settings, click the Hierarchy tab.

The Hierarchy tab opens.

To set a different parent service, select the desired service from the Parent Service drop-down list.

Cisco Service Control Application for Broadband User Guide
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b. To share a global usage counter with the parent service, uncheck the Map this Service to an
exclusive Global usage counter check box.

The name of the parent service’s counter is displayed in the Global counter used by this service field.

c. To define an exclusive global usage counter, check the Map this Service to an exclusive Global
usage counter check box.

The name in the read-only Global counter of this service field changes to reflect your choice.
The Counter Index drop-down list is enabled.

~

Note A default value of the counter index is provided by the system. Do not modify this value.

d. To share a subscriber usage counter with the parent service, uncheck the Map this Service to an
exclusive Subscriber usage counter check box.

The name of the parent service’s counter is displayed in the Subscriber counter used by this service
field.

e. To define an exclusive subscriber usage counter, check the Map this Service to an exclusive
Subscriber usage counter check box.

The name in the read-only Subscriber counter of this service field changes to reflect your choice.

The Counter Index drop-down list is enabled.

Note A default value of the counter index is provided by the system. Do not modify this value.

Step6  To change the service index:
a. In the Service Settings dialog box, click the Advanced tab.
The Advanced tab opens.
b. From the Set the Index for this Service drop-down list, select a service index.

The service index must an integer in the range 1 to 499; zero is reserved for the default service.

Note A default value of the service index is provided by the system. Do not modify this value.

Step7  Click OK.
The Service Settings dialog box closes.

The changes to the service are saved.

How to Delete Services

You can delete all services, even those in the Console installation, with the exception of the default
service.

Step 1 In the Services tab, select a service from the service tree.

Step 2 In the left pane, click ﬁ (Delete Service).

Cisco Service Control Application for Broadband User Guide
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Step 3

Step 4

A Service Warning message appears.

¥ Service Warning

1589581

Click Yes.

e If any package has a rule for this service (see Managing Rules, page 9-10), a second Service
Warning message appears.

3} Service Warning

92 All references to the Service "SMTF Outgoing” will be removed.
\._'_/ Are you sure you want to continue?

I
158983

e (lick Yes.

The service is deleted and is no longer displayed in the service tree. Any rules for the service are also
deleted.

Children of the deleted service are not deleted; they move up one level in the service tree.

Managing Service Elements

A service is a collection of service elements; to complete the definition of a service, you must define its
service elements. A service element maps a specific protocol, initiating side, zone, and flavor to the
selected service.

For more information, see Managing Protocols, page 7-20, Managing Zones, page 7-29, and Managing
Flavors, page 7-45.

A service configuration can contain up to 10,000 service elements. Every service element must be
unique.

A traffic flow is mapped by a service element to the service element’s service if it meets all five of the
following criteria:

¢ The flow uses the specified protocol of the service element.

¢ The flow is initiated by the side (network, subscriber, or either) specified for the service element.
e The destination of the flow is an address that belongs to the specified zone of the service element.
¢ The flow matches the specified flavor of the service element.

e The service element is the most specific service element satisfying the first four criteria.
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How to Add Service Elements

When necessary, you can add new service elements to a service. (The most useful service elements are
included in the Console installation.) A service may have any number of service elements (subject to the
limit of 10,000 service elements per service configuration).

Note  Every service element must be unique; if, at any stage, the new service element is the same as an existing
one, an error message is displayed in the dialog box and the Finish button is dimmed. If this occurs,
modify the value in at least one field.

Step 1 In the Services tab, select a service from the service tree.
Step 2 In the right (Service Elements) pane, click ':ll:ll:I (Add Service Element).

The New Service Element dialog box appears.

3£ New Service Element

Create Service Element

Create & new service element and assodiate it with a service

Assign the service element to service:

Service: [ sne | ISEIect... ]

Choose which flows will be mapped to the service by setting the following flow properties:

Protocol: [= | ISEIect... ]

Initiating Side: nih'ated by either _v-l

Zone: | = | ISEIect... ]
Flavor: | ¥ | [Select... ]
[ Finish l ’ Cancel ]

158887

Step3  To change the service to which this service element is assigned, click the Select button next to the
Service field.

The Select a Service dialog box appears, displaying a list of all services.
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Step 4
Step 5

Step 6

Note

Note

Select

Bittorrent
Browsing
Commerdial File Sharing
Default Service
DingoTel

E-Mail
eDankey,eMule
FTP

Gaming

Generic
Generic IP
Generic TCP
Generic UDP
Gnutella

H323

HTTP

L e

I oK ] [ Cancel

Select a service from the list.
Click OK.

The Select a Service dialog box closes.

158962

The selected service is displayed in the Service field of the New Service Element dialog box.

Click the Select button next to the Protocol field.

The default value (an asterisk, *) means that no protocol checking is performed when testing if a flow

maps to this service element.

The Select a Protocol dialog box appears, displaying a list of all protocols.

If you select a flavor (Step 15) before you select a protocol, only protocols relevant to the selected flavor

are displayed.

[l Cisco Service Control Application for Broadband User Guide
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3 - BX
Select

I |
* -
3com-amp3
3com-tsmux
3PC

914cfg

9pfs

AN

acap

acas
accessbuilder
accessnetwork
ad
acmaint_dbd
acmaint_transd
acp

acr-nema e

-yl
Cancel

158961

Step7  Select a protocol from the list. You can type in the field at the top of the dialog box to help locate the
desired protocol.

Step8  Click OK.
The Select a Protocol dialog box closes.
The selected protocol is displayed in the Protocol field of the New Service Element dialog box.

Step9  In the Initiating Side field, click the drop-down arrow.

Choose which flows will be mapped to the service by setting the following flow properties:

Protocol: ] | Select...

Initiating Side: -I_ _: -|
| |
Subscriber-Initiated

Zone: Network-Tnitiated i -! Select...

Initiated by either side

Flavar: il | Select...

158864

Step10  Select the appropriate initiating side from the drop-down list.
The following options are available:

e Subscriber-Initiated —Transactions are initiated at the subscriber side towards (a server at) the
network side.

e Network-Initiated —Transactions are initiated at the network side towards (a server at) the
subscriber side.

e Initiated by either side
Step11  Click the Select button next to the Zone field.

Note  The default value (an asterisk, *) means that no zone checking is performed when testing if a flow maps
to this service element.

The Select a Zone dialog box appears, displaying a list of all zones.

Cisco Service Control Application for Broadband User Guide
I oL-7205-11 .m



Chapter 7

Using the Service Configuration Editor: Traffic Classification |

M Managing Services

Step 12
Step 13

Step 14

Note

Note

Select

Europe
Local
Private Address Space

I

Ok

] [ Cancel

Select a zone from the list.

Click OK.

The Select a Zone dialog box closes.

158964

The selected zone is displayed in the Zone field of the New Service Element dialog box.

Click the Select button next to the Flavor field.

The default value (an asterisk, *) means that no flavor checking is performed when testing if a flow maps

to this service element.

The Select a Flavor dialog box appears, displaying a list of all flavors relevant to the protocol selected

in Step 7.

You can only select a ToS flavor if you select the default value (¥, meaning any protocol) for the

protocol.
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Select

Flavor 1
HTTP Streaming Agents
Vonage as Destination

[ OK l [ Cancel

158958

Select a flavor from the list.

Click OK.

The Select a Flavor dialog box closes.

The selected flavor is displayed in the Flavor field of the New Service Element dialog box.
Click Finish.

The New Service Element dialog box closes.

The new service element is added to the service.

A new row, representing the service element, is added to the service element list in the Service Elements
pane.

How to Duplicate Service Elements

Note

Step 1

Step 2
Step 3

Duplicating an existing service element is a useful way to add a new service element similar to an
existing service element. It is faster to duplicate a service element and then make changes than to define
the service element from scratch.

Every service element must be unique; if, at any stage, the new service element is the same as an existing
one, an error message is displayed in the dialog box and the Finish button is dimmed. If this occurs,
modify the value in at least one field.

In the Services tab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
In the Service Elements pane, select a service element to duplicate.

Click I;'l}' (Duplicate Service Element).

The Copy Service Element dialog box appears.

[ oL-7205-11
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3 Copy Service Element

Copy Service Element

Create a new service element using the selected service element as template

Assign the service element to service:

Service: | EMTR | ISEIect... ]

Choose which flows will be mapped to the service by setting the following flow properties:

Protocol: | smre | ISEIect... ]

Initiating Side: | [nitiated by either side vi

Zone: | = | ’Select... l

Flavor: | ol | [Select... ]

Cancel

158793

Step4  Modify the service element (see How to Edit Service Elements, page 7-16).

Note  Before you can save the new service element, you must change the value in at least one field.

How to Edit Service Elements

You can modify all service elements, even those included in the Console installation.

N
Note  Every service element must be unique. If, at any stage, the modified service element is the same as an

existing one, an error message is displayed in the dialog box and the Finish button is dimmed. If this
occurs, modify the value in at least one field.

Step 1 In the Services tab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
Step 2 In the Service Elements pane, select a service element to edit.
Step 3 In the Service Elements pane, click l (Edit Service Element).

The Edit Service Element dialog box appears.
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Step 7

Note

Step 8

Step 9

Step 10

Step 11
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3¢ Edit Service Element

Edit Service Element

Edit any of the service element's fields or assodate it with a different service

Assign the service element to service:

Service: '-SM'I'P - Select...

Choose which flows will be mapped to the service by setting the following flow properties:

Select...

Protocal: SM‘I‘P
Initiating Side: :_. _VJ
]

Flavor:

’ Einish l ’ Cancel ]

158811

To change the service to which this service element is assigned, click the Select button next to the
Service field.

The Select a Service dialog box appears, displaying a list of all services.

Select a service from the list.

Click OK.

The Select a Service dialog box closes.

The selected service is displayed in the Service field of the Edit Service Element dialog box.

To change the protocol of this service element, click the Select button next to the Protocol field.

An asterisk (*) means that no protocol checking is performed when testing if a flow maps to this service
element.

The Select a Protocol dialog box appears, displaying a list of all protocols.

Select a protocol from the list; you can type in the field at the top of the dialog box to help locate the
desired protocol.

Click OK.
The Select a Protocol dialog box closes.
The selected protocol is displayed in the Protocol field of the Edit Service Element dialog box.

To change the initiating side of this service element, click the drop-down arrow in the Initiating Side
field.

Select the appropriate initiating side from the drop-down list.
The following options are available:

e Subscriber-Initiated—Transactions are initiated at the subscriber side towards (a server at) the
network side.

[ oL-7205-11
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Step 12

Note

Step 13
Step 14

Step 15

Note

Step 16
Step 17

Step 18

e Network-Initiated—Transactions are initiated at the network side towards (a server at) the
subscriber side.

¢ Initiated by either side

To change the zone of this service element, click the Select button next to the Zone field.

An asterisk (*) means that no zone checking is performed when testing if a flow maps to this service
element.

The Select a Zone dialog box appears, displaying a list of all zones.

Select a zone from the list.

Click OK.

The Select a Zone dialog box closes.

The selected zone is displayed in the Zone field of the Edit Service Element dialog box.

To change the flavor of this service element, click the Select button next to the Flavor field.

An asterisk (*) means that no flavor checking is performed when testing if a flow maps to this service
element.

The Select a Flavor dialog box appears, displaying a list of all flavors.

Select a flavor from the list.

Click OK.

The Select a Flavor dialog box closes.

The selected flavor is displayed in the Flavor field of the Edit Service Element dialog box.
Click Finish.

The Edit Service Element dialog box closes.

The changes to the service element are saved.

The changes to the service element appear in the service element list in the Service Elements pane.

How to Delete Service Element

Step 1

Step 2
Step 3

You can delete all service elements, even those included in the Console installation.

In the Services tab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
In the Service Elements pane, select a service element to delete.

In the Service Elements pane, click ﬁ (Delete Service Element).

A Service Warning message appears.
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¥ Service Warning

158982

Stepd  Click Yes.

The service element is deleted and is no longer part of the selected service.

How to Move Service Elements

You can move an existing service element from one service to a different service.

Step 1 In the Services tab, select a service from the service tree.

A list of associated service elements is displayed in the Service Elements pane.
Step2  In the Service Elements pane, select a service element to move.
Step3  Click Iﬁ' (Move Service Element to Another Service).

The Move Service Element dialog box appears, displaying the complete service tree.

3£ Move Service Element

Mowe the selected Service Element bo the Service:

Default Service [id=0; global-counter=0; subscriber-c #
EJ Browsing [id=7; global-counter=0; subscriber-cou
g E-Mail [id=4; global-counter=0; subscriber-counte
Q IMAP [id=23; global-counter=15; subscriber-c
g M5 Push Mail [id=47; global-counter=30; subs
Q POP3 [id=21; global-counter=13; subscriber-c
gl SMTP [id=2Z; global-counter=14; subscriber-o
g File Sharing [id=49; global-caunter=0; subscriber-
Q Gaming [id=29; global-counter=0; subscriber-cou
E Instant Messaging [id=28; global-counter=0; sub:
EJ Internet Privacy [id=94; global-counter=0; subsc—
g Internet Yideo [id=70; global-counter=0; subscrit
EJ Met Admin [id=33; global-counter=0; subscriber-c
Bl Mewsoroups [id=5: dlobal-counter=5: subscriber- ¥

o
-l

[E 2 2 A IR e 2R

|

I OK l ’ Cancel ]

274093

Step 4 From the service tree, select a service.
Step5 Click OK.

The Move Service Element dialog box closes.
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The service element is moved to the selected service.

Managing Protocols

A protocol is composed of an application protocol signature, the destination port or ports, a unique name,
and an optional description.

Protocols are used to define service elements (see Managing Service Elements, page 7-10).

You can add new protocols (for example, to classify a new gaming protocol that uses a specific port).
You can also edit or delete existing ones.

A service configuration can contain up to 10,000 protocols.

SCA BB supports many commercial and common protocols. For a complete list of protocols included
with the current release of SCA BB, see “Protocols” in the “Default Service Configuration Reference
Tables” chapter of the Cisco Service Control Application for Broadband Reference Guide. As new
protocols are released, Cisco provides files containing the new protocol signatures so that you can add
the signatures to your service configuration. (See How to Import a Dynamic Signature Script into a
Service Configuration, page 7-39.)

e Viewing Protocols, page 7-20
e How to Add Protocols, page 7-22

How to Edit Protocols, page 7-23

How to Delete Protocols, page 7-24
e Managing Protocol Elements, page 7-25

Viewing Protocols

e How to View Protocols, page 7-20
e How to Filter the Protocols List, page 7-21

How to View Protocols

You can view a list of all protocols and their associated protocol elements.
The protocols are listed in ASCII sort order (that is, 0... 9, A... Z, a... z).

The protocol elements are not sorted; they are listed in the order in which they were added to the
protocol.

Step 1 From theClassification tab in the left pane, choose Configuration > Protocols.

The Protocol Settings dialog box appears.
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Protocol Settings

Protocols | Pratocol Elements

| (Show ll

= ®

2 Signature 1P Protacal Port Range

k{g" Scom-amp3
ks Bcom-tsmux
kafl 014/

bz opfs

kg an

kg aH

ke ARGls

kg aRIs

kil w25

kg pnarchy

kaf Asherons Call
kaf BBN-RCC-MON
R BrA

Close

158923

The Protocols tab displays a list of existing protocols.
Step2  Double-click a protocol to view its description and ID.

The Protocol Settings dialog box appears, displaying the protocol name, description, and ID.

Protocol Settings

Generall
Marne:
| 3rC |
Description:
Protocol IDy 788 w
-
[ OF; H Cancel ] %

Step3  Click Cancel.
The Protocol Settings dialog box closes.

Step4d  To view a list of protocol elements, select a protocol in the list in the Protocol Settings dialog box.
Protocol elements are displayed in the Protocol Elements tab.

Step5  Click Close.

The Protocol Settings dialog box closes.

How to Filter the Protocols List

You can filter the protocols by type, so that the Protocols tab displays only the selected type of protocol.
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There are ten categories of protocols:

e Generic Protocols—Generic IP, Generic TCP, and Generic UDP protocols, used for transactions
that are not specifically mapped to a protocol by any other protocol type.

e [P Protocols—Protocols (such as ICMP), other than TCP and UDP protocols, identified according
to the IP protocol number of the transaction.

¢ Port-Based Protocols—TCP and UDP protocols, classified according to their well-known ports. The
default service configuration includes more than 750 common port-based protocols.

¢ Signature-Based Protocols—Protocols classified according to a Layer 7 application signature.
Includes the most common protocols, such as HTTP and FTP, and a large group of popular P2P
protocols.

e P2P Protocols—Peer-to-peer file-sharing application protocols classified according to a Layer 7
application signature.

e VOIP Protocols—Voice-over-IP application protocols classified according to a Layer 7 application
signature.

e SIP Protocols—Protocols classified according to a Layer 7 application signature that is SIP or has
SIP characteristics.

e Worm Protocols—Protocols classified according to a Layer 7 application signature that is based on
traffic patterns of Internet worms.

e Packet Stream Pattern Based Protocols—Protocols classified according to a Layer 7 application
signature that is based on the pattern of the packet stream (for example, the stream’s symmetry,
average packet size, and rate) rather than on the packet’s payload content.

¢ Unidirectionally Detected Protocols—Protocols having a unidirectional signature.

Note Some protocols belong to more than one category. In particular, all predefined P2P, VOIP, SIP, Worm,
and Packet Stream Pattern-Based Protocols are also defined as Signature-Based Protocols.

Step 1 From theClassification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  From the drop-down list in the Protocols tab, select the type of protocol to display.
The protocols of the selected type appear in the Protocols tab.

Step3  Click Close.

The Protocol Settings dialog box closes.

Note  The setting in the drop-down list is not saved. The next time you open the Protocol Settings dialog box,
all protocols will be displayed.

How to Add Protocols

You can add new protocols to a service configuration, subject to the limit of 10,000 protocols per service
configuration.
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Step1  From theClassification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step 2 In the Protocols tab, click 5 (Add Protocol).
The Protocol Settings dialog box appears.

Protocol Settings

General

Mame:
| Protocol 1

Description:

Protocal ID: 5000 v |

[ oK ” Cancel l

158925

Step3  In the Name field, enter a unique name for the new protocol.
Stepd  (Optional) From the Protocol ID drop-down list, select an ID for the protocol.

The protocol ID must be an integer in the range 5000 to 9998; lower values are reserved for protocols
provided by SCA BB.

Note  The value of the protocol ID is supplied automatically by the system. Do not modify this field.

Step5 Click OK.
The Protocol Settings dialog box closes.

The new protocol is displayed in the Protocols tab. You can now add protocol elements to it. See How
to Add Protocol Elements, page 7-25.

How to Edit Protocols

You can modify the parameters of a protocol, even those included in the Console installation.

To add, modify, or delete protocol elements, see Managing Protocol Elements, page 7-25.

Step1  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.
Step 2 In the Protocols tab, double-click a protocol.

A second Protocol Settings dialog box appears.

Cisco Service Control Application for Broadband User Guide
I oL-7205-11 .m



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

Il Managing Protocols

Protocol Settings

General

L=
| 3PC

Deseription:.

Protocol ID: 738 v |

[ K ][ Cancel ]

158924

Step3  Modify fields in the Protocol Settings dialog box.
e In the Name field, enter a new name for the protocol.
e From the Protocol ID drop-down list, select an ID for the protocol.

The protocol ID must be an integer in the range 5000 to 9998; lower values are reserved for
protocols provided by SCA BB.

N

Note  The value of the protocol ID is supplied automatically by the system. Do not modify this field.

Step4  Click OK.

The Protocol Settings dialog box closes.

The new values of the protocol parameters are saved.
Step5  Click Close.

The Protocol Settings dialog box closes.

How to Delete Protocols

You can delete all protocols, even those included in the Console installation.

Step1  From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step 2 In the Protocols tab, select a Protocol.

Step 3 In the Protocols tab, click ﬁ (Delete Protocol).

A Protocol Warning message appears.
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3 Protocol Warning

€p | Are you sure you want to delete Protocol "3PC™?
\‘-.

158926

Stepd  Click Yes.

e If any service element maps the selected protocol to a service (see Managing Service Elements,
page 7-10), a second Protocol Warning message appears (even if the service is not used by any
package).

3 Protocol Warning

9 All references to the Protocol "3PC" will be deleted.
o Are you sure you want to continue?

I
I
158928

¢ (Click Yes.
The Protocol is deleted from the Protocols tab.
Step5  Click Close.

The Protocol Settings dialog box closes.

Managing Protocol Elements

A protocol is a collection of protocol elements .

To complete the definition of a protocol, you must define its protocol elements. A protocol element maps
a specific signature, IP protocol, and port range to the selected protocol. Every protocol element in a
service configuration must be unique.

A traffic flow is mapped to a specific protocol if it meets all four of the following criteria:
e The flow belongs to the specified signature of the protocol element.
e The flow protocol is the specified IP protocol of the protocol element.

e (If the IP protocol is TCP or UDP) The destination port is within the specified port range of the
protocol element.

e The protocol element is the most specific protocol element satisfying the first three criteria.

How to Add Protocol Elements

You can add any number of protocol elements to a protocol.

Cisco Service Control Application for Broadband User Guide
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S

Note

Step 1

Step 2
Step 3

Step 5

Note

Step 6

When you set the parameters of the protocol element, the values of the parameters are saved as you enter
them.

From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

In the Protocols tab, select a protocol.

In the Protocol Elements tab, click ':E:' (Add Protocol Element).

A protocol element is added to the protocol.

A new row, representing the protocol element, is added to the protocol element list in the Protocol
Element tab.

Click in the Signature cell of the protocol element, and then click the Browse button that appears in the
cell.

The default value (an asterisk, *) means that no signature checking is performed when testing if a flow
maps to this protocol element.

The Select a Signature dialog box appears, displaying a list of all signatures.

3 Select a Signature

Select a signature for the service element

= A
AntsP2P ]
AntsP2P - Unidirectional Client Request

BaiBao Download

Baifian Download - Unidirectional Client Request

BaiBao Download - Unidirectional Server Response

BaiBao Metworking

BaiBao Metworking - Unidirectional Client Reequest

Behavioral Upload/Download

Behavioral Upload/Download - Unidirectional Client Request

Behavioral Upload,Download - Unidirectional Server Response
Behavioral Upload/Download Host Based TCP

Behavioral Upload/Download Host Based UDP

Bittorrent

Bittorrent Aged Flow Continuation

Bittarrent Aged Flow Continuation - Unidirectional Client Request  +

2 | Cancel

210802

Select a signature from the list.

Select the Generic signature to allow a flow that has no matching signature in the protocol signature
database to be mapped to this protocol element (if the flow also matches the IP protocol and port range
of the protocol element).

Click OK.
The Select a Signature dialog box closes.

The selected signature is displayed in the Signature cell of the Protocol Settings dialog box.

Cisco Service Control Application for Broadband User Guide
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Step 8
Step 9

Step 10

Note

Step 11

Managing Protocols

Click in the IP Protocol cell of the protocol element, and then click the Browse button that appears in
the cell.

The default value (an asterisk, *) means that no IP protocol checking is performed when testing if a flow
maps to this protocol element.

The Select an IP Protocol dialog box appears, displaying a list of all IP protocols.

3£ Select an IP Protocol

Select an IP Protocol for the Service Element

any 0-hop Protocol

any distributed file system

any host internal Protocol

any local network

any private encryption scheme
ARGUS

ARIS

AX.25

EBN-RCC-MON

EMA

BR-SAT-MOMN

CBT G

——r

I Ok ] [ Cancel

158960

Select an IP protocol from the list.

Click OK.

The Select an IP Protocol dialog box closes

The selected IP protocol is displayed in the IP Protocol cell of the Protocol Settings dialog box.

In the Port Range cell, enter a port or range of ports. (For a range of ports, use a hyphen between the first
and last ports in the range.)

Specifying a port range is only possible when the specified IP protocol is either TCP or UDP (or
undefined, taking the wild-card value, *).

Only a flow whose port matches one of these ports will be mapped to this protocol element.
The protocol element is defined.

Click Close.

The Protocol Settings dialog box closes.

¢ Instead, if the protocol element that you have defined is not unique in this service configuration, a
Protocol Error message appears.

[ oL-7205-11
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3¢ Protocol Error

Errors must be resolved:

Item uniqueness violation error: duplicate Protocol Element <Generic, TCP,
629>

This Pratocol Element is contained in protocol '3com-tsmux’ and in protocal
'Jcom-amp3’

158922

a. Click OK.
b. Modify or delete the protocol element.
c. Click Close

The Protocol Settings dialog box closes.

How to Edit Protocol Elements

A

Note
Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

Step 7

Step 8
Step 9

Step 10

Step 11

You can modify all protocol elements, even those included in the Console installation.

All changes to the protocol element are saved as you make them.

From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

In the Protocols tab, select a protocol.

In the Protocol Elements tab, select a protocol element.

Click in the Signature cell of the protocol element, and then click the Browse button that appears in the
cell.

The Select a Signature dialog box appears.
Select a signature from the list.

Click OK.

The Select a Signature dialog box closes.

Click in the IP Protocol cell of the protocol element, and then click the Browse button that appears in
the cell.

The Select an IP Protocol dialog box appears.

Select an IP protocol from the list.

Click OK.

The Select an IP Protocol dialog box closes.

In the Port Range cell of the protocol element, enter a port or range of ports.
Changes to the protocol element are saved as you make them.

Click Close.
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The Protocol Settings dialog box closes.

e Instead, if the protocol element that you have modified is not unique in this service configuration,
a Protocol Error message appears.

a. Click OK.
b. Modify or delete the protocol element.
c. Click Close.

The Protocol Settings dialog box closes.

How to Delete Protocol Elements

Step 1
Step 2

Step 3
Step 4

Step 5

Step 6

You can delete all protocol elements, even those included in the Console installation.

From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Select a protocol in the Protocols tab.

In the Protocol Elements tab, select a protocol element.

In the Protocol Elements tab, click ﬁ (Delete Protocol Element).

A Protocol Warning message appears.

3 Protocol Warning

b ] Are you sure you want to delete this Protocol Element?

158927

Click Yes.
The protocol element is deleted from the Protocol Elements tab.
Click Close.

The Protocol Settings dialog box closes.

Managing Zones

A zone is a collection of destination IP addresses; usually the addresses in one zone will be related in
some way.

Zones are used to classify network sessions; each network session is assigned to a service element based
on its destination IP address.

A service configuration can contain up to 10,000 zone items. Every zone item must be unique.

e How to View Zones, page 7-30

[ oL-7205-11
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e How to Add Zones, page 7-30
e How to Edit Zones, page 7-31
e How to Delete Zones, page 7-32
e Managing Zone Items, page 7-33

How to View Zones

You can view a list of all zones and their associated zone items.

Step1  From the Classification tab in the left pane, choose Configuration > Zones.

The Zone Settings dialog box appears.

The Zones tab displays a list of all zones. The first zone in the list is selected, and its zone items are
displayed in the Zone Items tab.

Zone Settings

Zaone Thems i

172.16.0.0
192,165.0.0

Close

210058

Step2  Click a zone in the list to display its zone items.

The zone items of the selected zone are displayed in the Zone Items tab.
Step3  Click Close.

The Zone Settings dialog box closes.

How to Add Zones

Step1  From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

Step 2 In the Zones tab, click "8 (Add Zone).
The Zone Settings dialog box appears.
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Step 5
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General

Mame:
| Zone 1

Description:

Zone ID: ’4| v/

[ (0] 4 H Cancel ]

210059

In the Name field, enter a unique name for the new zone.
(Optional) From the Zone ID drop-down list, select an ID for the zone.

The zone ID must be a positive integer in the range 1 to 32767.

The value of the zone ID is supplied automatically by the system. Do not modify this field.

Click OK.
The Zone Settings dialog box closes.

The new zone is added to the Zones tab. You can now add zone items. (See How to Add Zone Items,
page 7-33.)

How to Edit Zones

Step 1

Step 2
Step 3

Step 4

Note

You can modify zone parameters at any time.

To add, modify, or delete zone items, see Managing Zone Items, page 7-33.

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.
In the Zones tab, select a zone.
Click _ " (Edit Zone).
The Zone Settings dialog box appears.
Modify fields in the dialog box.
e In the Name field, enter a new name for the zone.
¢ From the Zone ID drop-down list, select an ID for the zone.

The zone ID must be a positive integer in the range 1 to 32767.

The value of the zone ID is supplied automatically by the system. Do not modify this field.

[ oL-7205-11
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Step 5

Step 6

Click OK.

The Zone Settings dialog box closes.

The new values of the zone parameters are saved.
Click Close.

The Zone Settings dialog box closes.

How to Delete Zones

Step 1

Step 2
Step 3

Step 4

Step 5

You can delete any or all zones.

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

In the Zones tab, select a zone.

In the Zones tab, click * (Delete Zone).

A Zone Warning message appears.

3£ Zone Warning

€p | Are you sure you want to delete Zone "Europe™?
-

210060

Click OK.

e If any service element references the selected zone, a second Zone Warning message appears.

3 Zone Warning

9P All references to the Zone "Europe” will be deleted.
\"(/ Are you sure you want to continue?

210061

¢ Click Yes.
Every service element that references the selected zone is deleted.
The zone is deleted and is no longer displayed in the Zones tab.
Click Close.
The Zone Settings dialog box closes.
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Managing Zone Items

A zone is a collection of related zone items .
A zone item is an IP address or a range of IP addresses.

A service configuration can contain up to 10,000 zone items. Every zone item must be unique.

How to Add Zone Items

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6

You can add any number of zone items to a zone (subject to the limitation of 10,000 zone items per
service configuration).

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

In the Zones tab, select a zone.

In the Zone Items tab, click ':ll:ll:I (Add Zone Item).

A new line is added to the Zone Items table.

Double-click the new list item and enter a valid value.

A valid value is either a single IP address (for example, 63.111.106.7) or a range of IP addresses (for
example, 194.90.12.0/24).

Repeat Steps 3 and 4 for other IP addresses that will be part of this zone.
Click Close.
The Zone Settings dialog box closes.

e Instead, if the zone item that you have defined is not unique in this service configuration, a Zone
Error message appears.

3£ Zone Error

Errors must be resolved:
Item unigueness violation error; duplicate Zone Item 172.16.0.0

This Zone Item is contained in zone ‘Local' and in zone ‘Frivate Address Space’

210057

a. Click OK.
b. Modify or delete the zone item.
c. Click Close.
The Zone Settings dialog box closes.

How to Edit Zone Items

Step 1

From the Classification tab in the left pane, choose Configuration > Zones.

The Zone Settings dialog box appears.

[ oL-7205-11
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Step 2
Step 3
Step 4

Step 5

In the Zones tab, select a zone.
In the Zone Items tab, double-click a zone item.
Enter a new value for the zone item.

A valid value is either a single IP address (for example, 63.111.106.7) or a range of IP addresses (for
example, 194.90.12.0/24).

Click Close.
The Zone Settings dialog box closes.

e Instead, if the zone item that you have modified is not unique in this service configuration, a Zone
Error message appears.

a. Click OK.
b. Modify or delete the zone item.
c. Click Close.

The Zone Settings dialog box closes.

How to Delete Zone Items

Step 1
Step 2
Step 3

Step 4

Step 5

From the Classification tab in the left pane, choose Configuration > Zones.
The Zone Settings dialog box appears.

In the Zones tab, select a zone.

In the Zone Items tab, select a zone item.

In the Zone Items tab, click ﬁ (Delete Zone Item).

The zone item is deleted.

Click Close.

The Zone Settings dialog box closes.

Managing Protocol Signatures

A protocol signature is a set of parameters that uniquely identify a protocol.
e Viewing Signatures, page 7-34
e Dynamic Signatures, page 7-36

Viewing Signatures

e How to View Signatures, page 7-35
e How to Filter the Signatures List, page 7-35
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How to View Signatures

You can view a list of all signatures and the protocol to which each is assigned.

Step 1 From the Classification tab in the left pane, choose Configuration > Signatures Settings.

The Signatures Settings dialog box appears.

3£ Signatures Settings

Signatures Settings Dialog
This page lists the signatures supported by the Service Configuration
General | signatures seript |
| =l
Name ] I Assigned to Protocols Lol
(EQHoﬂine over HTTP 117769216 Hotline
EQHoﬂine over HTTP - Unidirectional Client Request 117770456 Hotline
%Hoﬂine over HTTP - Unidirectional Server Response 117770240 Hetine
'E@ Hotline Tracker 117768960 Hotline
rEQHcﬂiine Tracker - Unidirectional Client Request 117765254 Hotline
TR 50397184 HTTP Browsing
%QI'FI_I'P—GI:—I' 201392128 HTTP-GET
CRHTTP-Tunnel 234946560 HTTP Tunnel
(EQI—FI'I'P-TunneI - Unidirectional Client Request 234947072 HTTP Tunnel
EQI—I'I'I'P-TunneI - Unidirectional Server Response 234546816 HTTF Tunnel
(EQH'I'I'P - Unidirectional Client Request 50397696 HTTP Browsing E]
'EQH‘I‘I‘P - Unidirectional Server Response 50357440 HTTP Browsing
R)1CQ File Transfer 184877558 1CQ
(EQICQ File Transfer - Unidirectional Client Request 1846758438 co
%ICQ File Transfer - Unidirectional Server Response 184879380 1cq
{1CQ Networking 184877312 ilole}
(EQICQ Metworking - Unidirectional Client Request 184878592 1cqQ
E@ICQ Metworking - Unidirectional Server Responze 184879104 1cQ
(EQICQ FTT 184877824 1cQ
'E@ ICQ VoIP 34738048 ICQ VeIP
T e = L]
g
5
(oY)

Step2  Click Close.

The Signatures Settings dialog box closes.

How to Filter the Signatures List
You can filter the signature by type, so that the Signatures Settings dialog box lists only the selected type
of signature.
There are eight categories of signatures:
e DSS Contributed Signatures
e Not Assigned to any Protocol
e P2P Signatures
e VOIP Signatures

Cisco Service Control Application for Broadband User Guide
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Note

Step 1

Step 2

Step 3

e SIP Signatures
e Worm Signatures
e Packet Stream Pattern Based Protocols Signatures

e Unidirectionally Detected Signatures

Some signatures belong to more than one category.

From the Console main menu, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

From the drop-down list, select the type of signature to display.

The signatures of the selected type appear in the dialog box.

Click Close.

The Signatures Settings dialog box closes.

Dynamic Signatures

New protocols are being introduced all the time. Dynamic signatures is a mechanism that allows new
protocols to be added to the protocol list and, from there, to service configurations. This is especially
useful for classifying the traffic of a new protocol (for example, a new P2P protocol in a P2P-Control
solution).

¢ Installing new signatures to an active service configuration is described in Working with Protocol
Packs, page 4-17.

¢ Creating and modifying signatures is described in Using the Signature Editor, page 12-1.

¢ Using servconf, the SCA BB Server Configuration Utility, to apply signatures is described in The
SCA BB Service Configuration Utility, page 13-1.

The following sections describe working with dynamic signatures in the Service Configuration Editor.
e Dynamic Signature Script Files, page 7-36
e The Default DSS File, page 7-40

Dynamic Signature Script Files

Dynamic signatures are provided in special Dynamic Signatures Script (DSS) files that you can add to
a service configuration using either the Console or the Service Configuration API. After a DSS file is

imported into a service configuration, the new protocols it describes:

e Appear in the protocol list
e May be added to services

e Are used when viewing reports
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To simplify the configuration of new protocols added by a DSS, the DSS may specify a Buddy Protocol
for a new protocol. If, when loading a DSS, the application encounters the Buddy Protocol, it
automatically duplicates the set of service elements that use the Buddy Protocol, and replaces all
references to the Buddy Protocol with references to the new protocol. The association of the new
protocol to services will match that of the Buddy Protocol.

The following configuration actions are performed automatically when you import a DSS into a service
configuration:

¢ Signatures are updated and new signatures are loaded

¢ Protocol elements are created for new signatures of existing protocols

e New protocols are added to the protocol list, and protocol elements are created for them

e Service elements are created for new protocols according to the configuration of Buddy Protocols

The import procedure preserves all service and protocol settings.

After importing a DSS, associate the newly added protocols with services.

DSS files are periodically released by Cisco or its partners in accordance with customer requirements
and market needs. DSS files contain new protocols and signatures, and update previously defined
signatures. Updating a service configuration with the new DSS is explained in How to Import a Dynamic
Signature Script into a Service Configuration, page 7-39.

You can create your own DSS files or modify the Cisco release DSS file using the Signature Editor tool
(see Managing DSS Files, page 12-1).

¢ How to View Information About the Current Dynamic Signatures, page 7-37
¢ How to Import a Dynamic Signature Script into a Service Configuration, page 7-39

e How to Remove Dynamic Signatures, page 7-39

How to View Information About the Current Dynamic Signatures

From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Click the Signatures Script tab.

The Signatures Script tab opens.

e If no DSS file was imported into the current service configuration, the Signatures Settings dialog
box displays a message informing you of this.

[ oL-7205-11
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Step 3

3£ Signatures Settings

Signatures Settings Dialoeg

Use this page to import a DSS to the Service Configuration
or to remove the attached DSS

| et

DSS File Information:

Mo Dynamic Signatures Script has been imported.

Close

158997

e IfaDSS file was imported into the current service configuration, the Signatures Settings dialog box
displays information about the current dynamic signatures and the DSS file from which they were

imported.

3£ Signatures Settings

Signatures Settings Dialeg
Use this page to import a DSS to the Service Configuration
or to remove the attached DSS

General Signatures Script l

DSS File Information:

Script Mame: MewPocoScript

Version: 1.0 build 1

Created for SCA BB version: 3.1.0

Source File: Loco.dss

Imported On: Thu Apr 19 20:24:06 GMT+02:00 2007

Description:
Sseript.description

MNew Protocols: O (1) LOCOO
Enhanced Protocols: none.|

Import from File. .. |t D55 ‘ Remove ]

Close

Click Close.

211034
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Step 3

Step 4

Step 5

Step 6
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The Signatures Settings dialog box closes.

How to Import a Dynamic Signature Script into a Service Configuration

You can import signatures into a service configuration from a DSS file provided by Cisco or one of its
partners (described in this section), or from a DSS file that you have created or modified using the
Signature Editor tool (see Managing DSS Files, page 12-1).

It is recommended that you import the latest default DSS file (see How to Import the Default DSS File
Automatically, page 7-44) when creating a service configuration, and that you use this option only to
apply a new DSS to existing service configuration.

From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Click the Signatures Script tab.

The Signatures Script tab opens.

Click Import from File.

An Import Warning message appears.

3 Import Warning

2

Importing will override existing data. Are you sure you want to continue?

158863

Click Yes.

The Import from file dialog box appears.

Browse to the DSS file and click Open.

The Import from file dialog box closes.

The signatures in the DSS file are imported into the service configuration.

Information about the imported signatures and their DSS file is displayed in the Signatures Settings
dialog box.

Click Close.

The Signatures Settings dialog box closes.

How to Remove Dynamic Signatures

You can remove the installed dynamic signatures from a service configuration.

The DSS file is not deleted.
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Step1  From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears.

Step2  Click the Signatures Script tab.
The Signatures Script tab opens.

Step3  Click Remove.

A Dynamic Signature Script Confirmation message appears.

3£ Dynamic Signature Script Confirmation

Remaving the script TewPocoSeript” may affect traffic dassification.
I Press OK to continue.

Cancel

158802

Step4  Click OK.

e If any service element references a protocol whose signature is included in the imported DSS file, a
Dynamic Signature Script Removal Error message appears.

3£ Dynamic Signature Script Removal Error

The script MewPocoScript”™ which you are trying to replace or remove
wr contributes a protocol assigned to a service.

Press OK to remave the protocol from services and proceed with script

remaval.

Cancel

158803

e (lick Yes.

Every service element that references a protocol whose signature is included in the imported DSS
file is deleted.

The dynamic signatures are removed from the service configuration.
The Remove button is dimmed.

If the dynamic signatures were imported from the default DSS file, the Import Default DSS button is
enabled.

Step5  Click Close.

The Signatures Settings dialog box closes.

The Default DSS File

Whenever a protocol pack becomes available from Cisco (or one of its partners), you should update
offline service configurations (stored as PQB files on the workstation). The protocol pack (see Protocol
Packs, page 4-18) is provided as either an SPQI file or a DSS file.
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Step 1

Step 2

Managing Protocol Signatures

You can either offer updates automatically to every service configuration created or edited at the
workstation, or apply them from the workstation to the SCE platform. You make the latest update
available by installing the most recent DSS or SPQI file as the default DSS file. You can install the file
on the workstation either from the Console or by using The SCA BB Signature Configuration Utility,
page 13-6.

e The default DSS file is automatically offered for import when you perform any service configuration
operation (such as creating a new service configuration or editing an existing one) from the Console
on a service configuration that was not yet updated.

e The default DSS file is imported by default when any service configuration operation (such as
applying an existing service configuration) is performed using servconf, The SCA BB Signature
Configuration Utility, page 13-6. You can disable this option.

Users are expected to update the default DSS on their management workstation whenever they obtain a
new protocol pack, as explained in the following section.

e Setting and Clearing the Default DSS File, page 7-41
¢ Importing Dynamic Signatures from the Default DSS File, page 7-44

Setting and Clearing the Default DSS File

The default DSS file should normally be the latest protocol pack provided by Cisco (or one of its
partners). If necessary, modify the protocol pack using the Signature Editor tool (see How to Edit DSS
Files, page 12-13) to add signatures of new protocols until they become available from Cisco.

Whenever a new protocol pack becomes available, set it as the default DSS file. There is no need to clear
the current default DSS file; it will be overwritten by the new protocol pack.

e How to Set a Protocol Pack as the Default DSS File, page 7-41
e How to Clear the Default DSS File, page 7-43

How to Set a Protocol Pack as the Default DSS File

From the Console main menu, choose Window > Preferences.
The Preferences dialog box appears.
From the menu tree in the left pane of the dialog box, choose Service Configuration > Default DSS.

The Default DSS area opens in the right pane of the dialog box.

[ oL-7205-11
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Step 3

Step 4
Step 5
Step 6

3€ Preferences |Z|@@

| | Default DSS (=R
Help
InstalljUpdats Always add the Default DSS to service configurations without asking
Mebwork Connections . .
Reparter D35 File Information:
(= Service Configuration Mo Default D55 has been set,

Default 0S5

SCA BB
Web Browser

Choose File

[Clear Drefault DSS] [ Apply ]

[ Ok, H Cancel ]

274104

Click Choose File.

An Open dialog box appears.

From the Files of type drop-down list, select the file type of the protocol pack.
Browse to the protocol pack.

Click Open.

The Open dialog box closes.

Information about the default DSS file is displayed in the Default DSS area of the Preferences dialog
box.
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Step 7

Step 1

Step 2

Step 3

Note

Step 4

Managing Protocol Signatures

3 Preferences

type filter text - Default DSS ==

[+ Help
Install/Update
[+- Reporter DS5 File Information:

[=I- Service Configuration Script Name: NewPocoSaipt
Default D55 Version: 1.0 build 1
Created for SCA BB version: 3.1.0
Source File: Loco.dss
Imported On: Thu Apr 19 20:26: 18 GMT+02:00 2007

Description:
Sscript. description

Mew Protocols; O (1) LOCODO
Enhanced Protocals: none.

Clear Default DSS I Apply ‘

0K ‘ Cancel I

211033

Click OK.

The DSS file is copied to C:\Documents and Settings\<user name>\.p-cube\default3.1.7.dss as the
default DSS file.

The Preferences dialog box closes.

How to Clear the Default DSS File

From the Console main menu, choose Window > Preferences.

The Preferences dialog box appears.

From the menu tree in the left pane of the dialog box, choose Service Configuration > Default DSS.
The Default DSS area opens in the right pane of the dialog box.

Click Clear Default DSS.

The default DSS file, C:\\Documents and Settings\<user name>\.p-cube\default3.5.0.dss is deleted.
All information is deleted from the Default DSS area.

Deleting the default DSS file does not remove the imported dynamic signatures from the current service
configuration.

Click OK.

The Preferences dialog box closes.

[ oL-7205-11
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Step 1

Step 2

Step 1

Step 2

Importing Dynamic Signatures from the Default DSS File

If a default DSS file is installed, the application offers to import the dynamic signatures from the file
when you create a new service configuration or when you open an existing service configuration that has
not imported the signatures. Alternatively, you can manually import the dynamic signatures.

¢ How to Import the Default DSS File Automatically, page 7-44
e How to Import the Default DSS File Manually, page 7-44

How to Import the Default DSS File Automatically

Open an existing service configuration or create a new one.

A Default Signature message appears.

3£ Default Signature

9 Would you like to set the default signature script?

I
158793

Click Yes to import the default DSS file; click No to continue without importing the default DSS file.

How to Import the Default DSS File Manually

From the Classification tab in the left pane, choose Configuration > Signatures Settings.
The Signatures Settings dialog box appears

Click the Signatures Script tab.

The Signatures Script tab opens, with the Import Default DSS button enabled.
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3£ Signatures Settings

Signatures Settings Dialog

Use this page to import a DSS to the Service Configuration
or to remaove the attached DSS

DSS File Information:

Mo Dynamic Signatures Script has been imported.

Import from File. .. ] [ Import Default DSS

Close

210002

Step3  Click Import Default DSS.

An Import Warning message appears.

3 Import Warning

158863

Stepd  Click Yes.
The signatures in the default DSS file are imported into the service configuration.
The Import Default DSS button is dimmed.

Information about the imported signatures and the default DSS file is displayed in the Signatures
Settings dialog box.

Step5  Click Close.

The Signatures Settings dialog box closes.

Managing Flavors

Flavors are advanced classification elements that are used to classify network sessions.

Flavors are based on specific Layer 7 properties. For example, users can associate an HTTP flow with a
service based on different parts of the destination URL of the flow.

Cisco Service Control Application for Broadband User Guide
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Note

Flavors are supported only for small number of protocols, and for each such protocol there are different
applicable flavor types. Flavor types are listed in the table in the following section.

There is a maximum number of flavor items for each flavor type (see Maximum Number of Flavor Items
per Flavor Type, page 7-52). For each flavor type, every flavor item must be unique.

If unidirectional classification is enabled in the active service configuration, flavors are not used for

traffic classification.

e Flavor Types and Parameters, page 7-46
¢ How to View Flavors, page 7-48

e How to Add Flavors, page 7-50

e How to Edit Flavors, page 7-51

e How to Delete Flavors, page 7-51

e Managing Flavor Items, page 7-52

Flavor Types and Parameters

Table 7-1

Flavors are advanced classification elements that classify network sessions according to

signature-specific Layer 7 properties.

they are treated as character strings.

When Layer 7 application properties are used as session parameters, such as with an HTTP User Agent,

Layer 7 parameter-based flavor items may apply to the Layer 7 prefix (parameter beginning), Layer 7
suffix (parameter end), or a combination of Layer 7 prefixes and suffixes. A partial string must be
followed by "*" in case of a prefix and preceded by "*" in case of a suffix.

Table 7-1 lists available flavor types.

SCA BB Flavors

Flavor Type

Matched Session Parameters

Valid Values

HTTP Composite

HTTP User Agent, HTTP URL, HTTP Cookie
and HTTP Referer flavors serve as session
parameters.

<HTTP User Agent flavor, HTTP URL flavor,
HTTP Cookie flavor, HTTP Referer flavor>

e The flavors can be chosen using flavor
browsing.

HTTP User Agent

HTTP User-Agent retrieved from the HTTP
<User-Agent prefix> Request header field, from
the beginning of the Request header until the first
AN

For example, if the HTTP Request header field is
Mozilla/4.0, the HTTP User Agent retrieved is
Mozilla.

<User-Agent prefix>
Examples:

e <Moz*> matches all HTTP sessions with
User-Agent field starting with "Moz".

e <Mozilla> matches all HTTP sessions with
User-Agent field equal to "Mozilla".

¢ The maximum key length is 32 characters.

[l Cisco Service Control Application for Broadband User Guide
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Table 7-1 SCA BB Flavors (continued)
Flavor Type Matched Session Parameters Valid Values
HTTP URL e Host—Retrieved either from the HTTP Host |<host suffix, path prefix, path suffix, URL parame-

header field or from the Request URL. In the
latter case, the section from the beginning of
the URL until the first "/" is considered the
Host.

e Path—Retrieved from the Http URL, the
section from the first "/" to the "?".

e URL parameters—Any string following the
“?” (You do not need to start the parameters
prefix with “?”).

ters prefix>
e At least one parameter must be specified.
Unspecified parameters should be left as "*".

e For example:

<*cisco.com,*,* *> matches all HTTP
sessions with the Host ending with
"cisco.com", regardless of the values of Path
and Parameters.

e The maximum key length for all keys is 512
characters.

HTTP Cookie

Cookie "Key-Value" pairs that are retrieved from
the HTTP Request header Cookie field.

A Cookie may consist of many "Key-Value"
pairs; however, only the first three pairs are
calculated. The Cookie flavor calculation stops
when one of the "Key-Value" pairs matches the
specification, or when it has exceeded the three
pair limit.

<key prefix, value prefix>

e For example: <act*,*> matches any Cookie
pair where the Key begins with "act",
regardless of the Value.

e A flavor can be configured so that the Value
field is required to be empty. In this case, this
field should be left empty in the flavor item.

e White spaces are not allowed, "=" is not
allowed, and "*" is only allowed at the end of
the Key or Value.

¢ The maximum key length is 100 characters
for both the Key and Value fields

HTTP Referer

Similar to HTTP URL, but the parameters are
retrieved from the Referer HTTP header field.

<host suffix, path prefix, path suffix, URL parame-
ters prefix>
e At least one parameter must be specified.
Unspecified parameters should be left as "*".

e Forexample: <*cisco.com,*,* *>matches all
HTTP sessions with the Host ending with
"cisco.com", regardless of the values of Path
and Parameters.

e The maximum key length for all keys is 512
characters

HTTP Content
Category

Content Categories can be imported using the
Import dialog box or the HTTP Content Filtering
Settings dialog box.

Value selected from Select a Content Category
dialog box.

RTSP User Agent

RTSP User-Agent field that is retrieved from the
RTSP message header.

<RTSP User Agent prefix>

e For example: <abc*> matches all RTSP
sessions where the User-Agent starts with

" "

abc".

e The maximum key length is 128 characters

[ oL-7205-11
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Table 7-1

SCA BB Flavors (continued)

Flavor Type

Matched Session Parameters

Valid Values

RTSP Host Name

RTSP Host field that is retrieved from the RTSP
message header.

<RTSP Host suffix>

e For example: <*abc> matches all RTSP
sessions where the Host ends with "abc".

e The maximum key length is 128 characters

RTSP Composite

RTSP User Agent and RTSP Host Name flavors
serve as session parameters.

<RTSP User Agent flavor, RTSP Host Name
flavor>

SIP Source Domain

SIP Source Host field that is retrieved from the
SIP message header.

<SIP Host suffix>
e For example: <*abc>

e The maximum key length is 128 characters

SIP Composite

SIP Source Host and SIP Destination Host serve
as session parameters.

<SIP source domain, SIP destination domain>

SIP Destination

SIP Destination Host field that is retrieved from

<SIP Host suffix>

Domain the SIP message header. e For example: <*abc>
e The maximum key length is 128 characters
SMTP Host Name SMTP Host field that is retrieved from the SMTP | ¢ <SMTP Host suffix>
message header e For example: <*abc>
e The maximum key length is 128 characters
ToS DSCP value extracted from the IP header DSCP ToS (integer between 0 and 63)

~

Note

Composite Flavors are pairs of two defined flavors.

How to View Flavors

Step 1

You can view a list of all flavors and their associated flavor items.

From the Classification tab in the left pane, choose Configuration > Flavors.

The Flavor Settings dialog box appears.

[l Cisco Service Control Application for Broadband User Guide
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3£ Flavor Settings

Flavors Editing Dialog

HTTP Composite;
HTTP User Agent
4§/ HTTP Streaming Agents
HTTP URL

HTTP Content Category
RTSP Composite

RTSP User Agent

RTSP Host Name

SIP Composite

SIP Source Domain

i_a Yonage as Source

SIP Destination Domain

i_.a Yonage as Destination

= w; SMTP Host Name

@ Tos

i}
£t

i}
i b g g e

1
7

Rewvert I Accept ‘

OK | Cancel ‘

211747

The left area displays a tree showing all flavors of each flavor type.

Step2  Click a flavor in the tree to display its flavor items.

3£ Flavor Settings @

Flavors Editing Dialog

@ K
‘; HTTP Composite Name: ] HTTP Streaming Agents
2§ HTTP User Agent Index: | 100
in__a HTTP Streaming Agents
# HTTPURL :
; HTTP Content Category =
- RTSP Composite TE J
- ; RTSP User Agent F 3
-# RTSP Host Name ki
NSPlayer
; SIP Composite Mullsoft
-] ; SIP Source Domain QTS
4 Vonage as Source QuickTime
=% SIP Destination Domain RealPlayer
i; Yonage as Destination RM'?‘
= *;;‘ SMTP Host Name Sqn|que
Winamp
Tos WinampMPEG
Windows-Media-Flayer
Revert I Accept ‘

OK | Cancel ‘

211744
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The flavor items are displayed in the right area.
Step3  Click OK.
The Flavor Settings dialog box closes.

How to Add Flavors

You can import flavors from a CSV file. CSV files can be created by exporting flavors or created
manually as described in the “CSV File Formats” chapter of the Cisco Service Control Application Suite
for Broadband Reference Guide.

You can add any number of flavors to a service configuration.

Step1  From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.

Step2 In the flavor tree, select a flavor type.

Step3  Click ':::' .

A new flavor of the selected type is added to the flavor tree.

3£ Flavor Settings
Flavors Editing Dialog

HTTP Composite Mame: ] Flavor 1
i._" Index: ] 1
HTTP User Agent

i__; HTTP Streaming Agents "
HTTP URL L
HTTP Content Category
RTSP Composite

RTSP User Agent

RTSP Host Name

SIP Composite

SIP Source Domain

4 Vonage as Source

SIP Destination Domair

5,_; Yonage as Destination
SMTP Host Name

Tos

ol
3

]
=

Http User Agent | Hitp Url |

R

[
=

spa

Revert I Accept ‘

OK | Cancel ‘

Step 4 In the Name field, enter a name for the new flavor.

S

Note  You can use the default name for the flavor. It is recommended that you enter a meaningful name.

211745

Step5  (Optional) In the Index field, enter a unique integer value.
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Note SCA BB provides a value for the Index. There is no need to change it.

The flavor index must be a positive integer in the range 1 to 32767.

You have defined the flavor. You can now add flavor items. (See How to Add Flavor Items, page 7-53.)

How to Edit Flavors

You can modify flavor parameters at any time.

To add, modify, or delete flavor items, see Managing Flavor Items, page 7-52.

Step 1 From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.
Step 2 In the flavor tree, select a flavor.
The name and index of the flavor (and its flavor items) are displayed in the right area.
Step3  Modify fields in the dialog box:
e In the Name field, enter a new name for the flavor.
¢ In the Index field, enter a new, unique index for the flavor.
The flavor index must be a positive integer in the range 1 to 32767.
Step4  Click OK.

The Flavor Settings dialog box closes.

How to Delete Flavors

You can delete any or all flavors.

Step1  From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.

Step 2 In the flavor tree, right-click a flavor.
A popup menu appears.

Step3  Click 9% (Delete).

A Confirm Delete message appears.

Cisco Service Control Application for Broadband User Guide
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3£ Confirm Delete

€p | Are you sure you want to delete Flavor "Vonage as Source™

OK. | [ Cancel

158789

Step4  Click OK.

e If any service element references the selected flavor, a Confirm References Delete message appears.

3£ Confirm References Deletion

P All references to the Flavor "Vonage as Source” will be deleted.
“‘-.QJ Are you sure you want to continue?

oK | [ Cancel

155790

¢ Click Yes.
Every service element that references the selected flavor is deleted.
The flavor is deleted and is no longer displayed in the flavor tree.
Step5  Click Close.

The Flavor Settings dialog box closes.

Managing Flavor Items

A flavor is a collection of related flavor items .

A flavor item is a value of a property or properties of a flow. These properties depend on the flavor type
(see Flavor Types and Parameters, page 7-46).

There is a maximum number of flavor items for each flavor type (see the following section). For each
flavor type, every flavor item must be unique.

e Maximum Number of Flavor Items per Flavor Type, page 7-52
e How to Add Flavor Items, page 7-53

e How to Edit Flavor Items, page 7-55

e How to Delete Flavor Items, page 7-56

Maximum Number of Flavor Items per Flavor Type

Table 7-2 lists the maximum number of flavor items for each flavor type.
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Table 7-2 Maximum Number of Flavor Items per Flavor Type
Flavor Type Maximum No. of Flavor Items
HTTP Composite 10,000

HTTP User Agent 128

HTTP URL 100,000

HTTP Cookie 100

HTTP Referer 100

HTTP Content Category —

RTSP Composite 10,000

RTSP User Agent 128

RTSP Host Name 10,000

SIP Composite 10,000

SIP Source Domain 128

SIP Destination Domain 128

SMTP Host Name 10,000

ToS 64

How to Add Flavor Items

Step 1

Step 2
Step 3

You can add any number of flavor items to a flavor (subject to the limitation of the total number of each
type of flavor item per service configuration, as listed in the previous section).

From the Classification tab in the left pane, choose Configuration > Flavors.

The Flavor Settings dialog box appears.

In the flavor tree, click a flavor.

Above the flavor item list, click ' (Create New Flavor Item).

[ oL-7205-11
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3£ Flavor Settings
Flavors Editing Dialog

=
HTTP Composite Name: | Flavor 1

% Favor 1 Index: | 1

HTTP User Agent

% HTTP Streaming Agents

HTTP URL =« X
HTTP Content Category

S b :mp User Agent | Ttu: Url |
RTSP User Agent

RTSP Host Name

SIP Composite

SIP Source Domain

% Vonage as Source

SIP Destination Domain

'i_.; Yonage as Destination
SMTP Host Mame

ToS

m
BT

m
e

b b d e e

L
=T

Lot

Rewvert I Accept ‘

OK | Cancel ‘

211746

A new flavor item is added to the flavor item list. The number and type of parameters in the flavor item
depend on the flavor type (see Flavor Types and Parameters, page 7-46).

The new flavor item has a default value of all wild cards (*, asterisks).
Step4  For each cell of the new flavor item, click the asterisk and then enter an appropriate value.
For composite flavors and for the HTTP Content Category flavor:
a. Click the asterisk.
A Browse button is displayed in the cell.
b. Click the Browse button.

A Select dialog box appears, displaying all valid values for the parameter.
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3£ Select a Hitp User Agent |Z|@
Select

& HTTP Streaming Agents

I 0K H Cancel ]

158959

c. Select an appropriate value from the list.
d. Click OK.
The Select dialog box closes.
The selected value is displayed in the cell.
Step5 Repeat Steps 3 and 4 for other flavor items.
Step6  Click OK.
The Flavor Settings dialog box closes.

How to Edit Flavor Items

Step 1 From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.
Step 2 In the flavor tree, select a flavor.
Step 3 In the flavor item list, select a flavor item.
Stepd  For each cell of the selected flavor item, click the asterisk and then enter an appropriate value.
For composite flavors and for the HTTP Content Category flavor:
a. Click the asterisk.
A Browse button is displayed in the cell.
b. Click the Browse button.
A Select dialog box appears, displaying all valid values for the parameter.
c. Select an appropriate value from the list.
d. Click OK.
The Select dialog box closes.

Cisco Service Control Application for Broadband User Guide
I oL-7205-11 .m



Chapter 7 Using the Service Configuration Editor: Traffic Classification |

M Managing Flavors

The selected value is displayed in the cell.
Step5 Click OK.
The Flavor Settings dialog box closes.

How to Delete Flavor Items

Step 1 From the Classification tab in the left pane, choose Configuration > Flavors.
The Flavor Settings dialog box appears.
Step 2 In the flavor tree, select a flavor.
Step3  In the flavor item list, right-click anywhere in a flavor item.
A popup menu appears.
Step4  Click 9% (Delete).
The flavor item is deleted and is no longer displayed in the flavor item list.
Step5  Click Close.

The Flavor Settings dialog box closes.

Example: How to Import a List of URLs and Block Them

The following example shows how to import a URL file and configure the SCE to block these URLs

Step 1 Create a new flavor under the HTTP URL flavor type, as described in How to Add Flavors, page 7-50.
Step2 Import a CSV file containing the URLS you wish to block.
For further information, see How to Import Service Configuration Data, page 6-10.

N

Note The CSV file formats are described in the “CSV File Formats” chapter of the Cisco Service
Control Application Suit for Broadband Reference Guide.

Step3  Define a Service.
For further information, see How to Add a Service to a Service Configuration, page 7-4.

Step 4 Within the defined Service, add a service element that uses the new Flavor.
For further information, see How to Add Service Elements, page 7-11.

Step5  Add a rule to the package in which you want to block the URLSs, and associate it with the new Service.
For further information, see How to Add Rules to a Package, page 9-12.

Step6  Configure the rule to block the flow.

For further information, see How to Define Per-Flow Actions for a Rule, page 9-14.
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Managing Content Filtering

Content filtering involves classification and control of HTTP flows according to the requested URL. The
classification of the URL is performed by accessing an external database.

SCA BB provides content filtering by integrating with a SurfControl Content Portal Authority (CPA)
server.

Note  Content filtering is not supported when unidirectional classification is enabled.

e Information About Content Filtering, page 7-57

e The Content Filtering CLI, page 7-58

e How to Configure the RDR Formatter, page 7-59

e How to Enter Line Interface Configuration Mode, page 7-60
e Managing Content Filtering Settings, page 7-60

Information About Content Filtering

The Cisco HTTP Content Filtering solution consists of:
e The SCE application
e The Cisco CPA client
e The SurfControl CPA server

The SCE application classifies each HTTP flow according to the category returned by the CPA server.
This classification is then used for SCA BB traffic control and reporting. For example, users can define
a rule to block browsing of the “Adult/Sexually Explicit” category or to generate reports on the volume
consumed by browsing the “Kids” or “Shopping” categories.

e The SCE Application, page 7-57
e The Cisco CPA Client, page 7-57
e The SurfControl CPA Server, page 7-58

The SCE Application

The Cisco service control application runs on the SCE platform. It forwards HTTP URLs that it extracts
from traffic to the CPA client and uses the categorization results to classify the original HTTP flow to a
service. This classification is then used for normal SCA BB traffic control and reporting.

The SCE application communicates with the CPA client using Raw Data Records (RDRs). See How to
Configure the RDR Formatter, page 7-59.

The Cisco CPA Client

The Cisco CPA client runs on the SCE platform. It sends URL queries to the CPA server for
categorization, and updates SCA BB with the categorization results.

Cisco Service Control Application for Broadband User Guide
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The CPA client is installed as part of the SCA BB application (PQI) installation. Use the SCE platform
Command-Line Interface (CLI) (see The Content Filtering CLI, page 7-58) to configure and monitor the
client.

The SurfControl CPA Server

The CPA server runs on a dedicated machine. It receives categorization requests from the CPA client,
connects to the SurfControl Content Database, and responds with the category ID of the queried URL.

The SurfControl CPA Server is installed on a separate server that must be accessible from the SCE
platform. Details of the installation are not within the scope of this document.

The Content Filtering CLI

Use the SCE platform Command-Line Interface (CLI) to configure and monitor content filtering using
SurfControl CPA. For more information about the SCE platform CLI, see the Cisco SCES8000 CLI
Command Reference.

e CPA Client CLI Commands, page 7-58
e Description of CPA Client CLI Commands, page 7-58

CPA Client CLI Commands

The commands listed here are explained in the following section.
e Use the following CLI commands to configure the Cisco CPA client:

[no] cpa-client
cpa-client destination <address> [port <port>]
cpa-client retries <number_of_retries>

e These commands are line interface configuration commands. To run these commands you must
enter line interface configuration mode (see How to Enter Line Interface Configuration Mode,
page 7-60).

e Use the following CLI command in EXEC mode to monitor the status of the Cisco CPA client:

show interface LineCard <slot> cpa-client

Description of CPA Client CLI Commands

Table 7-3 gives a description of the Cisco CPA client CLI commands listed in the previous section and
their default values.

Table 7-3 CPA Client CLI Commands
Command Description Default Value
[no]l cpa-client Enables or disables the CPA Disabled
client
cpa-client destination Enables the CPA client and sets | ® Address—not defined
<address> [port <port>] S;ertCPA server IP address and e Port—9020
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Table 7-3

CPA Client CLI Commands (continued)
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Command

Description

Default Value

cpa-client retries
<number_of_retries>

Sets the number of retries to send
to the CPA server

3

show interface LineCard
<slot> cpa-client

Monitors the CPA client status
(See the following table)

Table 7-4 lists the information shown when monitoring the Cisco CPA client.

Table 7-4 CPA Client: Monitored Parameters
Parameter Description
Mode Enabled or disabled
CPA Address
CPA Port
CPA Retries
Status (If enabled) Active or error (and last error
description)
Counters e Number of successful queries
e Number of queries that failed because of no
Server response
e Number of pending queries
e Rate of queries per second (average over the
last 5 seconds)
Timestamps e CPA started

e Last query

e Last error

e Lastresponse

How to Configure the RDR Formatter

Step 1

Related Info

To enable the RDR formatter to issue HTTP categorization requests, configure the RDR formatter on

the SCE platform.

Make the appropriate SCE platform CLI command.

#>RDR-formatter destination 127.0.0.1 port 33001 category number 4 priority 100

For more information about configuring the RDR formatter, see the “Raw Data Formatting: The RDR
Formatter and NetFlow Exporting” chapter of the Cisco SCE8000 Software Configuration Guide.
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How to Enter Line Interface Configuration Mode

Step 1
Step 2

Step 3
Step 4

To run line interface configuration commands you must enter line interface configuration mode and see
the sCE(config if)# prompt displayed.

At the SCE platform CLI prompt (SCE#), type configure.

Press Enter.

The SCE(config)# prompt appears.

Type interface LineCard 0.

Press Enter.

The SCE (config if)# prompt appears.

Managing Content Filtering Settings

Applying HTTP URL content filtering requires the following steps in the Service Configuration Editor:

1.

Import the content filtering configuration file into your service configuration.

By default, SCA BB creates a separate flavor (of type HTTP Content Category) for each content
category and a service element for each new flavor. A new top-level service, “HTTP Browsing with
Categories”, is created, comprising these service elements.

Create new services and map the new category flavors to them.

Add content filtering rules to existing packages or create new packages that include content filtering
rules.

Enable content filtering for selected packages.

Apply the service configuration.

Importing Content Filtering Categories, page 7-60
How to Configure Content Filtering, page 7-67

How to View Content Filtering Settings, page 7-68
How to Remove Content Filtering Settings, page 7-69

Importing Content Filtering Categories

S

Note

Before you can control HTTP flows based on content, you must import an XML file provided with the
installation.

After you unzip the installation package, this file is located in the URL Filtering subfolder.

You cannot import content filtering categories when unidirectional classification is enabled.

HTTP Content Category Flavors, page 7-61
HTTP Browsing with Categories Service Elements, page 7-61
How to Import Content Filtering Categories Using the Import Dialog Box, page 7-62
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e How to Import Content Filtering Categories Using the HTTP Content Filtering Settings Dialog Box,
page 7-65

HTTP Content Category Flavors

By default, SCA BB creates a separate flavor (of type HTTP Content Category) for each content category
when importing the XML file.

3£ Flavor Settings @

Flavors Editing Dialog

k1 HTTP Compaosite Al
=] ;‘ HTTP User Agent Al
& HTTF Streaming Agents
% HTTPURL
53
% Category,Shopping
% Category Motor Vehides
% Category.Chat
& Category. Computing and Internet
& Category. Remate Proxies
%/ Category.Sex Education
% Category Travel
L Category. News
% Category.Hate Speech
& Category.Streaming Media
& Category, Sports
#_y Category.Weapons v

I. OK ] [ Cancel ]

158838

You can create additional HTTP Content Category Flavors that include two or more content categories.
(See How to Add Flavors, page 7-50.)

HTTP Browsing with Categories Service Elements

By default, SCA BB creates a service element for each flavor created when importing the XML file. A
new top-level service, HTTP Browsing with Categories, is created, comprising these service elements.

Cisco Service Control Application for Broadband User Guide
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Note

Note

Step 1

3£ Service Configuration Editor - pgb1.pgb - SCAS BB Console
File Edit Tools

MRS = .

Metwork Configuration  Window Help

E’ dscol.

pab

% pablpgh X

+ X N\

‘|:| Default Service

@ Signature Editor |Q Service Configuration Editor |ﬂ Metwork Mavigator

Zones

Flavor

#-0 Generic Initiated by either side . -~
E‘l:;] E-Mail HTTP Browsing  (Initiated by either side Category . kid's Sites
E‘l:;] Browsing HTTP Browsing  [Initiated by either side Cakegory Religion

L Newsgroups HTTP Browsing  [Initiated by either side Cakegory Hosting Sites
&0 pep HTTP Browsing  (Initiabed by either side Cakegory, Hacking
: L varp HTTP Browsing  [Initiated by either side Cakegory Remote Proxies

L Instant Messaging HTTP Browsing  [Initiated by either side Cakegory Hate Speech

HTTP Erowesing  |Initiated by either side _ategory, Shopping

HTTP Browsing

Initiated by either side

(Category . Streaming Media

HTTP Browesing

Initiated by either side

Category Usenet News

HTTP Browsing

Initiated by either side

Category, Education

HTTP Browsing

Initiated by either side

(Cateqory.Hobbies and Recreation

HTTP Browsing

Initiated by either side

Cakegory . Games

HTTP Browsing

Initiated by either side

Categary, Health and Medicine

HTTP Erowsing

Initiated by either side

Category, Photo Searches

HTTP Browsing  (Initiated by either side Cakegory, Gambling

HTTF Browsing  |Initiated by either side ategory Reference

HTTF Erowsing  |Initiated by either side _ategory, Food and Drink

HTTF Erowesing  |Initiated by either side Category, Computing and Internet

HTTF Erowsing  |Initiated by either side _ategory, Sex Education

HTTP Erowesing  |Initiated by either side Category, \Weapons

HTTP Browsing__IInitiated by either side Cateaory,Glamour and Intimate Ap... | ¥
,. = Consale e Sﬁ L:ﬁ =)

Report Only

158968

To view this new service you must save and close the service configuration and then reopen it.

How to Import Content Filtering Categories Using the Import Dialog Box

You can import content filtering categories using either the File > Import menu option or the
Configuration > Content Filtering menu option.

This procedure explains how to import using the File > Import menu option.

This is equivalent to the following procedure.

From the Console main menu, choose File > Import.

The Import dialog box appears.

[l Cisco Service Control Application for Broadband User Guide
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3£ Import |Z|@

Select

hoose import source.

Select an import source;

|type Filker bext

vigator
== Service Configuration

= Signature Editar

Impart content filkering database settings From an XML file
Import service configuration parks From a 3 file

Cancel |

274089

Step2  From the import source list, select Import content filtering database settings from XML file.

Step3  Click Next.

The Import Content Filtering Database Settings dialog box appears.

[ oL-7205-11
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3 Import

Import Content Filtering Database Settings
3 Please select a file

Select a XML file: | “ ! ’Browse... ]

Databaze Settings

Vendor Mame:

Vendor Information: |

Categorize Content by:

Content Categories:

Create Default Configuration

You can choose to create a default configuration matching the loaded configuration file. This default
configuration is a good starting peint for creating a service configuration matching your needs.

Create a distinct Flavor for each Content Category
Create a Service Element for each Content Category Flavor in service 'HT TP Browsing with Categories’

Cancel

158856

Step4  Click the Browse button next to the Select a XML file field.
An Open dialog box appears.

Step5 Browse to the folder containing the file to import, and select it.

Note For SurfControl’s CPA, the file is named surfcontrol.xml.

Step6  Click Open to select the file.
The Open dialog box closes.

Information about the content of the XML file is displayed in the Database Settings pane of the Import
Content Filtering Database Settings dialog box.

Step7 By default, SCA BB creates a separate flavor (of type HTTP Content Category) for each content
category when importing the XML file.

e To disable this option, uncheck the Create a distinct Flavor for each Content Category check box.

Note It is recommended that you do not disable this option.
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Step 8

Note

Step 9

Step 10

Managing Content Filtering

By default, SCA BB creates a service element for each flavor created in the previous Step. A new
top-level service, HTTP Browsing with Categories, is created, comprising these service elements.

e To disable this option, uncheck the Create a Service Element for each Content Category Flavor
in Service ‘HTTP Browsing with Categories’ check box.

It is recommended that you do not disable this option.

Click Finish.
The Import Content Filtering Database Settings dialog box closes.

Information from the imported file is displayed in the Database Settings tab of the HTTP Content
Filtering Settings dialog box.

3£ HTTP Content Filtering Settings

HTTP Content Filtering Settings Dialog

Enable HTTP content filtering

This section displays the information contained in the imported Database Settings XML file

Vendor Mame: SurfContorl
Vendor Information: | surfCantrol Content Portal Autharity A
Copyright 1998-2006 SurfControl plc. All rights reserved. P i

Categorize Content by: WholeUrl

Content Categories: [

‘Adut/Sexually Explct
%Cri mal Skills
@Drugs. Alcohol and Tobacco
‘@Gambling
%Hadﬂing
%Hate Speech
¥ violence
@Weapons
@Adverﬁsement&
| > Arts and Entertainment |

[ Remove ][ Import... ]

[ oK ” Cancel ]

158853

Click OK.
The HTTP Content Filtering Settings dialog box closes.

How to Import Content Filtering Categories Using the HTTP Content Filtering Settings Dialog Box

You can import content filtering categories using either the File > Import menu option or the
Configuration > Content Filtering menu option.

This procedure explains how to import using the Configuration > Content Filtering menu option.

[ oL-7205-11
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S

Note  This is equivalent to the previous procedure.

Step 1 From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears.
Step2  Click the Database Settings tab.
The Database Settings tab opens.
Step3  Click Import.
The Import Content Filtering Database Settings dialog box appears.
Step4  Click the Browse button next to the Select a XML file field.
An Open dialog box appears.

Step5 Browse to the folder containing the file to import, and select it.

Note For SurfControl’s CPA, the file is named surfcontrol.xml.

Step6  Click Open to select the file.
The Open dialog box closes.

Information about the content of the XML file is displayed in the Database Settings pane of the Import
Content Filtering Database Settings dialog box.

Step7 By default, SCA BB creates a separate flavor (of type HTTP Content Category) for each content
category when importing the XML file.

¢ To disable this option, uncheck the Create a distinct Flavor for each Content Category check box.

Note It is recommended that you do not disable this option.

Step8 By default, SCA BB creates a service element for each flavor created in the previous Step. A new
top-level service, HTTP Browsing with Categories, is created, comprising these service elements.

¢ To disable this option, uncheck the Create a Service Element for each Content Category Flavor
in Service ‘HTTP Browsing with Categories’ check box.

Note It is recommended that you do not disable this option.

Step9  Click Finish.
The Import Content Filtering Database Settings dialog box closes.

Information from the imported file is displayed in the Database Settings tab of the HTTP Content
Filtering Settings dialog box.
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3£ HTTP Content Filtering Settings

HTTP Content Filtering Settings Dialog

Enable HTTP content filtering

"ﬁa&age'é}.;tﬁ.;gs'} Database Settings |

This section displays the information contained in the imported Database Settings XML file

Vendor Mame: SurfContorl

Vendor Information: | surfControl Content Portal Autharity ~
Copyright 1998-2006 SurfControl plc. All rights reserved. v

Categorize Content by: WholeUrl

Content Categories: | ${Adult/Sexually Expict
@Criminal Skills

¥ Drugs, Alcohol and Tobacco =d
@Gambling

%Hacking

%Hate Speech

f}\-‘iolence

@Weapons

@Adverﬁsement&

> Arts and Entertainment b,

|

[ Remove ][ Import...

[ oK ” Cancel ]

158853

Step10 Click OK.
The HTTP Content Filtering Settings dialog box closes.

How to Configure Content Filtering

You can specify the packages where content filtering will be enabled. For packages where content
filtering is disabled, HTTP flows will be classified normally.

Step1  From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears.

The Package Settings tab displays a list of all packages defined for the current service configuration.

Cisco Service Control Application for Broadband User Guide
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3£ HTTP Content Filtering Settings

HTTP Content Filtering Settings Dialog

[¥IEnable HTTF content filtering:

| Package Settings | Datshase Settings |
Specify the packages where HTTP Content Filtering should be enabled:
[ ] A pefault Package
F =2 Package1
¥ B Unknown Subscriber Traffic

Select All ] [ Deselect Al ] [Invert Selection

I

O

l [ Cancel

Step2  Check the Enable HTTP content filtering check box.

Step3  Check the check box next to each package for which content filtering is to be applied.

Step4  Click OK.
The HTTP Content Filtering Settings dialog box closes.

How to View Content Filtering Settings

158852

You can view whether content filtering is enabled and to which packages content filtering is applied,

and information about the content filtering vendor and the vendor’s content categories.

Step1  From the Classification tab in the left pane, choose Configuration > Content Filtering.

The HTTP Content Filtering Settings dialog box appears.

The Package Settings tab displays a list of all packages defined for the current service configuration, and

shows for which packages content filtering is enabled.
Step2  Click the Database Settings tab.
The Database Settings tab opens.

This tab displays information about the content filtering vendor and the vendor’s content categories.

Step3  Click OK.

[l Cisco Service Control Application for Broadband User Guide
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The HTTP Content Filtering Settings dialog box closes.

How to Remove Content Filtering Settings

Step 1

Step 2

Step 3

Step 4

Step 5

You can remove all content filtering settings at any time.
Removing the settings:
e Removes content category flavor items from flavors
e Deletes all the content category flavor items

e Disables content filtering

From the Classification tab in the left pane, choose Configuration > Content Filtering.
The HTTP Content Filtering Settings dialog box appears.

Click the Database Settings tab.

The Database Settings tab opens.

Click Remove.

A Confirm Content Filtering Settings Removal dialog box appears.

3 Confirm Content Filtering Settings Removal

“» ), Remaving the Content Filtering Settings will:

- Remove Content Categories from Flavors
- Delete all Contet Categories
- Disable Content Filtering

QK. | [ Cancel

158787

Click OK.
All content filtering settings are removed.

Vendor Name, Vendor Information, and Content Categories are deleted from the HTTP Content
Filtering Settings dialog box.

Click OK.
The HTTP Content Filtering Settings dialog box closes.

e Generic Protocols—Generic IP, Generic TCP, and Generic UDP protocols, used for transactions
that are not specifically mapped to a protocol by any other protocol type.

e [P Protocols—Protocols (such as ICMP), other than TCP and UDP protocols, identified according
to the IP protocol number of the transaction.

e Port-Based Protocols—TCP and UDP protocols, classified according to their well-known ports. The
default service configuration includes more than 750 common port-based protocols.

¢ Signature-Based Protocols—Protocols classified according to a Layer 7 application signature.
Includes the most common protocols, such as HTTP and FTP, and a large group of popular P2P
protocols.

e P2P Protocols—Peer-to-peer file-sharing application protocols classified according to a Layer 7
application signature.

[ oL-7205-11
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e VOIP Protocols—Voice-over-IP application protocols classified according to a Layer 7 application
signature.

e SIP Protocols—Protocols classified according to a Layer 7 application signature that is SIP or has
SIP characteristics.

e  Worm Protocols—Protocols classified according to a Layer 7 application signature that is based on
traffic patterns of Internet worms.

e Packet Stream Pattern Based Protocols—Protocols classified according to a Layer 7 application
signature that is based on the pattern of the packet stream (for example, the stream’s symmetry,
average packet size, and rate) rather than on the packet’s payload content.

¢ Unidirectionally Detected Protocols—Protocols having a unidirectional signature.

Note  Some protocols belong to more than one category. In particular, all predefined P2P, VOIP, SIP, Worm,
and Packet Stream Pattern-Based Protocols are also defined as Signature-Based Protocols.

Step 1 From the Classification tab in the left pane, choose Configuration > Protocols.
The Protocol Settings dialog box appears.

Step2  From the drop-down list in the Protocols tab, select the type of protocol to display.
The protocols of the selected type appear in the Protocols tab.

Step3  Click Close.

The Protocol Settings dialog box closes.

Note  The setting in the drop-down list is not saved. The next time you open the Protocol Settings dialog box,
all protocols will be displayed.
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Using the Service Configuration Editor: Traffic
Accounting and Reporting

This module explains how to work with usage counters and Raw Data Records (RDRs).

Traffic Accounting and Reporting is the second step in creating a Cisco Service Control Application for
Broadband (SCA BB) service configuration.

e Usage Counters, page 8-1

e Raw Data Records, page 8-1

e NetFlow records, page 8-2

e Managing RDR Settings, page 8-2

Usage Counters

The SCA BB collects and maintains various network metrics (such as volume and number of sessions)
per service. This accounting takes place per subscriber, per group of subscribers (package or group of
packages), and for the entire link.

Service usage counters are used by the system to generate data about the total use of each service. A
service can use either its own usage counters, or those of the parent service. For example, in the default
service configuration the SMTP and POP3 services share the E-Mail service usage counters. The
assignment of services to usage counters is determined by the service hierarchy. How to Edit Services,
page 7-8, explains how to configure the service hierarchy.

The SCA BB also collects and maintains various network metrics per package.

Package usage counters are used by the system to generate data about the total use of each package. A
package can use either its own usage counters, or those of the parent package. The assignment of
packages to usage counters is determined by the package hierarchy. How to Set Advanced Package
Options, page 9-7, explains how to configure the package hierarchy.

Raw Data Records

Service Control Engine (SCE) platforms generate and transmit Raw Data Records (RDRs) that contain
information relevant to the service provider. These RDRs contain a wide variety of information and
statistics, depending on the configuration of the system. The content and structure of each type of RDR
is listed in the “Raw Data Records: Formats and Field Contents” chapter of the Cisco Service Control
Application for Broadband Reference Guide.

[ oL-7205-11
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e RDRs are not generated for filtered traffic (see Filtering the Traffic Flows, page 10-17).
e All RDR data is based on Layer 3 volume.

NetFlow records

¢ You enable and disable the export of NetFlow records using the CLI.

You can export records per supported RDR type. The data in the following RDR types can be
exported using NetFlow:

- Subscriber Usage RDR
- Package Usage RDR
- Link Usage RDR
e The NetFlow records can be sent to more than one collection device.

¢ NetFlow records can be generated concurrently with RDRs.

Managing RDR Settings

This section explains how to configure the generation of the different types of RDRs.

The content and structure of each type of RDR is listed in the “Raw Data Records: Formats and Field
Contents” chapter of the Cisco Service Control Application for Broadband Reference Guide.

¢ RDRs are not generated for filtered traffic (see Filtering the Traffic Flows, page 10-17).
e All RDR data is based on Layer 3 volume.

The RDR Settings Dialog Box

The RDR Settings dialog box allows you to control the generation of RDRs for an entire service
configuration. This dialog box contains seven tabs:

e Usage RDRs tab—Allows you to enable the generation each type of Usage RDR, and define their
generation intervals

¢ Transaction RDRs tab—Allows you to enable the generation of Transaction RDRs and define their
maximum rate of generation

e Quota RDRs tab—Allows you to enable the generation of each type of Quota RDR, and define their
generation parameters

e Transaction Usage RDRs tab—Allows you to specify the packages and services for which
Transaction Usage RDRs will be generated

e Log RDRs tab—Allows you to specify the packages and services for which Log RDRs will be
generated

e Real-Time Subscriber RDRs tab—Allows you to enable the generation of Real-Time Subscriber
Usage RDRs, and define their generation intervals and maximum rate of generation

e Real-Time Signaling RDRs tab—Allows you to specify the packages and services for which
Real-TimeSignaling RDRs will be generated

Cisco Service Control Application for Broadband User Guide
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Note

Managing RDR Settings Il

Media Flow RDRs and Malicious Traffic Periodic RDRs are enabled and configured in the How to Edit
Advanced Service Configuration Options, page 10-45.

How to Manage Usage RDRs

Note

Step 1

The four types of Usage RDRs contain data about total usage of all services included in a service usage
counter:

¢ Link Usage RDRs—For the entire link

¢ Package Usage RDRs—For all subscribers to a particular package
¢ Subscriber Usage RDRs—For a particular subscriber

e Virtual Links Usage RDRs—For a particular group of virtual links

You can enable or disable the generation of each type of Usage RDR, and set the generation interval for
each type of Usage RDR. You can limit the generation rate of Subscriber Usage RDRs. This is advisable
when there are a large number of subscribers.

By default, all four types of Usage RDRs are enabled. (Virtual Links Usage RDRs are enabled by default
only if Virtual Links mode was enabled when you created the service configuration.)

Usage RDRs are not generated for blocked sessions. A session is blocked if the service to which the
session is mapped is blocked for this user’s package (see How to Define Per-Flow Actions for a Rule,
page 9-14), or if the user has exceeded the allowed quota for this service (see Managing Quotas,
page 9-57).

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

e Link Usage RDR

e Package Usage RDR

¢ Subscriber Usage RDR
e Virtual Link Usage RDR

From the Classification tab in the left pane, choose Configuration > RDR Settings.

The RDR Settings dialog box appears.
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RDR Settings

Transactiﬁn Usage RDRs Log lilDRs Real-Time Subscriber .RDRs .ReaI-Time Signaling RDl;-!s
Usage RORs | Transaction RORs [ Quota RDRs
Link Usage RORs
Link IUsage RORs are generated at fixed intervals, They report the bokal usage of a particular service counter For the
entire link,
Generate Link Usage RDRs once every |5 | minutes, For each service

Package Usage RDRs

Package Usage RDRs are generated at fixed intervals. They repart the total usage of a particular service caunter,
generated by all subscribers in a group of packages.

Generate Package Usage RDRs once every -5 minutes, for each service

Subscriber Usage RDRs

Subscriber Usage RORs are generated at fixed intervals, They report the amount of usage consumed by an
individual subscriber for each service counter,

Generate Subscriber Usage RDRs once every | 5 | minutes, For each service

Limik the total rate of Subscriber Usage RDRs to [10 | RDRS per second

Yirtual Links Usage RDRs

‘irtual Links Usage RDRs are generated at Fixed intervals, They report the total usage of a particular service
counter, generated by all subscribers in a group of virkual links,

[[] Generate virtual Links Usage RDRs ance every minutes, for each service

[ ok H Cancel ]
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Step2  To enable the generation of a selected type of Usage RDR, check the appropriate Generate Usage RDRs
check box.

To disable the generation of a selected type of Usage RDR, uncheck the appropriate Generate Usage
RDRs check box.

Step3  To change the generation interval for a selected type of Usage RDR, enter the interval in minutes
between each generation of this type of Usage RDRs in the appropriate Generate Usage RDRs field.

Step4  To limit the generation rate of Subscriber Usage RDRs, enter the maximum number of Subscriber Usage
RDRs to be generated per second in the Limit the Total Rate of Subscriber Usage RDRs field.

Step5 Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Usage RDRs is saved.

How to Manage Transaction RDRs

Each Transaction RDRs contains data about a single network transaction. The SCE platform can
generate Transaction RDRs for selected service types. You can use these RDRs, for example, to generate
statistical histograms that help understand the traffic traversing the network.
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You can enable or disable the generation of Transaction RDRs, set the maximum number of Transaction
RDRs generated per second, and select for which services these RDRs are generated. You can also assign
a relative weight to each service. The relative weight determines the relative number of Transaction
RDRs that will be generated for this service, compared to other services.

By default, at most 100 Transaction RDRs are generated per second, and all services are given the same
weight.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the "Transaction RDR" section in the Cisco Service Control Application for
Broadband Reference Guide.

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Transaction RDRs tab.

The Transaction RDRs tab opens.

RDR Settings

LogRORs | Real-Time Subscriber RORs Real-Tims Signaling RDRs
|Jsage RORs Transaction RORs _ Quota RDRs | Transaction Lsage RDRs

Transaction RORs
Transaction RDRs represent single network transactions, They can be used to generate statiskical
histograms that help understand what kind of traffic is traversing the netwaork,

Generate Transaction RORs

Lirrit the kotal rate of Transaction RDRs ko | 100 : RORs per second

The relative weight of Transaction RDR. rate, for a certain service, determines the relative number
of RDRs per second that will be gererated For this service, compared with other services,

i Ensbled  Service Relative Weight
| [#]  |pefault Service 10] A |
[#]  |Generic 1) |
[#]  |Generic TCP 10—
[#]  |=eneric UDP 10
[#]  [E-Mai 10
[#]  |mGCP 10
[v]  |Generic IP 10
[v]  |Browsing 1o} |
el el ALInS ; nl ¥
[ (o4 ] [ Cancel ] g
&

To enable the generation of Transaction RDRs, check the Generate Transaction RDRs check box.
To disable the generation of Transaction RDRs, uncheck the Generate Transaction RDRs check box.

To change the maximum generation rate for Transaction RDRs, enter the desired rate in the Limit the
Total Rate of Transaction RDRs field.

To disable the generation of Transaction RDRs for a selected service, uncheck the Enabled check box
next to the service name.
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Step 6

Step 7

To set the relative weight for a selected service, double-click in the appropriate cell in the Relative
Weight column, and enter the desired weight.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Transaction RDRs is saved.

How to Manage Quota RDRs

Step 1

Step 2

Each Quota RDR contains data for a single subscriber. There are four types of Quota RDRs:

¢ Quota Breach RDRs—Generated when a quota breach occurs, that is, when services that try to
consume from a depleted quota bucket.

A breached service is handled according to its breach-handling settings. For example, when the
quota for a service is consumed, you can block its flows.

¢ Remaining Quota RDRs—Generated as quota is consumed, but only if a bucket state has change
since the last Remaining Quota RDR was generated.

¢ Quota Threshold Breach RDRs—Generated when the remaining quota in a bucket falls below a
threshold. External systems can treat this RDR as a quota request and provision the subscriber with
an additional quota before the bucket is depleted.

¢ Quota State Restore RDRs—Generated when a subscriber is introduced. When a subscriber logs out,
their remaining quota is stored in the Cisco Service Control Management Suite (SCMS) Subscriber
Manager (SM). When the subscriber logs in again, this quota is restored from the SM.

You can enable or disable the generation each type of Quota RDR and define the rate of generation of
these RDRs.

¢ For Remaining Quota RDRs, you can set the generation interval, and limit the generation rate
(advisable when there are a large number of subscribers).

e For Quota Threshold RDRs, you can configure the threshold.
By default, all Quota RDRs are disabled.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

e Quota Breach RDR

¢ Remaining Quota RDR

e Quota Threshold Breach RDR
e Quota State Restore RDR

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Quota RDRs tab.

The Quota RDRs tab opens.
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RDR Settings

LogRDRs Real-Time Subscriber RDRs I ReakTime Siénaling RDRs
Usage RDRs Transaction RDRs Transaction Usage RDRs

Quota Breach RDRs

[] Generate Quata Breach RORs

Remaining Quota RDRs

|:| Generate Rermaining Quata RORs every ' -: minukes

Limit the total rate of Remaining Quota RORs to | RORs per second

rGuota Threshold RORs

[] Generate Quata Threshold RDRs when remaining quota is less than | MBivtes

[ oK ” Cancel ]
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To enable the generation of Quota Breach RDRs, check the Generate Quota Breach RDRs check box.

To enable the generation of Remaining Quota RDRs, check the Generate Remaining Quota RDRs
check box.

To change the generation interval of Remaining Quota RDRs, in the Generate Remaining Quota RDRs
field, enter the interval in minutes between each generation of the RDR.

To limit the maximum generation rate of Remaining Quota RDRs, in the Limit the Total Rate of
Remaining Quota RDRs field, enter the maximum number of Remaining Quota RDRs to be generated
per second.

To enable the generation of Quota Threshold RDRs, check the Generate Quota Threshold RDRs check
box.

To change the Threshold for Quota Threshold RDRs, in the Generate Quota Threshold RDRs field, enter
the threshold for which Quota Threshold RDRs will be generated.

To enable the generation of Quota State Restore RDRs, check the Generate Quota State Restore RDRs
check box.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Quota RDRs is saved.
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How to Manage Transaction Usage RDRs

8-8

A

Transaction Usage RDRs are generated for all transactions of selected packages or for selected services
per package. Each Transaction Usage RDR contains data about a single network transaction. You can
use these RDRs, for example, to build detailed usage logs for specific services and subscribers for
transaction-based billing.

Caution

Note

Step 1

Step 2

Generating and collecting an RDR for each transaction can compromise performance. Enable

Transaction Usage RDR generation only for services and packages that must be monitored or controlled.

You can select the packages and services for which Transaction Usage RDRs are generated. The
following RDRs will also be generated for these packages and services:

e HTTP Transaction Usage RDR
e RTSP Transaction Usage RDR
e  VoIP Transaction Usage RDR

By default, no Transaction Usage RDRs are generated.

Media Flow RDRs are enabled in the How to Edit Advanced Service Configuration Options, page 10-45.

(When enabled, Media Flow RDRs are generated at the end of every SIP and Skype media flow; you can
use them to distinguish between SIP voice and video calls.)

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

e Transaction Usage RDR

e HTTP Transaction Usage RDR
e RTSP Transaction Usage RDR
e VoIP Transaction Usage RDR

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Transaction Usage RDRs tab.

The Transaction Usage RDRs tab opens.
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2£ RDR Settings E|
Usage RDREs Transaction RDRs Quoka RDRs
Transaction Usage RDRs Log RORs Real-Time Subscriber RORS Real-Time Signaling RORs
Transaction Usage RDRs
Transaction Usage RDRs represent single network kransactions, They can be used to generate detailed usage logs
far specific services and subscribers of specific packages.
Generate the Following types of Transaction Usage RDRs (TURS):
Generic TUR
[ Protocal specific TURs (include pratacol specific information)
[] Extended TURs (include extended protocol specific infarmation)
Packages and services for which Transaction Usage RDRs should be generated:
[ select/Deselect Al
-] Default Package
+-[][C3) Unknown Subscriber Package
Transaction IUsage RORs can be filkered according to the session's walume
[] Generate TUR only For sessions excesding Brvkes
Transaction Usage RORs can be generated at Fixed intervals, during long Fows
[] Enable Interim TUR to be generated every Minutes (from S minutes up to 2880 minutes)
— w
) 3
L) I oK ] [ Cancel ]
&
Step3  Check one or more of the following types of Transaction Usage RDRs to generate:
e Generic TUR
e Protocol Specific TURs (include protocol specific information)
¢ Extended TURs (include extended protocol specific information)
If you check Extended TURS, the Anonymize - Encrypt Personally Identifiable Information
checkbox is enabled. Check this box to anonymize the data.
Step4  (Optional) To enable the generation of Transaction Usage RDRs for a selected package, check the check
box next to the package name in the package tree.
The package expands to show all component services of the package; all services are checked.
Step5 Enable the generation of Transaction Usage RDRs for selected services of a package.
a. Expand the node of the desired package.
b. Check the check box next to the service name of each service for which a Transaction Usage RDR
is to be generated.
Cisco Service Control Application for Broadband User Guide
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Step 6

Step 7

Step 8

(Optional) Limit the generation of Transaction Usage RDRs by session size.
a. Check the Generate TUR only for sessions exceeding check box.
The Bytes field is enabled.

b. Enter the minimum session size in bytes for which a Transaction Usage RDR should be generated
for the session.

(Optional) Enable the generation of additional, interim Transaction Usage RDRs for long flows.
(Usually, a Transaction Usage RDR is generated only when a flow closes.)

a. Check the Enable Interim TUR to be generated every check box.
The Minutes field is enabled.

b. Enter the required time in minutes between each generation of a Transaction Usage RDR for each
flow.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Transaction Usage RDRs is saved.

How to Manage Log RDRs

Note

Step 1

Step 2

Log RDRs, which provide information about system events, are generated in response to specific actions
or state changes. There are two types of Log RDRs:

¢ Blocking RDRs—Generated each time a transaction is blocked
e Breach RDRs—Generated each time a bucket exceeds the global threshold

You can set the maximum number of Log RDRs generated per second. You can select the packages and
services for which Blocking RDRs are generated.

By default:
¢ Blocking RDRs are generated for all packages

e Breach RDRs are always generated

At most 20 Log RDRs are generated per second.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

e Blocking RDR
¢ Quota Breach RDR

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Log RDRs tab.

The Log RDRs tab opens.
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RDR Settings

Lisage RDRs Transaction RDRs _ Quota RDRs ) Transacti:on Usage RDRs
Real-Time Subscriber RDRs I Real-Time Signaling RCRs

Log RORs
Log ROR:s are generated in response bo specific application actions or state changes, Log RORs

include Blocking RDRs and Breach RDRs,

Limit the total rate of Log RDRs to 20 | RDRs per second

Elocking RORs

Packages and services For which Blocking RDRs should be generated:
[[J -4 selectiDeselect Al

- [#]__| Default Package

[#]__1 Unknawan Subscriber Traffic

[ oK ” Cancel ]
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To change the maximum generation rate for Log RDRs, enter the desired rate in the Limit the Total Rate
of Log RDRs field.

To enable the generation of Blocking RDRs for selected packages, check the check box next to the
package name in the package tree.

The package expands to show all component services of the package; all the services are checked.
Enable the generation of Blocking RDRs for selected services of a package.

a. Expand the node of the desired package.

b. Check the check box next to the service name of each desired service.

Click OK.

The RDR Settings dialog box closes.

The new configuration for the generation of Log RDRs is saved.

How to Manage Real-Time Subscriber Usage RDRs

Real-Time Subscriber Usage RDRs, which report subscriber usage, are generated for each individual
subscriber for each service used, at specified intervals. These RDRs permit a more granular monitoring
of selected subscribers when necessary.
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A

For more information about selecting subscribers to be monitored, see Selecting Subscribers for
Real-Time Usage Monitoring, page 13-12.

Caution

Step 1

Step 2

Generating and collecting Real-Time Subscriber Usage RDRs for many subscribers can compromise
performance. Enable Real-Time Subscriber Usage RDR generation only for subscribers that must be
monitored.

You can enable or disable the generation of Real-Time Subscriber Usage RDRs, set the generation
interval for these RDRs, and set the maximum number generated per second.

By default, Real-Time Subscriber Usage RDRs:
e Are enabled (but only for selected subscribers)
e Are generated for each subscriber once every minute
e Are limited to 100 RDRs generated per second

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the "Real-Time Subscriber Usage RDR" section in the Cisco Service Control
Application for Broadband Reference Guide.

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Real-Time Subscriber RDRs tab.

The Real-Time Subscriber RDRs tab opens.
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RDR Settings

Lsage RI&)R.S Il Transaction RORs _Cyota RDRs _ Transaction Usage le)Rls
Log RDRs Real-Time Subscriber RORs Real-Time Signaling RORs

Real-Time Subscriber Lsage RORs

Rezal-Time Subscriber Usage RDRs are generated at fixed intervals, They report the amount of
usage consumed by an individual subscriber For each service (which was actually used), ta allow
more granular monitoting of selected subscribers,

Generate Real-Time Subscriber Usage RDRs once every 1 minutes, for each service

Lirnit the tatal rate of Real-Time Subscriber Lisage RDRs to I-DD i RDRs per second

[ oK ” Cancel ]
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To enable the generation of Real-Time Subscriber Usage RDRs, check the Generate Real-Time
Subscriber Usage RDRs check box.

To change the generation interval for Real-Time Subscriber Usage RDRs, enter the desired interval in
minutes between each generation of the RDRs in the Generate Real-Time Subscriber Usage RDRs field.

To limit the generation rate of Real-Time Subscriber Usage RDRs, enter the maximum number of
Real-Time Subscriber Usage RDRs to be generated per second in the Limit the total rate of Real-Time
Subscriber Usage RDRs field.

Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Real-Time Subscriber Usage RDRs is saved.

How to Manage Real-Time Signaling RDRs

Real-Time Signaling RDRs, which are generated at the beginning and end of a flow, at specified intervals
after the beginning of the flow, and at the beginning and end of a network attack, can be used to signal
external systems concerning events detected by the SCE platform, allowing real-time actions to be taken
across the network.

There are two groups of Real-Time Signaling RDRs:

[ oL-7205-11
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Note

Step 1

Step 2

¢ Flow Signaling RDRs:
— Flow Start Signaling RDRs
- Flow Stop Signaling RDRs
— Flow Interim Signaling RDRs
e Attack Signaling RDRs:
— Attack Start Signaling RDRs
— Attack Stop Signaling RDRs

You can enable or disable the generation of Flow Signaling RDRs for selected packages, or for selected
services per package. You can set the generation interval for Flow Interim Signaling RDRs, which can
be generated only if Flow Start and Flow Stop Signaling RDRs are enabled.

You can enable or disable the generation of Attack Signaling RDRs for selected packages.

Malicious Traffic Periodic RDRs are enabled and configured in the How to Edit Advanced Service
Configuration Options, page 10-45.

For detailed information regarding the RDR purpose, default destination, content, generation logic, tag,
and fields, refer to the following sections in the Cisco Service Control Application for Broadband
Reference Guide:

¢ Flow Start RDR
¢ Flow End RDR
e Ongoing Flow RDR
e Attack Start RDR
e Attack End RDR
By default, no Real-Time Signaling RDRs are generated.

From the Classification tab in the left pane, choose Configuration > RDR Settings.
The RDR Settings dialog box appears.

Click the Real-Time Signaling RDRs tab.

The Real-Time Signaling RDRs tab opens.
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RDR Settings

LUsage RDFs Transaction RORs _ QuotaRDRs | Transaction Usage RDRs
LogRORs | Real-Time Subscriber RDRs Real-Time Signaling RDRs

Real-Time Signaling-

Rezal-Time Signaling RORs are generated at the beginning and end of a flow, at specified intervals
during the flow's life cycle, or at the beginning and end of a nebwork attack,

These RDRs signal events detected by the SCE to external systems (such as PCMM compliant
systems), to enable real-time actions across the nebwork,

Flow Signaling | attack Signaling|

[ Enable Flow Start and Flaw Stop Signaling RDR s

Packages and services For which to generate Realtime Signaling RDRs:
] Select/Deselect Al

| -] Defaul: Package

[ Unknown Subscriber Traffic

[ oK ” Cancel ]
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To enable the generation of Flow Start and Flow Stop Signaling RDRs, check the Enable Flow Start
and Flow Stop Signaling RDRs check box.

Generation of Flow Start and Flow Stop Signaling RDRs is not supported when unidirectional
classification is enabled. If you try to check the Enable Flow Start and Flow Stop Signaling RDRs check
box when unidirectional classification is enabled, an RDR Settings Error message appears.

Click OK, and continue at Step 8.

The Enable Flow Interim Signaling RDRs check box is enabled.

To enable the generation of Flow Interim Signaling RDRs, check the Enable Flow Interim Signaling
RDRs check box.

The Enable Flow Interim Signaling RDRs field is enabled.

To change the generation interval for Flow Interim Signaling RDRs, enter the interval in minutes
between each generation of the RDRs in the Enable Flow Interim Signaling RDRs field.

To enable the generation of Flow Interim Signaling RDRs for selected packages, check the check box
next to the package name in the package tree.

The package expands to show all component services of the package; all the services are checked.
To enable the generation of Flow Interim Signaling RDRs for selected services of a package:

a. Expand the node of the desired package.
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b. Check the check box next to the service name of each desired service.
Step8  To enable the generation of Attack Signaling RDRs:
a. In the body of the Real-Time Signaling RDRs tab, click the Attack Signaling tab.

Fla Sigrialing |

[]Enable Attack Start and Attack Stop Signaling RORs

Packages for which to generate attack Signaling RDRs:

1 Default Package
[] Unknown Subscriber Traffic

158933

b. Check the Enable Attack Start and Attack Stop Signaling RDRs check box.

Step9  To enable the generation of Attack Signaling RDRs for selected packages, check the check box next to
the package name in the package list.

Step10 Click OK.
The RDR Settings dialog box closes.

The new configuration for the generation of Real-Time Signaling RDRs is saved.
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Using the Service Configuration Editor: Traffic
Control

The Traffic Control capabilities of the Service Control Engine (SC platform and the Cisco Service
Control Application for Broadband (SCA BB) are used to limit and prioritize traffic flows. Control of
traffic is based on parameters such as the service of the flow, the subscriber’s package, and the
subscriber’s quota state.

e Unknown Subscriber Traffic, page 9-1
e Managing Packages, page 9-2

e Managing Rules, page 9-10

e Managing Bandwidth, page 9-29

e Managing Virtual Links, page 9-52

e Managing Quotas, page 9-57

Unknown Subscriber Traffic

Note

A traffic flow that does not match any filter rule (see Filtering the Traffic Flows, page 10-17) is
processed by the SCE platform, which tries to identify the subscriber responsible for the traffic flow. The
SCE platform checks its internal database for a subscriber identified by the IP address or VLAN tag of
the traffic flow. If no such subscriber exists, the traffic flow is mapped to the Unknown Subscriber Traffic
category.

The Unknown Subscriber Traffic category is included in the tree in the Network Traffic tab but is not
part of the package hierarchy. The Unknown Subscriber Traffic category cannot be deleted.

Traffic of one unknown subscriber cannot be distinguished from traffic of other unknown subscribers.
Therefore you cannot set either per-subscriber usage limits or subscriber-level metering with subscriber
BWCs. You can use subscriber BWCs only to link a selected service to a global controller.

The Unknown Subscriber Traffic category behaves like a package with the following parameters:
e Package Name = Unknown Subscriber Traffic
e Package Index = 4999
¢ One package usage counter:

— Counter Name = Unknown Subscriber Traffic Counter

[ oL-7205-11
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— Counter Index = 1023
You can:
e Edit the Unknown Subscriber Traffic package settings:
— Add extra BWCs (see How to Edit Package Subscriber BWCs, page 9-41)
— Select a calendar (see How to Set Advanced Package Options, page 9-7)
e Edit the default service rule for the Unknown Subscriber Traffic category:
— Change the Rule State (see How to Edit Rules, page 9-16)

— Change per-flow actions for the rule (see How to Define Per-Flow Actions for a Rule,
page 9-14)

e Add rules to the Unknown Subscriber Traffic package:

— Add rules (see How to Add Rules to a Package, page 9-12); edit (see How to Edit Rules,
page 9-16) and delete (see How to Delete Rules, page 9-18) these rules

— Add time-based rules (see How to Add Time-Based Rules to a Rule, page 9-19); edit (see How
to Edit Time-Based Rules, page 9-21) and delete (see How to Delete Time-Based Rules,
page 9-23) these rules

Managing Packages

A package is a description of subscriber policy. It is a collection of rules that defines the system’s
reaction when it encounters flows that are mapped to the service to which the rule is related. It is
recommended that you first define services (see Managing Services, page 7-2) and only then add and
define packages.

Every SCA BB service configuration contains a package, the default package, which is the root package
and cannot be deleted.

A subscriber is mapped to the default package if no other package is specifically assigned to the
subscriber, or if a nonexistent package is assigned to the subscriber.

A service configuration can contain up to 5000 packages.
e Package Parameters, page 9-2
e How to View Packages, page 9-3
e How to Add Packages, page 9-5
¢ How to Set Advanced Package Options, page 9-7
e How to Duplicate Packages, page 9-8
¢ How to Edit Packages, page 9-8
e How to Delete Packages, page 9-10

Package Parameters

A package is defined by the following parameters:
e General parameters:

— Package Name—A unique name for the package
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— Description—(Optional) A description of the package
e Quota Management parameters:

- Quota Management Mode—Specifies whether subscriber quotas are managed by an external
quota manager or replenished periodically by SCA BB.

— Aggregation Period Type—The quota aggregation period used when quotas are replenished
periodically.

— Quota Buckets—16 resource buckets used for quota management.
e Subscriber BW Controllers parameters:

— Subscriber relative priority—The relative priority given to subscribers of the package at times
of network congestion.

Separate priorities are defined for upstream and downstream flows.

— Subscriber Bandwidth Controllers—A list of BW controllers (BWCs) that are available to
services that are part of the package. Various parameters are defined for each BWC, including
a mapping to a global controller.

Separate BWCs are defined for upstream and downstream flows.
¢ Advanced parameters:

— Package Index—The unique number by which the system recognizes a packages. (Changing the
package name does not affect SCE platform activity.) A default value of the package index is
provided by the system. Do not modify this value.

— Parent Package—The package one level higher in the package hierarchy. The parent package is
important when packages share usage counters. The default package is the base of the package
hierarchy, and does not have a parent.

- Package Usage Counter—Used by the system to generate data about the total use by each
package. A package can use either an exclusive package usage counter or the package usage
counter of the parent package.

Each usage counter has:

— A name assigned by the system (based on the package name).

)

Note  An asterisk is appended to a package usage counter name whenever the counter applies to more than one
package.

— A unique counter index—A default value of the counter index is provided by the system.
Do not modify this value.

— Calendar—The calendar used as the basis for the time-based rules of the package.
— VAS Traffic Forwarding Table—The forwarding table used by the package.

These parameters are defined when you add a new package (see How to Add Packages, page 9-5). You
can modify them at any time (see How to Edit Packages, page 9-8).

How to View Packages

You can view a hierarchy tree of all existing packages, and you can see a list of services for which
specific rules are defined for any selected package.
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Step 1

Note

Step 2

In the current service configuration, click the Policies tab.

s |g Service Configuration Editor |

Q *<new service configurations 3

Paolicies : Subscriber Policies : Default Package

L Policies | |51 Classification

s g4 3 . Configuration -

Defaulk Package : Default Service

2 g B XN

o T Filkered Traffic
e Eﬂ Service Security
5 Global Palicy

[
(=L & Subscriber Palic

Unknown Subscriber Package

Rule Action

E console E_\ Problems
0 errors, O warnings, 0 infos
Description

Report Only

A list of all packages is displayed in the package tree.

274097

To view more information about a package, open the Package Settings dialog box (see How to Edit

Packages, page 9-8).

Click a package in the hierarchy to display the rules of the package.

A list of all rules of this package is displayed in the right (Rule) pane.

[l Cisco Service Control Application for Broadband User Guide
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ﬁ |Q Service Configuration Editor |

Q *<new service configurations &3

Paolicies : Subscriber Policies : Unknown Subscriber Package

L& Policies | B Classification g+ B X N

%} 9= 3 . Configuration - Unknown Subscriber Package : Yonage : Peak

Rule Action

- * Filkered Traffic

Eﬂ Service Security

5 clabal Palicy
Subscriber Policies
Default Package

controlled ; unlimited quata

disabled; rule of parent service applies
controlled ; unlimited quata
controlled ; unlimited quata
controlled ; unlimited quata
icontrolled ; unlimited quata
controlled ; unlimited quota

E console [& Problems
0 errors, O warnings, 0 infos
Descripkion

274096

Report Only

How to Add Packages

A default package is predefined in the Console installation. You can add additional packages to a service
configuration, subject to the limit of 5000 packages per service configuration.

After you have added a new package, you can define rules for the package (see How to Add Rules to a
Package, page 9-12).

Step 1 In the Policies tab, select a package from the package tree. This package will be the parent of the package
you are adding.

Step2 In the Policies tab, click ':::' (Add Package).
The Package Settings dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Step 3
Step 4
Step 5
Step 6

Package Settings for ""

General i-dL'lota.iVlanagemel-ﬂt || Subscriber BW Controllers | .a-:.Ivanced:

Package name:

| Packagel

Description:

[ QK ][ Cancel ]

158394

In the Package name field, enter a unique and relevant name for the package.

(Optional) In the Description field, enter a meaningful and useful description of the package.

To configure parameters in the Advanced tab, continue with the instructions in the following section.
Click OK.

The Package Settings dialog box closes.

The new package is added as a child to the package selected in the package tree and becomes the selected
package. The default service rule is displayed in the right (Rule) pane.

To edit the default service rule, and to add new rules to the package, see Managing Rules, page 9-10.

What to Do Next

To configure parameters in the Quota Management tab see How to Edit Quota Management Settings for
Packages, page 9-58.

To configure parameters in the Subscriber BW Controllers tab, see How to Edit Package Subscriber
BWCs, page 9-41.
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How to Set Advanced Package Options

Step 1

Step 2

Note

Step 3

Step 4

You can change the index for the package, specify an exclusive usage counter, or select a calendar for
the package in the Advanced tab.

In the Package Settings dialog box, click the Advanced tab.
The Advanced tab opens.

£ Package Settings for “Default Package” §|

General | Quota Management | Subscriber Bw Controllers | Adwanced

Package Index

Set the Index for this Package:

Parent Package

Select Parent Package (for sharing usage counters):

Package Usage Counters

& package can either be mapped to exclusive package usage counters, or share usage counters with its
ancestor package,

Package usage counter name For this package:| Default Package Counter

Counter Index:

Calendar

Select Calendar For this Package: | Default Calendar

@ [ oK, H Cancel ] g

To change the package index for this package, from the Set the Index for this Package drop-down list,
select a package index.

A default value of the index is provided by the system. Do not modify this value unless a specific index
value must be assigned to the package.

To set a different parent package for this package, select the desired parent from the Select Parent
Package drop-down list.

By default, a new package uses an exclusive usage counter. To share the parent package usage counter,
uncheck the Map this Service to exclusive package usage counters check box.

The name in the read-only Package usage counter name for this package field changes to reflect your
choice.

The Counter Index drop-down list is dimmed.

[ oL-7205-11
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Step 5

Note

Step 6

Step 7

Note

Step 8

To change the counter index (if you are using an exclusive package usage counter), select a value for the
index from the Counter Index drop-down list.

A default value of the index is provided by the system. Do not modify this value.

To set a calendar for this package (to use its time frames for time-based rules), select the desired calendar
from the Select Calendar for this Package drop-down list.

To set a VAS traffic-forwarding table for this package, select the desired traffic-forwarding table from
the Select Traffic Forwarding Table for this Package drop-down list.

If VAS traffic forwarding is disabled (the default), the drop-down list is dimmed. To enable VAS traffic
forwarding, see How to Enable VAS Traffic Forwarding, page 10-48.

Click OK.
The Package Settings dialog box closes.

The new package is added as a child to the selected parent package and becomes the selected package.
The default service rule is displayed in the right (Rule) pane.

To edit the default service rule, and to add new rules to the package, see Managing Rules, page 9-10.

How to Duplicate Packages

Step 1
Step 2

Step 3

Duplicating an existing package is a useful way to create a new package similar to an existing package.
It is faster to duplicate a package and then make changes than to define the package from scratch.

A duplicated package is added at the same level in the package tree as the original package.

In the Policies tab, select a package from the package tree.
In the Policies tab, click g (Duplicate Package).

A duplicate package is created with all the same attributes as the original package. The name of the new
package is the name of the selected package followed by “(1)” (or “(2)”, and so on if a package is
duplicated many times).

Modify the package parameters (see How to Edit Packages, page 9-8).

How to Edit Packages

Step 1
Step 2

You can modify the parameters of a package (including the default package) at any time.

In the Policies tab, select a package from the package tree.

In the Policies tab, click __ (Edit Package).

The Package Settings dialog box appears.
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Step 5

Step 6
Step 7

Note

Note

Note

Step 8

Managing Packages W

In the Package name field, enter a new name for the package.
In the Description field, enter a new description of the package.

(Optional) Change quota management settings, see Editing Package Quota Management Settings (Using
the Quota Management Tab (Packages) How to Edit Quota Management Settings for Packages,
page 9-58.

(Optional) Change bandwidth control settings, see How to Edit Package Subscriber BWCs, page 9-41.
To change advanced settings, click the Advanced tab.
The Advanced tab opens.

a. To change the package index for this package, from the Set the Index for this Package drop-down
list, select a Package Index.

A default value of the counter index is provided by the system. Do not modify this value unless a specific
index value must be assigned to the package.

b. To change the parent package of this package, select the desired parent from the Select Parent
Package drop-down list.

c. To share the parent package usage counter, uncheck the Map this Service to exclusive package
usage counters check box.

The name in the read-only Package usage counter name for this package field changes to reflect your
choice.

The Counter Index drop-down list is dimmed.

d. To use an exclusive package usage counter, check the Map this Service to exclusive package usage
counters check box.

The name in the read-only Package usage counter name for this package field changes to reflect your
choice.

The Counter Index drop-down list is dimmed.

e. To change the counter index if you are using the exclusive package usage counter, select a value for
the index from the Counter Index drop-down list.

A default value of the counter index is provided by the system. Do not modify this value.

f. To change the calendar used by this package, select the desired calendar from the Select Calendar
for this Package drop-down list.

g. To change the VAS traffic-forwarding table for this package, select the desired traffic-forwarding
table from the Select Traffic Forwarding Table for this Package drop-down list.

If VAS traffic forwarding is disabled (the default), the drop-down list is dimmed. To enable VAS traffic
forwarding, see How to Enable VAS Traffic Forwarding, page 10-48.

Click OK.
The Package Settings dialog box closes.

[ oL-7205-11
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All changes to the package parameters are saved.

How to Delete Packages

You can delete user-defined packages. The default package cannot be deleted.

Step 1 In the Policies tab, select a package from the package tree.
Step2 In the Policies tab, click ﬁ (Delete Package).

A Package Warning message appears.

3£ Package Warning

This Package might be mapped to a Subscriber.
. Are you sure you want to remove Package "Basic Package™

—l

158897

Step3  Click Yes.
The package is deleted and is no longer displayed in the package tree.

Managing Rules

After you have defined services and basic packages, you can define rules for the package.
You can configure rules to do some or all of the following:

e Block the service

¢ Define maximum bandwidth for the service

¢ Change the DSCP ToS value of a flow's packets

e Set a quota for the service

e Define behavior when the quota for this service is breached

A rule usually applies at all times. To allow additional flexibility, you can divide the week into four
separate time frames. You can define subrules—time-based rules—for each time frame.

e The Default Service Rule, page 9-11

¢ Rule Hierarchy, page 9-11

¢ How to View the Rules of a Package, page 9-11

e How to Add Rules to a Package, page 9-12

e How to Define Per-Flow Actions for a Rule, page 9-14
e How to Edit Rules, page 9-16

¢ How to Delete Rules, page 9-18
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e How to Display the Services Affected by a Rule, page 9-18
e Managing Time-Based Rules, page 9-19
¢ How to Manage DSCP ToS Marker Values, page 9-28

The Default Service Rule

A default service rule is assigned to every package. It cannot be deleted or disabled.
The default values of this rule are:

e Admit (do not block) traffic.

e Map traffic to the default BWCs.

¢ Do not limit quotas for either upstream or downstream traffic.

Rule Hierarchy

The SCE platform will apply the most specific rule to any flow.

For example, if you define rules for E-Mail and POP3, any flow mapped to the POP3 service will be
handled according to the POP3 rule—any flow mapped to the SMTP or IMAP service will be handled
according to the E-Mail rule. This means, for example, that POP3 can have its own usage limits, whereas
SMTP and IMAP must share usage limits.

Note  If you add a rule for a child service, the settings for the parent rule are not copied to the new rule. All
new rules start with default values.

Any rule that also applies to child services is indicated by &

services are shown by

. Rules that do not apply to any child

Time-based rules are shown as child;g of t}‘,§=t:elevant rule. The icon for a time-based rule also shows
if the rule applies to child services (‘1= or H&l=).

See also How to Display the Services Affected by a Rule, page 9-18.

How to View the Rules of a Package

You can view a list of the rules of a package.

The listing for each rule includes an icon, the name of the service or group of services to which the rule
applies, whether the rule is enabled or disabled, and a brief description of the rule.

Step1  In the Policies tab, select a package from the package tree.

A list of all rules defined for this package is displayed in the right (Rule) pane.
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I oL-7205-11 .m



Chapter 9 Using the Service Configuration Editor: Traffic Control |

M Managing Rules

ﬁ |Q Service Configuration Editor |

Q *<new service configuration= 2 =0

Paolicies : Subscriber Policies : Unknown Subscriber Package

L& Policies | B Classification B o B RO\
%} 9= 3 . Configuration - Unknown Subscriber Package : Yonage : Peak

Rule Action

controlled ; unlimited quata

disabled; rule of parent service applies
controlled ; unlimited quata
controlled ; unlimited quata
controlled ; unlimited quata
icontrolled ; unlimited quata
controlled ; unlimited quota

Service Security
Global Policy
Subscriber Policies
Default Package

Unknown Subscribe

E console E_\ Problems
0 errors, O warnings, 0 infos
Descripkion

Report Only

274096

What to Do Next

To see more information about a rule, open the Edit Rule for Service dialog box (see How to Edit Rules,
page 9-16).

To see more information about a time-based rule, open the Edit Time-Based Rule for Service dialog box
(see How to Edit Time-Based Rules, page 9-21).

How to Add Rules to a Package

A default service rule is assigned to every package. You can add additional rules to a package.

Adding time-based rules is described in the section How to Add Time-Based Rules to a Rule, page 9-19.

Step 1 In the Policies tab, select a package from the package tree.
Step 2 In the right (Rule) pane, click ':::' (Add Rule).
The Add New Rule to Package dialog box appears.
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Step 3

Step 4

Step 5

Step 6
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Add New Rule to Package "Default Package™

General | Cantral | Usage Limits || Breach Handling|

Service
Select the Service to which the Rule will relate:

| Generic |

Rule State
Define the state of this Rule:

() Enable reparting and active actions

(") Disable reporting and active actions

[ O ” Cancel ]

158747

In the Service area of the Add New Rule to Package dialog box, select a service from the Select the
Service to Which the Rule will Relate drop-down list.

S

Note  Services for which a rule is already defined for this package are dimmed.

In the Rule State area, select one of the Define the State of this Rule radio buttons.
¢ Enable reporting and active actions
¢ Disable reporting and active actions

~

Note  You can enable or disable a rule at any time (see How to Edit Rules, page 9-16).

(Optional) Set behavior per traffic flow for this rule, continue with the instructions in the section How
to Define Per-Flow Actions for a Rule, page 9-14.

Click OK.
The Add New Rule to Package dialog box closes.
The new rule is added to the list of rules displayed in the right (Rule) pane.

What to Do Next

Usage limits and breach handling are part of quota management (see Managing Quotas, page 9-57):

[ oL-7205-11
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e To configure parameters in the Usage Limits tab see How to Select Quota Buckets for Rules,
page 9-60.

e To configure parameters in the Breach Handling tab, see How to Edit Breach-Handling Parameters
for a Rule, page 9-61.

How to Define Per-Flow Actions for a Rule

The Control tab of the Add New Rule to Package dialog box allows you to set behavior per traffic flow
for sessions that are mapped to the current service.

Step1  In the Add New Rule to Package dialog box, click the Control tab.
The Control tab opens.

2 Add New Rule to Package "Default Package” E|

General | Contral | Usage Limits | Breach Handling

Define the per-flow action to be performed by this Rule:

() Block the Flow

() Control the flow's characteristics:
Select an upstream Bandwidth Controller | Default Upstream Bbw'C A
Select a downstream Bandwidth Contraller | Default Downstream BwC R
[ Limit the Flow's upstream bandwidth ko
[ Limit the flow's downstream bandwidth to
[] 5et the flow's upstream packets ToS (DSCP) to
[] 5et the Flaw's downstream packets TaS (DSCP) ta
[ Limit camcurrent Flows of this Service to

Set CoS for Flows of this Service to |BE %

[] Redirect profile For this service:

[ Mirrar Eraffic to server group:

@ I oK H Cancel ]

274148

To control flows that are mapped to the service of this rule, continue at Step 3.

Step2  To block flows that are mapped to the service of this rule, select the Block the flow radio button and and
continue at Step 12.

Step3  Select the Control the flow’s characteristics radio button.
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Step 4

Note

Step 5
Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Managing Rules

The options in the Flow Characteristic area are enabled.

From the upstream Bandwidth Controller drop-down list, select an upstream BWC. This sets up
bandwidth metering of all concurrent flows mapped to this rule, based on the characteristics of the
selected BWC.

The BWCs in this drop-down list are defined when creating or editing the package.

Important Note for time-based rules: If you need different global controller settings for different time
frames, define maximum bandwidths per time frame for one global controller. Do not create a separate
global controller for each time frame.

When the mouse is placed over the drop-down list, a tooltip appears containing the properties of the
selected BWC (Peak Information Rate (PIR), Committed Information Rate (CIR), Global Controller, and
Assurance Level).

Select an upstream Bandwidth Controller | Default Upstream EwhC L

Select a downstream Bandwidth ControllenDefault Upstream BWC:

PIR = Unlimited

IR = 0 Kbps

1slobal Contraller = Default Global Controller
fssurance Level = 1

[ Limit the Flow's downstream bandwidth ta

[ Limit the Flow's upstream bandwidth b

158746

From the downstream Bandwidth Controller drop-down list, choose a downstream BWC.

(Optional) To set a per-flow upstream bandwidth limit, check the Limit the flow’s upstream bandwidth
check box and enter a value in the Kbps field.

~

Note  Per-flow bandwidth has a granularity of 1 Kbps up to 57 Mbps.

(Optional) To set a per-flow downstream bandwidth limit, check the Limit the flow’s downstream
bandwidth check box and enter a value in the Kbps field.

(Optional) To change the DSCP ToS marker of all packets in upstream flows, check the Set the flow's
upstream packets ToS (DSCP) to check box and select a value from the drop-down list.

Set the flow's upstream packets ToS (DSCP) bo | =SS (| v
[] et the fow's downstream packets Tas (DSCR) HTaS 2 [0]
Tos 3 [0]
‘g : : ; Tos 4 [0]
[ Limit concurrent: Flaws of this Service to Tos 5 [0]
. : Tos 6 [0] I
Sek CoS For Flows of this Service to |[BE % Tos 7 [0] =~
k : ™

(Optional) To change the DSCP ToS marker of all packets in downstream flows, check the Set the flow's
downstream packets ToS (DSCP) to check box and select a value from the drop-down list.

(Optional) To set the maximum number of concurrent flows (mapped to this rule) permitted to a
subscriber, check the Limit concurrent flows of this Service check box and enter a value in the
associated field.

From the Set CoS for flows of this Service drop-down list, select a class-of-service.

[ oL-7205-11
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Step 12

Step 13

Step 14

(Optional) To enable subscriber redirection, check the Redirect profile for this service check box and
choose a redirect profile from the drop-down list.

(Optional) To enable traffic mirroring, check the Mirror traffic to server group check box and choose
a server group from the drop-down list.

A

Note  The Mirror traffic to server group check box is only enabled when Traffic Mirroring is enabled
in the VAS Settings dialog box.

Click OK.
The Add New Rule to Package dialog box closes.
The new rule is added to the list of rules displayed in the right (Rule) pane.

How to Edit Rules

Step 1
Step 2
Step 3

You can edit any rule, including the default service rule.

You cannot disable the default service rule.

The tabs of the Edit Rule for Service dialog box are the same as the tabs of the Add New Rule to Package
dialog box, except for the General tab—you cannot change the service to which the rule applies.

In the Policies tab, select a package from the package tree.
In the right (Rule) pane, select a rule.

Click _ " (Edit Rule).

The Edit Rule for Service dialog box appears.
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Edit Rule for Service "PZ2P"

General | Cantral | Usage Limits || Breach Handling|

-Rule State
Define the state of this Rule:

(%) Enable reparting and active actions

() Disable reporting and active actions

[ O ” Cancel ]

158503

Step 4 In the Rule State area, select one of the Define the State of this Rule radio buttons.
e Enable reporting and active actions
¢ Disable reporting and active actions
Step5 Change behavior per traffic flow.
a. Click the Control tab.
The Control tab opens.
b. Follow the instructions in How to Define Per-Flow Actions for a Rule, page 9-14.
Step6  Change usage limits.
a. Click the Usage Limits tab.
The Usage Limits tab opens.
b. Follow the instructions in How to Select Quota Buckets for Rules, page 9-60.
Step7  Define behavior when a quota is breached.
a. Click the Breach Handling tab.
The Breach Handling tab opens.
b. Follow the instructions in How to Edit Breach-Handling Parameters for a Rule, page 9-61.
Step8  Click OK.
The Edit Rule for Service dialog box closes.

All changes to the rule are saved.
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How to Delete Rules

You can delete any user-defined rule. The default service rule cannot be deleted.

N

Note  Youcan disable a rule without losing its profile (see Step 4 of How to Edit Rules, page 9-16). This allows
you to enable the rule again later, without having to reset all its parameters. You cannot disable the
default service rule.

Step 1 In the Policies tab, select a package from the package tree.
Step2  In the right (Rule) pane, select a rule.
Step3  In the Rule pane, click * (Delete Rule).

A Rule Warning message appears.

3 Rule Warning

9P Are you sure you want to remove Rule "SMTP*™?
-

1559458

Stepd  Click Yes.

The selected rule is deleted.

How to Display the Services Affected by a Rule

You can define a service as the child of another service (the parent service is a service group). Until you
define a separate rule for a child service, the child service is governed by the rule of the parent service.
A rule that affects any of a service’s children is indicated in the rules list by a different icon, as illustrated
for the default service rule and the P2P rule in the following figure.

Rule _ Action
Kﬁ Default Rule controlled [Default Upstream B'WC; Default Downstream BWC]; unlimited quota
= controlled ; quota replenished ...
----- $=*' ‘fahoo Messenger YolP controlled [Default Upstream BWC; Default Downstream EWiC]; unlimited quota -
----- $=*' Minkendo Wi controlled [Default Upstream BWC; Default Downstream EWiC]; unlimited quota E
----- L MiECP controlled [Default Upstreamn BWiC; Default Downstraam BwiC]; unlimited quota 5

You can display all (child) services that are affected by a rule.

Note  The default service rule applies to all services for which a specific rule is not defined.

Step 1 In the right (Rule) pane of the Policies tab, select a rule and click ?—E (Show All Services Affected By
This Rule).

The Services Affected dialog box appears.
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Step 2

Managing Rules

3£ Services Affected by 'P2P’ Rule

Pzp
L eDonkey/ emule

L Kazaa

L) Bittorrent
- Commercial File Shating

L winny
I Grutella
o R T
c
b
B
Click OK.

The Services Affected dialog box closes.

Managing Time-Based Rules

The Console allows you to divide the week into four time frames (see Managing Calendars, page 9-23).
A time-based rule is a rule that applies to one time frame.

You can add time-based rules to any rule. If a time-based rule is not defined for a time frame, the parent
rule is enforced.

Often, you will want the rules for the different time frames to be similar. When you add a time-based
rule, the settings of the parent rule are copied to the new time-based rule; you can make any needed
changes. Subsequent changes to the parent rule do not affect the time-based rule.

You must define the calendar before defining the related time-based rules.

How to Add Time-Based Rules to a Rule

Adding a time-based rule to a rule allows you to specify alternate rule parameters applicable only for a
specific time frame. If a time-based rule is not defined for a time frame, the parent rule is enforced.

e When you add a time-based rule, all parameters are initially set to the values defined for the parent
rule. Subsequent changes to the parent rule do not change the time-base rule.

¢ The tabs of the Add New Time-Based Rule dialog box are the same as the tabs of the Add New Rule
to Package dialog box, except for the General tab. In the Add New Rule to Package dialog box, you
select a service; in the Add New Time-Based Rule dialog box, you select a time frame.

A service whose time-based rule affects any of its child services is indicated in the rules list by a
modified icon, as illustrated for the Weekend time-based rule of the P2P rule in the following screen
capture.

[ oL-7205-11
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Rule Action
controlled 5 unlimited quata
=455 P2P controlled [Default Upstream BWC; Defaulk Downstream BWC]; quoka replenished ..
‘:;__." Weekend controlled [Default Upstream BWC; Defaulk Downstreann BWC]; quata replenished ..
----- % vahoo Messenger YoIP controlled [Default Upstrean BWC; Defaulk Downstreann BWC]; unlimited quaota
=55 Mintendo Wi controlled [Defaulk Upstream BWC; Defaulk Downstream BWC]; unlimited quota -
: ;“ weekend controlled [Cefault Upstream BwC; Defaulk Downstream BwC]; unlimited quota g
ST MECP controlled [Default Upstream BWC; Defaulk Downstream W]y unlimited quota 5

Step 1 In the Policies tab, select a package from the package tree.
Step2  In the right (Rule) pane, select a rule.
Step3  Click r.'-'f'f} (Add Time-Based Rule).

The Add New Time-Based Rule dialog box appears.

Add New Time-Based Rule to Package "Default Package”

General i Cantrol | Usage Limits | Breach Handling|

~Time Frame

Select the Time Frame For this Rile:

Peak. |

rRule State—
Define the state of this Rule:

() Enable reporting and active actions

() Disable reporting and active actions

[ QF ” Cancel ]

158748

Step 4 In the Time Frame area, from the Select the Time Frame for this Rule drop-down list, select one of the

four time frames.
Step 5 In the Rule State area, select one of the Define the State of this Rule radio buttons.
¢ Enable reporting and active actions
¢ Disable reporting and active actions
Step6  Define behavior per traffic flow.
a. Click the Control tab.
The Control tab opens.

b. Follow the instructions in How to Define Per-Flow Actions for a Rule, page 9-14.

[l Cisco Service Control Application for Broadband User Guide
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Step 7

Step 8

Step 9

Managing Rules

Change usage limits.
a. Click the Usage Limits tab.
The Usage Limits tab opens.
b. Follow the instructions in How to Select Quota Buckets for Rules, page 9-60.
Define behavior when a quota is breached.
a. Click the Breach Handling tab.
The Breach Handling tab opens.
b. Follow the instructions in How to Edit Breach-Handling Parameters for a Rule, page 9-61.
Click OK.
The Add New Time-Based Rule dialog box closes.

The new time-based rule is displayed as a child of the rule in the Rule pane.

How to Edit Time-Based Rules

A

Note

Step 1
Step 2
Step 3

You can edit time-based rules.

The tabs of the Edit Time-Based Rule for Service dialog box are the same as the tabs of the Add New
Time-Based Rule dialog box, except for the General tab. You cannot change the time frame to which the
rule applies.

In the Policies tab, select a package from the package tree.
In the right (Rule) pane, select a time-based rule.

Click _ " (Edit Rule).

The Edit Time-Based Rule for Service dialog box appears.

[ oL-7205-11
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Edit Time-Based Rule for Service "PZ2P" at Weekend

General | Cantral | Usage Limits || Breach Handling|

-Rule State
Define the state of this Rule:

(%) Enable reparting and active actions

() Disable reporting and active actions

[ O ” Cancel ]

158514

Step 4 In the Rule State area, select one of the Define the State of this Rule radio buttons.
¢ Enable reporting and active actions
¢ Disable reporting and active actions
Step5  Define behavior per traffic flow.
a. Click the Control tab.
The Control tab opens.
b. Follow the instructions in How to Define Per-Flow Actions for a Rule, page 9-14.
Step6  Change usage limits.
a. Click the Usage Limits tab.
The Usage Limits tab opens.
b. Follow the instructions in How to Select Quota Buckets for Rules, page 9-60.
Step7  Define behavior when a quota is breached.
a. Click the Breach Handling tab.
The Breach Handling tab opens.
b. Follow the instructions in How to Edit Breach-Handling Parameters for a Rule, page 9-61.
Step8  Click OK.
The Edit Time-Based Rule for Service dialog box closes.

All changes to the time-based rule are saved.
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How to Delete Time-Based Rules

S

Note

Step 1
Step 2
Step 3

Step 4

You can delete any time-based rule.

Managing Rules

You can disable a rule without losing its profile (see How to Edit Time-Based Rules, page 9-21). This

allows you to enable the rule again later, without having to reset all its parameters.

In the Policies tab, select a package from the package tree.
In the right (Rule) pane, select a time-based rule.
In the Rule pane, click ﬁ (Delete Rule).

A Rule Warning message appears.

3£ Rule Warning

P Are you sure you want to remove Rule P2P 1 Weekend™

158949

Click Yes.

The selected rule is deleted.

Managing Calendars

Step 1

Calendars are used to divide the hours of the week into four time frames .

After you have configured a calendar, you can add time-based rules to a package that uses the calendar.
A time-based rule is a rule that applies to only one time frame. Time-based rules allow you to set rule
parameters that will apply only at specific times. You might, for example, want to define different rules

for peak, off-peak, nighttime, and weekend usage.

Each service configuration includes one default calendar. You can add nine more calendars, each with a
different time-frame configuration. You can use different calendars for different packages. You can also
use different calendars where a service provider has customers in more than one time zone by

configuring calendars with a one-hour offset from each other.
e How to View Calendars, page 9-23
e How to Add Calendars, page 9-24
¢ How to Rename the Time Frames, page 9-25
¢ How to Delete Calendars, page 9-26
e How to Configure the Time Frames, page 9-26

How to View Calendars

You can view a list of existing calendars and their time frames.

From the Policies tab of the left pane, choose Configuration > Weekly Calendars.

[ oL-7205-11
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The Calendar Settings dialog box appears.

Calendar Settings

Calendars Calendar Parameters |

Calerdar Mame: | D

BB Default Calendar

Define Time Frames for this Calendar:

7 6 9 1011 12 13 14 15 16 17 18 19 20 21 22 23 24

) @ | @) r2 | (] 7 | @]+ |

Close

158765

The Calendars tab displays a list of existing calendars. Click a calendar in the list to display its
time-frame settings.

The time frames for the selected calendar are displayed and configured in the Calendar Parameters tab.
Step2  Click Close.
The Calendar Settings dialog box closes.

How to Add Calendars
Each service configuration includes one default calendar. You can add up to nine more calendars.

Step1  rom the Policies tab of the left pane, choose Configuration > Weekly Calendars.
The Calendar Settings dialog box appears.

Step 2 In the Calendar tab, click "8 (Add).
A new calendar is added with the name Calendar (1).

Step3  In the Calendar Parameters tab, click in the Calendar Name field and enter the name for this calendar.
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Calendars Calendar Parameters |

Managing Rules

&+ K

Calendar Marie: | Basic Package Calendar|

| Default Calendar

Define Time Frames for this Calendar:

o
Tue)
fired

6 7 & 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

() | @ 2 | ]

| [ T+

Close

Step4  Click Close.

The Calendar Settings dialog box closes, and the new calendar name is saved.

158766

How to Rename the Time Frames

By default, the time frames are named T1, T2, T3, and T4. You can change these names at any time; for

example, you may want to name the time frames Peak, Off Peak, Night, and Weekend.

Note  Although you can configure the time frames differently in each calendar, the names of the time frames
are the same in all of the calendars. If you change the name when configuring one calendar, the names

are also changed for all other calendars.

Step1  From the Policies tab of the left pane, choose Configuration > Weekly Calendars.

The Calendar Settings dialog box appears.

In the Calendar Parameters tab, below the grid, each of the four time frames is listed in a field next to a

colored square.

Step2  Click in a Time Frame Name field, and enter a new name for the time frame.

Calendar Parameters |

Calendar Mame; | Basic Package Calendar

Define Time Frames For this Calendar:

6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

(W] Peak | [ off Pesk | ] | | [F] 74

Step3  Repeat Step 2 for the other three time frames.

158767
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Stepd  Click Close.

The Calendar Settings dialog box closes, and the changes to the names of the time frames are saved.

How to Delete Calendars

You can delete any user-added calendar. The default calendar cannot be deleted.

Note A calendar used by a package cannot be deleted. (When you select the calendar, the Delete icon is
dimmed.) To delete the calendar, you must first select a different calendar for each package using the
calendar that will be deleted.

See How to Set Advanced Package Options, page 9-7 for information about changing the calendar
associated with a package.

Step1  From the Policies tab of the left pane, choose Configuration > Weekly Calendars.
The Calendar Settings dialog box appears.
Step2 In the Calendar tab, select a calendar and click ﬁ (Delete).

A Calendar Removal Confirmation message appears.

3£ Calendar Removal Confirmation

9 Are you sure you want to delete this calendar?

158764

Step3  Click Yes.
The calendar is deleted.
Stepd  Click Close.
The Calendar Settings dialog box closes.

How to Configure the Time Frames

By default, all the hours of the week belong to one time frame. The Console allows you to assign each
of the 168 (24x7) hours of the week to one of four separate time frames. These time frames allow you
to supply time-dependent differentiated services and to impose constraints on any service.

You might want, for example, to divide the week as follows:

e Peak

e Off Peak
e Night

e Weekend

You can define different time frames for each calendar.

Step1  From the Policies tab of the left pane, choose Configuration > Weekly Calendars.
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The Calendar Settings dialog box appears.
Step2  In the Calendars tab, select a calendar to configure.

In the Calendar Parameters tab, the selected calendar’s Define Time Frames for this Calendar grid is

displayed. The grid, representing one week, is laid out in a format of 24 hours x 7 days. Each cell
represents one hour.

Below the grid, the name of each time frame appears next to a colored button.
Step3  Click one of the colored buttons.
Step4  Select all the cells in the grid that represent hours that will be part of the selected time frame.

You can select a group of cells by holding down the mouse button and dragging across the cells.

Calendar Parameters |

Calendar Mame: | [

Defing Time Frames for this Calandar:

7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

@| Peak | | CIFf Peak. | | Might | | Weekend |

210037

The changes are written to the service configuration as you make them.
Step5  Repeat Steps 3 and 4 for the other time frames until you have mapped the entire grid.

You have now mapped the week into four different time frames. The following figure illustrates a
possible time partition plan:

Calendar Parameters |

Calendar Mame: | Dief,

Define Time Frames for this Calendar:

78 9 10 11 12 13 14 15 16 17 158 19 20 21 22 23 24

1 2 3 4 5 &
[ o o o o

W rek [ orerea W | [ wedkene |

210035

Step6  Click Close.

The Calendar Settings dialog box closes.

Cisco Service Control Application for Broadband User Guide
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How to Manage DSCP ToS Marker Values

SCA BB can change the value of the DSCP ToS marker of packets of flows that match a filter rule (see
Step 11 of How to Add Filter Rules, page 10-21) or a service rule (see Steps 10 and 11 of How to Define
Per-Flow Actions for a Rule, page 9-14 and Step 9 of How to Edit Breach-Handling Parameters for a
Rule, page 9-61).

SCA BB supports seven ToS Marker Classes. You assign each class a specific value to apply to a flow's
packets.

Note If you have used DSCP marking on a SCA BB release prior to 3.1.5 and you are converting your old
service configurations, you must reconfigure the service configurations to obtain the same network
behavior as in the former release.

DSCP ToS Marking

DSCP ToS marking is used in IP networks as a means to signal the type and priority of a flow between
network elements.

The default marking option is not to mark the packet. Since classification may take a few packets to
finalize, it is important to note that if ToS marking is enabled, the first few packets may still be processed
under the default option and therefore may not be marked.

A

Caution  In an MPLS environment, the SCE platform does not map the DSCP bits to the EXP bits of the MPLS
header.

Step 1 From the Policies tab of the left pane, choose Configuration > ToS Marking Settings.
The ToS Marking Settings dialog box appears.

ToS Marking Settings

To35 Matking allows setting the DSCP TaS value of the Flow,
To3 Marking are enabled per direction,

[ Enable Upstream TS Marking

[ Enable Downstream Tos Marking

To3 Marking allows sekting seven DSCP To3 values as an action of the Package rules or for Flow Filter rules,
The values allowed are between 0 and 63 and are given as an integer,

Tos Markers

ToS Marker Class DSCP Yalue
ToS 1
ToS 2
ToS 3
ToS 4
TasS S
ToS &
ToS 7

=] R=1 N=1 =1 =1 K=1K=]

’ Qk, H Cancel ]

274150

Step2  (Optional) To enable DSCP ToS marking on upstream flows, check the Enable Upstream ToS Marking
check box.
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Step 4

Note

Step 5

Note

Step 6

Managing Bandwidth W

If Upstream ToS Marking is disabled, it overrides filter rule and service rule settings.

(Optional) To enable DSCP ToS marking on downstream flows, check the Enable Downstream ToS
Marking check box.

If Downstream ToS Marking is disabled, it overrides filter rule and service rule settings.

Give unique names to the ToS Marker Classes.

You can use the default names for the ToS Marker Classes, but it is recommended that you provide
meaningful names.

Assign values to the ToS Marker Classes.

Values must be in the range from 0 to 63.

When defining filter rules and service rules, the names and values of ToS Marker Classes are displayed
in drop-down lists in the format "name [value]". For example, "ToS 1 [23]" or "My P2P ToS [1]"

Click OK.
Your changes are saved.

The ToS Marking Settings dialog box closes.

Managing Bandwidth

A

The upstream and downstream interfaces are each assigned one default global controller. You can add
additional global controllers.

A service configuration can contain up to 1024 upstream global controllers and 1024 downstream global
controllers (including the default global controllers).

After you have defined global controllers, you can add subscriber BW controllers (BWCs) to packages,
and map these subscriber BWCs to different global controllers.

Caution  If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration. A subscriber BWC that pointed to a user-defined global controller now points to
the default global controller. (Other parameters of these subscriber BWCs remain unchanged.)

e Managing Global Bandwidth, page 9-30
e How to View Global Controller Settings, page 9-30
e How to Edit the Total Link Limits, page 9-32
e How to Add Global Controllers, page 9-34
¢ How to Set the Maximum Bandwidth of Global Controllers, page 9-35
e How to Delete Global Controllers, page 9-37
e Defining Global Controllers in a Dual-Link System, page 9-38
e Managing Subscriber Bandwidth, page 9-40
Cisco Service Control Application for Broadband User Guide
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e Managing Bandwidth: a Practical Example, page 9-43
e How to Set BW Management Prioritization Mode, page 9-51

Managing Global Bandwidth

The upstream and downstream interfaces are each assigned one default global controller that, by default,
controls 100 percent of the link traffic. You can add up to 1023 more global controllers for each interface,
and assign a maximum percentage of the total link limit to each global controller separately.

You can also define the bandwidth total link limit to be less than the physical capacity of the SCE
platform for each interface separately. When another device that has limited BW capacity is next to the
SCE platform on the IP stream, you can have this limitation enforced in a policy-aware manner by the
SCE platform, instead of having it enforced arbitrarily by the other device.

How to View Global Controller Settings

A

Note

Step 1

Global controller bandwidth is based on Layer 1 volume.
(Accounting, reporting, and subscriber bandwidth control in SCA BB is based on Layer 3 volume.)

In the Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.

& <new servics configuration 53 =8
Folicies : Global Policy
L& policies | |8 Classification Global Upstream Palicy
* + X Configuration = Tkl Lk Limit: Link 1 Uniimited | Edit Rate L., = X N B E
S Fileered Traffic Upstream Policy Description

ity =)@ Default Global Controller aggregated Bandwidth Limit: Unlimited; Link Bandwidth Limit: Unlimited
= =+ Default Upstres WC Low Priority
Default Service Rule under Default Package controlled ; unimited quots

=-LE licies
2 (@Derault Package
*-{7) Unknown Subscriber Package

Global Downstream Palicy

Tatal Link Limit: Link 13 Unlimited | Edit Rate Limit... + X

Downstream Folicy Description
=@ Default Global Contrales Aggregated Bandwidth Limit; Unlimited; Link Bandwidth Linit: Unlimited
= =+ Defaul C Low Priority
- under Default Package controlled ; unlinited quota

|
&
i

Global Policy Preferences Display Filter

Enable Global Priaritization Made. Enforce handwidth limitation on the sum of bwo links. Filter: Hide Unknawn Subscriber Package

Edit Preferences... Configure Fiters...

274129

The two check boxes near the top of the Global Controllers tab are used only in dual-link systems (see
Defining Global Controllers in a Dual-Link System, page 9-38).

The main part of the pane contains the Upstream area listing upstream global controllers and the
Downstream area listing downstream global controllers. Each list has two columns:

¢ Upstream or Downstream—Displays the hierarchy of global controllers, bandwidth controllers,
and service rules. Each global controller has the bandwidth controllers that are connected to it listed
as children. Each bandwidth controller has the service rules associated with it listed as children.

Cisco Service Control Application for Broadband User Guide
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¢ Policy Description—Summarizes the details of the global controller, bandwidth controller, or
service rule in the corresponding column. In the rows containing the global controller details, the
maximum bandwidth value permitted to this global controller is displayed.

For each global controller you can set different values for the maximum bandwidth for each of the
four time frames defined by the default calendar (see Managing Calendars, page 9-23):

- A single value in this field indicates that the maximum bandwidth for this global controller is
constant.

— If each time frame has a different maximum bandwidth, the maximum bandwidth for each time
frame is displayed, separated by commas.

Upstream Palicy Description

th Limit: 2.0 Mpbs, 3.0 Mpbs, 4.0 Mpbs, 6.0 Mpbs; Link vicdth Limit: e
10 Kbps; PIR:Unlimited; AL:1]

274130

— If two time frames have the same maximum bandwidth, the value is not repeated. (So 40,,,100
means that the first three time frames have a maximum bandwidth of 40 percent of the total link
limit, and the fourth time frame has a maximum bandwidth equal to the total link limit.)

| Mame Link 1 BW (%)

Downstrean Tokal Link Limik 100
| i--Default Global Contraller 100
| i-Downstream Controller 1 44d,,,100

Above the area (Upstream or Downstream) of each interface, the total link limit is displayed

| Mame Link. 1 B (%) Link, 2 BW (%) Aggregated B (%)
pstream Total Link Limit 100 !
| -Default Global Controller 100

| *-Upstream Controller 1 40,60,30,100

ast Ethernet= 40Mbps, 60Mbps, 80Mbps, 100Mbps
igabit Ethernet= 300Mbps, 1200Mbps, 1600Mbps, 2000Mbps

210586

How to Filter Global Controllers

Step1  In the Policies tab, click Global Policy.

The Global Bandwidth Settings are displayed in the right (Rule) pane.
Step2  Click Configure Filters.

The Filter View dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Filter view

ease select a Fileer,
& The Filker is for the display only

(3 Mo Filker

() Filker Unknown Subscriber Package
() Show only Global Controllers

() Filker Bandwidth Controllers

I Finish l ’ Cancel ]

243363

Step3  Choose one of the filter radio buttons:
e No Filter
¢ Filter Unknown Subscriber Package
e Show only Global Controllers
¢ Filter Bandwidth Controllers
Step4  Click Finish.

The Filter View dialog box closes and the right (Rule) pane is filtered according to your selection.

How to Edit the Total Link Limits

You can limit the total bandwidth passing through the SCE platform.

For example, if another device sitting next to the SCE platform on the IP stream has limited BW capacity,
you can limit the bandwidth passing through the SCE platform to match the capacity of the other device.

The total link limits for upstream and downstream traffic are defined independently.

Step1  In the Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.

Step2  In the Upstream or Downstream section, click Edit Rate Limit.
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3£ SCE Upstream Links - Total Rate Limit

SCE Upstream Links - Total Rate Limit

Configure the total rate limit For all SCE links.

Selecting ‘Unlimited" means limiting by the physical capacity of the link.

Total rate limit For each SCE link {kbps): w

I OK l ’ Cancel ]

243367

Step3  Choose the Add a new Global Controller radio button.
Step4  Click Finish.
The Global Bandwidth Settings dialog box appears.

F Upstream Global Controller, Settings

Global Controller Settings

Configure the rate limit that this global contraller should enforce,

Marne: | i1

The global controller enforces a L1 rate limit on traffic that is mapped ta it
The global controller can enforce an aggregate rate limit across all SCE links, as well
as a separate rate limit per SCE link,

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame,
(%) The same rate limit For all time Frames
() & different rate limit per time frame

Single Fate Limit

Rate limit For the Per Link Global Conkraller (in kbps): | Unlimited v

I OK l ’ Cancel ]

158843

Step 5 In the Name field, enter a meaningful name.
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Step 6 To edit the maximum bandwidth of the global controller, continue with the instructions in the following
section.

Step7  Click Finish.
Your changes are saved.

The Global Controller Settings dialog box closes.

How to Add Global Controllers

You can add up to 1023 upstream global controllers and 1023 downstream global controllers to a service
configuration.

Step 1 In the Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Step 2 Above the area (Upstream or Downstream) of the desired interface, click & (Add).

The Select Addition mode dialog box appears.

Select addition mode

(#) add a new Global Contraller
() add a Global Controller and map a Rule and a EWC ko it

[ Finish ” Cancel ]

243368

Step3  Choose the Add a new Global Controller radio button.
Stepd  Click Finish.
The Global Controller Settings dialog box appears.

Cisco Service Control Application for Broadband User Guide



| Chapter9

Using the Service Configuration Editor: Traffic Control

Step 5
Step 6

Step 7

Managing Bandwidth W

# Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Mame: | GC1

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links, as well
as a separate rate limit per SCE link,

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame,
(%) The same rate limit For all time Frames
() & different rate limit per time frame

Single Rate Limit

Rate limit For the Per Link Global Contraller (in Kbps): | Unlimited -

[ Ok ” Cancel ]

158843

In the Name field enter a meaningful name.

To edit the maximum bandwidth of the global controller, continue with the instructions in the section
How to Set the Maximum Bandwidth of Global Controllers, page 9-35.

Click OK
Your changes are saved.

The Global Controller Settings dialog box closes.

How to Set the Maximum Bandwidth of Global Controllers

Step 1

Step 2
Step 3

You can edit the maximum bandwidth (as a percentage of the total link limit) that a global controller can
carry.

You can set a different maximum bandwidth for each of the four available time frames.

In a dual-link system, you can set different values for each link and for the aggregated BW of the two
links.

In the Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
Select a global controller.

Click _ . (Edit).

[ oL-7205-11

Cisco Service Control Application for Broadband User Guide g



Chapter 9 Using the Service Configuration Editor: Traffic Control |

Bl Managing Bandwidth

The Global Controller Settings dialog box appears.

# Upstream Global Controller Settings

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Mame: | GC1

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links, as well
as a separate rate limit per SCE link,

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame,
(%) The same rate limit For all time Frames
() & different rate limit per time frame

Single Rate Limit

Rate limit For the Per Link Global Contraller (in Kbps): | Unlimited -

[ Ok ” Cancel ] %

&

Step4  Set a single value for the maximum bandwidth limit that this global controller carries.

e Choose the The same rate limit for all time frames radio button, and in the Rate limit for the Per
Link Global Controller (in Kbps) field, enter the desired value in Kbps for the maximum bandwidth.

Step5  Set the maximum limit that this global controller carries to vary according to time frame.

e Choose the A different rate limit per time frame radio button, and enter the desired value for each
time frame.
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Step 6

Step 7

# Upstream Global Controller Settings |Z|@@

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Mame: | GC1

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller can enforce an aggregate rate limit across all SCE links, as well
as a separate rate limit per SCE link,

Per Link Global Contraller

The global controller can enforce a different rate limit per time frame,
() The same rate limit For all time Frames
() & different rate limit per time frame

Rake Limnit per Time Frame

Time frame schedule is based on the policy's default calendar,

Reate limit per time Frame For the Per Link Global Controller;

Time Frame = Rate Limit (Kbps)
Weekend Unlimited
Peak. Unlimited
Day Unlimited
Weeknight  Unlimited

Ok ” Cancel ]

243364

Managing Bandwidth W

These values will be applied to the time frames of the default calendar.

Click OK

Your changes are saved.

The value in the Policy Description column changes to reflect the new bandwidth limits.

Repeat Step 2 through Step 6 for other global controllers.

How to Delete Global Controllers

Step 1

Step 2
Step 3

You can delete unused global controllers at any time. The default global controller and the Total Link

Limit cannot be deleted.

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box appears.
Select a global controller.

Click ﬁ (Delete).

[ oL-7205-11
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S

Note

Step 4

If a subscriber BWC is using the specified global controller (see How to Edit Package Subscriber BWCs,
page 9-41), a global controller cannot be removed message is displayed. The global controller cannot be
deleted until you unassign it from all subscriber BWCs.

The global controller is deleted.
Click OK
Your changes are saved.

The Global Bandwidth Settings dialog box closes.

Defining Global Controllers in a Dual-Link System

Note

In a dual-link system, you can define each global controller’s maximum bandwidth separately for each
link.

Alternatively, you can apply bandwidth limitations to the sum of the two links.

If Virtual Links mode is enabled, bandwidth limitations are applied to the sum of the two links.

e How to Set Global Controller Bandwidth Limits Separately for Each Link, page 9-38
¢ How to Set Global Controller Bandwidth Limits as the Sum of Two Links, page 9-39

How to Set Global Controller Bandwidth Limits Separately for Each Link

Step 1

Step 2
Step 3

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add global controllers, as described in How to Add Global Controllers, page 9-34.
Click Edit Preferences.

The Global Controllers mode dialog box appears.
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Global Controllers mode

Select the Global Controllers made

Link Mades

In & dual link svstem, each GC has a counterpart GC on the other link,
It is possible to configure separate rate limits for each @C on each link, and to enforce a limit on the aggregated rate of this pair of GCs,
Wirtual Links mode allows setting virtual links,

[C1Enforce B limitation on the sum of twa links
[C1Enable separate BYW settings for each link

Wirtual Links
[C1Enable Yirtual Links Mode

B Prioritization Mods

In Global Prioritization Mode, Fows that go through internal B\ controllers get their Relative Priority from the B controller's Assurance Level,
In Subscriber Prioritization Mode, the flows' Relative Priority is determined by the Relative Priority of the subscriber,

(%) Global Prioritization Mode
() Subscriber Prioritization Mode

Finish H Cancel ]

243365

Stepd  Check the Enable separate BW setting for each link check box.
Step5  Click Finish.

The Global Controllers mode dialog box closes.

The values for link 2 are set identical to the parallel values in link 1.
Step6  Set the total link limit, for each link.

Step7  Set the maximum bandwidth of the global controllers, for each link.

How to Set Global Controller Bandwidth Limits as the Sum of Two Links

Step 1 In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.
Step2  Click Edit Preferences.

The Global Controllers mode dialog box appears.
Step3  Check the Enforce BW limitation on the sum of two links check box.
Step 4 Click Finish.

The Global Controllers mode dialog box closes.
Step5  Select a global controller.
Step6  Click _ " (Edit).

The Global Controller Settings dialog box appears with an additional tab for Aggregated GC. The values
on the Aggregated GC tab are equal to the total link limit.

Step7  Configure the maximum bandwidths and click Finish.

Cisco Service Control Application for Broadband User Guide
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Step 8

The Global Controllers mode dialog box closes.

Managing Subscriber Bandwidth

A

After you have defined global controllers, you can add subscriber BWCs to packages and map these
subscriber BWCs to different global controllers.

A Subscriber BWC controls subscriber bandwidth consumption for upstream or downstream flows. It

controls and measures the bandwidth of an aggregation of traffic flows of a service or group of services.

Each package has its own set of BWCs that determine the bandwidth available per package subscriber
for each available service.

The two Primary BWCs , one for upstream traffic and one for downstream traffic, allocate bandwidth to
specific subscribers, depending upon the Committed Information Rate (CIR), the Peak Information Rate
(PIR), and the Subscriber relative priority settings. You can configure these parameters, but the Primary
BWCs cannot be deleted.

There are two default BWCs, one for upstream traffic and one for downstream traffic. By default, all
services are mapped to one of these two BWCs. The BWC mechanism controls rate subpartitioning
within the default BWC rate control, based on the CIR, PIR, and AL. You can configure these
parameters,but the default BWCs cannot be deleted.

You can add up to 32 user-defined BWCs per package:

e Subscriber BWCs operate at the service-per-subscriber level. They allocate bandwidth for each
subscriber’s service, based upon the CIR, PIR, global controller and Assurance Level (AL) set for
the BWC. Each rule defines a link between the service’s flows and one of the BWCs (unless the
flows are to be blocked). See How to Define Per-Flow Actions for a Rule, page 9-14.

e Extra BWCs also operate at the subscriber level. Extra BWCs (based on the CIR, PIR, global
controller, and AL) can be allocated for services that are not included in the Primary BWC. These
are services that are not often used but have strict bandwidth requirements, for example, video
conference calls. The Extra BWCs are BWCs that control a single service (or service group). BWCs
cannot borrow bandwidth from Extra BWCs and vice versa.

Each user-defined BWC controls either downstream or upstream traffic.

Caution

If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration. A BWC that pointed to a user-defined global controller now points to the default
global controller. (Other parameters of these BWCs remain unchanged.)

¢ Subscriber BWC Parameters, page 9-40
e How to Edit Package Subscriber BWCs, page 9-41

Subscriber BWC Parameters

The Subscriber BW Controllers tab of the Package Settings dialog box has the following configuration
parameters:

e Name—A unique name for each BWC.
¢ CIR (L3 Kbps)—The minimum bandwidth that must be granted to traffic controlled by the BWC.
e PIR (L3 Kbps)—The maximum bandwidth allowed to traffic controlled by the BWC.
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Bandwidth for a subscriber BWC has a granularity of 16 Kbps:

If you specify a bandwidth of, for example, 64 Kbps, the bandwidth will be stable at this value.

If you specify a bandwidth of, for example, 70 Kbps, the bandwidth will be unstable and oscillate
between 64 Kbps and 80 Kbps.

Global Controller—The global controller with which this BWC is associated. The global controllers
are virtual queues that are part of the bandwidth control mechanism. Direct traffic with similar
bandwidth control properties to the same global controller.

AL—How fast bandwidth either decreases from the PIR to the CIR as congestion builds or else
increases from the CIR to the PIR as congestion decreases. A higher AL ensures a higher bandwidth
compared to a similar BWC with a lower AL. The lowest assurance value is 1, the highest is
Persistent.

Assurance Level 10 (persistent) never goes below the relevant CIR, unless the total line rate cannot
sustain this.

Subscriber relative priority—Assurance Level given to the Primary BWC of the subscriber. It
determines the assurance given to all the subscriber traffic when competing for bandwidth with
subscribers to other packages. The lowest value is 1; the highest is 10.

Subscriber bandwidth control (and accounting and reporting) is based on Layer 3 volume.
Global controller bandwidth is based on Layer 1 volume.

How to Edit Package Subscriber BWCs

Step 1

Step 2

Step 3

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box in the right (Rule) pane.
In the right (Rule) pane, select a BWC and click _ ™. (Edit).

The Package Settings dialog box appears.

In the Package Settings dialog box, click the Subscriber BW Controllers tab.

The Subscriber BW Controllers tab opens.

[ oL-7205-11
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Package Settings for "Basic Package”

General | Quota Management |; Subscriber BW Controllers || Advanced |

Subscriber B\W Controllers limit the B\ of transaction groups and prioritize between transactions of different services
for a single subscriber. They are also used For linking services to Global Controllers,

stream B

Default Downstrean BWC

rUpskrean-
Subscriber relative priority (Upskrean): E @ @ X
lame CIR (kbps)  PIR (kbps) = Global Contraller AL |
7 ~Default Upstream B 0 Unlimited Default Global Controller 1
rDownstream
Subscriber relative priority (downskreamn): B @ @' >4
CIR (kbps)  PIR (kbps) = Global Contraller Al |

Unlimited

Default Global Controller 1

[ QK ][ Cancel ]

27410

Set your requirements for upstream bandwidth control in the Upstream area of the dialog box.

— In the PIR field, select Unlimited from the drop-down list, or enter the BWC PIR in Kbps.

To add BWCs to the package, click @ (Add a sub BW Controller) once for each additional BWC.
To add Extra BWCs to the package, click @I (Add an extra BW Controller) once for each

Step 4
a. Select a value from the Subscriber relative priority drop-down list.
b. Set the parameters for the Primary Upstream BWC.
— In the CIR field, enter the BWC CIR in Kbps.
c.
d.
additional BWC.
e. Set the parameters for each BWC

Primary or Default BWCs.)

Kbps.

(including the Primary and Default BWCs).

(Optional) In the Name field, enter a meaningful name for each BWC. (You cannot rename the

In the CIR field, enter a value for the BWC CIR in Kbps.
In the PIR field, select Unlimited from the drop-down list, or enter a value for the BWC PIR in

To set the global controller with which this BWC is associated:

Click in the Global Controller cell of the BWC, and then click the Browse button that appears.

[l Cisco Service Control Application for Broadband User Guide
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The Select a Global Controller dialog box appears.

3£ Select a Global Controllers |Z|@

Select a global controllers for the service element

Default Global Contraller
uz2
Upstream Controller 1

Cancel

210585

— Select a global controller and click OK.
- Select a value from the AL drop-down list.
Step5 Repeat Step 3 for downstream bandwidth control in the Downstream area of the dialog box.
Step6  Click OK.
The Package Settings dialog box closes.
All changes to the BWC settings are saved.

Managing Bandwidth: a Practical Example

This section explains how to achieve effective bandwidth control by combining the configuration of
global controllers and subscriber BWCs, and gives a practical example.

¢ How to Configure Total Bandwidth Control, page 9-43
e Example: How to Limit P2P and Streaming Traffic Using the Console, page 9-44

How to Configure Total Bandwidth Control

Step1  Configure the necessary global controllers.

Ascertain which services are likely to be problematic, and what the maximum percentage of total
bandwidth should be for each. You do not need to configure services and packages that are unlikely to
be problematic; you can include them in the default global controllers.

Step2  Configure the subscriber BWCs for the package.

a. Add a subscriber BWC for each type of upstream or downstream traffic that you want to limit, and
configure the CIR and the PIR accordingly.

b. Select an appropriate global controller for each subscriber BWC.

Cisco Service Control Application for Broadband User Guide
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Step 3

For each service that is to have its own BWC, create a rule and select appropriate upstream and
downstream BWCs.

Example: How to Limit P2P and Streaming Traffic Using the Console

)

Note

~

Note

Step 1

Step 2

Step 3

This example assumes that the traffic flow is bidirectional; you may decide that you only need upstream
controllers or downstream controllers.

The P2P Traffic Optimization wizards allow you to create a simple model of devices, connect to them,
and limit P2P traffic to a specified percentage of total available bandwidth. (See How to Use the P2P
Traffic Optimization Wizards, page 4-37.)

In the Policies tab, click Global Policy.
The Global Bandwidth Settings dialog box in the right (Rule) pane.

Add two upstream global controllers and two downstream global controllers and assign the desired
percentage of traffic to each global controller.

Global Upstrearn Policy

Total Link Limit: Link 1: Unlimited | Edit Rate Limi... BN =l

Policy Description

Upstream
0 Mpb

Link Bandwidth Limit: 3.0 Mpbs

|Link Bandwidth Limit: Unlimited

i@ Upstream Global Contraller 1
[#-@ Default Global Controller

Global Downstreann Palicy

Tokal Link Limit: Link 1: Unlimited | Edit Rate Limit. .. = B N =

Policy Description

Downstrean
6.0 Mpb

Link Bandwidth Limit: 2.0 Mpbs

|Link Bandwidth Limit: Unlimited

i@ Downstream Global Controller 1
[+-@ Default Global Controller

274076

(Here, Upstream Controller 1 and Downstream Controller 1 will be used for P2P traffic, and Upstream
Controller 2 and Downstream Controller 2 will be used for streaming traffic.)

In a Package Settings dialog box, add two upstream BWCs and two downstream BWCs, map them to the
appropriate global controllers, and set their parameters (CIR, PIR, AL).

[l Cisco Service Control Application for Broadband User Guide
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Package Settings for, "Gold®

| General || Quoka Managementl Subscriber BW Controllars | Advanced|

Subscriber BW Contrallers limit the BW of transaction groups and priotitize between transactions of different services
for a single subscriber, They are also used for linking services to Global Controllers,

—Upskream
Subscriber relative priority (upstream): @ @l x
Mame CIR{L3K... PIR{L3K... aGlobal Controller AL
5 Unlimited
-Diefaulk Upstrearm BwbC a Unlimited Default Global Controller 1
- EWIC 1 0 Unlimited Upstream Global Controller 1 1
BT 2 0 nlimited Upstream Global Controller 2 1
rDownskream
Subscriber relative priority (downstrean): @ @l x
lame CIR{L3K... PIR{L3K... alobal Controller AL

ef aulk Downstream BWC 0 Default Global Controller 1
~-BWC 3 a Unlimited Downstream Global Contraller 1|1
—-BWC 4 a Unlimited Downstream Global Contraller 2 |1

[ o4 ” Cancel ]

274077

(Here, BWC1 will be for upstream P2P traffic and BWC3 will be for downstream P2P traffic; BWC2
will be for upstream streaming traffic and BWC4 will be for downstream streaming traffic.)

Stepd  Add a rule for the P2P service.

Cisco Service Control Application for Broadband User Guide
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Add New Rule to Package “Gold™

General | Control | Usage Limits | Ereach Handling

Service

Select the Service to which the Rule will relate:

Rule State
Define the state of this Rule:

(#) Enable reporting and active actions

() Disable reporting and active actions

’ K ][ Cancel ]

274075

Step5  In the Control tab, assign BWC 1 as the upstream BWC and BWC 3 as the downstream BWC.
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| General | Contral | Lisage Limits || Breach Handling |

Define the per-flow action to be performed by this Rule:

() Block the Flow

(%) Control the flow's characteristics:

Select an upstream Bandwidth Contraller |BWC 1

Select a downstream Bandwidth Controller |BWC 3

[ Limit the Flow's upstream bandwidth ko I:I Kbps

[] Set the Flow's upstream packets ToS (DSCPY o 1

[ Limit concurrent Flows of this Service to |

Set Cas far Flows of this Service to |BE w |

[[] Set the flow's downstream packets Tas (DSCPy ke Tos 1 [0]

[ Limit the Flow's downstream bandwidth to kbps

[] Redirect profile Far Ehis service:

[ Mirrar traffic bo server group: 5=

@

QK

J[ Cancel ]

Managing Bandwidth

274128

Step6  Repeat Step 4 and Step 5 for the Streaming service, using BWC 2 as the upstream BWC and BWC 4 as

the downstream BWC.

All subscriber traffic using these services will be added to the virtual queue total for these queues. In
turn, the bandwidth available to the subscriber for these protocols will fluctuate, depending on how

“full” these queues are.

Step7  Click Global Policy to view the hierarchy of the GCs, BWCs, and rules.

[ oL-7205-11
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How to Configure a Rule, Bandwidth Controller, and Global Controller Using the

Wizard

Step 1
Step 2

Step 3
Step 4

Total Link Upstream Bandwidth Limit: Link 1: Unlimited | Edit Bandwidth Limit...

%

Upstream
3
= =) Upstream Global Contraller 1

Folicy Description

Bandwidth Limit: 4.0 Mpbs

L = BWC L

Low Priority [CIR.:0 Kbps; PIR:rlinited; AL:1]

: = P2P; Gold controlled [B+C 1; B+#C 5]; unlimited quota
=)= Upstream Global Controller 2 Eandwidth Limit: 3.0 Mpbs -

S BWC 2 Low Priority [C1FR.0 kbps; PIR:nimited; AL1] v
Total Link Downstream Bandwidth Limit: Link 1: Urlimited 3 4 N
Downstream Palicy Description
n od

=] Downstream Global Cantroller 1 Bandwidth Limit: 6.0 Mpbs

o= BWC 3 Low Priority [C1R:0 Khps; PIR:Ulimiced; AL1]

== P2P; Gald lcontrolled [5+/C 1; BW0 3); unlimited quata
=4 Downstream Global Cantroller 2 Bandwidth Limit: 3.0 Mpbs
o BWC 4 lLow Priority [CIR:0 Kbps; PIR:Urlimied; AL:1]

= Streaming; Gold

[controlled [E4/C 2; 5/ 41; unlimited quota

Global Policy Prefersnces

Edit: Preferences. ..

Enforce same bandwidth limitation an al links

Display Filter

Filter: filker Unknown Subscriber Package Configure Fiters...

273437

You can configure a rule, BWC, and GC together from the Global Policy window.

In the Policies tab, click Global Policy.

The Global Bandwidth Settings are displayed in the right (Rule) pane.

Above the area (Upstream or Downstream) of the desired interface, click ':::' (Add).

The Select addition mode dialog box appears.
Choose the Add a Global Controller and map a Rule and BWC to it radio button.

Click Finish.

The GC Selection dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Upstream GC selection

@ Please choose a GC {existing or a new GZ name)

Please select a Global Contraller,
The contraller can be an existing one of you can create one.
Select the button to choose an existing GC or bype the name of a new GC.

GC | | [Select...]

PIR: | Unlimited |

273440

Step5 In the GC field, enter a new GC name, or click Select to choose an existing GC.

Step6  (Optional) In the PIR field, enter the maximum bandwidth limit that this global controller carries in
Kbps.

Step7  Click Next.

The Service and Packages selection dialog box appears.

Cisco Service Control Application for Broadband User Guide
I oL-7205-11 .ﬂFl



Chapter 9 Using the Service Configuration Editor: Traffic Control |

M  Managing Bandwidth

¥ - B
Upstream Service and Packages selection

3 Please chonse an existing Service

“lease select a Service and the Packages.
A Service Rule will be crated For them, if one is not already defined.
The directional pre-breach B\WContraller will be defined in the next page

Service! | | [Select... ]
Packages:

[] Default Package

[] Bronze Package

7 silver Package

[] Gold Package

] Unknown Subscriber Traffic

Select al... ] [Deselect all...

Cancel

243355

Step8 In the Service field, select an existing service.
Step9  In the Packages section, select one or more packages for the rule to apply to.

If a rule does not exist for the service, it is created. The new, or existing rule is then mapped to the
selected package or packages.

Step10  Click Next.
The BWC selection dialog box appears.
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Upstream BWC selection

@ Please choose an Upstreanm BWiC (existing or a new BWC name)

Please select a BwiContraller,
The contraller can be an existing one of you can create one.
Select the button to choose an existing BWC o type the name of a new B,

BWC: || Select...

273439

Step11  Enter a new BWC name, or click Select to choose an existing BWC.

Step12 Click OK.

How to Set BW Management Prioritization Mode

Relative priority is the level of assurance that an internal BWC (iBWC) receives when competing against
other iBWCs for bandwidth.

The relative priority of the flow that goes through an iBWC is determined by the relative priority of one
of:

e The iBWC—In Global Prioritization Mode

e The subscriber—In Subscriber Prioritization Mode

Step 1 In the Policies tab, click Global Policy.

The Global Bandwidth Settings are displayed in the right (Rule) pane.
Step2  Click Edit Preferences.

The Global Controllers mode dialog box appears.

Cisco Service Control Application for Broadband User Guide
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Step 3

Step 4

Global Controllers mode

Select the Global Controllers made

Link Mades

In & dual link svstem, each GC has a counterpart GC on the other link,
It is possible to configure separate rate limits for each @C on each link, and to enforce a limit on the aggregated rate of this pair of GCs,
Wirtual Links mode allows setting virtual links,

[C1Enforce B limitation on the sum of twa links
[C1Enable separate BYW settings for each link

Wirtual Links
[C1Enable Yirtual Links Mode

B Prioritization Mods

In Global Prioritization Mode, Fows that go through internal B\ controllers get their Relative Priority from the B controller's Assurance Level,
In Subscriber Prioritization Mode, the flows' Relative Priority is determined by the Relative Priority of the subscriber,

(%) Global Prioritization Mode
() Subscriber Prioritization Mode

Finish ] l Cancel

|

Select one of the BW Prioritization Mode radio buttons.
¢ Global Prioritization Mode
¢ Subscriber Prioritization Mode

Click OK.

The Global Controllers mode dialog box closes.

The selected BW management parameter is saved.

Managing Virtual Links

In Virtual Links mode, template bandwidth controllers are defined for packages. Actual bandwidth
parameters are assigned when a subscriber enters the system and depend on the subscriber's package

(which defines the template controllers) and the physical link assigned to the subscriber.

For each service configuration that has Virtual Links mode enabled, there is one default upstream virtual
link and one default downstream virtual link. The upstream and downstream interfaces are each assigned

one default template global controller.

You can add additional template global controllers. You can add, modify, and delete virtual links using

a command-line interface (CLI).

A service configuration can contain up to 1024 upstream global controllers and 1024 downstream global
controllers (including the default global controllers). The maximum number of virtual links is limited
by the number of directional template global controllers: the number of template global controllers times

the number of virtual links cannot exceed 1024.

243365
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Managing Virtual Links

Caution

If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration. A subscriber BWC that pointed to a user-defined global controller now points to
the default global controller. (Other parameters of these subscriber BWCs remain unchanged.)

The following steps outline configuring a service configuration in Virtual Links mode. The procedure is
similar to that for configuring any service configuration, but virtual links must be added using the CLI.

1. Create a new service configuration.

2. Open the Global Bandwidth Settings dialog box and check the Enable Virtual Links Mode check
box.

3. Create template global controllers.
4. Create packages.

Add subscriber BW controllers to the packages and associate them with appropriate global
controllers.

5. Apply the service configuration.

The bandwidth values of the default global controllers are set; the values of all other global
controllers are not set — these global controllers are templates.

6. Add virtual links using the CLI.

Each virtual link gets a set of global controllers with the PIR values of the template global controller
configuration.

If necessary, you can use the CLI to change the global controllers’ PIR values.

1. A subscriber is introduced to the SCE platform. Upstream and downstream virtual links are
associated with the subscriber as well as a package.

8. Rule resolution for each flow of the subscriber is according to the subscriber’s package and the
virtual links’ global controller configuration.

Collection Manager Virtual Links Names Utility

The Collection Manager (CM) includes a command-line utility for managing the names of virtual links.

For more information about the CM Virtual Links Names Utility, see “Managing Virtual Links” in the
“Managing the Collection Manager” chapter of the Cisco Service Control Management Suite Collection
Manager User Guide.

How to Enable Virtual Links Mode

A

To use virtual links, you must enable Virtual Links mode.

Caution If you enable or disable Virtual Links mode, all user-defined global controllers are deleted from the
service configuration.
Step 1 In the Policies tab, click Global Policy.
The Global Bandwidth Settings are displayed in the right (Rule) pane.
Cisco Service Control Application for Broadband User Guide
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Step2  Click Edit Preferences.
The Global Controllers mode dialog box appears.
Step3  Check the Enable Virtual Links Mode check box.

Note If you have already added global controllers or if you selected asymmetric routing classification mode,
a warning message appears. To continue, click OK.

The Virtual Links Global Controllers tab opens.
Step4  Click Finish.
The Global Bandwidth Settings dialog box closes.

How to View Virtual Links Global Controller Settings
~

Note  Global controller bandwidth is based on Layer 1 volume.
(Accounting, reporting, and subscriber bandwidth control in SCA BB is based on Layer 3 volume.)

Step 1 In the Policies tab, click Global Policy.
The Global Bandwidth Settings are displayed in the right (Rule) pane.

The maximum amount of bandwidth that can be used by any global controller is displayed at the top of
the Global Bandwidth Settings:

¢ Total Link Upstream Bandwidth Limit: Link 1
¢ Total Link Downstream Bandwidth Limit: Link 1
Step2  Select a global controller, and click _ ™ (Edit).
The Global Controller Settings dialog box appears.
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# Upstream Global Controller Settings |Z|@@

Global Controller Settings

Configure the rate limit that this global controller should enforce.

Mame: | Defaulk Global Controller

The global controller enforces a L1 rate limit on traffic that is mapped to ik,
The global controller enforces an aggregate rate limit across all SCE links belonging
to the same virtual link,

In virtual links mode, rate limits for each virtual link are provisioned dynamically to
the SCE, vet 'Template' and 'Default’ values allow static proviosioning:

‘Template' rate limits apply to newly-created virtual links,

‘Default’ rate limits apply to the default virtual link {virtual link 03,

Template Yirtual Link | Default Yirkual Link
The global controller can enforce a different rate limit per time frame,
(%) The same rate limit For all time Frames
() & different rate limit per time frame

Single Rate Limit

Rate limit for the Template Yirtual Link in Kbps): | Unlimited w

[ Ok ” Cancel ]

273580

.The values of the global controllers defined in the dialog box depends on the values displayed in the
Global Bandwidth Settings. So, for example, if the Total Link Upstream Bandwidth Limit: Link 1 has a
value of 10 Mbps then the upstream default global controller value cannot exceed 10 Mbps.

The Name field contains a unique name assigned to the global controller. The system automatically
assigns the names Controller 1, Controller 2, and so on.

The dialog box contains the following two tabs:

¢ Template Virtual Link—The default maximum value of the total link limit permitted to global
controllers of any created virtual links, either for all time frames or per time frame.

¢ Default Virtual Link—The maximum value of the total link limit permitted to global controllers of
the default virtual link, either for all time frames or per time frame.

Step3  Click OK.
The Global Bandwidth Settings dialog box closes.

Managing Virtual Links Global Controllers

Virtual link global controllers can be added edited and deleted in the same way as regular global
controllers. For more information, refer to the following sections:

Cisco Service Control Application for Broadband User Guide
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e How to Add Global Controllers, page 9-34

¢ How to Set the Maximum Bandwidth of Global Controllers, page 9-35
e How to Delete Global Controllers, page 9-37

e Managing Subscriber Bandwidth, page 9-40

How to Edit the Virtual Links Total Link Limits

Step 1

Step 2

Step 3

Step 4

You can limit the total bandwidth passing through the physical link.
The total link limits for upstream and downstream traffic are defined independently.

In a dual-link system, bandwidth limitations are applied to the sum of the two links.

In the Policies tab, click Global Policy.

The Global Bandwidth Settings dialog box is displayed in the right (Rule) pane.
In the Upstream or Downstream section, click Edit Rate Limit.

The Total Rate Limit dialog box appears.

In the Total Rate Limit for each SCE link (Kbps) field, enter the maximum percentage of the SCE
platform capacity that the platform will carry, or enter Unlimited.

Click OK.
The Total Rate Limit dialog box closes.
The Total Link Bandwidth Limit: Link 1 field is updated.

Managing Virtual Links with CLI Commands

You can configure, enable and disable virtual links using the SCE platform Command-Line Interface
(CLI). For more information about the SCE platform CLI, see the Cisco SCES8000 CLI Command
Reference.

e Use the following CLI commands to manage virtual links:

virtual-links index <index> direction [upstream | downstream]

virtual-links index <VL index> direction [upstream \ downstream] gc <gc index> set-PIR
value <PIR 1, PIR2, PIR3, PIR4>

virtual-links index <VL index> direction [upstream | downstream] gc <gc index> set-PIR
value <PIR for all timeframes>

virtual-links index <VL index> direction [upstream \ downstream] gc <gc index>
reset-PIR

no virtual-links index <index> direction [upstream | downstream]

These commands are line interface configuration commands. To run these commands see How to

Enter Line Interface Configuration Mode, page 9-57.

¢ Use the following CLI command to set the virtual links index of a subscriber:

subscriber name <name> property name [v1Up \ v1lDown] value <vl index>
This commands is a line interface configuration command. To run this command see How to Enter
Line Interface Configuration Mode, page 9-57.

e Use the following CLI command in EXEC mode to monitor the status of virtual links:
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show interface LineCard 0 virtual-links [all | changed]

Description of Virtual Links CLI Commands

Table 9-1 gives a description of the virtual links CLI commands.

Table 9-1 Virtual Links CLI Commands

Command

Description

virtual-links index <index> direction [upstream |
downstream]

Add a virtual link

virtual-links index <VL index> direction
[upstream | downstream] gc <gc index> set-PIR
value <PIR 1, PIR2, PIR3, PIR4>

Update the global controller PIR values of a
virtual link - separate values for each time frame

virtual-links index <VL index> direction
[upstream | downstream] gc <gc index> set-PIR
value <PIR for all timeframes>

Update the global controller PIR values of a
virtual link - one value for all time frames

virtual-links index <VL index> direction
[upstream | downstream] gc <gc index> reset-PIR

Update the global controller PIR values of a
virtual link - take the values defined in the
template global controller

no virtual-links index <index> direction [upstream
| downstream]

Delete a virtual link

subscriber name <name> property name [vlUp |
viDown] value <vl index>

Set a subscriber’s virtual links index

show interface LineCard 0O virtual-links all

Show information about all virtual links

show interface LineCard O virtual-links changed

Show information about virtual links whose PIR
differs from the value defined in the template
global controller

How to Enter Line Interface Configuration Mode

Step 1
Step 2

Step 3
Step 4

At the SCE platform CLI prompt (sce#), type configure.

Press Enter.

The sCE (config)# prompt appears.
Type interface LineCard 0.

Press Enter.

The SCE(config if)# prompt appears.

Managing Quotas

e How to Edit Quota Management Settings for Packages, page 9-58

e How to Select Quota Buckets for Rules, page 9-60

[ oL-7205-11
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e How to Edit Breach-Handling Parameters for a Rule, page 9-61

How to Edit Quota Management Settings for Packages

You can define whether quota management for a package is performed by an external quota manager or
by SCA BB.

You also define the quota buckets associated with the package. Rules can use quota buckets to set limits

to the consumption of particular service groups (see How to Select Quota Buckets for Rules, page 9-60).

Quota Replenish Scatter

Step 1

Step 2

By default, if subscriber quota is replenished using periodical quota management, the quota of all
subscribers is replenished at the same time. To smooth quota replenishment, you can scatter the time of
quota replenishment.

To activate this feature, enter a non-zero value for the Length of the time frame for quota replenish scatter
(minutes) property of the Advanced Options tab of the Systems Settings dialog box (see Managing
Advanced Service Configuration Options, page 10-43). By default, this property has a value of zero, that
is, all quota is replenished at the same time.

Each subscriber’s quota replenishment occurs at a random time within the quota replenish scatter time
frame, with replenish events split evenly before and after the quota aggregation time.

Best results are obtained if the scatter time frame is the same length as the quota aggregation period,
which should completely smooth replenish events. (Do not enter a value larger than the quota replenish
period.) In the case of hourly quota replenish period, the scatter should therefore be set to 60 minutes.

The quota replenish scatter function is independent of all other quota management parameters.

In the Policies tab, select a package from the package tree, and click __ (Edit Package).
The Package Settings dialog box appears.
In the Package Settings dialog box, click the Quota Management tab.

The Quota Management tab opens.
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Step 3

Note

Note

Step 4

Step 5

Managing Quotas

Package Settings for "Basic Package”

Subscriber BW.ControIIers_ || Advanced|

Select quota management mode;
() External - replenished on external request
(%) Periodical - replenished automatically at the end of the aggregation period
Aagagreqgation Period
() Hourly - ends on the hour

(%) Daily - ends at midnight

Quota Buckets
Buckets define limits on the volume and session consumption of a subscriber,

Bucket ID Marne Type Quata Lirnit
1|Bucket 1 Wolume (L3 KBytes) 250000000 A
2|Bucket 2 Wolume (L3 KByvtes) 250000000] = |
3|Bucket 3 Wolume (L3 KBytes) 250000000
4|Bucket 4 Wolume (L3 KBytes) 250000000, |
N 5|Bucket 5 wolurne (L3 KBytes) I 250000000 V
[ QK ] [ Cancel

158895

Select one of the Select quota management mode radio buttons.

e External —Replenishes quota on external request

External quota management is not supported when unidirectional classification is enabled. If you try to
select the External radio button when unidirectional classification is enabled, a Package Error message
appears.

Click OK to continue.

e Periodical —Replenishes quota automatically at the end of the aggregation period

Using periodical quota management, you can scatter quota replenishment so that the quota of all
subscribers is not replenished at the same time. (See Quota Replenish Scatter, page 9-58.)

If you selected the Periodical radio button, select one of the Aggregation Period radio buttons to specify
when the quota is renewed for the package:

¢ Hourly Resolution —Replenishes quota at each hour change
¢ Daily Resolution —Replenishes quota at midnight
Configure the quota buckets.

[ oL-7205-11
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Note

Note

Step 6

Make sure that the configuration is appropriate to the rules that you will apply to the package. For
example, if you do not configure a bucket with Type = Number of sessions, you cannot define a rule with
usage limits defined in number of sessions.

a. (Optional) In the Name cell, enter a name for the bucket.

You can use the default name for the bucket. It is recommended that you enter a meaningful name.

b. Click in the Type cell, click the drop-down arrow that appears in the cell, and then select either
Volume (L3 Kbytes) or Number of sessions from the drop-down list.

c. In the Quota Limit cell, enter the actual limit for this bucket in kilobytes or number of sessions,
depending on the selected Type.

In the Quota Limit cell, enter the actual limit for this bucket in kilobytes or number of sessions,
depending on the selected Type.

Quota limits can be set only if you selected the Periodical radio button in Step 4 above.

Click OK.
The Package Settings dialog box closes.

All changes to the quota management settings are saved.

How to Select Quota Buckets for Rules

Step 1
Step 2
Step 3

Step 4

You can select the quota buckets that the flows mapped to a rule will use. The quota buckets in the
drop-down lists were defined during package setup (see How to Edit Quota Management Settings for
Packages, page 9-58). If no quota bucket is appropriate for the rule, add a new quota bucket to the
package or edit an existing bucket.

In the Network Traffic tab, select a package from the package tree.
In the right (Rule) pane, select a rule.

Click _*. (Edit Rule),

The Edit Rule for Service dialog box appears.

Click the Usage Limits tab.

The Usage Limits tab opens.
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Step 5

Note
Step 6

Step 7

Edit Rule for Service "SMTP™

| Gereral | Control USC"QBLIW Breach Handling|
Set the Quota Buckets that the Service's traffic will consure.
Select Quota Bucket For upstream traffic ENone {Unlimited) v-:
Select Quota Bucket For downstream traffic ;.None (Unlirmited) :
Select Quota Bucket For sessions ?NDHB {Unlimited) s
[ O ] [ Cancel

Select the desired bucket from each drop-down list.
¢ Select Quota Bucket for upstream traffic
e Select Quota Bucket for downstream traffic

¢ Select Quota Bucket for sessions

155509

Managing Quotas

For unlimited quota, select None (Unlimited).

To define behavior when a quota is breached (not relevant if all quota buckets have unlimited quota),

continue with the instructions in the following section.
Click OK.
The Edit Rule for Service dialog box closes.

All changes to the rule are saved.

How to Edit Breach-Handling Parameters for a Rule

You can define the SCE platform behavior when an aggregated volume limit or the total

number-of-sessions limit is exceeded. You can also notify subscribers when they exceed their quotas.

[ oL-7205-11
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Breach-Handling Parameters

Note

Step 1
Step 2
Step 3

The following are the configuration parameters in the Breach Handling tab of the Edit Rule for Service
Settings dialog box.

- No changes to active control—Flows mapped to this rule are not affected when quota is

breached. SCA BB can generate Quota Breach RDRs even when this option is selected (see How
to Manage Quota RDRs, page 8-6).

Block the flow—Flows mapped to this rule are blocked when quota is breached.

Redirect to—Redirect the flow to a specified, protocol-dependent URL, where a posted web
page explains the reason for the redirection. URL redirection sets are defined in the System
Settings dialog box. (See How to Add a Set of Redirection URLs, page 10-38.) Only three
protocol types support redirection: HTTP, HTTP Streaming, and RTSP. Redirection is not
supported when unidirectional classification is enabled.

Control the flow characteristics—The behaviors of flows mapped to this rule change when
quota is breached:

Select an upstream Bandwidth Controller—Map this rule’s traffic flows to a specific upstream
BW controller (BWC). This sets up bandwidth metering of all concurrent flows mapped to this
rule, based on the characteristics of the selected BWC.

Select a downstream Bandwidth Controller—The same functionality as the previous option, but
for downstream flow.

Limit the flow’s upstream bandwidth—Set a per-flow upstream bandwidth limit (for flows
mapped to the service of this rule).

Limit the flow’s downstream bandwidth—Set a per-flow downstream bandwidth limit.

Set the flow's upstream packets ToS—Set the DSCP ToS marker of all packets of upstream
flows.

Set the flow's downstream packets ToS—Set the DSCP ToS marker of all packets of downstream
flows.

Limit concurrent flows of this Service—Set the maximum number of concurrent flows (mapped
to this rule) permitted to a subscriber.

Activate a Subscriber Redirect—Activate a Subscriber Redirect when subscribers exceed their quota
limit.
Activate a Subscriber Notification—Activate a Subscriber Notification when subscribers exceed

their quota limit. This notification can, for example, convey the quota breach situation to the
subscriber and explain how to obtain additional quota.

You determine what happens to flows identified as belonging to this rule when a quota is breached:

Subscriber notification is not supported when unidirectional classification is enabled.

To define Subscriber Notifications, see Managing Subscriber Notifications, page 10-27..

Activate Traffic Mirroring—Activate traffic mirroring when subscribers exceed their quota limit

In the Policies tab, select a package from the package tree.

In the right (Rule) pane, select a rule.
Click _ . (Edit Rule).

Cisco Service Control Application for Broadband User Guide



| Chapter Using the Service Configuration Editor: Traffic Control

Step 4

Step 5

Step 6
Step 7
Step 8

The Edit Rule for Service dialog box appears.
Click the Breach Handling tab.

The Breach Handling tab opens.

£ Add New Rule to Package "Default Package”

General | Control | Usage Limits | Breach Handling

() Mo changes to active control
() Block the flaw

() Control the flow's characteristics:

Select an upstream Bandwidth Controller | Defaulk Upstream BwC
Select a dovanstream Bandwidth Contraller | Defaulk Downstrean BWC
[ Limit: the: flow's upstream bandwidth to

[] Limit the flow's downstream bandwidth to

[] Set the Flaw's upstream packets Tas (DSCP) ko

[] 5et the Flow's downstream packets ToS (DSCP) to

[ Limit concurrent Flaws of this Service to

[ Redirect profile for this service:
[] Motification redirect: profile For this service:

[ Mirrar traffic to server group:

In case a subscribet's usage exceeded the volume or number of sessions limits:

Ok

] [ Cancel

]

Set the flow's behavior when quota is breached.

To block the flow, select the Block the flow radio button.

To block the flow when quota is breached, continue at Step 6.

To change the flow’s characteristics when quota is breached, continue at Step 10.

274149

Managing Quotas

To leave the flow unchanged when quota is breached, select the No changes to active control radio

button and continue at Step 11.

Continue at Step 10, page 350.

Change the flow’s characteristics.

Select the Control the flow’s characteristics radio button.

The options in the Flow Characteristic area are enabled:

From the upstream Bandwidth Controller drop-down list, select an upstream BWC

The BWCs in this drop-down list are defined when creating or editing the package.

[ oL-7205-11
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Step 9

Step 10

Step 11
Step 12

Step 13

When the mouse is placed over the drop-down list, a tooltip appears containing the properties of the
selected BWC (Peak Information Rate (PIR), Committed Information Rate (CIR), Global Controller, and
Assurance Level).

e From the downstream Bandwidth Controller drop-down list, select a downstream BWC.

e (Optional) Check the Limit the flow’s upstream bandwidth check box and enter a value in the
Kbps field.

e (Optional) Check the Limit the flow’s downstream bandwidth check box and enter a value in the
Kbps field.

¢ (Optional) Check the Set the flow's upstream packets ToS (DSCP) to check box and select a value
from the drop-down list.

e (Optional) Check the Set the flow's downstream packets ToS (DSCP) to check box and select a
value from the drop-down list.

e (Optional) Check the Limit concurrent flows of this Service check box and enter a value in the
associated field.(Optional) To enable subscriber

(Optional) To enable subscriber redirect, check the check box and select a redirect profile from the
drop-down list.

(Optional) To enable subscriber notification, check the Notification redirect profile for this service check
box and select a notification redirect profile from the drop-down list.

~

Note A subscriber notification can be activated in addition to any of the three breach-handling options.

~

Note  Subscriber notification is not supported when unidirectional classification is enabled. If you try
to check the Activate a Subscriber Notification check box when unidirectional classification is
enabled, a Rule Error message appears.

Click OK to continue.

(Optional) To enable mirror traffic to a server group, check Mirror traffic to server group and choose a
server group to send the mirror traffic to.

S

Note  The Mirror traffic to server group check box is only enabled when Traffic Mirroring is enabled
in the VAS Settings dialog box.

Click OK.
The Edit Rule for Service dialog box closes.

All changes to the rule are saved.

Example: Creating Tiered Subscriber Services

Tiered subscriber services can be implemented using the SCA BB Console. Because the definition of
such services is open ended, this section describes how to define two of the tiers outlined in the value
proposition description. The two tiers are defined as follows:
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Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Managing Quotas

e Silver
- Weekly bandwidth limited to 4.2 GB (corresponds to a daily limit of 600 MB)
— Email and browsing services are limited to 256 kbps
— Audio and video streaming services are limited to 64 kbps
— P2P services are limited to 28 kbps
* Gold
Weekly bandwidth limited to 5.6 GB (corresponds to a daily limit of 800 MB)

Email and browsing services are not bandwidth limited

Audio and video streaming services are limited to 128 kbps
— P2P services are limited to 28 kbps
The following steps are applicable to both the 'Silver' and 'Gold' packages.

Create a new package as described in How to Add Packages, page 9-5.

Enable periodical (internal) quota management.

a. Set the aggregation period to Daily

b. b) Set the quota limit to the desired value and give the quota bucket a meaningful name
For further information, see How to Edit Quota Management Settings for Packages, page 9-58.
Add the bandwidth controllers for the required services and set the PIR to the desired rate.

~

Note  Each service that is bandwidth limited requires a sub bandwidth controller that is a child of the
primary bandwidth controller, not an extra bandwidth controller.

For further information, see How to Edit Package Subscriber BWCs, page 9-41.
Add a rule to the package for each bandwidth limited service.
For further information, see How to Add Rules to a Package, page 9-12.

Configure the rule to control the flow's characteristics with the bandwidth controller for the relevant
service.

For further information, see How to Define Per-Flow Actions for a Rule, page 9-14.
Set the usage limit for the package to use the quota bucket defined in Step 2, page 351.

For further information, see the How to Select Quota Buckets for Rules, page 9-60 section.
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Cisco Service Control Application for Broadband User Guide g



Chapter 9 Using the Service Configuration Editor: Traffic Control |

Bl Managing Quotas

Cisco Service Control Application for Broadband User Guide



= CHAPTER 10

Using the Service Configuration Editor:
Additional Options

This chapter explains how to use additional, advanced functionality available in the Service
Configuration Editor.

e The Service Security Dashboard, page 10-1

e Filtering the Traffic Flows, page 10-17

e Managing Subscriber Notifications, page 10-27
e Managing the System Settings, page 10-40

e Managing VAS Settings, page 10-47

The Service Security Dashboard

A

The Service Security Dashboard allows you to view and control all SCA BB security functionality.

The Dashboard is a gateway to a set of features that help you protect your network from security threats
such as worms, DDoS attacks, and spam zombies. It allows configuration of the detection mechanisms
(for example, attack thresholds) and of the actions to be taken when an attack is detected.

The Dashboard also allows you to access malicious traffic reports in the Reporter tool.

Caution  If anomaly-based detection of malicious traffic is enabled, any access control list (ACL) that is
configured on the Service Control Engine (SCE) platform but is not applied to anything (for example,
an interface, an access map, or an SNMP community string) might be deleted when a service
configuration is applied to the platform.

Workaround:

Disable anomaly-based detection of malicious traffic. (Clear the Enable anomaly detection check box.)
e How to View the Service Security Dashboard, page 10-2
e Managing Worm Detection, page 10-2
e Managing Anomaly Detection, page 10-3
e Managing Spam Detection, page 10-14
e Viewing Malicious Traffic Reports, page 10-16

Cisco Service Control Application for Broadband User Guide
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How to View the Service Security Dashhoard

Step 1 In the Network Traffic tab, select Service Security.

Step2  The Service Security Dashboard is displayed in the right pane.

3 Service Configuration Editor - <new service configuration> - SCA BB Console

File Tools Preferences ‘Window Help
B | Q Service Configuration Editor ‘

Q *<new service configuration &3 =0

(8 Folisies | [E1 Classification

+ X
% 4+ X N\ Configuration ~ Signature Based Worm Detection
; S Filkered Traffic view and configure signatures For warms and ather bypes of malicious traffic,
‘% h " - View Repart ] [ View Signatures

(@ Subscriber Policies
Qﬂ Default Package
7 Unknown Subscriber Traffic Anomaly Based Detection of Malicious Traffic

Define anomaly detection settings and mitigation scheme For worms, DoS{DDoS attacks and YoIP threats,

| Enable anomaly detection ieve Reporl onfigure, ..
[v] Enabl ly detect View Report Confi

Spam Zombies and Email Yiruses Detection

Define detection settings and mitigation scheme For Spam Zombies and emall based viruses.

View Report ” Configure...

B console - [21 Problems LR | =
Console

x
[0
==
|
I-

Report Only

274115

Managing Worm Detection

SCA BB uses three mechanisms for detecting worms:

¢ Signature based detection—The SCE platform’s stateful Layer 7 capabilities can detect malicious
activity that is not easily detectable by other mechanisms. You can add signatures for new worms.

¢ Anomaly based detection—Overall traffic analysis can detect anomalies that might indicate worm
activity. See Managing Anomaly Detection, page 10-3.

Mass-mailing based detection—E-mail traffic analysis can detect anomalies that might indicate
e-mail-based worms. See How to Configure Spam Detection Settings, page 10-15.

How to View Supported Worm Signatures

Step 1 In the Service Security Dashboard, click View Signatures.

The Signatures Settings dialog box appears, with Worm Signatures selected in the Signature Type
drop-down list.

All supported worm signatures are listed.
Step2  Click Close.
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The Signatures Settings dialog box closes.

How to Add New Worm Signatures to a Service Configuration

Step 1 Either import the latest DSS or SPQI file provided by Cisco or create a DSS file containing any worm
signatures that you wish to add to the service configuration.

Related Info

For more information, see Managing Protocol Signatures, page 7-34.

Managing Anomaly Detection

The most comprehensive threat detection method is anomaly detection.
¢ Anomaly Detection, page 10-3
¢ Anomaly Detection Parameters, page 10-4
e How to View Anomaly Detection Settings, page 10-5
e How to Add Anomaly Detectors, page 10-7
e Editing Anomaly Detectors, page 10-10
¢ How to Delete Anomaly Detectors, page 10-13

Anomaly Detection

The basic principle of anomaly detection is monitoring successful (correctly established for TCP,
bi-directional for other protocols) and unsuccessful (not properly established for TCP, unidirectional for
other protocols) connection rates both to and from any IP address viewed by the system, and triggering
an anomaly detection condition based of one of the following criteria:

e The total connection rate exceeds a predefined threshold.

¢ The suspicious connection rate exceeds a predefined threshold and the ratio of suspicious to
unsuspicious connections exceeds a predefined threshold.

The ratio metric is a particularly robust indicator of malicious activity, and together with a rate qualifier
serves as a reliable identifier for malicious activity.

Anomaly detection is divided into three categories based on the directional nature of the detected
anomaly condition. The concepts used for the three categories are identical, but the nature of the detected
malicious activity is different for each category.

¢ Scan/Sweep detector—Detects malicious activity based on an anomaly in connection rates from an
IP address.

¢ DoS detector—Detects an anomaly in the connection rate between a pair of IP addresses: one of
them is attacking the other. This can be either an isolated attack or part of a larger scale DDoS attack.

Cisco Service Control Application for Broadband User Guide
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e DDoS detector—Detects an anomaly in the connection rate coming fo an IP address, which means
that it is being attacked. The attack can be by either a single IP address (DoS) or multiple IP
addresses.

For all kinds of anomaly detection conditions, maximum flexibility is provided by the ability to define
detection thresholds and the trigger actions to be taken for each:

¢ Flow direction
¢ Flow protocol

e (Optional) Port uniqueness for TCP and UDP

Note The GUI configuration described here replaces the CLI command set for configuring the Attack Filtering
Module of the SCE platform, which was available in previous releases.

Anomaly Detection Parameters

For each anomaly detector category (Scan/Sweep, DoS, DDoS) there is one default detector. You can
add additional detectors of each category. Detectors in each category are checked in order; the first match
(according to the detector’s threshold settings) triggers detection. You set the order in which detectors
are checked; the default detector is checked last.

Anomaly detectors can contain up to 12 anomaly types associated with malicious traffic:
e Network initiated—Malicious traffic initiated from the network side:
- TCP—Aggregate TCP traffic on all ports
- TCP Specific Ports—TCP traffic on any single port
- UDP—Aggregate UDP traffic on all ports
— UDP Specific Ports—UDP traffic on any single port
- ICMP—Aggregate ICMP traffic on all ports
— Other—Aggregate traffic using other protocol types on all ports
e Subscriber initiated—Malicious traffic initiated from the subscriber side:
- TCP
— TCP Specific Ports
- UDP
— UDP Specific Ports
- ICMP
— Other

N

Note  ICMP and Other anomaly types are not available for DoS attack detectors.

Each anomaly type on a detector has the following attributes associated with it:

e Detection thresholds—There are two thresholds, crossing either of them means that an attack is
defined to be in progress:

— Session Rate threshold—The number of sessions (per second) over specified ports for a single
IP address that trigger the anomaly detection condition.
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— Suspected sessions threshold— Suspected sessions are sessions that are not properly

established (for TCP), or that are unidirectional sessions (for other protocols). Exceeding both
the Suspected Session Rate and the Suspected Session Ratio will trigger the anomaly detection
condition. (A relatively high session rate with a low response rate typically indicates malicious
activity.)

Suspected Session Rate—The number of suspected sessions (per second) over specified ports

for a single IP address.

Suspected Session Ratio—The ratio (as a percentage) between the suspected session rate and
the total session rate. A high ratio indicates that many sessions received no response, an
indication of malicious activity.

Actions—Zero or more of the following actions may be taken when an anomaly detection condition
is triggered (by default, no action is enabled):

Logging of the anomaly to an on-device log file and generation of RDRs is not configurable per anomaly

type.

— Alert User—Generate an SNMP trap (see the “SCA BB Proprietary MIB Reference” chapter of

the Cisco Service Control Application for Broadband Reference Guide for information about the
Cisco proprietary MIB) indicating the beginning and end of an anomaly.

Notify Subscriber—Notify the relevant subscriber of the malicious activity, by redirecting his
browsing sessions to a captive portal. To configure network attack subscriber notification, see
Managing Subscriber Notifications, page 10-27.

Block Attack—Block the relevant sessions. Blocking is performed based on the specification of
the malicious traffic that triggered the anomaly detection condition. If subscriber notification is
enabled for the anomaly type, blocking is not applied to the port relevant for browsing (by
default, this is TCP port 80; see Managing Advanced Service Configuration Options,

page 10-43).

User defined detectors can also have one or more of the following attributes:

IP address list—Limit detection to the listed IP address ranges. This applies to the source IP when
detecting IP sweeps and port scans. It applies to the destination IP when detecting DoS and DDoS
attacks.

TCP port list—Limit detection to the listed destination TCP ports. This list is applied to TCP
Specific Ports anomaly types only.

UDP port list—Limit detection to the listed destination UDP ports. This list is applied to UDP
Specific Ports anomaly types only.

How to View Anomaly Detection Settings

Step 1

You can view a list of all anomaly detectors. The anomaly detectors are displayed in a tree, grouped
according to detector category (Scan/Sweep, DoS, or DDoS).

For each anomaly detector you can view its associated parameters and see a list of all anomaly types
included in the detector, together with their parameters.

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

[ oL-7205-11
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Step 2

The detector tree is displayed in the left area of the dialog box; the right area is empty.

Add, remove and set the order of the detectors,
Detectors are checked from the bottom up and
the first match triggers detection.

The Default Detector is checked last.

%
B
¥ scan/Sweep Default Detector
=My Dos
¥y Dos Default Detector
= ¥J DDoS
¥ DDos Default Detector

158752

In the detector tree, select a detector.

The detector parameters are displayed in the upper right area of the dialog box.

Mame: SM‘I‘P éervers

Apply this detector to the following IP addressesfranges {enter up to 100 comma-separated IP ranges)

| 10.99.99.1/32

[ apply this detector to the following TCP ports {enter up to 15 comma-separated port numbers)

[ Apply this detector to the following UDP ports {enter up to 15 comma-separated port numbers)

The detector’s defined anomaly types are listed in the lower right area of the dialog box, together with

158751

the value of each parameter. The following screen capture shows the default parameter values for the

Scan/Sweep default detector.

[l Cisco Service Control Application for Broadband User Guide

0L-7205-11



| Chapter 10

Using the Service Configuration Editor: Additional Options

Step 3

The Service Security Dashboard

[+ =]

Initiating Side Session Rate | Suspected Session Rate | Suspected Session Ratio | Alert User | Motify Subscriber | Block Attack |
=| Netwark

TCP 1000 500 50 Dizable Disable Disable

TCP Spedfic Ports 1000 500 50 Disable Disable Disable

uoP 1000 500 50 Disable Disable Diszble

UDP Spedific Ports 1000 500 50 Dizable Disable Disable

ICMP 500 250 50 Disable Disable Disable

Other 500 250 50 Disable Disable Disable
|- Subscriber

TCP 1000 500 50 Disable Disable Disable

TCP Spedfic Ports 1000 500 50 Disable Disable Disable

UDP 1000 500 50 Disable Disable Disable

UDF Spedific Ports 1000 500 50 Disable Disable Disable w

210799

If unidirectional classification is enabled, the Suspected Session Rate is set equal to the Session Rate,
which effectively disables anomaly detection by the suspected session trigger.

Initiating Side | Session Rate | Suspected Session Rate
=1 Metwork
TCP 1000 1000
TCP Specific Ports 1000 1000
upp 1000 1000
UDP Spedfic Ports 1000 1000
ICMP 500 500
Other 500 500
=} Subscriber
TCP 1000 1000
TCP Specific Ports 1000 1000 -
UDP 1000 1000 o
UDP Specific Ports 1000 1000 E
Click OK.

The Anomaly Detection Settings dialog box closes.

How to Add Anomaly Detectors

Step 1

Step 2
Step 3

You can add new anomaly detectors. A service configuration can contain up to 100 anomaly detectors.
You define IP address ranges and TCP and UDP ports for the new detector, and one anomaly type.

After you have defined the detector, you can add other anomaly types (see Editing Anomaly Detectors,
page 10-10).

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
In the detector tree, select a detector category.

Click " .

The Anomaly Detector Creation wizard appears, open to the Malicious Traffic Detector page.

[ oL-7205-11
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3£ Anomaly Detector Creation Wizard

Malicious Traffic Detector
3 Detector Detector 1 has no lists set

Mame:; !__?_n_a_tector 1 |

] apply this detector to the following IP addresses/ranges (enter up to 100 comma-separated IP ranges)

[] apply this detector to the following TCP ports {enter up to 15 comma-separated port numbers)

[ Apply this detector to the following UDP ports (enter up to 15 comma-separated port numbers)

Back Next Eirish Cancel

156754

Step 4 In the Name field, enter a meaningful name for the detector.

Step5  Check one or more of the check boxes to limit the scope of the detector.
The relevant fields are enabled.

Step6  Enter lists of IP addresses or ports in the relevant fields.

Step7  Click Next.

The Malicious Traffic Characteristics for a WORM attack page of the Anomaly Detector Creation
wizard opens.

3 Anomaly Detector Creation Wizard @

Malicious Traffic Characteristics for a WORM attack
Define the type of attadk you wish to create

Malicious Traffic Originator
() Subscriber () Network

Malicious Traffic Transport
@ T1CcP (O TCP-SpecificPorts (JUDP ()UDP-SpedificPorts () ICMP () Other

[ <Back |} Mext> |I Finish H Cancel ]

158755

Step8 Depending on the detector type that you are defining, select the originating side or the target side.
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e If you are defining a Scan/Sweep detector or a DoS detector, select the originating side for the
anomaly type you are defining.

e If you are defining a DDoS detector, select the target side for the anomaly type you are defining.
Step9  Select a transport type for the anomaly type that you are defining.
Step10 Click Next.

The Anomaly Detection Thresholds page of the Anomaly Detector Creation wizard opens.

3£ Anomaly Detector Creation Wizard @

Anomaly Detection Thresholds

Define attack detection thresholds, or use the Default Detector's
values

Malicious Traffic Detection Thresholds
[ Use the Default Detector's settings

an anomaly will be detected once flow rate exceeds this threshold.

Flow Open Rate (flowsfsec) 50

An anomaly will be detected once suspected flow rate exceeds threshold AND
suspected flows ratio exceeds threshald.

Suspected Flows Rate (flows/sec) 50

Ratio of Suspected Flow Rate [5&) 50

’ < Back ]| MNext = |[ Finish H Cancel

156756

Step11  Set the detector settings for this anomaly type.
Do one of the following:
e To use the default detector’s settings, check the Use the Default Detector’s settings check box.
¢ Enter values in the Flow Open Rate, Suspected Flows Rate, and Ratio of Suspected Flow Rate fields.
Step12 Click Next.

The Anomaly Detection Action Settings page of the Anomaly Detector Creation wizard opens.

[ oL-7205-11

Cisco Service Control Application for Broadband User Guide g



Chapter 10 Using the Service Configuration Editor: Additional Options |

I The Service Security Dashboard

3 Anomaly Detector Creation Wizard @

Anomaly Detection Action Settings

Choose the actions to perform upon detecting malidous
attack

Block
Block malidious traffic

(%) Use the Default Detector's settings () Enable () Disable

Alert

Generate an SNMP trap

(%) Use the Default Detector's settings () Enable () Disable

Maotify Subscriber

Motify the subscriber through browser redirect

(%) Use the Default Detector's settings (JEnable () Disable

[ Einish l ’ Cancel

158757

Step13  Select Block, Alert, and Notify Subscriber actions.
Step14 Click Finish.
The Anomaly Detector Creation wizard closes.

The new detector is added to the detector tree.

What to Do Next

You can now add additional anomaly types to the detector. (See Editing Anomaly Detectors,
page 10-10.)

Editing Anomaly Detectors

You can perform the following actions on a user-defined anomaly detector:
e Edit detector parameters.
e Edit anomaly types.
e Add anomaly types.
e Delete anomaly types.
¢ Change the order of the detectors in the detector tree.

For each detector category, detectors are checked, bottom-up, in the order that they are listed in the
detector tree; the default detector is checked last.

You can edit the anomaly types of the three default detectors.
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Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Step 8
Step 9

The Service Security Dashboard

How to Edit Detector Parameters

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

In the detector tree, select a detector.

The detector parameters are displayed in the upper right area of the dialog box.
In the Name field, enter a new name for the detector.

Check or uncheck the IP address range and ports check boxes.

Enter or modify lists of IP addresses or ports in the relevant fields.

Click OK.

The Anomaly Detection Settings dialog box closes.

Your changes are saved.

How to Edit Anomaly Types

In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

In the detector tree, select a detector.

Information about the anomaly types is displayed in the lower right area of the dialog box.
Double-click an anomaly type.

The Anomaly Detector Creation wizard appears, open to the Anomaly Detection Thresholds page (see
How to Add an Anomaly Type, page 10-12).

Set the detector settings for this anomaly type.
Do one of the following:
e To use the default detector’s settings, check the Use the Default Detector’s settings check box.

¢ Change the values in the Flow Open Rate, Suspected Flows Rate, and Ratio of Suspected Flow Rate
fields.

Click Next.

The Anomaly Detection Action Settings page of the Anomaly Detector Creation wizard opens.
Change Block, Alert, and Notify Subscriber actions.

Click Finish.

The Anomaly Detector Creation wizard closes.

The anomaly type is updated with your changes.

Repeat Steps 3 to 7 (or Steps 2 to 7) for other anomaly types.

Click OK.

[ oL-7205-11
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The Anomaly Detection Settings dialog box closes.

How to Add an Anomaly Type

Step1  In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
Step 2 In the detector tree, select a detector.

The anomaly types are listed in the lower right area of the dialog box.
Step3  Click 0 (Create New Detector Item Under Detector Items Feature).

The Anomaly Detector Creation wizard appears, open to the Malicious Traffic Characteristics for a
WORM attack page (see How to Add Anomaly Detectors, page 10-7).

Step4  Select an origin for the anomaly type you are defining.
Step5  Select a transport type for the anomaly type you are defining.
Step6  Click Next.
The Anomaly Detection Thresholds page of the Anomaly Detector Creation wizard opens.
Step7  Set the detector settings for this anomaly type.
Do one of the following:
e To use the default detector’s settings, check the Use the Default Detector’s settings check box.
¢ Enter values in the Flow Open Rate, Suspected Flows Rate, and Ratio of Suspected Flow Rate fields.
Step8  Click Next.
The Anomaly Detection Action Settings page of the Anomaly Detector Creation wizard opens.
Step 9 Select Block, Alert, and Notify Subscriber actions.
Step10 Click Finish.
The Anomaly Detector Creation wizard closes.
The new anomaly type is added to the anomaly type list.
Step11  Repeat Steps 3 to 10 (or Steps 2 to 10) for other anomaly types.
Step12 Click OK.

The Anomaly Detection Settings dialog box closes.

How to Delete an Anomaly Type

Step1  In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
Step 2 In the detector tree, select a detector.
The anomaly types are listed in the lower right area of the dialog box.

Step3  In the anomaly type list, select an anomaly type.
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Stepd  Click 9% .

The selected anomaly type is deleted from the anomaly type list.
Step5  Repeat Steps 3 and 4 (or Steps 2 to 4) for other anomaly types.
Step6  Click OK.

The Anomaly Detection Settings dialog box closes.

How to Change the Order in which Detectors are Checked

Step 1 In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.
Step 2 In the detector tree, select a detector.

The move up arrow, the move down arrow, or both are enabled, depending on the detectors location in
the tree.

Add, remove and set the order of the detectars,
Detectors are checked from the bottom up and
the first match triggers detection.

The Default Detector is checked last.

i = ¥

=¥ Scan/sweep

¥l scan/sweep Default Detector
= My Dos

¥J DoS Default Detector
=-#J DDoS

¥ DDos Default Detector

Elj DMS Servers

o

158753

Step3  Using these navigation arrows, move the detector to its desired location.
Stepd  Repeat Steps 2 and 3 for other detectors.
Step5 Click OK.

The Anomaly Detection Settings dialog box closes.

Your changes are saved.

How to Delete Anomaly Detectors

You can delete any or all user-defined detectors.

You cannot delete the three default detectors.

Step 1 In the Service Security Dashboard, in the Anomaly Based Detection of Malicious Traffic pane, click
Configure.

The Anomaly Detection Settings dialog box appears.

Step 2 In the detector tree, select one or more user-defined detectors.

Cisco Service Control Application for Broadband User Guide
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Step3  Click 4% .

A Confirm Delete message appears.

3£ Confirm Delete

€p | Are you sure you want to delete Detector "SMTP Servers™

ok | [ Cancel

158788

Step4  Click OK.
The selected detectors are deleted and are no longer displayed in the detector tree.
Step5 Click OK.

The Anomaly Detection Settings dialog box closes.

Managing Spam Detection

The anomalous e-mail detection method monitors SMTP session rates for individual subscribers. A high
rate of SMTP sessions from an individual subscriber is usually an indicator of malicious activity that
involves sending e-mail (either mail-based viruses or spam-zombie activity).

This method will work only if the system is configured in subscriber-aware or anonymous subscriber
mode. This allows the SCE to accurately account the number of SMTP sessions generated per subscriber.

The detection method is based on the following:

e Typical broadband subscribers generate a small number of SMTP sessions (at most a single session
each time they send an e-mail message).

e Typical broadband subscribers normally use the ISP’s SMTP server (as configured in their mail
client) as their only mail relay, and do not communicate with off-net SMTP servers.

e Spam zombies create many SMTP sessions, mainly to off-net servers (the mail servers of the
destined recipient of the messages).

When configuring spam detection, you select an appropriate service to monitor. By default, this is the
built-in SMTP service. To improve detection sensitivity, you can create a more specific service to narrow
the scope of detection. Two possible services are:

e “Outbound SMTP”—SMTP sessions generated by the subscriber.

e “OffNet SMTP”—SMTP sessions that are not targeted to the SMTP server of the subscriber’s ISP.
Limiting the service to OffNet can avoid accounting for legitimate sessions.

Note  Prominent non-ISP e-mail providers (for example, Google and Yahoo!) now provide SMTP-based
service, so OffNet is no longer a very good differentiator between legitimate and illegitimate activity. To
refine the OffNet service, you must include an SMTP server list in the “OnNet SMTP” service definition;
all other SMTP servers will be OffNet.
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How to Configure Spam Detection Settings

Step1  In the Service Security Dashboard, in the Spam Zombies and Email Viruses Detection pane, click
Configure.

The Spam Detection and Mitigation settings dialog box appears.

3£ Spam Setting

Spam Detection
This Wizard helps you configure detection and mitigation settings for Spam zombies and email based viruses
activity.
Enable Spam detection

Spam is detected based on exceeding & predefined quota of sessions for SMTF,
For best accuracy, detect Spam/email virus activity on a service that indudes “outbound SMTP® or “outbound off-net SMTP™.

Service to monitor for Spam: EMI'P ¥ |
Define Spam as | 10 | sessions over | 30 | seconds.

Select the action to take upon detection of Spam Zombie [ email virus activity,

Action upon detection §Ignore A '

Subscriber Motification

[ FEinish l [ Cancel ]

zlo0iz

Step2  (Optional) To disable spam detection, uncheck the Enable Spam detection and mitigation check box.
All other fields are disabled.

Continue at Step 7.

Step3  From the Service to monitor for Spam drop-down list, select the monitored service.

Note  Leave the default value for the monitored service (SMTP), unless you have defined a more specific
service, such as “Outbound SMTP” or “OffNet SMTP”.

Step4  For each package, do the following:

a. Define the quota to be used for indicating anomalous email activity. The quota is defined as a
number of sessions for a given period—number of sessions and period length are both configurable.
It is suggested to base the values for these fields on some baseline monitoring of subscriber activity.

— Click in the Detection threshold column.
A More button ( ) appears.
— Click the More button.

Cisco Service Control Application for Broadband User Guide
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¥ Spam detection threshold @I

Spam detection threshold for package Default Package

Spam is detected when a subscriber exceeds a predefined SMTP session rate.,

Enable sparm detection for this package

Define spam as | 1000000 | sessions over | 1 seconds,

[ o8 H Cancel ]

250623

— Define the threshold e-mail session rate for anomalous behavior.
- Click OK.
b. Define one or more actions to be taken upon detecting mass-mailing activity.
Available actions are:

— Send RDR—A Raw Data Record (RDR) is sent from the SCE to the Collection Manager (CM),
and a second RDR is sent when the subscriber's status as a spammer is removed. The CM
collects these RDRs in CSV files for logging purposes. Alternatively, you can implement your
own RDR collectors to receive these RDRs and respond in real-time.

- Block selected service Traffic—Block the spam SMTP traffic.

— Notify Subscriber (HTTP)—Redirect the subscriber browsing sessions to a captive portal
presenting a message from the operator. This is done using "subscriber notification".

— Mirror SMTP traffic—Divert spam SMTP traffic to an inline spam detection service.

Note  For the send RDR action, one RDR is sent when the subscriber is marked as a spammer and a
second RDR is sent once the subscriber is no longer considered a spammer. However, when
using the block, notify, and mirror actions, the action begins when the subscriber is marked as a
spammer and is maintained until the subscriber is no longer considered a spammer.

N

m Block selected service Traffic and Mirror SMTP traffic cannot both be selected

Step5  If you selected Notify Subscriber (HTTP), choose or enter a notify subscriber.
Step6  If you selected Mirror SMTP traffic, choose a server group.
Step7  Click Finish.

The Spam Detection and Mitigation settings dialog box closes.

Viewing Malicious Traffic Reports

Information about detected traffic anomalies is stored in the Collection Manager database. You can use
this information for network trending, detection of new threats, and tracking of malicious hosts or
subscribers.
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e Malicious Traffic Reports, page 10-17
e How to View a Service Security Report, page 10-17

Malicious Traffic Reports

A number of reports dealing with malicious traffic can be displayed in the Reporter tool:
¢ Global reports:
- Global Scan or Attack Rate
- Global DoS Rate
— Infected Subscribers
— Infected Subscribers vs Active Subscribers
— DoS Attacked Subscribers
— Top Scanned or Attacked ports
¢ Individual subscriber or hosts reports:
— Top Scanning or Attacking hosts
— Top DoS Attacked hosts
— Top DoS Attacked Subscribers

— Top Scanning or Attacking Subscribers
How to View a Service Security Report

Step 1 In the Service Security Dashboard, in the relevant pane, click View Report.
A Choose a report dialog box appears, displaying a tree of relevant reports.
Step2  Select a report from the report tree.
Step3  Click OK.
The Choose a report dialog box closes.
The Reporter tool opens in the Console, and displays the requested report.

Step4  For information about manipulating and saving the report, see the “Working with Reports” chapter of
the Cisco Service Control Application Reporter User Guide.

Filtering the Traffic Flows

Filter rules are part of service configurations. They allow you to instruct the Service Control Engine
(SCE) platform, based on a flow’s Layer 3 and Layer 4 properties, to:

e Bypass—Ignore the flow and transmit it unchanged.

¢ Quick forward—Duplicate the flow and send one copy directly to the transmit queue to ensure
minimal delay. The second copy goes through the normal packet path.

When a traffic flow enters the SCE platform, the platform checks whether a filter rule applies to this flow.

Cisco Service Control Application for Broadband User Guide
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Note

If a filter rule applies to this traffic flow, the SCE platform passes the traffic flow to its transmit queues.
No RDR generation or service configuration enforcement is performed; these flows will not appear in

any records generated for analysis purposes and will not be controlled by any rule belonging to the active
service configuration.

It is recommended that you add filter rules for OSS protocols (such as DHCP) and routing protocols
(such as BGP) that might traverse the SCE platform. These protocols usually should not be affected by
policy enforcement, and their low volume makes them insignificant for reporting.

A number of predefined filter rules are included in every new service configuration.

By default, some, but not all, of the predefined filter rules are active.

Flows of certain protocols can also be filtered according to the flow’s Layer 7 characteristics. (See
Managing Advanced Service Configuration Options, page 10-43.) Like other filtered flows, Layer 7
filtered flows are not controlled, but can be classified and reported. The flows of the protocols that can
be filtered are typically short and their overall volume is negligible, so filtering these protocols has little
effect on network bandwidth and on the accuracy of the SCA BB reports.

¢ Information About Traffic Filtering, page 10-18

e How to View Filter Rules for a Package, page 10-20

e How to Add Filter Rules, page 10-21

e How to Edit Filter Rules, page 10-26

e How to Delete Filter Rules, page 10-26

e How to Activate and Deactivate Filter Rules, page 10-27

Information About Traffic Filtering

Note

For certain types of traffic, service providers may need to reduce the latency and jitter introduced by the
SCE platform or even to bypass the SCE platform to avoid traffic control as well. Typically, such
decisions are made for a portion of the traffic, to reduce latency for delay sensitive applications, such as
voice, and to bypass mission-critical traffic, such as routing protocols. The SCA BB Filtered Traffic
mechanism is used to address this need.

Most voice traffic is handled automatically by the SCE platform to reduce latency (see Automatic Quick
Forwarding of Media Flows, page 10-20).

e The SCA BB Filtered Traffic Mechanism, page 10-19

e Filter Rule Actions, page 10-19

e Filter Rules and Service Rules, page 10-20

e Automatic Quick Forwarding of Media Flows, page 10-20
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The SCA BB Filtered Traffic Mechanism

Note

Note

Note

The SCA BB Filtered Traffic mechanism reduces latency or completely bypasses portions of the traffic
by defining filter rules that match relevant flows and assign the correct action to them. A filter rule
matches a packet according to its Layer 3 and Layer 4 properties, such as IP address, port number, and
DSCP ToS, as well as the SCE platform interface (subscriber or network) from which the packet arrived.
For packets that match a filter rule, the following actions can be applied:

¢ Bypass the current packet (to reduce latency and avoid traffic control).

When this action is applied, the current packet is directly transmitted from the SCE platform without
going through any service configuration processing or reporting. You must map the bypassed packet
to a Class of Service (CoS) to assign it to one of the transmit queues of the SCE platform.

Possible values for CoS are BE, AF1, AF2, AF3, AF4, and EF; where EF implies high processing
priority and the other classes imply normal processing priority.

¢ Quick forward the flow (to reduce latency).

When this action is applied, the current packet and all subsequent packets belonging to the same
flow are duplicated and sent through two different paths: the original packet goes directly to the
transmit queue, and thus has only a minimal delay, while a copy of the packet goes through the
normal service configuration processing path for classification and reporting, and is then discarded.

e Assign the flow to the high priority processing input queue (to reduce latency).

Not all platforms support this option.

e When this action is applied, the current packet and all subsequent packets belonging to the same
flow enter the high priority processing input queue. They go through the normal service
configuration processing path ahead of other packets that arrive simultaneously. You should map the
flow to the EF CoS to assign it to the high processing priority transmit queue of the SCE platform.

In an MPLS environment, the SCE platform does not map the DSCP bits to the EXP bits of the MPLS
header.

A filter rule can perform DSCP ToS marking (by changing the DSCP ToS field of the packet) of the
matched traffic in conjunction with any of the above actions.

DSCP ToS marking and the assignment to CoS only take place when the operational mode of the system
is Full Functionality (see System Operational Mode, page 10-40).

Filter Rule Actions

The Bypass and Quick forward actions apply to different scopes of traffic:

¢ The Bypass action only bypasses the current packet; every subsequent packet of the same flow goes
through the Filtered Traffic mechanism. This means, for example, that when traffic is to be bypassed
based on its destination port number, two rules should be created in order to match packets from
both sides of a bidirectional flow.

For example, to bypass all traffic to destination port 23, two filter rules are needed, one for packets
arriving from the subscriber side addressed to network side port 23, and another for packets arriving
from the network side addressed to subscriber side port 23.

[ oL-7205-11
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e The Quick forward action is applied to the entire flow; once identified, all subsequent packets do
not go through the filter rule mechanism, instead going through normal service configuration
processing.

A packet may match more than one filter rule. If both Bypass and Quick forward are matched, the
packet/flow will be bypassed with minimum delay. Furthermore, if only Bypass is matched, the
packet/flow will also be bypassed with minimum delay.

Filter Rules and Service Rules

Filter rule actions to reduce latency allow the flow to be controlled by the SCE platform. This means that
the flow can be blocked or given limited bandwidth if it matches a service rule. For example, if a filter
rule is applied to reduce latency, but a service configuration rule is applied to block the same traffic, the
traffic will be blocked.

The Bypass action is designed to avoid service configuration processing; bypassed traffic is not affected
by service rules.

Automatic Quick Forwarding of Media Flows

The SCE platform reduces the latency of delay-sensitive voice and video media flows by applying the
quick-forwarding action to SIP, MGCP, H323, Skinny, and RTSP media flows during classification. That
is, when a media flow is classified as being of one of these types, it will be subject to quick forwarding
immediately. The SCE platform does this automatically, regardless of filter rule configuration. These
media flows might still be blocked or given limited bandwidth if they match a service rule.

How to View Filter Rules for a Package

You can view a list of the filter rules included in a service configuration.

The listing for each filter rule includes the name, the status, and a brief description (generated by the
system) of the rule.

To see more information about a filter rule, open the Edit Filter Rule dialog box (see How to Edit Filter
Rules, page 10-26).

Step 1 In the Policies tab, select the Filtered Traffic node.
A list of all filter rules is displayed in the right (Rule) pane.

& *<new service configuration> 53 =0
Policies : Filtered Traffic

[# policies

@ M % Corfiguration ~ er Rule : 2 Filter

Classification

ered Traffic el
-My Service Security
5 Global Policy
=@ Subscriber Policies
- DHS (ko network) ol
#2 Default Parkags Inebwark-side part is equal to 53,
*-7 Unknown Subscriber Traffic Ipackets bypass the polcy engine,
[Cos is set to BE'
DN (ko subscriber) |Applies to LIDP packets,
lsubscriber-side port is equal to 53,
v )
lpackets bypass the policy endine,
[Ca3 s set to BE'
net-bios (ko networ \Applies ko UDP packets,
Inebwork-side port is equal to 137,
Ipacksts bypass the plicy engine,
[Cos is set to BE'
net-bios (to subscribl |Applies to LIDP packets,
lsubscriber-side port is equal to 137,
v
lpackets bypass the policy endine,
o ic cat to B!

274085
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How to Add Filter Rules

Step 1
Step 2

Step 3

Step 4

The Add Filter Rule wizard guides you through the process of adding a filter rule.

In the Policies tab, select the Filtered Traffic node.
Click ':E:' (Add Rule) in the right (Rule) pane.
The Add Filter Rule wizard appears.

Add Filter Rule

Constructing a Filker Rule consists of defining the parameters
of packets that are to be bypassed with no processing.

The system will aukomatically bypass packets that match one of
the Filter Rules definitions. Mote that Filker Rules anly apply
to packets that do not have an open flow context,

Construct a Filter Rule by defining the Filter walues far a
variety of packet properties.

274072

Click Next.

The Transport Type and Direction page of the Add Filter Rule wizard opens.

Add Filter Rule

Apply to packets where the transport byvpe is: ?(.ﬂny) w [

Apply to packets that arrive Fram:
() the netwark side
() the subscriber side
(%) either side
Moke: In most cases, 'either side’ should be selected. wWhen filtering one side only, a response

packet atriving from the opposite side will nok match the rule, hence a Flow context would be
created for it, and all consecutive flow packets will be processed instead of being bypassed,

[ Clase ] [ < Back. H Text = l Finish |

274073

Select the transport type and initiating side and click Next.

The Subscriber-Side IP Address page of the Add Filter Rule wizard opens.

Filtering the Traffic Flows

[ oL-7205-11
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Step 5

Step 6

Add Filter Rule

Apply bo packets where the subscriber-side IP address is:
() Any IP address

() Equal ta ;____ [ |

O Cther than [00.0.10 |

() In the range of [D.0.0:0 |-|0.0.0i0 |

() Mot in the range of | 0.0.0.0 |={o.0oo |

[ Close ] [ < Back. H Mexk = ]

158738

Define the subscriber-side IP address and click Next.

The Network-Side IP Address page of the Add Filter Rule wizard opens.

Add Filter Rule

apply ko packets where the network-side IP address is:
(%) Any IP address

() Equal ta ;____ [ |

() Other Ehan |_ il

() In the range of [0.0.0:0 |={0.0.0:0 |

(7 Mot in the range of | 0.0.0.0 | e R |

’ Close ] [ < Back ]l_ Mext = J

158739

Define the network-side IP address and click Next.

If the transport type selected in Step 4 was not TCP or UDP, the ToS page of the Add Filter Rule wizard

opens. Go to Step 9.

If the transport type selected in Step 4 was TCP or UDP, the Subscriber-Side Port page of the Add Filter

Rule wizard opens.

[l Cisco Service Control Application for Broadband User Guide
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Filtering the Traffic Flows

Add Filter Rule

Apply bo packets where the subscriber-side port is:
() Any port

() Equal ta I__ |

() In the range of [0 |={0

(O Matinthe range of |0 3 0

[ Close ]

[ < Back. H Mexk = ]

158740

158741

Step7  Define the subscriber-side port and click Next.
The Network-Side Port page of the Add Filter Rule wizard opens.
Add Filter Rule
apply bo packets where the network-side patt is:
() Any port
() Equal ta I__ |
() Other Ehan |_ |
() In the range of [0 Ji=i{ 0 |
() Mot in the range of | ] 1= 1 |
’ Close ] [ < Back ] [ Mext = ]
Step8  Define the network-side port and click Next.

The ToS page of the Add Filter Rule wizard opens.

[ oL-7205-11
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Add Filter Rule

Apply bo packets where the To3 is:
(%) Any value
() Equal ta ; i] |

(O other than | |

() In the range of [0 1-{0 1

() Mot in the range of | | ]

[ Close ] [ < Back. H Mexk = Finish

158742

Step9  Define the ToS and click Next.

Note  Acceptable values for ToS are O to 255.

The Action and Class-of-Service page of the Add Filter Rule wizard opens.

Add Filter Rule

Select the action to apply on packets with properties matching this filter's definitions.

(%) Bypass - Packets bypass the SCABE application,

CQuick Forward - Packets are Forwarded to the Tx queue in parallel to being processed
O offline

The system maps the filkered packets to a certain Class-of-Service,

Select the Cos to use: QBE vi

[ Close ] [ < Back ][ Mext = ] Firiish

211739

Step10  Select the radio button for the required action.
e Bypass —Packets that match this filter rule are not passed to SCA BB.

¢ Quick Forward —The SCE platform ensures low latency for packets that match this filter rule (use
for delay sensitive flows). Packets are duplicated and passed to SCA BB for processing.

Step11  Select a Class-of-Service value, and click Next.

The ToS Marking page of the Add Filter Rule wizard opens.
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Filtering the Traffic Flows

Add Filter Rule

[] Remark Upstream ToS with To5 Marker | TS 111

[] Remark Downstream ToS with ToS Marker I 511 |
Eortioe |

To5 Marking allows to set the ToS walue of the filtered traffic.

Choosing not ko set the ToS will keep the packets' original ToS value

[ Close ]

[ < Back. H Mexk = ]

211735

274074

Step12  (Optional) To change the DSCP ToS marker of packets in the filtered traffic, check the Remark
Upstream ToS with ToS Marker and Remark Downstream ToS with ToS Marker check boxes, as
required, select the required ToS marker from the drop-down list, and click Next.

e Disabling directional DSCP ToS marking in the ToS Marking Settings dialog box (see How to
Manage DSCP ToS Marker Values, page 9-28) overrides DSCP ToS marking in that direction by a
filter (that is, the DSCP ToS value will not be changed). In this case, the Problems View will display
a Warning.

e Ifyou filter for a flow in one direction in Step 4 but select ToS marking in the other direction in this
Step, the filter rule will be created, but no DSCP ToS remarking will occur. In this case, the Problems
View will display a Warning.

e If you select Quick Forward in the previous Step, SCA BB receives the original package and
processes it. That is, the original DSCP ToS value is seen by the application regardless of the ToS
marking action selected in the filter rule.

The Finish page of the Add Filter Rule wizard opens.
Applies to TCP packets,
The packets bypass the policy engine, and are mapped to Cos BE
Rule Marme
| Filker Rule 1
[] Activate this Rule
[ Close ] [ < Back ]
Step13 In the Rule Name field, enter a unique name for the new filter rule.

[ oL-7205-11
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S

Note  You can use the default name for the filter rule. It is recommended that you enter a meaningful name.

Step14  (Optional) To activate the filter rule, check the Activate this rule check box. Traffic is filtered according
to the rule only when it is activated.

Step15 Click Finish.
The Add Filter Rule wizard closes.
The filter rule is added and is displayed in the Filter Rule table.

How to Edit Filter Rules

You can view and edit the parameters of a filter rule.

Step 1 In the Policies tab, select the Filtered Traffic node.
A list of all filter rules is displayed in the right (Rule) pane.
Step2  Select a rule in the Filter Rule table.
Step3  Click _* (Edit Rule).
The Introduction page of the Edit Filter Rule wizard appears.
The Edit Filter Rule wizard is the same as the Add Filter Rule wizard.
Step4  Follow the instructions in the section How to Add Filter Rules, page 10-21, Steps 4 to 14.
Step5  Click Finish.

The filter rule is changed and relevant changes appear in the Filter Rule table.

How to Delete Filter Rules

You can delete filter rules. This is useful, for example, when you want the system to resume handling
the IP addresses and their attributes according to the individual rules that were previously defined for
each subscriber IP address.

Step 1 In the Policies tab, select the Filtered Traffic node.

A list of all filter rules is displayed in the right (Rule) pane.
Step2  Select a rule in the Filter Rule table.
Step3  Click ﬁ (Delete Rule).

A Filter Rule Warning message appears.
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Managing Subscriber Notifications 1l

3 Filter Rule Warning

158825

Click Yes.

The filter rule is deleted and is no longer displayed in the Filter Rule table.

How to Activate and Deactivate Filter Rules

Step 1

Step 2
Step 3
Step 4
Step 5

You can activate or deactivate filter rules at any time. Deactivating a filter rule has the same effect as
deleting it, but the parameters are retained in the service configuration, and you can reactivate the filter
rule at a later date.

In the Policies tab, select the Filtered Traffic node.

A list of all filter rules is displayed in the right (Rule) pane.
Select a rule in the Filter Rule table.

To activate the rule, check the Active check box.

To deactivate the rule, uncheck the Active check box.

Repeat Steps 3 and 4 for other rules.

Managing Subscriber Notifications

Note

The subscriber notification feature pushes web-based messages to a subscriber by redirecting the
subscriber HTTP traffic to relevant web pages. These web pages contain information relevant to the
subscriber, such as notifications of quota depletion. HTTP redirection starts when the subscriber
notification is activated and ceases when the notification is dismissed.

Subscriber notification is not supported when unidirectional classification is enabled.

Each set of subscriber redirection parameters comprises a notification redirect profile. The Cisco
Service Control Application for Broadband (SCA BB) supports a maximum of 128 redirect profiles,
including notification and redirect profiles. There are 3 default redirect profiles that cannot be deleted:
Default Notification, Network Attack Notification and Default Redirection. You configure which
notification redirect profile to use when defining rules

e Subscriber Notification Parameters, page 10-28

e Network Attack Notification, page 10-29

e How to Add a Notification Redirect Profile, page 10-30
e How to Add a Set of Redirection URLs, page 10-38

[ oL-7205-11
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Subscriber Notification Parameters

Note

Each redirect profile of type notification contains the following subscriber notification parameters:

The Activation trigger configuration options are only available for redirect profile of type redirect.

Name—Each profile must have a unique name.

You cannot change the name of the Default Notification or the Network Attack Notification.

Note

Redirect profile type—Each profile must be one of two types:
— Notification
- Redirect

Set of Redirection URLs—A configurable set of destination URLs, to which the subscriber’s HTTP
flows are redirected after redirection is activated. This web page usually contains the message that
needs to be conveyed to the subscriber. The redirection set can optionally include one, or several
parameters appended to the destination URL including the redirect reason and subscriber ID.

The destination web server can use these parameters to carry a more purposeful message to the
subscriber.

Activation frequency—Indicates when to activate the notification redirect. The activation frequency
is one of the following:

The Periodically option is only available for redirect profile of type redirect.

Only once—The subscriber is redirected to the notification only the first time the conditions are met.

For example, if a quota was exceeded, the subscriber browses to the destination URL that informs
them of this fact, only once (even though the subscriber still remains in a breach state).

Always—The subscriber is redirected to the notification every time the conditions are met.

For example, if a quota was exceeded, the subscriber is continuously redirected to the notification
until the subscriber completes the procedure to refresh their quota.

Until the subscriber browses to—Every time the conditions are met, the subscriber is redirected to
the notification, until the subscriber proceeds from the destination URL to a different, final URL.

For example, if a quota was exceeded, the web page at the destination URL may ask the subscriber
to press an Acknowledge button after reading the message. The acknowledge URL would be defined
as the dismissal URL and would deactivate further notifications.

The dismissal URL is composed of the URL hostname and the URL path, separated by a colon, in
the following format:

[*]<hostname>:<path>[*]
— <hostname> may optionally be preceded by a wildcard (*), to match all hostnames with the
same suffix.

— The path element must always start with ““/”.
— <path> may be followed by a wildcard (¥), to match all paths with a common prefix.

For example, the entry *.some-isp.net:/redirect/* matches all the following URLs:
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* www.some-isp.net/redirect/index.html
* support.some-isp.net/redirect/info/warning.asp
* noquota.some-isp.net/redirect/acknowledge.aspx?ie=UTF-8

e List of Allowed URLs—A list of URLs that will not be blocked and redirected even though
redirection is activated.

After redirection is activated, all HTTP flows, except flows to the destination URL and to the
dismissal URL, are blocked and redirected to the destination URL. However, subscribers can be
permitted to access an additional set of URLs. This is useful, for example, to give subscribers access
to additional support information.

Allowed URLSs have the same format as the dismissal URL.

These parameters are defined when you add a new notification redirect profile (see How to Add a Set of
Redirection URLs, page 10-38). You can modify them at any time.

Network Attack Notification

A

Subscriber notification informs a subscriber in real-time about current attacks involving IP addresses
mapped to that subscriber. (Enabling these notifications is described in The Service Security Dashboard,
page 10-1.) SCA BB notifies the subscriber about the attack by redirecting HTTP flows originating from
the subscriber to a server that supplies information about the attack.

One subscriber notification, Network Attack Notification, is dedicated to providing these notifications;
it cannot be deleted. A Network Attack Notification is not dismissed at the end of an attack; subscribers
must respond to it.

To allow redirection when blocking traffic, the system is configured to leave open one specified TCP
port (by default, port 80). See Managing Advanced Service Configuration Options, page 10-43.

Caution

In earlier releases of SCA BB, configuring network attack notifications was performed using CLI
commands. CLI commands should no longer be used for this purpose.

e Network Attack Notification Parameters, page 10-29
e Example of URL with Description Tail, page 10-30

Network Attack Notification Parameters

When a network attack is detected, HTTP flows of the subscriber are redirected to a configurable
destination URL. This web page should display the warning that needs to be conveyed to the subscriber.

Optionally, the destination URL can include a query part containing notification parameters. The
destination web server can use these parameters to create a more specific warning to the subscriber.

The query part of the URL has the following format:

?ip=<ip>&side=<side>&dir=<dir>&prot=<protocol>&no=<open-flows>&nd=<suspected-flows>&to=<op
en-flows-threshold>&td=<suspected-flows-threshold>&ac=<action>&nh=>handled-flows>
The meaning of each field in the tail is described in Table 10-1:

[ oL-7205-11
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Table 10-1 Description Tail Fields
Field Description Possible Values
ip Detected IP address
side e s—Subscriber
e n—Network
dir e s—Source
e d—Destination
protocol e TCP
e UDP
e ICMP
e OTHER
open-flows Number of open flows
suspected flows Number of attack-suspected
flows
open-flows-threshold Threshold for open flows
suspected-flows-threshold Threshold for attack-suspected
flows
action e R—Report

e B—Block and report

handled-flows

Number of flows handled since
the attack began

(Non-zero only during and at the
end of an attack)

Example of URL with Description Tail

http://www.some-isp.net/warning?ip=80.178.113.222&side=s&proto=TCP&no=34&nd=4&to=34&td=10&

ac=B&nh=100

How to Add a Notification Redirect Profile

~

Note

Step 1

Creating a notification redirect profile does not activate the subscriber notification feature. After the
notification redirect profile is defined, it must be activated for a particular package

.From the Policies tab in the left pane, choose Configuration > Subscriber Redirection.

The Redirect Actions Settings dialog box appears.

[l Cisco Service Control Application for Broadband User Guide
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3 Redirect Actions Settings

X

Create and edit Redirect Profiles

Configure the redirection parameters

Default Mokfication
Defaulk Redirection

General |Activati0n Allowed URLs

Mamne: | Metwork Attack Motification

Select redirection profile type:

Manage redirect sets:

Select URL set: |DeFauIt set [htbpe . my-http-server, comfredirect . cgi) -

[ CK H Cancel ] g

Step2  Click Add.

A new redirection profile containing the default redirection URL set is added to the redirection profile
list.

Step 3 In the Name field, enter a unique name for the new notification redirect profile.

Note  You can use the default name for the notification redirect profile. It is recommended that you enter a
meaningful name

Step4  In the Select redirection profile type field, select Notification.

Do not skip this step or a redirect profile will be created instead of a notification redirect profile.
Step5 Choose a URL set.
Step6  Click the Activation tab.

The Activation tab opens.

Cisco Service Control Application for Broadband User Guide
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Step 7

Step 8

Step 9

3 Redirect Actions Settings

Configure the redirection parameters

Network Attack Motification
Diefault Matification
Default Redirection

ion Profile 1

Create and edit Redirect Profiles

General | Adtivation | Alowed URLs

X

Activation trigger®
Activate upon:
() subscriber dlicks

O Erowse ko a new site

O any

Ackivation fregquency
() Orly once

(O Always

() Periodically*:

Every |

() Until the subscriber browses ko

* These configuration options are available only for redirect profile of type "redirect”.

[ o

J{

Cancel ]

273585

Configure the frequency in which the redirection is triggered. Choose one of the Activation frequency

radio buttons:
e+ Only once

e+ Always

e« Until the subscriber browses to

If you chose the Until the subscriber browses to radio button, enter the dismissal URL host-suffix and
path-prefix in the fields provided.

Click the Allowed URLs tab.
The Allowed URLs tab opens.

[l Cisco Service Control Application for Broadband User Guide
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H Redirect Actions Settings

X

Create and edit Redirect Profiles

Configure the redirection parameters

Network Attack Motification
Diefault Matification
Default Redirection

General | Activation | Alowed URLs

Redirection Profile 1 Allowed URLs
List of URLs that are allowed to browse to overriding the redirection conditions

The aAllowed URLs should be in a Format *hast-suffixpath-prefix* (For example *.my-hosk. com: fredir™),
Type one URL per Line:

* . mywebserver,.com:path™

CK ][ Cancel ]

273586

Step10  (Optional) Enter any allowed URLS, one per line.
Step11  Click OK.
The Redirect Actions Settings dialog box closes.

The notification redirect profile is added to the profile list.

Managing Subscriber Redirection

The rules for a package may deny access to selected protocols. When a subscriber to the package tries
to access a blocked protocol, the traffic flow can be redirected to a server where a posted web page
explains the reason for the redirection (for example, a “Silver” subscriber trying to access a service
available only to “Gold” subscribers). This web page can offer subscribers the opportunity to upgrade
their packages. You configure which redirection profile to use when defining rules.

Note  Redirection is not supported when unidirectional classification is enabled.

Each redirect profile consists of a set of redirect parameters. The Cisco Service Control Application for
Broadband (SCA BB) supports a maximum of 128 redirect profiles, including notification redirect and redi-
rect profiles.

Cisco Service Control Application for Broadband User Guide
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Subscriber Redirect Parameters

Each redirect profile of type redirect contains the following parameters:
e Name—Each profile must have a unique name.

~

Note  You cannot change the name of the Default Redirection Profile.

e Redirect profile type—Each profile must be one of two types:
- Notification
- Redirect

e Set of Redirection URLs—A configurable set of destination URLs, to which the subscriber’s HTTP
flows are redirected after redirection is activated. The redirection set can optionally include one, or
several parameters appended to the destination URL including the redirect reason or subscriber ID.

e Activation trigger—The action that initiates the redirect. The activation trigger is one of the
following:

— Subscriber clicks—When the redirect is activated through a subscriber clicking a link.
— Browse to a new site—When the redirect is activated through browsing.
— Any—Wahen the redirect is activated either via a link or browsing.

e Activation frequency—Indicates when to activate the redirect. The activation frequency is one of the
following:

— Only once—The subscriber is redirected only the first time the conditions are met.
- Always—The subscriber is redirected every time the conditions Seconds

— Triggering events

- KBytes

— Until the subscriber browses to—Every time the conditions are met, the subscriber is redirected,
until the subscriber proceeds from the destination URL to a different, final URL.

The dismissal URL is composed of the URL hostname and the URL path, separated by a colon,
in the following format:

[*]1<hostname>:<path>[*]
— <hostname> may optionally be preceded by a wildcard (*), to match all hostnames with the
same suffix.

— The path element must always start with ““/”.
— <path> may be followed by a wildcard (¥), to match all paths with a common prefix.
For example, the entry *.some-isp.net:/redirect/* matches all the following URLs:
* www.some-isp.net/redirect/index.html
* support.some-isp.net/redirect/info/warning.asp
* noquota.some-isp.net/redirect/acknowledge.aspx?ie=UTF-8

e List of Allowed URLs—A list of URLs that will not be blocked and redirected even though
redirection is activated.
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After redirection is activated, all HTTP flows, except flows to the destination URL and to the
dismissal URL, are blocked and redirected to the destination URL. However, subscribers can be
permitted to access an additional set of URLSs. This is useful, for example, to give subscribers access
to additional support information.

Allowed URLs have the same format as the dismissal URL.

These parameters are defined when you add a new notification redirect profile. You can modify them at
any time.

How to Add a Redirect Profile

Step 1

Step 2

Step 3

A redirect profile contains a set of redirection URLs as well as conditions in which to use the redirect
feature, such as the action that triggers the redirect, or the frequency in which the redirect occurs.

From the Policies tab in the left pane, choose Configuration > Subscriber Redirection.

The Redirect Actions Settings dialog box appears.

X

H Redirect Actions Settings

Create and edit Redirect Profiles

Configure the redirection parameters

Diefault Matification General fwati
Do eanon Activation | Allowed URLs

Mame: | Metwork Attack Motification

Select redirection profile type:

Manage redirect sets:

Select URL set: | Default set [httpe/ funsw . my-http-server, com/redirect. cgi] -

[ CK H Cancel ] g

Click Add.
A new redirect profile containing the default redirection URL set is added to the redirect profile list.

In the Name field, enter a unique name for the new redirect profile.

[ oL-7205-11
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Note  You can use the default name for the redirect profile, but it is recommended that you enter a meaningful
name.

Step 4 Choose a URL set.
Step5  Click the Activation tab.

The Activation tab opens.

¥ Redirect Actions Settings

X

Create and edit Redirect Profiles

Configure the redirection parameters

Netwark Atkack Motification

Default Matification ARt
Default Redirection General Allowed LURLs

Redirection Profils 1 Ackivation brigger*
Activate upon:

(®) Subscriber dlicks

O Browse ko a new site

O any

Activation Frequency
(%) Only once

O Always

() Periodically*:

Every | |

(2 Until the subscriber browses bo:

* These configuration options are available only For redirect profile of bype "redirect”.

[ 0K ” Cancel ]

273585

Step6  Configure the activity that triggers the redirection. Choose one of the Activation trigger radio buttons:
e Subscriber clicks
¢ Browse to a new site
e Any

Step7  Configure the frequency in which the redirection is triggered. Select one of the Activation frequency
radio buttons:

e Only once

e Always

e Periodically

e Until the subscriber browses to

Step8  If you selected the Periodically radio button, enter a number and an increment in the Every fields, to
specify the frequency in which the redirection occurs.
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Step 9

Step 10

Step 11
Step 12

Managing Subscriber Redirection

If you selected the Until the subscriber browses to radio button, enter the dismissal URL in the fields

provided.
Click the Allowed URLs tab.
The Allowed URLs tab opens.

H Redirect Actions Settings

Create and edit Redirect Profiles

Configure the redirection parameters

Netwark Atkack Motification
Default Matification
Defaulk Redirection

General | Activation | Allowed URLs

Redirection Profils 1 Allowed URLs
List of URLs that are allowed ta browse to averriding the redirection conditions

The allowed URLs should be in a format *host-suffixpath-prefix® (For example *.my-hosk, com: fredir™),
Type one URL per Line:

* . mywebserver,.com: fpath™

X

[ 0K ] ’ Cancel

l

(Optional) Enter a URL, or multiple URLSs that can be browsed, overriding the redirect conditions.

Click OK.
The Redirect Actions Settings dialog box closes.

The Redirection profile is added to the redirection profile list.

How to Delete a Redirection Profile

Step 1

Step 2
Step 3
Step 4

You cannot delete the Default Redirection Profile.

From the Policies tab in the left pane, choose Configuration > Subscriber Redirection.
The Redirect Actions Settings dialog box appears.

Click the name of the profile.

Click Remove.

Click OK.

The Redirect Actions Settings dialog box closes.

[ oL-7205-11
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The Redirection settings are saved..

How to Add a Set of Redirection URLs

The Console Redirection feature supports only three protocols:
e HTTP Browsing
e HTTP Streaming
e RTSP Streaming

Each redirection set contains one redirection option for each of these three protocols. The system
provides a default redirection set, which cannot be deleted. You can add up to 127 additional sets.

Each redirection URL includes the URL specified name, the Subscriber ID, and the Service ID in the
following format:

<URL>?n=<subscriber-ID>&s=<service-ID>
Optionally, the URL can contain one or multiple parameters appended to it.

Step 1 From the Policies tab of the left pane, choose Configuration > Subscriber Redirection.
The Redirect Actions Settings dialog box appears.
Step 2 In the General tab, click Edit.
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Step 3

Step 4

Note

Step 5
Step 6

Step 7
Step 8

Step 9

Managing Subscriber Redirection

The Redirect Set Settings dialog box appears.

X

# Redirect Set Settings

Create and edit Redirect sets

Transaction of specific protocols can be blocked by rules and redirected to a predefined URL,
Specify Redirection set URLs and parameters to be used in rules to redirect blocked transactions

Default set

Redirection Set Name: | Default set

Redirect destination URLs

HTTP Browsing: hiktpe: g v, my-http-server, comfredirect, cgi

HTTP Streaming: htkp: ffwnan, my-streaming-server . comredirect. cgi
RTSP Streaming: rksp: ) s m-streaming-server , com/redirect rm

Reditect response headsar

J Response code:
D Cookie:

Parameters ko append to the destination LIRL

[] redirect Reasan [ service ID [] subscriber ID [] Distinct Mumber
[ Time Stamp [] referer [] original Cookie [] original Host
[ ©riginal URL [] original Parameters

[1Frestextto append:

Select All | | Deselect Al

K ][ Cancel ]

273438

Click Add.
A new redirection set containing the default redirection URLs is added.

In the Redirection Set Name field, enter unique name for the new redirection set.

You can use the default name for the redirection set, but it is recommended that you provide a meaningful
name.

Enter new values in the Redirection destination URLSs section of the new redirection set.

(Optional) To include a response code, check the Response code check box, and choose a response code
fromthe drop-down list.

(Optional) To include a cookie, check the Cookie check box, and enter a value.

(Optional) Check the check boxes of any parameters you wish to append to the destination URL
If you check the Free text to append check box, enter text into the text box to append to the URL.
Click OK.

Your settings are saved and the Redirect Set Settings dialog box closes.

[ oL-7205-11
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How to Delete a Set of Redirection URLs

Step 1 From the Policies tab of the left pane, choose Configuration > Subscriber Redirection.
The Redirect Actions Settings dialog box appears.

Step 2 In the General tab, click Edit.
The Redirect Set Settings dialog box appears.

Step3  Click the name of the redirection set.

Step4  Click Remove.

Step5 Click OK.
The Redirect Set Settings dialog box closes.

The Redirection settings are saved.

Managing the System Settings

The Console allows you to determine various system parameters that control:
e The operational state of the system
e Enabling and disabling asymmetric routing classification mode

e Advanced service configuration options

Setting the System Modes

From the Console you can select:
¢ The operational mode of the system

e Asymmetric routing classification mode

Information About the System Modes

e System Operational Mode, page 10-40
e Asymmetric Routing Classification Mode, page 10-41

System Operational Mode

The operational mode of the system defines how the system handles network traffic.

Note  Each rule has its own operational mode (state). If this differs from the system mode, the “lower” of the
two modes is used. For example, if a rule is enabled, but the system mode is report-only, the rule will
only generate RDRs.

The three operational modes are:

e Full Functionality—The system enforces active rules on the network traffic and performs reporting
functions (that is, generates RDRs).
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e Report Only—The system generates RDRs only. No active rule enforcement is performed on the
network traffic.

e Transparent—The system does not generate RDRs and does not enforce active rules on the network
traffic.

Asymmetric Routing Classification Mode

Enabling unidirectional classification significantly improves classification accuracy when the SCE
platform is deployed in an environment with a high rate of unidirectional flows.

e Unsupported Features, page 10-41

e Protocol Classification, page 10-41

e Switching to Asymmetric Routing Classification Mode, page 10-41

e Switching from Asymmetric Routing Classification Mode, page 10-42

Unsupported Features
The following SCA BB features are not supported when unidirectional classification is enabled:

¢ Flavors

e External quota provisioning
e Subscriber notification

e Redirection

¢ Flow Signaling RDRs

¢ Content filtering

e VAS traffic forwarding

When unidirectional classification is enabled, the service configuration editor indicates (in the Problems
View) if the service configuration is consistent with the features that are supported in this mode.

The following features, which are not part of the service configuration, are also affected when
unidirectional classification is enabled:

e Subscriber-Aware Mode (a mode in which subscriber information is dynamically bound to the IP
address currently in use by the subscriber) is not supported.

¢ Enhanced flow open mode must be enabled.

The system gives no indication if the state of the above features is consistent with the state of the routing
classification mode.

Protocol Classification

When unidirectional classification is enabled, protocol classification is performed in the normal way

with the exception of unidirectional UDP flows. Because it is impossible to know the server side of a
unidirectional UDP flow, SCA BB tries to classify the protocol using the destination port of the first

packet; if no exact match is found, SCA BB tries to classify the protocol using the source port.

Switching to Asymmetric Routing Classification Mode

If you create a service configuration in symmetric mode and switch to asymmetric routing classification
mode:

¢ Flavors are not used for classification.

¢ Periodic quota management mode is used.

[ oL-7205-11
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e Data is not lost when you switch to asymmetric routing classification mode, but you cannot apply
the service configuration to an SCE platform until all unsupported features are removed from the
service configuration.

Switching from Asymmetric Routing Classification Mode

If you create a service configuration in asymmetric routing classification mode:
e The Suspected Session Rate is set equal to the Session Rate for all anomaly detectors.

¢ No flavors are created in the default service configuration, and no service elements have specified
flavors.

e The quota management mode is periodic, with a daily aggregation period.

e Asymmetric routing classification mode limitations remain if you switch to symmetric mode. To
change them, you must edit the service configuration.

How to Set the Operational and Topological Modes of the System

Step 1 From the Policies tab of the left pane, choose Configuration > System Settings.

The System Settings dialog box appears.

3} System Settings g]

dvanced Options
System Operational Mode
Select the system's operational mode For handling the nebwork traffic:
() Transparent
(%) Repart Cnly

() Full Functionality

Routing Classification Made

Enable Asymmetric Routing Classification Mode in topologies
with high rate of unidirectional Flows, In this mode, the system is
better tuned For classifying traffic according to just ane side of the
Flows, but some control capabilities are disabled,

6] [ Ok H Cancel ]

274132

Step2  Select one of the System Operational Mode radio buttons:
e Transparent
¢ Report Only
e Full Functionality

Step3  To change the routing classification mode, check or uncheck the Enable the Asymmetric Routing
Classification Mode check box.

Step4  Click OK.
The System Settings dialog box closes.
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The new System Mode setting is saved.

Managing Advanced Service Configuration Options

Advanced service configuration options control the more sophisticated and less frequently changed
attributes of the system. It is recommended that you do not change these options.

e The Advanced Service Configuration Properties, page 10-43
e How to Edit Advanced Service Configuration Options, page 10-45

The Advanced Service Configuration Properties

The following table lists the advanced service configuration properties:

Property ‘Default Value ‘Description

Classification

Guruguru detailed inspection |FALSE The Guruguru protocol is used by the Guruguru file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for

classification of this protocol:

e Default—Suitable for networks where little Guruguru traffic is
expected. This is usual in all countries except Japan.

e Detailed—Suitable for networks where Guruguru traffic is expected
to be common. This should occur in Japanese networks only.

Kuro detailed inspection FALSE The Kuro protocol is used by the Kuro file-sharing application popular
mode enabled in Japan. SCA BB provides two inspection modes for classification of
this protocol:

e Default—Suitable for networks where little Kuro traffic is expected.
This is usual in all countries except Japan.

e Detailed—Suitable for networks where Kuro traffic is expected to
be common. This should occur in Japanese networks only.

Soribada detailed inspection |FALSE The Soribada protocol is used by the Soribada file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:

e Default—Suitable for networks where little Soribada traffic is
expected. This is usual in all countries except Japan.

e Detailed—Suitable for networks where Soribada traffic is expected
to be common. This should occur in Japanese networks only.

TCP destination port 1720:H323 TCP destination port numbers for signatures that require a port hint for
signatures correct classification.

Valid values are comma-separated items, each item in the form
<port-number>:<signature-name>.

Applicable signature names are: H323, Radius Access, Radius
Accounting, and DHCP.

Cisco Service Control Application for Broadband User Guide
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Property Default Value Description
UDP destination port 67:DHCP, UDP destination port numbers for signatures that require a port hint for
signatures 68:DHCP, correct classification.
1812:Radius Valid values are comma-separated items, each item in the form
Access, o
. <port-number>:<signature-name>.
1645:Radius
Access, Applicable signature names are: H323, Radius Access, Radius
1813:Radius Accounting, and DHCP.
Accounting,
1646:Radius
Accounting
UDP ports for which flow 5060, 5061, 67, Enhanced flow-open mode is disabled on the specified UDP ports, to
should be opened on first 68, 69, 1812, allow classification according to the flow’s first packet.

packet

1813, 1645, 1646,
2427,2727, 9201,
9200, 123, 1900,

5190, 10000
UDP source port signatures 1812:Radius UDP source port numbers for signatures that require a port hint for
Access, correct classification.
1645:Radius Valid values are comma-separated items, each item in the form
Access, e}
. <port-number>:<signature-name>.
1813:Radius
Accounting, Applicable signature names are: H323, Radius Access, Radius
1646:Radius Accounting, and DHCP.
Accounting
V-Share detailed inspection FALSE The V-Share protocol is used by the V-Share file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:
e Default—Suitable for networks where little V-Share traffic is
expected. This is usual in all countries except Japan.
e Detailed—Suitable for networks where V-Share traffic is expected
to be common. This should occur in Japanese networks only.
Winny detailed inspection FALSE The Winny P2P protocol is used by the Winny file-sharing application
mode enabled popular in Japan. SCA BB provides two inspection modes for
classification of this protocol:
e Default—Suitable for networks where little Winny traffic is
expected. This is usual in all countries except Japan.
e Detailed—Suitable for networks where Winny traffic is expected to
be common. This should occur in Japanese networks only.
Malicious Traffic
Malicious Traffic RDRs TRUE Specifies whether to generate Malicious Traffic RDRs.
enabled
Number of seconds between |60 A Malicious Traffic RDR is generated when an attack is detected.

Malicious Traffic RDRs on
the same attack

Malicious Traffic RDRs are then generated periodically, at
user-configured intervals, for the duration of the attack.

[l Cisco Service Control Application for Broadband User Guide
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Property Default Value Description

TCP port that should remain |80 You can choose to block flows that are part of any detected network

open for Subscriber attack, but this may hinder subscriber notification of the attack.

Notification The specified TCP port will not be blocked to allow notification of the
attack to be sent to the subscriber.

Multi stage Classification

Blocking FALSE Specifies whether to block the sub services under the main service.

Enable TRUE Specifies whether to enable the sub service classification of a service.
Multi stage classification describes the application level services that
can be enabled or disabled. By default sub service classification of the
services is enabled.
For example, Google talk service contains Google talk file transfer,
Google talk Networking, Google talk VoIP as sub services.

Policy Check

Ongoing policy check mode |TRUE Specifies whether policy changes affect flows that are already open.

enabled

Time to bypass between 30 Maximum time (in seconds) that may pass before policy changes affect

policy checks flows that are already open.

Quota Management

Grace period before first 2 The time (in seconds) to wait after a quota limit is breached before the

breach breach action is performed.
Policy servers should use this period to provision quota to a subscriber
that just logged in.

Length of the time frame for |0 The size of the window across which to randomly scatter the periodic

quota replenish scatter quota replenishment.

(minutes)

Time to bypass between 30 Maximum time (in seconds) that may pass before a quota breach affects

policy checks for quota flows that are already open.

limited flows

Volume to bypass between 0 Maximum flow volume (in bytes) that may pass before a quota breach

policy checks for quota affects flows that are already open.

limited flows A value of zero means that unlimited volume may pass.

Reporting

Media Flow RDRs enabled TRUE Specifies whether to generate Media Flow RDRs.

Subscriber Accounting RDR |FALSE Specifies whether to generate Subscriber Accounting RDRs.

enabled

The Subscriber Accounting RDR is used for SM-ISG integration. For
more information, see the ISG documentation in the “Managing the
SCMP” chapter of the Cisco SCE8000 Software Configuration Guide.

How to Edit Advanced Service Configuration Options

Step 1

From the Policies tab of the left pane, choose Configuration > System Settings.

The System Settings dialog box appears.

[ oL-7205-11
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Step2  Click the Advanced Options tab.
The Advanced Options tab opens.

System Mode | Redirection URLs | BW Managemen

Advanced service configuration options control the more sophisticated and less
frequently changed attributes of the system.

Advanced Service Configuration Options ...

[ ok ] [ Cancel

210023

Step3  Click Advanced Service Configuration Options.

The Advanced Service Configuration Options dialog box opens.

3£ Advanced Service Configuration Options i ﬂ

Advanced Service Configuration Options

Wiew & edit advanced options

dwidth Management
Relax B enforcement on netw Use Default Service BWiCs {relaxed enforcement)
=] Classification
Click Stream Event recogrition  true
Enable sending ‘404, Page Mok Fr False
Gurugury detailed inspection rmo: False
Kuro detailed inspection mode er false
Murmber of HTTP GET detections 1
Soribada detailed inspection mod False
TCP destination port signatures  1720iH323
UDP destination port signatures  65:DHCP,&7:DHCF, 151 2:Radius Access, 1645, Radius Acc,,,  —
UDP ports For which Flow should | S060,5061,67,68,69,1812,1813, 1645, 1646,2427 2727,..,
UDP source port signatures 1512:Radius Access, 1645 Radius Access, 1813 Radius Ac...
\-Share detailed inspection mode False
‘inmy detailed inspection mode ¢ False
= Malicious Traffic
Malicious Traffic RDRs enablad  true
Murber of seconds between Mal 60
TCP pott that should remain oper 80
[=1 Multi Skage Classification ;I

I
-
274151
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Stepd  Make your changes to the configuration options.
Step5 Click OK.

The Advanced Service Configuration Options dialog box closes.

The changes to the advanced options are saved.

Step6  Click OK.

The System Settings dialog box closes.

Managing VAS Settings

Value Added Service (VAS) settings includes the following features:

Traffic mirroring—Traffic mirroring allows using the SCE to mirror a portion of the traffic based on
its application and subscriber awareness. Traffic to be mirrored continues forwarding as is, and
copies of the packets are sent to the corresponding VAS vlan, thereby minimizing traffic.

Traffic forwarding—Traffic forwardingservers allows you to use an external expert system (VAS
server) for additional traffic processing, such as intrusion detection and content filtering to
subscribers. After processing, flows are sent back to the SCE platform, which then sends them to
their original destinations.

The flows to be forwarded are selected based on the subscriber package and the flow type (IP
protocol type and destination port number).

VAS mirroring has the following limitations:

The SCE 2000 and SCE8000 both support traffic mirroring.

Traffic mirroring is supported on any SCE platform that has at least 2 ports.
An SCE8000 can contain 64 distinct VLANS.

An SCE 2000 supports 8 distinct VLAN:Ss.

VAS forwarding has the following limitations:

Only the SCE 2000 4xGBE platform supports VAS traffic forwarding.
A single SCE platform can support up to eight VAS servers.

A service configuration can contain up to 64 traffic-forwarding tables.
A traffic-forwarding table can contain up to 64 table parameters.

VAS traffic forwarding is not supported when unidirectional classification is enabled.

Note  Because of the complexity of the VAS settings features, VAS flows are not subject to global bandwidth
control.

To use VAS traffic forwarding, you must also configure VAS services on the SCE platform. Additional
information is available in the “Value Added Services (VAS) Traffic Forwarding” chapter of the Cisco
SCE2000 and SCE1000 Software Configuration Guide.

How to Enable VAS Traffic Forwarding, page 10-48
How to Rename VAS Server Groups, page 10-49

[ oL-7205-11
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¢ How to View VAS Traffic-Forwarding Tables, page 10-51
e How to Delete VAS Traffic-Forwarding Tables, page 10-52
e How to Add VAS Traffic-Forwarding Tables, page 10-53

e Managing VAS Table Parameters, page 10-53

How to Enable VAS Traffic Forwarding

By default, VAS traffic forwarding is disabled. You can enable it at any time.

S

Note  VAS traffic forwarding is not supported when unidirectional classification is enabled.

Step 1 From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.

£ VAS Settings g|
Select Yas Mode!
(%) Enable Traffic Mirroring

(") Enable Traffic Forwarding

Traffic Mirroring Groups

Server Groups Table

The Server Groups Table lisks the names of YAS server groups, & YAS server group is &
collection of physical WS servers that provides the same service as configured in the SCE,

Server Group 1D Server Group Mame Flow Yolumne ko Mirror (KE)
Server Group 0
Server Group 1
Server Group 2
Server Group 3
Server Group 4
Server Group S
Server Group &
Server Group 7

oojlo|lojlo/ oo o

Rl = ) o A e ]

&) Close
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Step2  Choose the Enable Traffic Forwarding radio button.

Note  VAS traffic forwarding is not supported in asymmetric routing classification mode. If you try to check
the Enable Traffic Forwarding radio button when asymmetric routing classification mode is enabled, a
VAS Error message appears.
Click OK, and continue at Step 4.

A VAS warning message appears.
Step3  Click OK.
Stepd  Click Close.

Cisco Service Control Application for Broadband User Guide
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The VAS Settings dialog box closes.

How to Enable VAS Traffic Mirroring

Traffic Mirroring in enabled and configured in the VAS Setting dialog box. However, you configure
which server group to use when defining rules.

Step1  From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.

Step2  Choose the Enable Traffic Mirroring radio button.
A VAS warning message appears.

Step3  Click OK.

Stepd  Click Close.
The VAS Settings dialog box closes.

How to Rename VAS Server Groups

An SCE platform can forward flows to up to eight different VAS server groups. By default, the eight
server groups are named “Server Group n”, where n takes a value from O to 7. Give the server groups
meaningful names; the names you give will appear in the drop-down list in the Control and Breach
Handling tabs of the Add Rule to Package dialog box (see How to Set Advanced Package Options,
page 9-7) and in the Server Group field of the table parameters added to each traffic-forwarding table
(see Managing VAS Table Parameters, page 10-53).

Step 1 From the Policies tab of the left pane, choose Configuration > VAS Settings.

The VAS Settings dialog box appears.
Step2 In the table in the Server Groups Table area, double-click in a cell containing a server group name.
Step3  Enter a meaningful name in the cell.

Step4  Repeat Step 2 and Step 3 for other server groups you wish to rename.

Cisco Service Control Application for Broadband User Guide
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F£ vAS Settings
Select Yas Mode:
(") Enable Traffic Mirroring

(%) Enable Traffic Forwarding

Traffic Forwarding Groups | Traffic Forwarding Tables

%]

Server Groups Table

The Server Groups Table lists the names of YAS server groups, These names are used in YAa5
traffic Farwarding tables. & WAS server group is a collection of physical YAS servers that

provides the same service as configured in the SCE.

Server Group ID

Server Group Marne
0 |Http content filkering | »

1 Server Group 1
mtp filker
Server Group 3

Server Group 4

Server Group S

Server Group 6

EIEAEIEIE

Server Group 7

<

Close
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Click Close.
The VAS Settings dialog box closes.

Step 5

How to Configure VAS Traffic-Mirroring

Step 1
The VAS Settings dialog box appears.

From the Policies tab of the left pane, choose Configuration > VAS Settings.

[l Cisco Service Control Application for Broadband User Guide
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3£ VAS Settings

%]

Select Yas Mode:
(%) Enable Traffic Mirroring

() Enable Traffic Forwarding

Traffic Mirraring Groups

Server Groups Table

The Server Groups Table lists the names of YA5 server groups, & YAS server group is a
collection of physical WAS servers that provides the same service as configured in the SCE.

Server Group 1D Server Graup Mame Flaw Yolumne ko Mirror (KB)
Server Group O
Server Group 1
Server Group 2
Server Group 3
Server Group 4
Server Group S
Server Group 6
Server Group 7

o|olo/olo/ oo o

I =1

&) Close

Click the Enable Traffic Forwarding radio button.

210051

For each server group, in the Flow Volume to Mirror (KB) column, enter the maximum amount of
volume to mirror, in KB.

Click Close.
The VAS Settings dialog box closes.

How to View VAS Traffic-Forwarding Tables

Step 1

Step 2
Step 3

Step 4

SCA BB decides whether a flow passing through an SCE platform should be forwarded to a VAS server
group based on a traffic-forwarding table. Each entry (table parameter) in a traffic-forwarding table
defines to which VAS server group the specified flows should be forwarded.

From the Policies tab of the left pane, choose Configuration > VAS Settings.

The VAS Settings dialog box appears.

Click the Enable Traffic Forwarding radio button.

Click the Traffic Forwarding Tables tab.

The Traffic Forwarding Tables tab opens.

A list of all traffic-forwarding tables is displayed in the Traffic Forwarding Tables area.
Click a table in the list of traffic-forwarding tables to display its table parameters.

A list of all table parameters defined for this traffic-forwarding table opens in the Table Parameters tab.

[ oL-7205-11
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F£ vAS Settings

%]

Select Yas Mode:
(") Enable Traffic Mirroring

(%) Enable Traffic Forwarding

Traffic Farwarding Groups | Traffic Forwarding Tables |

Traffic Forwarding Tables | | Table Pararmeters |

& % || tomvane

LU Default Table

g X
L0 Silver
IP Prokacal TCPIUDP Part Server GEroup
TP Part |50 [Http content Fitering

Al LDF [rfes |FzP cache

=
2) Close

Step5  Click Close.
The VAS Settings dialog box closes.

274126

How to Delete VAS Traffic-Forwarding Tables

You can delete all user-created traffic-forwarding tables. The default traffic-forwarding table cannot be
deleted.

)

Note A traffic-forwarding table cannot be deleted while it is associated with a package.

Step1  From the Policies tab of the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.
Step2  Click the Enable Traffic Forwarding radio button.
Step3  Click the Traffic Forwarding Tables tab.
The Traffic Forwarding Tables tab opens.
Stepd  From the list of traffic-forwarding tables in the Traffic Forwarding Tables area, select a table.
Step5  Click “ (Delete).
A VAS Warning message appears.
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3 VAS Warning

I
210054

Click Yes.

The selected table is deleted and is no longer displayed in the list of traffic-forwarding tables.
Click Close.

The VAS Settings dialog box closes.

How to Add VAS Traffic-Forwarding Tables

Step 1

Step 2
Step 3

Step 4

Step 5

A default traffic-forwarding table is included in the service configuration. You can add up to 63 more
traffic-forwarding tables, and then assign different traffic-forwarding tables to different packages.

From the Policies tab in the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.

Click the Enable Traffic Forwarding radio button.

Click the Traffic Forwarding Tables tab.

The Traffic Forwarding Tables tab opens.

In the Traffic Forwarding Tables area, click "0 (Add).

A new table named Table (n), where n is a value between 1 and 63, is added to the list of
traffic-forwarding tables in the Traffic Forwarding Tables area.

The table name is also displayed in the [tem Name box in the Table Parameters tab.
In the Item Name field, enter a unique and relevant name for the traffic-forwarding table.

You can now add table parameters to the new traffic-forwarding table, see How to Add VAS Table
Parameters, page 10-54.

Managing VAS Table Parameters

A table parameter is an IP protocol type, an associated TCP/UDP port (where applicable), and a VAS
server group or a range of IP addresses.

A traffic-forwarding table is a collection of related table parameters.
A traffic-forwarding table can contain up to 64 table parameters.

¢ How to Add VAS Table Parameters, page 10-54

e How to Edit VAS Table Parameters, page 10-54
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e How to Delete VAS Table Parameters, page 10-56

How to Add VAS Table Parameters

Step 1

Step 2
Step 3

Step 4

Step 5

Note

Step 6

You can add up to 64 table parameters to a traffic-forwarding table.

From the Policies tab in the left pane, choose Configuration > VAS Settings.

The VAS Settings dialog box appears.

Click the Enable Traffic Forwarding radio button.

Click the Traffic Forwarding Tables tab.

The Traffic Forwarding Tables tab opens.

From the list of traffic-forwarding tables in the Traffic Forwarding Tables area, select a table.
In the Traffic Parameters tab, click = (Add).

A new table parameter is added to the list of table parameters in the Table Parameters tab.

Each new table parameter has the following default values:

Parameter Default value
IP Protocol TCP Port
TCP/UDP Port 80

Server Group Server Group 0

You can now edit the new table parameter, as described in the following section.
Click Close.
The VAS Settings dialog box closes.

How to Edit VAS Table Parameters

Step 1

Step 2
Step 3

Step 4

From the Policies tab in the left pane, choose Configuration > VAS Settings.
The VAS Settings dialog box appears.

Click the Enable Traffic Forwarding radio button.

Click the Traffic Forwarding Tables tab.

The Traffic Forwarding Tables tab opens.

From the list of traffic-forwarding tables in the Traffic Forwarding Tables area, select a table.

[l Cisco Service Control Application for Broadband User Guide
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Step5 In the table in the Table Parameters tab select a protocol, port, and server group.

a. Click in a cell in the IP Protocol column, and, from the drop-down list that opens, select an IP
protocol type.

Table Parameters |

Item Marme: | Gold

= X

IP Protocal TCPIUDP Port Server Group
TCP Port 30 HTTP content Filt...
TCP Park
all
all TCP
Al LDP
All Mon TCP/UDP
TCP Paort

UCF Port

210052

If you select All, All TCP, All UDP, or All Non TCP/UDP, “N/A” will appear in the TCP/UDP Port
cell when you move to another cell in the table.

b. If you selected TCP Port or UDP Port, double-click in the cell in the TCP/UDP Port column, and
enter the port number.

S

Note  You cannot enter a range of ports in the TCP/UDP Port cell; you must add a separate table parameter for
each port.

c. Clickin the cell in the Server Group column, and, from the drop-down list that opens, select a server
group.

Table Parameters |

Ttem Mame: | Gold

+* X

1P Prokocol TCPIUDP Port Server Group
TCP Port 30 HTTP conkent filt. .,

Al UDP TES HTTF conken... s

i
S
3
3
%
g
-
7
o
2
=
-
=

Server Group 4
Server Group 5
Server Group 6
Server Group 7
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Step6  Click Close.
The VAS Settings dialog box closes.
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How to Delete VAS Tabhle Parameters

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

Step 7

From the Policies tab in the left pane, choose Configuration > VAS Settings.

The VAS Settings dialog box appears.

Click the Enable Traffic Forwarding radio button.

Click the Traffic Forwarding Tables tab.

The Traffic Forwarding Tables tab opens.

From the list of traffic-forwarding tables in the Traffic Forwarding Tables area, select a table.
From the list of table parameters in the Table Parameters tab, select a table parameter.

Click ﬁ (Delete).

The selected table parameter is deleted and is no longer displayed in the list of table parameters.
Click Close.

The VAS Settings dialog box closes.

Managing the Protected URL Database

The SCE Protected URL Database is a database that contains a "blacklist,”" a list of websites that are
considered off limits or dangerous. You can configure the SCE to apply a specific action, such as
blocking a site, when a subscriber attempts to access a site listed on the blacklist.

The database is encrypted so that no one, including the operator, can view the blacklist. The blacklist is
managed on the SCE and cannot be withdrawn to the management PC.

RDRs are created when a subscriber attempts to access a link included in the blacklist. However, the
RDRs do not contains the URL or Host information of the site.

In order to enable the blacklist feature, you must do the following:
e Define an HTTP flavor
e Create a blacklist service
e Assign the HTTP flavor to the blacklist service
e Create a rule for the blacklist service
e Assign black list entries to the flavor, using the CLI

For more information about the Protected URL Database, see the Cisco Service Control URL
Blacklisting Solution Guide.
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Using the Subscriber Manager GUI Tool

This chapter describes how to use the Subscriber Manager (SM) GUI tool to configure subscribers in the
Cisco Service Control Management Suite (SCMS) Subscriber Manager (SM) database.

The SM GUI tool is especially useful when the SCMS-SM holds a static list of subscribers. It is not
applicable when the Cisco Service Control Application for Broadband (SCA BB) is operating in
subscriberless mode (a mode in which control and analysis functions are available only at a global
platform resolution) or in anonymous subscriber mode (a mode in which entities defined as IP addresses
or VLANSs are treated as subscribers).

e Using the SM GUI Tool, page 11-1
e Working with Subscriber CSV Files, page 11-5
e Managing Subscribers, page 11-6

Using the SM GUI Tool

Note

The SM GUI tool allows you to manage subscribers on an SCMS-SM. The SCMS-SM functions as
middleware software that bridges between the OSS and the Service Control Engine (SCE) platforms.
SCE platforms use the subscriber information to provide subscriber-aware functionality, per-subscriber
reporting, and policy enforcement. Subscriber information is stored in the SCMS-SM database and can
be distributed between multiple platforms according to actual subscriber placement.

You can use the SM GUI tool to import and export subscriber files, and to perform operations on
individual subscribers, such as adding a new subscriber, editing parameters of an existing subscriber,
and deleting a subscriber.

To access an SCMS-SM from the SM GUI tool, you must first add the SCMS-SM to the Site Manager
tree in the Network Navigator tool (see How to Add SM Devices to a Site, page 5-4).

The SM GUI tool provides only a subset of the functionality that is provided by the SM Command-Line
Utility. For more information about the SCMS-SM, see the Cisco Service Control Management Suite
Subscriber Manager User Guide.

Connecting to an SCMS-SM

You can connect to an SCMS-SM:

e From the Network Navigator tool
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I Using the SM GUI Tool

N

Note

e From anywhere else in the Console

e From the Subscriber Manager GUI tool

The SM GUI tool performs authentication on the SCMS-SM by opening a PRPC connection to port
14374 and attempting to log in using the username and password that you entered in the Password
Management dialog box. If a PRPC server with this user is not running on the SCMS-SM, authentication
will fail.

If you have changed the PRPC port on the SCMS-SM, see User Authentication, page 5-34.

How to Connect to an SCMS-SM from the Network Navigator

Step 1

Step 2

Step 3
Step 4

In the Site Manager tree in the Network Navigator tab, right-click an SM device.

A popup menu appears.

£, Manage Subscribers

@) Cnline Status. ..
f# Generate Tech Support Info File...

Advanced L
Configuration Wizards 4
Editing 3 8
Show Properties \isw g

From the menu, select Manage Subscribers.

A Password Management dialog box appears.

Enter the appropriate password. (For more information, refer to Password Management, page 5-6).
Click Connecting.

The Password Management dialog box closes.

A Connecting to progress bar appears.

Tl}_f; system connects to the SCMS-SM.

=~ (Import subscribers from CSYV file), (Export subscribers to CSYV file), and -l-x-l-
(Disconnect from SM) are enabled.
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3¢ subscriber Manager - SCA BB Console » = IEIlzI
File Edit Tools Mebwork ‘Window Help

=] -ﬁSubscriber Manager gService Configuration Editor @ Netwark Navigator

¥ 10 Bt—x-olmv

= XN

Subscriber 1D | Subscriber Domain | Mekwork Mappings I Package

210007

Using the SM GUI Tool

How to Connect to an SCMS-SM from the Console

~

Note

Step 1

Step 2

Step 3

(If you are already in the SM GUI tool, start at Step 3.)

From the Console main menu, choose Tools > Subscriber Manager.
The SM GUI tool opens.

A Subscriber Manager is not connected message appears.

B

Subscriber Manager is not connected to any SM,
Please connect to an S,

210017

Click OK.
The Subscriber Manager is not connected message closes.

In the SM GUI toolbar, click ¢ (Connect to an SM).

If more than one SCMS-SM device is configured in the Network Navigator, the Choose SM Devices

dialog box appears.
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3€ choose sMDevices 1=

]

Backup 5M[10.56.212.111]
Sike 5M [10,56,212.71]

oK I Cancel

158778

Step4  Select a device and click OK.

A Password Management dialog box appears.
Step5  Enter the appropriate password. (For more information, refer to Password Management, page 5-6.)
Step6  Click Connecting.

The Password Management dialog box closes.

A Connecting to progress bar appears.

The system connects to the SCMS-SM.

E (Import subscribers from CSYV file), (Export subscribers to CSYV file), and -l-x-r
(Disconnect from SM) are enabled.

How to Disconnect from the Current SCMS-SM

Step 1 In the SM GUI toolbar, click -l-x-l- (Disconnect from SM).
The Console disconnects from the SCMS-SM, but the SM GUI tool remains open.

[5 (Import subscribers from CSYV file), (Export subscribers to CSYV file), and -l-x-l-
(Disconnect from SM) are dimmed.

The subscriber list is empty.
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Working with Subscriber CSV Files W

[ff i-ﬁ- Subscriber Manager

¥ Subseriber Manager ] [+

210016

Working with Subscriber CSV Files

Because of the large number of subscribers that must be introduced into the system, it is not feasible to
enter subscriber information manually. Subscriber information is usually generated by a RADIUS server
(or some similar source) and imported into the SM GUI tool.

You can also export updated subscriber information to a CSV file.

The format of subscriber CSV files is described in the “CSV File Formats” chapter of the Cisco Service
Control Application for Broadband Reference Guide.

e How to Import Subscriber Information from a CSV File, page 11-5
e How to Export Subscriber Information to a CSV File, page 11-6

How to Import Subscriber Information from a CSV File

You can import subscriber data that was exported to a CSV file into the SM GUI tool.

Step 1 In the SM GUI toolbar, click [E (Import subscribers from CSV file).
An Import from File dialog box appears.
Step2  Browse to the file that is to be imported and click Open.

An Import Warning message appears.

x

@ Imparting will override existing data. Are wou sure wou wank to continue?

!
210009

Step3  Click Yes.
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The Import from File dialog box closes.

The selected file is imported into the SM GUI tool; the imported subscribers are listed in the subscriber
list.

How to Export Subscriber Information to a CSV File

You can export subscriber information to a CSV file (for example, when data in the SCMS-SM database
is updated).

Step 1 Select the subscribers whose data you want to save (see Selecting Subscribers, page 11-7)
Step2 In the SM toolbar, click (Export subscribers to CSV file).
An Export to File dialog box appears.
Step3  Browse to the folder in which you want to save the exported file.
Step4  In the File name field, enter a file name.
Step5  Click Save.
The Export to File dialog box closes.

The selected subscribers are saved to the CSV file.

Managing Subscribers

After importing subscribers into the system, you can maintain and update the database.
You can perform the following operations:

e Add subscribers

e Edit information for existing subscribers

e Delete subscribers

Subscriber Information

All subscribers currently introduced into SCA BB are displayed in a list in the SM GUI tool. Use this
list to manage individual subscribers or groups of subscribers. Use the Find function to display a subset
of the subscribers (see How to Find a Subscriber or Group of Subscribers, page 11-7).

The subscriber list has the following columns:
e Subscriber ID—Name of the subscriber in the system.

¢ Subscriber Domain—Domain to which the subscriber is assigned. The names of the SCE platforms
that belong to each domain appear in square brackets.

e Network Mappings—IP address, range of IP addresses, or VLAN tag mapped to the subscriber.

e Package—Package ID assigned to the subscriber. The name of the package is shown in square
brackets.
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3¢ subscriber Manager - SCA BB Console
File Edit Tools Mebwork ‘Window Help

=] -ﬁSubscriber Manager QService Configuration Editor @ Netwark Navigator

S [=] 3

EEXA| &7

Subscriber 1D Subscriber Domain
Subscriberl subscribers [
Subscriber2

210008

Finding and Selecting Subscribers

For ease of use, the SM GUI tool incorporates two standard features:

e Find—Search for a specific subscriber.

e Multiple Select—Select a range of subscribers or a number of individual subscribers.

How to Find a Subscriber or Group of Subscribers

Use this feature to find a specific subscriber or a group of subscribers according to a subscriber ID prefix

This is useful for editing the parameters of either a specific subscriber or a group of subscribers (see
Editing Subscriber Details, page 11-10)

Step1  In the Find field (see the following illustration), enter the prefix to be matched.

= X N i}

Step2  Click H (Find Subscribers).

Only those subscribers that match the specified prefix are displayed in the subscriber list.

Selecting Subscribers

You can edit, export, or delete a group of subscribers at one time by selecting subscribers displayed in
the subscriber list. The group may be either of the following:

¢ A range of contiguous subscribers

Cisco Service Control Application for Broadband User Guide
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e A number of noncontiguous subscribers
e How to Select a Range of Subscribers, page 11-8

e How to Select a Number of Noncontiguous Subscribers, page 11-8

How to Select a Range of Subscribers

Step 1 Select the first subscriber in the range.
Step2  Press the Shift key and click the last subscriber in the range.
All subscribers in the range are selected.

You can combine this function with the search function; search to display specific subscribers and then
select the entire range.

How to Select a Number of Noncontiguous Subscribers

Step 1 Press the Ctrl key while selecting subscribers.

You can combine this function with selecting a range of subscribers; first select the range of subscribers
and then select additional subscribers.

How to Add a Subscriber

You can add additional individual subscribers to the SCMS-SM.

To add large number of subscribers, export their information from a RADIUS (or DHCP) server to a CSV
file, and then import the CSV file (see Working with Subscriber CSV Files, page 11-5)

Step 1 In the SM toolbar, click ' (Add Subscriber).
The Add A New Subscriber dialog box appears.

Add a New Subscriber I

General I Metwork Mappings |

Subscriber ID
ISubscriberZ

Subscriber Domain:

| <not introduced:= LI
Subscriber Package:
I <package 0= LI

[ #ctivate Subscriber Real-Time Monitaring

oF | Cancel |

158730

Step 2 In the Subscriber ID field, enter text that identifies the subscriber.
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Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Managing Subscribers

From the Subscriber Domain drop-down list, select the appropriate domain for the new subscriber.
From the Subscriber Package drop-down list, select a package to assign to this subscriber.
The contents of the list depend on the selected subscriber domain.

To activate subscriber real-time monitoring, check the Activate Subscriber Real-time Monitoring
check box. This causes the SCE application to generate Real-Time Subscriber Usage RDRs for this
subscriber.

If you are not going to define network mappings for this subscriber, continue at Step 11.
Click the Network Mappings tab.
The Network Mappings tab opens.

Add a New Subscriber I

General Metwork Mappings I

Subscriber Metwork Mappings:
=" IP Address

= WLAN

| x|

QF | Cancel |

158731

The system supports either IP addresses or VLAN tags as network identification for subscribers.
Select one of the Subscriber Network Mappings radio buttons.

e IP Address

e VLAN
Click & (Add) to add a network mapping of the type selected in the previous Step.

A new network-mapping entry is added to the subscriber network mappings list, displaying a default
value.

Edit the network-mapping entry.
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Add a New Subscriber

General  Metwork Mappings I

Subscriber Metwork Mappings:
o IP Address

= WLAN

10.56.216.1/32

2| x|

oF | Cancel |

158732

Step10 Repeat Steps 8 and 9 for other network mappings.
Step11  Click OK.
The Add A New Subscriber dialog box closes.
The new subscriber is added to the database, and to the subscriber list displayed in the SM GUI tool.

Editing Subscriber Details

You can edit parameters of single or multiple subscribers.
e How to Edit Details for Single Subscribers, page 11-10
e How to Edit Details for a Group of Subscribers, page 11-12

How to Edit Details for Single Subscribers

Step1  Find and select a subscriber. (See How to Find a Subscriber or Group of Subscribers, page 11-7.)
Step 2 In the SM toolbar, click l (Edit Subscriber).
The Edit Subscriber dialog box appears.
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Edit Subscriber "Subscriber2™

General I Metwork Mappings |

Subscriber ID
ISubscriberZ

Subscriber Domain:

|subscribers x |

Subscriber Package:

[ #ctivate Subscriber Real-Time Monitaring

apply | Cancel |

158812

Step3  Modify subscriber details.
e Edit the entry in the Subscriber ID field.
e From the Subscriber Domain drop-down list, select a subscriber domain.
e From the Subscriber Package drop-down list, select a package to assign to this subscriber.
The contents of the list depend on the selected subscriber domain.
¢ Check or uncheck the Activate Subscriber Real-time Monitoring check box.
If you are not editing the network mappings for this subscriber, continue at Step 6.
Stepd  Click the Network Mappings tab.
The Network Mappings tab opens.

Edit Subscriber "Subscriber2™

General Metwork Mappings I

Subscriber Metwork Mappings:
=" IP Address

= WLAN

10,1,11,20/32 i

| x|

Apply | Cancel |

158813

Step5  Modify subscriber network mappings:
a. Select one of the Subscriber Network Mappings radio buttons:
- IP Address
- VLAN

b. To add a new network mapping to the list, click EE:' (Add), and edit the network-mapping field that
is added to the Subscriber Network Mappings list.

Cisco Service Control Application for Broadband User Guide
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Step 6

c¢. To delete ~ . ~ctwork mapping from the list, select an entry in the subscriber network mappings list
and click ﬁ (Delete).
Click Apply.

The Edit Subscriber dialog box closes.

The modified subscriber information is saved to the database and displayed in the subscriber list in the
SM GUI tool.

How to Edit Details for a Group of Subscribers

Step 1
Step 2

Step 3

Step 4

You can assign the same package or domain to many subscribers at one time.

Select a group of subscribers (see Selecting Subscribers, page 11-7) to modify.
In the SM toolbar, click _ (Edit).
The Edit Multiple Subscribers dialog box appears.

Edit Multiple Subscribers 1

General I Network Mappings |

Subscriber ID
ISubscriberl

Subscriber Domain:

|subscribers hd |

Subscriber Package:
I <package 1> ;I

[ Activate Subscriber Real-Time Monitaring

Apply | Cancel |

158806

The Subscriber ID field is dimmed and the Network Mappings tab is disabled.
Modify fields in the General tab.
e From the Subscriber Domain drop-down list, select a subscriber domain.
¢ From the Subscriber Package drop-down list, select a package to assign to this subscriber.
The contents of the list depend on the selected subscriber domain.
¢ Check or uncheck the Activate Subscriber Real-time Monitoring check box.
Click Apply.
The Edit multiple Subscribers dialog box closes.

The modified subscriber information is saved to the database and displayed in the subscriber list in the
SM GUI tool.
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How to Delete a Subscriber from the Database

You can delete subscribers from the database.

Step 1 Select a single subscriber or a group of subscribers (see Selecting Subscribers, page 11-7).
Step2 In the SM toolbar, click ﬁ (Delete Subscriber).

The system asks for confirmation before deleting the selected subscribers:

3£ subscriber Warning |

@ Are wou sure you want ko remove these subscribers?
H

I
210018

Step3  Click Yes to confirm.

The selected subscribers are deleted from the database and removed from the subscriber list displayed
in the SM GUI tool.

Cisco Service Control Application for Broadband User Guide
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Using the Signature Editor

This module describes the Signature Editor tool and how to use it to create and modify Dynamic
Signature Script (DSS) files.

The Signature Editor tool allows you to create and modify DSS files that can add and modify protocols
and protocol signatures in the Cisco Service Control Application for Broadband (SCA BB), based on
your knowledge of new network protocols that are not yet supported by SCA BB.

The Signature Editor Console, page 12-1
Managing DSS Files, page 12-1

How to Create DSS Files, page 12-10
How to Edit DSS Files, page 12-13

How to Import DSS Files, page 12-13

The Signature Editor Console

The Signature Editor writes log and error messages to the Signature Editor Console (in the Console
view), when appropriate.

Managing DSS Files

Installing new signatures to an active service configuration is described in Working with Protocol
Packs, page 4-17.

Working with signatures in the Service Configuration Editor is described in Managing Protocol
Signatures, page 7-34.

Using serveonf, the Server Configuration Ultility, to apply signatures is described in The SCA BB
Service Configuration Utility, page 13-1.

The DSS file components, and the creation and editing of DSS files, are explained in the following
sections.
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The DSS File Components

The DSS file components are displayed in the Script pane of the Signature Editor, in a tree structure. By
selecting the appropriate node of the DSS component tree, you can define the properties associated with
the node in the Property pane.

The DSS file components are described in the following sections.
e The DSS File, page 12-2
e DSS Protocol List, page 12-2
e Information About DSS Protocols, page 12-3
e DSS Signatures, page 12-4
e DSS Deep Inspection Clauses, page 12-9
e DSS Deep Inspection Conditions, page 12-9

The DSS File

The DSS file name is the root node of the DSS file component tree.
When you select the root node, you can define the following properties for the DSS file:
e Script Name—Enter a meaningful name for this script.
e Script Description—Enter the reason for creating this script and describe its contents.
e Script Version (Major)
e Script Version (Minor)
e Script Build Number (Major)
e Script Build Number (Minor)
¢ Created for Application Version—Select from a list of predefined values.

Figure 12-1 shows the default values for the DSS file properties.

Figure 12-1 Default Values for DSS File Properties

3 Properties B |t a2

Property | Value
Seript Mame MyScript
Seript Description
Seript Version (Major)
Seript Version (Minor)
Script Build no. (Major)
Script Build no. (Minor)
Created for App. Version

WO O

210804

The DSS file contains a single protocol list.

DSS Protocol List

The protocol list has no properties to define. It contains all the protocols that are being added, modified,
or enhanced.
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Information About DSS Protocols
When you select a Protocol node in the DSS file component tree, you can define the following properties
of the protocol:
e Basic:
— Protocol Name—See Setting Protocol Name and ID, page 12-3.
— Protocol Description
— Protocol ID—See Setting Protocol Name and ID, page 12-3.
¢ Protocol Category:
— Buddy Protocol—See The Buddy Protocol, page 12-4.
— Protocol Families—Assign the protocol to one or more protocol families:
- P2p
- SIP
- VOIP

- Worm

Associating a protocol with a protocol family allows reports about the family to include the new
protocol.

Figure 12-2 shows the default values for the protocol properties.

Figure 12-2 Default Values for the Protocol Properties
Property Value
Protocol Name <enter a unigue name >
Protocol Description
Protocol Id 1

-1 Protocol Category
Buddy Protocol
Protocol Families

210809

Protocols contain signatures.

Setting Protocol Name and ID

A DSS can include two types of protocols:
e A protocol new to SCA BB—The protocol is being defined in the DSS.

e A protocol that SCA BB already supports—The protocol identification is being enhanced or
modified in the DSS.

Selecting a name and ID is different for the two cases:

¢ For a protocol new to SCA BB, the name must not match any of the protocol names that SCA BB
already supports. To see a list of supported-protocol names, open the Protocol Settings dialog box
in the Service Configuration Editor (see How to View Protocols, page 7-20). Assign the protocol a
unique ID in the range 5000 to 9998.

Cisco Service Control Application for Broadband User Guide
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DSS Signatures

e For an existing protocol, the protocol name and ID in the DSS must be identical to the protocol name
and ID in the service configuration. Locate the name and ID in the Protocol Settings dialog box in
the Service Configuration Editor (see How to View Protocols, page 7-20).

The Buddy Protocol

To simplify the configuration of new protocols added by a DSS, the DSS may specify a Buddy Protocol
for a new protocol. If, when importing a DSS to a service configuration, the application encounters
service elements referring to the Buddy Protocol, it automatically duplicates the set of service elements
that use the Buddy Protocol and replaces all references to the Buddy Protocol with references to the new
protocol. The association of the new protocol to services will match that of the Buddy Protocol.

A protocol may contain as many different signatures as necessary.
Four different types of signatures may be added to a protocol:
e String Match Signatures
¢ Payload Length Signatures
e HTTP User Agent Signatures
e HTTP x-Header Signatures
Each of the four signature types tests different conditions against the first payload packet of the flows.
These signature types and their conditions are described in the following subsections.

String Match Signatures and Payload Length Signatures can contain deep inspection clauses. A signature
whose first payload packet conditions are met will accept a flow if the conditions of any of its deep
inspection clauses are also met.

DSS String Match Signature

When you select a String Match Signature node in the DSS file component tree, you can define the
following properties of the signature:

e Signature Name—A unique name
e Signature Description
e Signature ID—A value in the range 0xC010000 to 0xCO100FF (decimal 201392128 to 201392383)
¢ First Payload Packet Conditions:
— Fixed Size Byte String—(Display only) Shows the string formed by the next four fields:

— [0]—Enter the ASCII code for the first byte of the string, or enter “*” to indicate that any
value is acceptable.

— [1]—Enter the ASCII code for the second byte of the string, or enter “*” to indicate that any
value is acceptable.

— [2]—Enter the ASCII code for the third byte of the string, or enter “*” to indicate that any
value is acceptable.

— [3]—Enter the ASCII code for the fourth byte of the string, or enter “*” to indicate that any
value is acceptable.
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— String Position—The position of the Fixed Size Byte String in the packet. The position is the
location of the first byte of the string, counting from the first byte in the packet. To match the
string with the beginning of the packet, this value should be zero. The value must be an integer
divisible by four.

— Packet Direction—The initiating side of the first packet in the flow that has a payload. This field
can have one of three values:

-~ From Server
— From Client
— Don’t Care (either side)

— Port Range—(Display only) The port range formed by the next two fields. The default value is
the entire port range: 0 to 65535.

— From Port—Lower bound of the port range (inclusive)
— To Port—Upper bound of the port range (inclusive)

— Check before PL—Toggles between the values true and false.

This field indicates whether to test the signature before or after the execution of the SCA BB
built-in PL (Protocol Library) classification. Testing this signature before the execution of the
built-in classification means that if the flow matches this signature, the PL classification will be
skipped. If this field is set to “false”, this signature will be tested only if the PL classification
fails to identify any of its supported protocol signatures.

— Asymmetric Routing Classification Mode—This field indicates whether to test the signature
depending on the state of the asymmetric routing classification mode. It can have one of three
values:

— Don't Care—Signifies that this signature should be tested whether asymmetric routing
classification mode is enabled or disabled.

- Disabled

- Enabled

- Flow Type—(Display only) This field shows to which flow types the condition applies (the
condition may be applied to multiple types). It is ignored unless asymmetric routing
classification mode is enabled.

The flow type is specified by the next four fields:

— Bidirectional—Toggles between the values true and false.

— Unidirectional Client Side—Toggles between the values true and false. Applies to TCP
flows for which only packets from the client side have been detected.

— Unidirectional Server Side—Toggles between the values true and false. Applies to TCP
flows for which only packets from the server side have been detected.

— Unknown (UDP)—Toggles between the values true and false. Applies to UDP flows for
which packets from only one direction have been detected.

Caution  Set Check before PL to true only if the signature identifies the protocol according to the first payload
packet only. If the signature also uses a Deep Inspection Condition that looks into later packets, and the
signature does not match the flow, the PL classification will not perform properly.

Figure 12-3 shows the default values for the String Match Signature properties.
Cisco Service Control Application for Broadband User Guide
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Figure 12-3

=

E 3

Signature Mame

Value
<enter a unigue name >

Default Values for the String Match Signature Properties

Signature Description
Signature Id OxC0 10000
- First Payload Packet Conditions
= Fixed Size Byte String abcd
[0 97
1 93
B EE
I3 100
5tring Position a
Packet Direction Don't Care
= Port Range 0:65535
From port o]
To port 55535
Check before PL false
Asymmetric Routing Classification Mode Don't Care
= Flow Type Bidirectional
Bidirectional true
Unidirectional Client Side false
Unidirectional Server Side false
Unknown (UDP) falze o
=
o

A flow that matches the first payload packet conditions of a String Match Signature will then be
compared against the deep inspection conditions of the signature (see DSS Deep Inspection Conditions,
page 12-9).

DSS Payload Length Signature

When you select a Payload Length Signature node in the DSS file component tree, you can define the
following properties of the signature:

e Signature Name—A unique name

¢ Signature Description

¢ Signature ID—A value in the range 0xC010000 to OxCO100FF (decimal 201392128 to 201392383)

e First Payload Packet Conditions:

Packet Direction—The initiating side of the first packet in the flow that has a payload. This field
can have one of three values:

— From Server

— From Client

— Don’t Care (either side)

Payload Length—The number of bytes in the payload packet.

Port Range—(Display only) The port range formed by the next two fields. The default value is
the entire port range: 0 to 65535.

— From Port—Lower bound of the port range (inclusive)
— To Port—Upper bound of the port range (inclusive)
Check before PL—Toggles between the values true and false.

[l Cisco Service Control Application for Broadband User Guide
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This field indicates whether to test the signature before or after the execution of the SCA BB
built-in PL (Protocol Library) classification. Testing this signature before the execution of the
built-in classification means that if the flow matches this signature, the PL classification will be
skipped. If this field is set to “false”, this signature will be tested only if the PL classification
fails to identify any of its supported protocol signatures.

- Asymmetric Routing Classification Mode—This field indicates whether to test the signature
depending on the state of the asymmetric routing classification mode. It can have one of three
values:

— Don't Care—Signifies that this signature should be tested whether asymmetric routing
classification mode is enabled or disabled.

— Disabled
— Enabled

— Flow Type—(Display only) This field shows to which flow types the condition applies (the
condition may be applied to multiple types). It is ignored unless asymmetric routing
classification mode is enabled.

The flow type is specified by the next four fields:
- Bidirectional—Toggles between the values true and false.

— Unidirectional Client Side—Toggles between the values true and false. Applies to TCP
flows for which only packets from the client side have been detected.

— Unidirectional Server Side—Toggles between the values true and false. Applies to TCP
flows for which only packets from the server side have been detected.

— Unknown (UDP)—Toggles between the values true and false. Applies to UDP flows for
which packets from only one direction have been detected.

Caution

Set Check before PL to true only if the signature identifies the protocol according to the first payload
packet only. If the signature also uses a Deep Inspection Condition that looks into later packets, and the
signature does not match the flow, the PL classification will not perform properly.

Figure 12-4 shows the default values for the Payload Length Signature properties.

Figure 12-4 Default Values for the Payload Length Signature Properties

Signature MName <enter a unique name >
Signature Description
Signature Id 0xC010000
=| First Payload Packet Conditions
Packet Direction Don't Care
Payload Length 1
-1 Port Range 0:65535
From port o]
To port 55535
Check before PL false
Asymmetric Routing Classification Mode Don't Care
=1 Flow Type Bidirectional
Bidirectional true
Unidirectional Client Side false
Unidirectional Server Side false
Unknown {UDP) false

210505
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A flow that matches the first payload packet conditions of a Payload Length Signature will then be
compared against the deep inspection conditions of the signature (see DSS Deep Inspection Conditions,
page 12-9).

DSS HTTP User Agent Signature

When you select an HTTP User Agent Signature node in the DSS file component tree, you can define
the following properties of the signature:

e Signature Name—A unique name
¢ Signature Description
¢ Signature ID—A value in the range 0xC010000 to OxCO100FF (decimal 201392128 to 201392383)
¢ Conditions:
— User Agent—The value of the User Agent field in the HTTP header
Figure 12-5 shows the default values for the HTTP User Agent signature properties.

Figure 12-5 Default Values for the HTTP User Agent Signature Properties

&=k =
B

Signature Name <enter a unigue name >
Signature Description
Signature Id 0xC0 10000
<] Conditions
User Agent <user agent>

210505

DSS HTTP x-Header Signature

When you select an HTTP x-Header Signature node in the DSS file component tree, you can define the
following properties of the signature:

e Signature Name—A unique name
¢ Signature Description
¢ Signature ID—A value in the range 0xC010000 to OxCO100FF (decimal 201392128 to 201392383)
¢ Conditions:
- x-Header Field Name—A name of a field in the x-Header of the HTTP header
Figure 12-6 shows the default values for the DSS file properties.

Figure 12-6 Default Values for the DSS File Properties

| s

B Properties L =

Signature Name <enter a unique name
Signature Description
Signature Id 0xC010000

= Conditions
x-Header Field Name <field name =

210806
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DSS Deep Inspection Clauses

S

Note

A deep inspection clause is a conjunctive clause of deep inspection conditions—a signature will accept
a flow only if all conditions in a clause are met.

If a signature has multiple deep inspection clauses, the clauses (and the deep inspection conditions
making up each clause) are tested in an order based on the value of the Packet Number property of the
deep inspection conditions.

After the first payload packet is accepted by the first payload packet conditions, the clause containing

the condition with the lowest Packet Number is tested. The other conditions in this clause are checked
in ascending Packet Number order. Thus, the Packet Number of any condition in a clause cannot be less
than the largest Packet Number in the clause it succeeds.

DSS Deep Inspection Conditions

A deep inspection condition is a set of conditions that are checked against flows that pass the first
payload packet conditions screening of String Match Signatures or Payload Length Signatures.

When you select a Deep Inspection Condition node in the DSS file component tree, you can define the
following properties of the deep inspection condition:

e Packet Direction—The initiating side of the first packet in the flow that has a payload. This field can
have one of three values:

— From Server
— From Client
— Don’t Care (either side)

¢ Packet Number—The number of the packet in the flow. The payload packets are numbered from
zero; packets are counted in both directions.

e Payload Length—The length of the packet in bytes. Enter zero to indicate that any value is
acceptable.

e Printable Characters—Test if the inspected packet contains only printable characters. This field can
have one of three values:

— Printable Characters Only
— At Least One Non-Printable
— Don’t Care

¢ Substring Search—Match a search string with a specific location in the packet. Leave the Search
String fields empty if this condition is irrelevant.

— Position Offset—The position from which to start searching for the search string in the packet.
The offset is relative to the location specified in the Start Search From field.

— Start Search From—This field can have one of two values:
- Packet beginning
— Last match

Last match means that the search for this search string starts where the last search match ended.
The last match may be from a previous substring search or from the last string-based first
payload packet condition.

[ oL-7205-11
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— Searchable Range—Search in this number of bytes for the search string.
— Search Packets—This field can have one of two values:

— This packet only

— Multiple packets

Multiple Packets means that the search may span across packets, as long as the overall number
of bytes is less than the number specified in the Searchable Range field.

— Search String—Enter the search string in one of the following three fields (the other two fields
will be updated automatically):

— ASCII Codes—Enter the ASCII codes for the characters of the search string. Separate each
code by a comma.

— Byte String—Enter the actual search string.

— Hex Values—Enter the hexadecimal values of the ASCII codes for the characters of the
search string. Separate each code by a comma.

e Transport Protocol—This field can have one of three values:
- TCP
- UDP
— Don’t Care (either TCP or UDP)

Figure 12-7 shows the default values for the deep inspection condition properties.

Figure 12-7 Default Values for the Deep Inspection Condition Properties
il Properties = -_'E—Iv B
Property Value
Packet Direction Don't Care
Packet Number 0
Payload Length 0
Printable Characters Don't Care
=| Substring Search
Position Offset 0
Start Search From Packet beginning
Searchable Range 3
Search Packets This packet only
-1 Search String
ASCII Codes 97,98,99
Byte String abc
Hex Values 61,62,63
Transport Protocol Don't Care %
[}
w

The structure of deep inspection conditions is the same for String Match Signatures and Payload Length
Signatures.

How to Create DSS Files

If you have a DSS file open in the Signature Editor, save it before you create a new DSS file. All unsaved
changes will be lost.

Step 1 From the toolbar, click b (Create a New DSS File).
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A DSS component tree containing a DSS File node, a Protocol List node, and a Protocol node, is
displayed in the Script view.

The default properties of the new DSS file are displayed in the Properties view.

s gService Configuration Editor Signature Editor € Network Navigator
<new D552 W Properties
. =
=] -|=| MyScript Script Description
= |E| Protocol List Script Version (Major) 1
< <enter a unique name > Script Version (Minor) 0
Script Build no. (Major) 1
Script Build no. (Minor) 0
Created for App. Version 3.1.0
< >
E conscle ) 5 UE i i -
: AL 1S
o
o
&

Step2  Edit the DSS file properties.
For an explanation of the properties, see The DSS File, page 12-2.
Step3  Click the Protocol node.
The protocol properties appear in the Properties view.
Stepd4  Edit the protocol properties.
For an explanation of the properties, see Information About DSS Protocols, page 12-3.

Step5  Click the drop-down arrow next to the ':E:' button.

s gService Configuration Editor Signature Editor € nNetwork Navigator

E <new D55 > 08 Properties ™.
— Froper
*-wB | T
=[] MySaipt String Match Signature | Name
= |E| Protocal List Payload Length Signature EI Description
Pl < cnter a u HTTP User Agent Signature | Id
HTTP x-Header Signature ! tegory

BUAdY Protocol
Protocol Families

210810

Step6  From the drop-down menu that appears, select a signature type.
A Signature node is added under the Protocol node.

If you selected a String Match Signature or a Payload Length Signature, a Deep Inspection Clause node
and a Deep Inspection Condition node are also added.

Cisco Service Control Application for Broadband User Guide
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Step 7

Step 8

Step 9

Step 10
Step 11

Step 12
Step 13
Step 14

B *<newDss>

ﬂ 2
1
®
L

= MyScript
= E Protocol List
= < <enter a unigue name >
[=- @ <enter a unique name >
=0} Deep Inspection Clause
B Deep Inspection Condition

158992

Click the Signature node.

The signature properties appear in the Properties view.

Edit the signature properties.

For an explanation of the properties., see DSS Signatures, page 12-4

If you selected a String Match Signature or a Payload Length Signature, click the Deep Inspection
Condition node to edit the deep inspection condition properties.

The deep inspection condition properties appear in the Properties view.

For an explanation of the properties, see DSS Deep Inspection Conditions, page 12-9.

Add additional deep inspection conditions, deep inspection clauses, signatures, and protocols as needed.

From the toolbar, click E_I3] (Save).

e If there are duplicate protocol names or protocol IDs, a Validation Error message appears.

3£ Validation Error

Cannot save script.
The script contains errors that have to be fixed before saving. See Console
view for errars,

Click OK, remove the duplication, and then click (Save) again.
A Save As dialog box appears.
Browse to the folder where you want to save the new DSS file.
In the File name field, enter an appropriate name for the DSS file.
Click Save.
The Save As dialog box closes.
The DSS file is saved.

Cisco Service Control Application for Broadband User Guide



| Chapter 12

Using the Signature Editor

How to Edit DSS Files W

How to Edit DSS Files

A

You can edit an existing DSS file, and add new protocols, or modify or delete existing protocols.

Caution

Step 1

Step 2
Step 3

Step 4

Step 5

If you have a DSS file open in the Signature Editor, save it before you open a different DSS file. All
unsaved changes will be lost.

From the toolbar, click 'E (Open a DSS File).

An Open dialog box appears.

Browse to the DSS file that you want to edit.

Click Open.

The Open dialog box closes.

The DSS Component tree of the selected file is displayed in the Script view.

The DSS File node is selected, and the properties of the DSS file are displayed in the Properties view.
Add, edit, or delete DSS file components.

See the subsections of The DSS File Components, page 12-2for an explanation of the properties of the
different components.

Save the modified DSS file.
e To overwrite the current DSS file with the changes you have made:
— From the toolbar, click L&l (Save).
The changes to the DSS file are saved.
e To save the modified DSS file with a new name:
1. Choose File > Save As.
A Save As dialog box appears.
2. Browse to the folder where you want to save the new DSS file.
3. In the File name field, enter an appropriate name for the DSS file.
4. Click Save.
The Save As dialog box closes.

The modified DSS file is saved with the new name.

How to Import DSS Files

S

Note

Step 1

You can import DSS files into the file you are currently editing.

Importing signatures may create duplication of protocol names or protocol IDs.

From the Console main menu, choose File > Import.

[ oL-7205-11
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The Import dialog box appears.

3£ Import

Select

hoose import source.

Select an import source;

|type Filker bext |

(5 Hetwork [ay
== Service Configuration
Iport content filkering database settings From an XML File
Import service configuration parks From a 5 file
[~ Signature Editar

Cancel

274089

Step2  From the import source list, select Import protocols from one DSS file to another DSS.
Step3  Click Next.

The second screen of the Import dialog box opens.
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3 Import

Import Protocols from One DSS File to Another
Select a DSS file containing the protocols you would like to import

D35 File Infomation:

Mo file has been selected.

Choaose File

Cancel

158857

Step4  Click Choose File.

An Open dialog box appears.
Step5  Browse to the DSS file to import.
Step6  Click Open.

The Open dialog box closes.

Information about the DSS file that you have chosen is displayed in the DSS File Information area.

Cisco Service Control Application for Broadband User Guide
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3 Import |g|

Import Protocols from One DSS File to Another
Select a DSS file containing the protocols you would like to import

D35 File Infomation:

D35 File: Loco.dss

Script Name: NewPocoScript
Version: 1.0 build 1.0

Created for SCA BB version: 3.1.0
Description:

The D55 contains signatures for the following protocols:
i_DCD

Choose File

< Back lest = ] Einish | Cancel

211136

Step7  Click Finish.
The Import dialog box closes.

The content of the selected DSS file is imported into the Signature Editor.

Cisco Service Control Application for Broadband User Guide



= CHAPTER 13

Additional Management Tools and Interfaces

e The SCA BB Service Configuration Utility, page 13-1

e The SCA BB Real-Time Monitoring Configuration Utility, page 13-3

e The SCA BB Signature Configuration Utility, page 13-6
e Overview of SNMP, MIB, and Traps, page 13-7

¢ Installing PQI Files from the Command Line, page 13-9

e Managing Subscribers via Other System Components, page 13-9

The SCA BB Service Configuration Utility

The Cisco Service Control Application for Broadband (SCA BB) Service Configuration Utility
(serveconf) is a command-line utility (CLU) for applying and retrieving service configurations. Use it in

a scripting environment to automate service configuration tasks on multiple Service Control Engine
(SCE) platforms.

The Service Configuration Utility can run in Windows, Solaris, and Linux environments.

servconf Syntax

The command-line syntax of servconf is:

servconf <operation> [<option>]

[<option>]...
Table 13-1 lists the servconf operations.

Table 13-2, Table 13-3, Table 13-4, Table 13-5, and Table 13-6 list the servconf options.

Table 13-1 servconf Operations

Operation Abbreviation Description

--apply -a Copies the specified service configuration file to the
specified SCE platforms and activates it

--retrieve -r Retrieves the current service configuration

--update-dc -u Updates a Cisco Service Control Management Suite
(SCMS) Collection Manager (CM) with service
configuration values

--status

Shows the service configuration status on the SCE platform

[ oL-7205-11
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Table 13-1 servconf Operations (continued)
Operation Abbreviation Description

--update-signature

Updates the SCE platform with a new protocol pack

--update-signature-pqi

Updates the SCE platform with a new SPQI protocol pack

--signature-info -i Shows information about the Dynamic Signature Script
(DSS) file

--help Displays help, then exits

--version Displays the program version number, then exits

Table 13-2 servconf File Options

File Option Abbreviation |Description

--file=filename -f Specifies a service configuration file or DSS file

--backup-directory=directory |-b

Specifies the directory to which to save the
retrieved PQB file before applying a new protocol
pack

Table 13-3

servconf Connection Options

File Option Abbreviation

Description

--se=address -S

Specifies the IP address of the destination SCE platform.

To specify multiple SCE platforms, list the IP addresses
separated by semicolons (see Example 1 in the following
section).

When using a semicolon in a Unix command line, the
command-line argument must be enclosed in quotation
marks.

--dc=address -D

Specifies the IP address of the destination SCMS-CM
platform (required only for the --update-dc operation).

o

--password=password

Specifies the password for connecting to the SCE platform.

&

==username=usernam

Specifies the username for connecting to the SCE platform.

e If this option is not specified, the following default values
are used:
e SCE—admin
e CM-—pcube
e SM—pcube
Table 13-4 servconf Reference SCE Option
File Option Description

--refer-se=address

Specifies the IP address of the SCE platform to which the service
configuration values refer (required only for --update-dc operation)

[l Cisco Service Control Application for Broadband User Guide
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Table 13-5 servconf Apply Options

File Option Description

--no-dc (Optional) Specifies that the --apply operation should not automatically
update the SCMS-CM with service configuration values.

--no-default-signature Applies the service configuration without adding the default DSS to it.

--force-default-signature |Forces the replacement of the DSS in the retrieved PQB with the default
DSS, even if the signatures of the existing DSS are mapped to services.
Without this flag, trying to update a PQB containing a DSS will fail.

Table 13-6 servconf Update Signature Option
File Option Description
--force-signature Forces replacement of the DSS in the retrieved PQB, even if the signatures

of the existing DSS are mapped to services. Without this flag, trying to
update a PQB containing a DSS will fail.

servconf Examples

Example 1

To copy the service configuration file config.pqb from the local machine to two SCE platforms (at
63.111.106.7 and 63.111.106.12), and activate this configuration:

servconf ”"--se=63.111.106.7;63.111.106.12" --username Alice --password ***** —_apply
--file config.pgb
Example 2

To retrieve the current service configuration from the SCE platform at 63.111.106.7, and save it in file
my_files\config.pgb on the local machine:

servconf -S 63.111.106.7 -U Bob -P ***** __retrieve --file my_ files\config.pgb
Example 3

To update the SCMS-CM at 63.121.116.17 with service configuration values from file config.pgb, as if
they were applied to the SCE platform at 63.111.106.7 (but without actually applying them to the SCE
platform):

servconf -D 63.121.116.17 -U Alice -P ***** __ypdate-dc

--refer-se 63.111.106.7 --file config.pgb
Example 4

To distribute the protocol pack file new_signature.spqi to the SCE platforms at 10.56.216.33 and
10.56.216.36:

servconf --update-signature-pgi -f new_signature.spqgi
-S ”10.56.216.33;10.56.216.36" -U userl23 -P ****x*

The SCA BB Real-Time Monitoring Configuration Utility

SNMP-based monitoring tools, such as MRTG, allow network administrators to monitor the activity and
health of network devices in real time. SCA BB includes an SNMP-based real-time monitoring solution,
which is implemented using MRTG and a graphics utility (RRDTool).

Cisco Service Control Application for Broadband User Guide
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The SCA BB Real-Time Monitoring Configuration Utility (rtmemd) is a command-line utility (CLU)
for automating the production of the files required by the MRTG tool.

For installation instructions, see How to Install the SCA BB Configuration Ultilities, page 4-7. For more
information about installing and using the SCA BB SNMP-based real-time monitoring solution, see the
Cisco SCA BB SNMP Real-Time Monitoring User Guide.

e rtmemd Syntax, page 13-4
e rtmcmd Examples, page 13-5
e The rtmcmd User Configuration File, page 13-5

e An rtmcemd User Configuration File Example, page 13-6

rtmemd Syntax

The command-line syntax of the SCA BB Real-Time Monitoring Configuration Utility is:

rtmcmd --sce <SCE (SNMP) addresses> {--file <PQB filename> | (--pgb-sce
<SCE (PQB) addresses> --username <username> --password <password>)} --source-dir <dir>
--dest-dir <dir> --config-file <file>

Table 13-7 lists the rtmemd options.

Table 13-7 rtmemd Options

Option Abbreviation  |Description

--sce address -S Specifies the IP address or hostname of the SCE platform from
which SNMP data will be collected.
To specify multiple SCE platforms, list the IP addresses separated
by semicolons.
When using a semicolon in a Unix command line, the
command-line argument must be enclosed in quotation marks.

--file filename  |-f (Required if --pgb-sce is not included) Specifies the service
configuration file to use when generating the configuration and
report files. If this option is specified, the --username/-U and
--password/-P options are prohibited.

--pgqb-sce -q (Required if --file is not included) Specifies the hostname or IP

address address of the SCE platform from which the service configuration
should be retrieved. This option requires the --username/-U and
--password/-P options.

--username -U (Required if --pgb-sce is included) Specifies the username for

<username> connecting to the SCE platform.

--password -P (Required if --username is included) Specifies the password for

<password> connecting to the SCE platform.

--source-dir -S Specifies the location of the report template files.

<dir>

--dest-dir -d Specifies the directory where the processedreport templates should

<dir> be stored.

--config-file -c Specifies the configuration file. (See The rtmcmd User

<file> Configuration File, page 13-5).
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You can invoke additional operations (see Table 13-8) to display information about the rtmemd using
the following syntax:

rtmemd <operation>

Table 13-8 rtmcmd Operations

Operation Description

--version Displays the program version number, then exits
--help Displays help, then exits

rtmcmd Examples

Example 1

To use the service configuration file servicecfg.pqb to create configuration and report files for the
collecting and reporting of SNMP information from two SCE platforms (at 63.111.106.7 and
63.111.106.12):

rtmcmd --sce="63.111.106.7;63.111.106.12" --file=servicecfg.pgb
--source-dir=/rtm-templates --dest-dir=/rtm-output -c./rtmcmd.cfg

Example 2

To use the service configuration loaded on the SCE platform at 63.111.106.7 to create configuration and
report files for the collecting and reporting of SNMP information from two SCE platforms (at
63.111.106.7 and 63.111.106.12):

rtmcemd -S "63.111.106.7;63.111.106.12" -U userl23 -P **** —_pgb-sce=63.111.106.7
--source-dir=/rtm-templates --dest-dir=/rtm-output -c./rtmcmd.cfg

The rtmcmd User Configuration File

The user configuration file contains user-specific information required by the rtmemd utility. The SCA
BB utilities distribution package contains a sample configuration file, named rtmcmd.cfg. You should
edit this file according to the details of your setup.

Table 13-9 lists the configuration parameters that should be present in the user configuration file:

Table 13-9 rtmemd User Configuration File Parameters
Required/
Parameter Description |Description Default Value |Optional
rrdtool_bin_dir The absolute path to the directory where Required
RRDTool and RRDCGTI binary files are
installed.
rtm_dir The absolute path to the directory where Required
RRD archives and CGI files are stored. This
is under the web server web directory.

[ oL-7205-11
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Table 13-9 rtmemd User Configuration File Parameters (continued)

Required/
Parameter Description |Description Default Value |Optional

mrtg_bin_dir The absolute path to the directory where Required
MRTG binary files are installed.

This location is used to create MRTG

invocation commands in the crontab sample
file.

snmpCommunityString |The SNMP community string to use when Public Required
accessing the SCE platforms.

The configuration text file is a listing of key-value pairs, where the key is one of the parameters listed
above, in the following format:

e Each key-value pair is on a separate line.

e A key-value pair may be extended across several adjacent lines by putting a backslash character, “\”,
at the end of each line.

e To use an actual backslash in the value (as in directory names on Windows), the backslash should
be escaped with a second backslash, like this: “\\” (or use a slash “/”).

)

e To comment a line, add “#” or at the beginning of the line.

For example:

# This is a comment line.
# Directory names should use escape backslashes:
rtm_dir=D:\\PROGRA~1\\APACHE~1\\Apache2.2\\htdocs

An rtmcmd User Configuration File Example

#The absolute path to the RRD tool's execution files folder
#Use '\\' or '/' as path separator
rrdtool_bin_dir=C:/rrdtool-1.2.15/rrdtool/Release

#The absolute path where RTM files will be placed.

#This path will be used by MRTG to create and update the RRD files
#Note: path must not contain white spaces!
rtm_dir=C:/PROGRA~1/APACHE~1/Apache2.2/htdocs

#The absolute path to the MRTG bin folder.
#This path will be used to create file crontab.txt
mrtg_bin dir=C:/mrtg-2.14.5/bin

#The SCE's community string
snmpCommunityString=public

The SCA BB Signature Configuration Utility

The SCA BB Signature Configuration Utility (sigconf) is a command-line utility for installing and
managing the default DSS.

The Signature Configuration Utility can run in Windows, Solaris, and Linux environments.
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For installation instructions, see How to Install the SCA BB Configuration Utilities, page 4-7.

sigconf Syntax

The command-line syntax of the SCA BB Signature Configuration Utility is:

sigconf <operation> [--file <filename>]
Table 13-10 lists the sigconf operations.

Table 13-11 lists the sigconf option.

Table 13-10 sigconf Operations

Operation Abbreviation |Description

--set-default-dynamic-signature -d Installs the default DSS on this workstation

--remove-default-dynamic-signature Uninstalls the default DSS from this
workstation

--get-default-dynamic-signature Fetches the default DSS installed on this
workstation

--help Displays help, then exits

Table 13-11 sigconf File Option

File Option Abbreviation Description

--file filename -f Specifies a DSS file

sigconf Examples

Example 1
To install the file new_signature.dss as the default DSS:

sigconf --set-default-dynamic-signature --file new_signature.dss

Example 2
To retrieve the installed default DSS file, and save it as default_backup.dss :

sigconf --get-default-dynamic-signature --file default_backup.dss

Overview of SNMP, MIB, and Traps

Cisco provides complete network FCAPS (Fault, Configuration, Accounting, Performance, Security)
management.

Two interfaces are provided for network management:

¢ Command-line interface (CLI)—Accessible through the console port on the front panel of the SCE
platform or through a Telnet connection to the SCE platform, the CLI is used for configuration and
security functions.
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SNMP

Traps

e SNMP (Simple Network Management Protocol)—Provides fault management (via SNMP traps) and
performance monitoring functionality.

SNMP is a set of protocols for managing complex networks. SNMP works by sending messages, called
protocol data units (PDUs), to different parts of a network. SNMP-compliant devices, called agents,
store data about themselves in Management Information Bases (MIBs) and return this data to the SNMP
requesters.

The SCE platform operating system includes an SNMP agent. Configuring the SNMP agent parameters
and enabling the SNMP interface is described in the “Configuring the Management Interface and
Security” chapter of the Cisco SCES000 Software Configuration Guide.

Management Information Bases (MIBs) are databases of objects that can be monitored by a network
management system. SNMP uses standardized MIB formats that allow standard SNMP tools to monitor
any device defined by a MIB.

The SCE platform supports the following MIBs:

e MIB-II—Defined in RFC 1213, (Management Information Base for Network Management of
TCP/IP-based Internets)

¢ Cisco Service Control Enterprise MIB—Described by a number of MIB files

The Cisco proprietary MIB allows external management systems to retrieve general information about
the SCE platform operating status and resource utilization, extract real-time measurements of bandwidth
utilization and network statistics, and receive notifications of critical events and alarms.

The part of the Cisco proprietary MIB that provides configuration and runtime status for SCA BB is
documented in the “SCA BB Proprietary MIB Reference” chapter of the Cisco Service Control
Application for Broadband Reference Guide. Other parts of the Cisco proprietary MIB are documented
in the “Proprietary MIB Reference” appendix of the Cisco SCES8000 Software Configuration Guide.
These books also explain the order in which the MIB must be loaded.

Traps are unsolicited messages generated by the SNMP agent that resides inside the SCE platform. Traps
are generated when an event occurs. When the Network Management System receives the trap message,
it can take suitable actions, such as logging the occurrence or ignoring the signal.

The SCE platform supports two general categories of traps:
e Standard SNMP traps—As defined in RFC 1157 and using the conventions defined in RFC 1215
e Proprietary Cisco Service Control Enterprise traps—As defined in the Cisco proprietary MIB

For a description of the SNMP traps and an explanation of how to configure the SNMP trap
managers, see “SNMP Configuration and Management” in the “Configuring the Management
Interface and Security” chapter of the Cisco SCES000 Software Configuration Guide.
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Installing PQI Files from the Command Line

e How to Install a SCA BB PQI File on an SCE Platform, page 13-9

e How to Enter Line Interface Configuration Mode, page 13-9

How to Install a SCA BB PQI File on an SCE Platform

Step 1

Step 2

Step 3
Step 4

You can install a SCA BB PQI file on an SCE platform using the SCE platform Command-Line Interface
(CLI).

Make sure that the PQI file is available.
Do one of the following:
¢ Locate the PQI file on the SCE platform.
e Upload the appropriate PQI file to the SCE via FTP.

Enter line interface configuration mode. (See How to Enter Line Interface Configuration Mode,
page 13-9.)

Type pqi install file engXXXXX.pqi.

Monitor the installation progress until it is completed.

What to Do Next

After you install the Console, you can use the Network Navigator tool to install PQI files. See How to
Install PQI Files on SCE Devices, page 5-21.

How to Enter Line Interface Configuration Mode

Step 1
Step 2

Step 3
Step 4

At the SCE platform CLI prompt (sce#), type configure.
Press Enter.

The sCE (config)# prompt appears.

Type interface LineCard 0.

Press Enter.

The SCE(config if)# prompt appears.

Managing Subscribers via Other System Components

Other components of the Cisco Service Control solution offer alternatives for subscriber management
(as opposed to using the Subscriber Manager GUI tool in the Console):
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e The Cisco Service Control Management Suite (SCMS) Subscriber Manager (SM) has options that
are not available from the Console.

e The SCE platform has a wide range of subscriber-related functions.

This section gives an overview of these alternatives, with emphasis on the SCA BB-specific subscriber
management options. For in-depth explanations, see the appropriate Service Control documentation.

¢ Anonymous Subscriber Mode, page 13-10

¢ Subscriber-Aware Mode, page 13-11

e Selecting Subscribers for Real-Time Usage Monitoring, page 13-12
e Managing Subscriber CSV Files, page 13-15

Anonymous Subscriber Mode

Note

Note

An anonymous subscriber is one with a name generated automatically by the SCE platform according to
an anonymous subscriber group specification. An anonymous subscriber is always mapped to a single
IP address. The actual identity of the customer is unknown to the system.

An anonymous group is a specified IP range, possibly assigned a subscriber template. If an anonymous
group is configured, the SCE platform generates anonymous subscribers for that group when it detects
traffic with an IP address in the specified IP range. If a subscriber template is assigned to the group, the
anonymous subscribers generated have properties defined by that template. If no subscriber template is
assigned, the default template is used, which cannot be changed by template import operations. Initially,
32 templates are preconfigured, one for each package ID.

Anonymous subscriber groups and subscriber templates are managed using the SCE platform
Command-Line Interface (CLI). You can enter CLI commands via a Telnet session. For more
information, see the Cisco Service Control Engine (SCE) CLI Command Reference.

Use the following commands to import anonymous subscriber groups and subscriber templates from
CSV files and to export subscriber data to these files:

e subscriber anonymous-group import csv-file
e subscriber anonymous-group export csv-file
e subscriber template import csv-file

e subscriber template export csv-file

The preceding CLI commands are line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-9) and see the
SCE(config if)# prompt displayed before entering a command.

Use the following commands to delete anonymous groups or subscriber templates from the system.
e no subscriber anonymous-group [all] [name <groupname>]
e clear subscriber anonymous

e default subscriber template all

The preceding CLI commands are line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-9) and see the
SCE(config if)# prompt displayed before entering a command.
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Use the following commands to display anonymous subscriber information:
¢ show interface LineCard O subscriber templates [index]
¢ show interface LineCard O subscriber anonymous-group [all] [name <groupname>]

e show interface LineCard O subscriber amount anonymous [name <groupname>]

show interface LineCard O subscriber anonymous [name <groupname>]

Subscriber-Aware Mode

In subscriber-aware mode, each subscriber is a specific customer with an externally generated name.
This externally generated name allows the subscriber to be mapped to more than one IP address and still
be identified. Each traffic session (single IP flow, or a group of related IP flows) processed by the SCE
platform is assigned to a recognized subscriber on the basis of the configured subscriber mappings.

There are three options for introducing and managing these subscribers:
e The SM GUI tool (see Using the SM GUI Tool, page 11-1)
e The SCE platform subscriber CLI
e The SM subscriber management CLU

The SCE Platform Subscriber CLI

Note

Note

Use the following commands to import subscriber data from CSV files and to export subscriber data to
these files:

subscriber import csv-file
subscriber export csv-file

The preceding CLI commands are line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-9) and see the
SCE(config if)# prompt displayed before entering a command.

Use the following command to remove subscribers from the system.

no subscriber [all] [name <subscriber-name>]

The preceding CLI command is a line interface configuration commands. You must enter line interface
configuration mode (see How to Enter Line Interface Configuration Mode, page 13-9) and see the
SCE(config if)# prompt displayed before entering the command.

Use the following commands to display subscribers meeting various criteria:

show interface LineCard 0 subscriber [amount]

[prefix <prefix>] [property <propertyname> equals \ greater-than | less-than
<property-val>]

show interface LineCard
show interface LineCard

0 subscriber [amount] prefix <prefix>
0
show interface LineCard 0 subscriber mapping IP <iprange>
0
0

subscriber [amount] suffix <suffix>

show interface LineCard subscriber [amount] mapping intersecting IP <iprange>
show interface LineCard subscriber mapping VLANid <vlanid>
Use the following commands to display information about a specific subscriber:

show interface LineCard 0 subscriber properties
show interface LineCard 0 subscriber name <name>
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show interface LineCard 0 subscriber name <name> mappings
show interface LineCard 0 subscriber name <name> counters
show interface LineCard 0 subscriber name <name> properties

The SM Subscriber Management CLU

The SM Subscriber Management Utility (p3subs) is a CLU for managing subscribers. You can use it to
add or remove subscribers. You can also manage subscriber properties and mappings with this utility.

For more information about p3subs, see the Cisco Service Control Management Suite Subscriber
Manager User Guide.

p3subs Syntax
You run p3subs from the Solaris shell prompt. The command-line syntax of the utility is:

p3subs <operation> --subscriber=<Subscriber-Name> [--ip=<IP-address>]
[--property=<property-name=value>] [--domain=<domain-name>] [--overwrite]

The following table lists the p3subs operations relevant to managing subscribers.

Table 13-12 p3subs Subscriber Operations

Operation Description

--add Adds a subscriber or replaces the existing subscriber configuration
--set Updates mappings and properties for the specified subscriber
--remove Removes the specified subscriber

--show Displays information for specified subscriber

Selecting Subscribers for Real-Time Usage Monitoring

Real-Time Subscriber Usage RDRs report the network activity of a single subscriber per service per
metric, in real-time. You must enable the generation of these subscriber usage RDRs separately for each
subscriber that you wish to monitor.

A

Caution  Generating and collecting Real-Time Subscriber Usage RDRs for many subscribers can compromise
performance. Enable Real-Time Subscriber Usage RDR generation only for subscribers that must be
monitored.

Generation of Real-Time Subscriber Usage RDRs is controlled by the monitor subscriber property. By
default, generation of these RDRs is disabled (monitor = 0).To enable generation of the RDRs, change
the value of the property to 1.

You can modify this property for selected subscribers using either the SM Command-Line Utility (CLU)
or the SCE platform CLI.

e Managing Subscriber Monitoring via the SM, page 13-13
e Managing Subscriber Monitoring via the SCE Platform, page 13-14
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Managing Subscriber Monitoring via the SM

Step 1

Step 1

Step 1

Step 2

Step 1

You can enable or disable the generation of the Real-Time Subscriber Usage RDRs using the SM p3subs
utility. You can also create a file that processes a batch of subscribers. For more information, see the
Cisco Service Control Management Suite Subscriber Manager User Guide.

e How to Enable Subscriber Monitoring for a Subscriber, page 13-13

e How to Disable Subscriber Monitoring for a Subscriber, page 13-13

e How to Enable Subscriber Monitoring for Multiple Subscribers, page 13-13

e How to Verify that Subscriber Monitoring is Enabled for a Subscriber, page 13-13

How to Enable Subscriber Monitoring for a Subscriber
You can enable subscriber monitoring for a specified subscriber.

From the command line, run sm/server/bin/p3subs --set --subscriber Smith --property monitor=1.

How to Disable Subscriber Monitoring for a Subscriber

You can disable subscriber monitoring for a specified subscriber.

From the command line, run sm/server/bin/p3subs --set --subscriber Smith --property monitor=0.

How to Enable Subscriber Monitoring for Multiple Subscribers

You can enable subscriber monitoring for multiple subscribers.

Create a text file (named monitor.txt in this example) containing the sequence of CLU invocations.

The file would look something like this:

p3subs --set --subscriber Jerry --property monitor=1
p3subs --set --subscriber George --property monitor=1
p3subs --set --subscriber Elaine --property monitor=1
p3subs --set --subscriber Kramer --property monitor=1

p3subs --set --subscriber Newman --property monitor=1
From the command line, run sm/server/bin/p3batch -f monitor.txt.

How to Verify that Subscriber Monitoring is Enabled for a Subscriber

You can check to see whether subscriber monitoring is enabled for a specific subscriber.

From the command line, run sm/server/bin/p3subs --show-property --subscriber Smith --property
monitor.

[ oL-7205-11
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Managing Subscriber Monitoring via the SCE Platform

Step 1

Step 2

Step 1

Step 2

Step 1

Step 2

Step 1

You can also enable or disable the generation of the Real-Time Subscriber Usage RDRs using the SCE
platform. For more information, see the Cisco SCES000 CLI Command Reference.

e How to Enable Subscriber Monitoring for a Subscriber, page 13-14

e How to Disable Subscriber Monitoring for a Subscriber, page 13-14

e How to Enable Subscriber Monitoring for Multiple Subscribers, page 13-14

e How to Verify that Subscriber Monitoring is Enabled for a Subscriber, page 13-14

How to Enable Subscriber Monitoring for a Subscriber
You can enable subscriber monitoring for a specified subscriber.

Enter line interface configuration mode. (See How to Enter Line Interface Configuration Mode,
page 13-9.)

At the SCE(config if)# prompt, run subscriber name Smith property name monitor value 1.

How to Disable Subscriber Monitoring for a Subscriber

You can disable subscriber monitoring for a specified subscriber.

Enter line interface configuration mode. (See How to Enter Line Interface Configuration Mode,
page 13-9.)

At the sCE(config if)# prompt, run subscriber name Smith property name monitor value 0.

How to Enable Subscriber Monitoring for Multiple Subscribers

You can enable subscriber monitoring for multiple subscribers.

Create a text file (named monitor.txt in this example) containing the sequence of CLI invocations,
including the commands to access the appropriate CLI mode.

The file would look something like this:

configure

interface LineCard 0

subscriber name Jerry property name monitor value 1

subscriber name George property name monitor value 1

subscriber name Elaine property name monitor value 1

subscriber name Kramer property name monitor value 1

subscriber name Newman property name monitor value 1

From the SCE platform CLI prompt (sce#), run script run monitor.txt.

How to Verify that Subscriber Monitoring is Enabled for a Subscriber

You can check to see whether subscriber monitoring is enabled for a specific subscriber.

From the SCE platform CLI prompt (sce#), run show interface LineCard 0 subscriber name Smith
properties.
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The properties are displayed; monitor is the relevant parameter.

Subscriber smith properties:
subscriberPackage=0

monitor=1

Subscriber 'smith' read-only properties

Managing Subscriber CSV Files

Use the p3subsdb SM utility to import and export subscriber CSV files. You can import subscriber
information for a group of subscribers from a CSV file into the SM database. You can also export
subscriber information from the SM database to a CSV file.

For more information, see the Cisco Service Control Management Suite Subscriber Manager User
Guide.

CSV file structure is described in the “CSV File Formats” chapter of the Cisco Service Control
Application for Broadband Reference Guide.

e How to Import Subscriber CSV Files, page 13-15
e How to Export Subscriber CSV Files, page 13-15

How to Import Subscriber CSV Files

Step 1 At the Solaris shell prompt, run p3subsdb --import <filename>.

How to Export Subscriber CSV Files

Step 1 At the Solaris shell prompt, run p3subsdb --export <filename>.

Example: Filtering and Exporting Subscribers

The following example exports every subscriber whose name begins with ‘a’ to the file
silverSubscriberFile.csv

p3subsdb --export --prefix=a --output=silverSubscriberFile.csv

Cisco Service Control Application for Broadband User Guide
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